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ВВЕДЕНИЕ

Ежегодно 3 декабря отмечается Всемирный день компьютерной 
графики. Дата выбрана не просто так: этот день в англо язычном вари-
анте – 3 December, т. е. получается единственное в своем роде ключевое 
сочетание 3December, или 3D. 

В современном мире, который по праву можно назвать миром ин-
формационных технологий, компьютерная графика занимает прочные 
позиции во многих сферах человеческой жизни: практически все изо-
бражения, которые нас окружают (обложки журналов, книги, газеты, 
рекламная печатная продукция, рек ламные ролики по телевидению, 
фильмы, презентации, сеть Интернет и т. д.), – объекты применения 
методов и инструментальных средств компьютерной графики. Это об-
условлено следующими причинами: 

 y эффективнее и экономически выгоднее создавать изображение на 
компьютере, чем используя традиционные методы;

 y легче становится улучшать цифровые изображения и компоно-
вать их с текстом;

 y компьютер обеспечивает надежное сохранение изображений на 
носителях информации. 

Сегодня любому человеку, работающему в сфере дизайна, фото-
графии, полиграфии, необходимо владеть основными графическими 
пакетами. Однако эффективная работа с графикой не только подраз-
умевает хорошее владение определенными графическими программа-
ми, средствами для создания и обработки изображений, но и требует 
конкретных знаний в области представления и хранения графической 
информации.

Компьютерная графика – симбиоз науки, творчества и компьютер-
ных технологий. Это область информатики, изучающая методы и сред-
ства создания и обработки изображения с помощью программно-аппа-
ратных вычислительных комплексов. Предметом ее изучения является 
создание, хранение и обработка моделей и их изображений с помощью 
средств вычислительной техники. 

Результатом применения компьютерной графики является цифро-
вое изображение – массив графической информации, представленный 
в форме данных, пригодных для хранения на цифровых носителях, об-
работки с помощью программ, воспроизведения с помощью периферий-
ных графических устройств и передачи средствами телекоммуникации. 
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Введение

В зависимости от сферы использования изображения компьютер-
ную графику подразделяют на следующие виды:

 y научная графика – визуализация объектов научных исследова-
ний, графическая обработка результатов расчетов, проведение вычис-
лительных экспериментов с наглядным представлением их результатов;

 y деловая графика – наглядное представление различных показате-
лей работы учреждений (диаграммы в MS Excel);

 y конструкторская графика, используемая в работе инженеров-
конструкторов, архитекторов, изобретателей новой техники. Этот вид 
компьютерной графики является обязательным элементом систем авто-
матизированного проектирования (САПР);

 y иллюстративная графика – создание иллюстраций (2D). Пакеты 
иллюстративной графики называют графическими редакторами и от-
носят к прикладному программному обеспечению общего назначения;

 y Web-графика – создание графических элементов Web-стра ниц. 
Для изображений Web-графики характерны ограничения по размеру 
файлов в целях минимизации времени передачи по сети и необходи-
мость сохранения качества изображения;

 y 3D-графика и компьютерная анимация – создание искусствен-
ных предметов и персонажей, их анимация и совмещение с реальными 
предметами и интерьерами. Сфера применения: индустрия компьютер-
ных игр, телереклама и оформление телеканалов, архитектура и дизайн;

 y мультимедиа – создание интерактивных энциклопедий, справоч-
ных систем, обучающих программ и интерфейсов к ним. Помимо гра-
фических редакторов, используют программы создания мультимедиа, 
например Macromedia Director и MS PowerPoint;

 y видеомонтаж: спецэффекты в кино, подготовка телевизионных 
передач.

Таким образом, компьютерная графика в современном обществе 
является базовым инструментом для дизайнера, стилиста, специалиста 
по рекламе, мастера издательского дела, строителя, архитектора, худож-
ника, инженера, конструктора, технолога, научного работника. А ос-
новным инструментом для применения компьютерной графики явля-
ются графические редакторы. 

Файлы, необходимые для выполнения практических заданий, 

приведенных в учебном пособии, можно скачать здесь.
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РАЗДЕЛ 

1

ВВЕДЕНИЕ В КОМПЬЮТЕРНУЮ ГРАФИКУ 

1.1. История развития компьютерной графики

Развитие компьютерной графики во многом обусловлено 
развитием технических средств ее поддержки, и прежде всего 
устройств вывода – мониторов или дисплеев. До 50-х годов прош-
лого столетия компьютеры выводили информацию только на пе-
чатающие устройства. Впервые в 1950 году в Кембриджском уни-
верситете (Англия) электронно-лучевая трубка осциллографа была 
использована для вывода графической информации на компьюте-
ре EDSAC (Electronic Delay Storage Automatic Computer).

Примерно полтора года спустя английский ученый К. Стрет-
чи написал для компьютера «Марк 1» программу, позволявшую 
играть в шашки и выводить информацию на экран. Однако это 
были лишь отдельные примеры, не носившие системного харак-
тера. 

Реальный прорыв в представлении графической информа-
ции на экране монитора произошел в рамках военного проекта 
на базе компьютера «Вихрь» Массачусетского технологического 
института (США). Данный компьютер использовался для фикса-
ции информации о вторжении самолетов в воздушное простран-
ство США. Первая демонстрация «Вихря» состоялась 20 апреля 
1951 года – радиолокатор посылал информацию о положении са-
молета компьютеру, и тот передавал на экран положение самоле-
та-цели, которая отображалась в виде движущейся точки и буквы 
T (Target). Это был первый крупный проект, в котором электрон-
но-лучевую трубку использовали для отображения графической 
информации.

С этого эксперимента начался этап развития векторных дис-
плеев (дисплеев с произвольным сканированием луча, каллигра-
фических дисплеев). 

В 1961 году программист С. Рассел возглавил проект по соз-
данию первой компьютерной игры с графикой «Spacewar» («Кос-
мические войны»). Игра была создана на машине PDP-1. 
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Раздел 1. Введение в компьютерную графику 

В 1963 году американский ученый в области информатики 
А. Сазерленд создал программно-аппаратный комплекс Sketch-
pad, который позволял рисовать точки, линии и окружности на 
трубке цифровым пером. По сути, это был прообраз САПР, ре-
ализованный на компьютере. Также программу можно назвать 
первым графическим интерфейсом, причем она являлась таковой 
еще до появления самого термина. Сам же термин «компьютер-
ная графика» придумал в 1960 году сотрудник компании Boeing 
У. Феттер.

К середине 1960-х годов наступил период плодотворной ра-
боты и в промышленных приложениях компьютерной графики. 
Фирма Itek разработала цифровую электронную чертежную маши-
ну. В 1964 году General Motors представила систему автоматизиро-
ванного проектирования DAC-1, разработанную совместно с IBM.

В 1968 году в СССР был снят мультфильм «Кошечка», в кото-
ром впервые появился анимированный компьютером персонаж. 
Группой под руководством математика Н. Н. Константинова была 
создана компьютерная математическая модель движения кошки. 
Машина БЭСМ-4, выполняя написанную программу решения 
дифференциальных уравнений, рисовала мультфильм, который 
для своего времени являлся прорывом. 

В конце 1970-х годов в компьютерной графике произошли 
значительные изменения. Появились мониторы с растровым ска-
нированием, имеющие множество преимуществ: вывод больших 
массивов данных, устойчивое, немерцающее изображение. Впер-
вые стало возможным получение цветовой гаммы. Со временем 
появились и другие технологии, которые позволили создавать бо-
лее компактные и легкие экранные панели. 

В 1977 году компания Commodore выпустила персональный 
электронный делопроизводитель (РЕТ), а компания Apple созда-
ла компьютер Apple-II. 

В это же время интенсивно развивается индустрия ком-
пьютерных игр. Одновременно компьютерную графику начи-
нают широко использовать на телевидении и в киноиндустрии. 
В 1975 году Дж. Лукас основал собственную компанию Industrial 
Light & Magic (ILM), которая занималась разработкой спецэф-
фектов. Немного позже в рамках этой компании было основано 
подразделение Lucasfilm CG (Lucasfilm Computer Graphics), кото-
рое начало активно развивать компьютерную графику. Именно 
оно выпустило в 1984 году первый анимационный CG-фильм 
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1.1. История развития компьютерной графики1.1. История развития компьютерной графики

«Приключения Андре и пчелки Уолли» (The Adventures of Andre 
& Wally B.). Этот фильм отличался от эффектов, которые созда-
вались ранее, он был полностью сделан при помощи компьютера.

Еще одно важное событие в процессе становления области 
компьютерной графики – выпуск в 1984 году компанией Apple 
компьютеров Macintosh. Они были для своего времени насто-
ящей революцией. Во-первых, Macintosh серийно поставлялся 
с цветным монитором. Во-вторых, его операционная система 
обладала наглядным, визуальным интерфейсом. И в-третьих, 
его мощности было достаточно для обработки графических изо-
бражений. В 1985 году появился первый мультимедийный персо-
нальный компьютер Amiga, который впервые позволил отобра-
жать фотографии, а впоследствии и видеоизображение на экране 
компьютера. 

В 1980-е годы появляется целый ряд компаний, занимающих-
ся прикладными разработками в области компьютерной графики, 
в частности Silicon Graphics, Adobe System. К концу 80-х годов 
программное обеспечение имелось для всех сфер применения: от 
комплексов управления до настольных издательских систем. В эти 
годы компьютерная графика уже прочно внедряется в киноинду-
стрию, развиваются приложения к инженерным дисциплинам.

В 1990-е годы в связи с возникновением сети Интернет 
у компьютерной графики появляется еще одна сфера приложе-
ния. Стираются различия между компьютерной графикой и об-
работкой изображения. Кроме того, появляется возможность ра-
боты с видео. 

Таким образом, в процессе развития компьютерной графики 
можно выделить несколько этапов:

 y 1960–1970-е годы: компьютерная графика формировалась 
как научная дисциплина. В это время разрабатывали основные 
методы и алгоритмы: отсечение, растровая развертка графиче-
ских примитивов, закраска узорами, реалистическое изображе-
ние пространственных сцен (удаление невидимых линий и гра-
ней, трассировка лучей, излучающие поверхности), моделирова-
ние освещенности;

 y 1980-е годы: графика развивается более как прикладная 
дисциплина. Разрабатывают методы ее применения в самых раз-
личных областях человеческой деятельности;

 y 1990-е годы: методы компьютерной графики становятся ос-
новным средством организации диалога «человек – компьютер» 
и остаются таковыми по настоящее время.
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Раздел 1. Введение в компьютерную графику 

1.2. Способы представления цифровых изображений. 
Типы компьютерной графики

В зависимости от принципа формирования изображения 
компьютерную графику подразделяют на следующие виды: 

 y растровая;
 y векторная;
 y фрактальная; 
 y трехмерная.

Трехмерная графика предназначена для отображения объем-
ных объектов. Она подробно рассматривается в главе 4.

1.2.1. Растровая графика

Под растровой графикой понимают формирование изображе-
ния в том виде, в котором оно выводится на экран монитора и на 
печать. Основным элементом растрового изображения является 
точка; если изображение экранное, то эта точка называется пик-
селем. Таким образом, растровое изображение может быть пред-
ставлено в виде матрицы элементов – пикселей.

Пиксель – минимальный участок изображения, которому 
независимым образом можно задать цвет.

Для растровых изображений особую важность имеет понятие 
разрешения, выражающее количество точек, приходящихся на 
единицу длины: точек на дюйм – dpi (dots per inch) или пикселей 
на дюйм – ppi (pixels per inch). 

Чем выше разрешение, тем большее количество пикселей 
содержит изображение и тем, соответственно, меньше размер 
отдельного пикселя. Например, если изображение имеет размер, 
равный одному квадратному дюйму, а разрешение изображения 
равно 8 ppi, то количество пикселей, содержащихся в нем, равно 
1 ∙ 82 = 64. Если разрешение 16 ppi, то изображение этого же 
размера содержит 1 ∙ 162 = 256 пикселей. Ни 8, ни 16 пикселей 
на дюйм не могут обеспечить создание качественного изобра-
жения. 

На рисунке 1.1 показаны линейка и согласование числа пик-
селей с разрешением изображения. 

Следует различать:
 y разрешение изображения (входное разрешение);
 y разрешение экрана (выходное разрешение);
 y разрешение печатающего устройства (выходное разрешение).
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1.2. Способы представления цифровых изображений1.2. Способы представления цифровых изображений

Пиксель

10 10 10

8 ppi 16 ppi 72 ppi

Рис. 1.1. Изображения с различными разрешениями

Все эти понятия относятся к разным объектам. Друг с дру-
гом эти виды разрешения никак не связаны, пока не потребуется 
узнать, какой физический размер будут иметь изображение на 
экране монитора и отпечаток на бумаге.

Разрешение изображения определяют, когда изображение 
оцифровывают с использованием сканера или цифрового фото-
аппарата или создают в программе обработки и редактирова-
ния изображения. Значение разрешения изображения хранится 
в файле изображения и неразрывно связано с другим свойством 
изображения – его физическим размером, определяющим физи-
ческую длину и ширину изображения. 

Физический размер изображения можно измерять как в пик-
селях, так и в единицах длины (миллиметрах, сантиметрах, дюй-
мах). Если изображение готовят для демонстрации на экране, то 
его ширину и высоту задают в пикселях, если изображение гото-
вят для печати, то его размер задают в единицах длины.

Выбор в качестве единицы измерения пикселя приводит 
к тому, что размер изображения определяют установленными 
значениями ширины и высоты и он не зависит от разрешения. 

При установке в качестве единиц измерения дюймов размер 
изображения определяют по формуле

Размер изображения = (Ширина ∙ Высота) ∙ Разрешение2.

Разрешение экрана измеряют в пикселях, оно определяет раз-
мер изображения, которое может поместиться на экране цели-
ком. У монитора с диагональю 15 дюймов размер изображения на 
экране составляет примерно 28 × 21 см. Зная, что в одном дюйме 
25,4 мм, можно рассчитать, что при работе монитора в режиме 
800 × 600 пикселей разрешение экранного изображения равно 
72 рpi, а в в режиме 1024 × 768 – 92 рpi.
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Например, есть два изображения: первое размером 1 × 1 дюйм 
с разрешением 200 ppi и второе размером 2 × 2 дюйма с разреше-
нием 100 ppi. На экране они выглядят идентично, поскольку име-
ют одинаковый размер изображения в пикселях: (1 ∙ 1) ∙ 2002 = 
= 400 000 пикселей (первое) и (2 ∙ 2) ∙ 1002 = 400 000 пикселей 
(второе). 

Разрешение печатающего устройства – это свойство, выража-
ющее количество отдельных точек, которые могут быть напеча-
таны на участке единичной длины. 

Для экранной копии достаточно разрешения 72 dpi, при пе-
чати разрешение должно быть намного выше. Полиграфическая 
печать полноцветного изображения требует разрешения не менее 
300 dpi. Стандартный фотоснимок размером 10 × 15 см должен 
содержать примерно 1000 × 1500 пикселей.

У растровой графики есть два существенных недостатка: 
большой объем данных и потеря качества при масштабировании.

При уменьшении количества точек теряются мелкие детали 
и деформируются надписи. 

Для увеличения размеров изображения возможны следую-
щие варианты: 

 y увеличить изображение, увеличив размеры пикселей;
 y добавить пиксели и создать для них новые цвета. 

1.2.2. Векторная графика

В основе векторной графики лежат математические представ-
ления о свойствах геометрических фигур: точки, прямой, отрезка 
прямой, кривой второго порядка, кривых Безье. 

Базовым элементом является линия, которая обладает свой-
ствами: формой, толщиной, цветом, начертанием. Для описания 
прямой линии используют уравнение y = ax + b. В отличие от 
прямой, отрезок требует дополнительных параметров, соответ-
ствующих его началу и концу. Узлы, наряду с линиями, выпол-
няют функции основных элементов векторного изображения. 
Узел представлен двумя координатами (Х, Y ) относительно на-
чала координат. Узлы также имеют свойства, параметры которых 
влияют на форму конца линии и характер сопряжения с другими 
объектами. Они служат для построения контуров, из которых 
состоят все прочие объекты векторной графики. Замкнутые кон-
туры приобретают свойство заполнения. В качестве заполнителя 
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может быть выбрана цветная краска, регулярная текстура или 
растровые изображения, называемые картой.

Кривые 2-го порядка (эллипсы, параболы, гиперболы) пред-
ставляются в памяти пятью параметрами, так как общая форму-
ла линии 2-го порядка имеет вид 

x2 + a
1
y2 + a

2
xy + a3x + a4y + a5 = 0. 

Для кодирования кривой 3-го порядка используют 11 па-
раметров. В векторных редакторах применяют частный случай 
кривых 3-го порядка – кривые Безье (8 параметров).

В начале 1970-х годов профессор П. Безье, проектируя на 
компьютере корпуса автомобилей «Рено», для построения кри-
вых использовал две касательные, проведенные к крайним точ-
кам отрезка. Кривизна линии зависит от угла наклона и длины 
отрезка касательной (управляющей линии) (рис. 1.2).

Управляющая 

точка

Управляющая 

точка

Управляющая 

линия

Управляющая 

линия

Опорная 

точка

Опорная 

точка

Кривая

Безье

Р
1

Р
2

Р
0

Р
3

Рис. 1.2. Кривая Безье

Таким образом, изображение в векторной графике – это со-
вокупность объектов, а объект, в свою очередь, состоит из кон-
тура и внутренней области, контур – из линий (прямых или 
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кривых) и узлов. Объекты векторной графики легко трансфор-
мируются и модифицируются, что не оказывает практически 
никакого влияния на качество изображения. Однако вектор-
ная графика ограничена в живописных средствах: в программах 
векторной графики практически невозможно создавать фото-
реалистические изображения. Кроме того, векторный принцип 
описания изображения не позволяет автоматизировать ввод 
графической информации, как это делает сканер для точечной  
графики.

Растровая графика незаменима в изображениях, которые очень 
сложны и которые невозможно описать математическими форму-
лами. Именно поэтому растровую графику применяют практиче-
ски во всех областях, связанных с компьютерной графикой.

Таким образом, выбор растрового или векторного формата 
зависит от целей и задач работы с изображением. Если нужна 
фотографическая точность цветопередачи, то предпочтительнее 
растр. Логотипы, схемы, элементы оформления удобнее пред-
ставлять в векторном формате.

1.2.3. Фрактальная графика

Фрактальная графика, как и векторная, – вычисляемая, но 
отличается от нее тем, что никакие объекты в памяти компьюте-
ра не хранятся. Изображение строят по уравнению или по систе-
ме уравнений. Изменяя коэффициенты уравнений, можно полу-
чать различные фрактальные изображения. Фракталом называют 
структуру, состоящую из частей, которые в каком-то смысле по-
добны целому.

Простейшим фрактальным объектом является фрактальная 
кривая Коха. Построение кривой Коха начинают с прямолиней-
ного отрезка единичной длины. Этот исходный отрезок, называ-
емый затравкой, может быть заменен каким-нибудь многоуголь-
ником, например равносторонним треугольником, квадратом. 
Каждое звено затравки заменяют образующим элементом. Сле-
дующее поколение получают при замене каждого прямолинейно-
го звена уменьшенным образующим элементом (рис. 1.3). 

Форматы графических файлов определяют способ хранения 
информации в файле (растровый, векторный, универсальный), 
а также форму хранения информации (используемый алгоритм 
сжатия).
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n = 1

n = 2

Рис. 1.3. Фрактальная кривая Коха

1.3. Форматы графических файлов

Сжатие применяют для растровых графических файлов, так 
как они имеют достаточно большой объем. Для различных типов 
изображения целесообразно применять подходящие типы алго-
ритмов сжатия.

Все существующие алгоритмы сжатия делят на 2 класса:
 y сжатие без потерь графической информации (алгоритмы 

RLE и LZW);
 y сжатие с потерями (алгоритм JPEG).

Кодирование с переменной длиной строки (Run-Length En-
coding, RLE) заменяет последовательность повторяющихся пик-
селей одинакового цвета на две величины: пиксель и количество 
его повторений. Например, если в строке имеются 3 пикселя бе-
лого цвета, 25 – черного, затем 14 – белого, то применение RLE 
кодирует эту строку как 3 белых, 25 черных и 14 белых вместо 
последовательности из кодов цветов всех 42 пикселей.

Алгоритм LZW (Lempel–Ziv–Welch) заключается в поиске 
одинаковых последовательностей (фраз) пикселей во всем фай-
ле. Выявленные последовательности сохраняются в таб лице, им 
присваиваются более короткие коды (ключи).

Алгоритм сжатия с потерями JPEG (Joint Photographic Experts 
Group) основан на том, что человеческий глаз очень чувствите-
лен к изменению яркости отдельных точек изображения, но го-
раздо хуже замечает изменение цвета. При сжатии с потерями 
приносится в жертву часть информации об изображении, чтобы 
достичь большего коэффициента сжатия. Распакованное изобра-
жение JPEG редко соответствует оригиналу абсолютно точно, но 
очень часто эти различия столь незначительны, что их едва мож-
но обнаружить.
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В таблице 1.1 приведены сведения об основных растровых 
форматах. 

Таблица 1.1

Основные растровые форматы

Наименование  

формата
Характеристика Сжатие

BMP (Device 
Independent Bitmap)

Поддерживается большинством графических прило-
жений для Windows;
глубина цвета 1, 4, 8, 16, 24 и 32 бита

RLE  
(по желанию)

GIF (Graphic  
Interchange Format) 

Создан специально для передачи изображений в сетях 
(формат Web-графики);
количество цветов в изображении – от 2 до 256 (глуби-
на цвета 1–8 бит);
поддерживает бинарную прозрачность;
поддерживает покадровую смену изображений (ани-
мацию)

LZW 

(всегда)

PNG (Portable  
Network Graphics)

Максимальная глубина цвета 24 бита;
поддерживает градиентную прозрачность (256 уровней);
формат Web-графики

Усовершен-
ствованный 
LZW

TIFF (Tagged Image 
File Format)

Поддерживает все цветовые модели;
максимальная глубина цвета 48 бит;
позволяет сохранять информацию о слоях, цветовых 
профилях и каналах;
поддерживается основными пакетами растровой и век-
торной графики, издательскими системами

RLE, LZW, 
JPEG  
(по желанию)

JPEG (Joint 
Photographic Experts 
Group)

Глубина цвета 24 бита;
позволяет выбрать уровень сжатия от 1 до 100;
формат Web-графики

JPEG

TGA (Truevision Targa 
Format)

Глубина цвета от 1 до 32 бит; 
поддержка альфа-каналов;
используют в основном для хранения текстур в 3D-гра-
фике

RLE  
(по желанию)

PSD (Photoshop 
Document)

Собственный формат программы Adobe Photoshop;
поддерживает все цветовые модели;
максимальная глубина цвета 48 бит;
позволяет сохранять информацию о слоях, цветовых 
профилях и каналах

RLE  

(по желанию)

Векторные форматы содержат описания рисунков в виде на-
бора команд для построения графических примитивов (линий, 
окружностей, дуг и т. д.). 

В таблице 1.2 приведены некоторые векторные форматы гра-
фических файлов.
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Таблица 1.2

Векторные форматы

Наименование формата
Программы, которые могут открывать  

файлы указанного формата

WMF (Windows Metafile) Большинство приложений Windows 

DXF (Drawing eXchange Format) Все программы САПР, многие векторные редакторы, неко-

торые издательские системы 

CGM (Computer Graphics Metafile) Большинство программ редактирования векторных рисун-

ков, САПР и издательские системы

CDR (CorelDRAW Document) Собственный формат программы CorelDRAW. Импорт в 

большинство векторных редакторов

AI (Adobe Illustrator Artwork) Собственный формат программы Adobe Illustrator. Напря-

мую открывается через Adobe Photoshop, практически все 

графические редакторы для Macintosh и Windows

К универсальным форматам относят E P S (Encapsulated Post-
Script) и PDF (Portable Document Format). Особенность этих 
форматов заключается в том, что они хранят как растровые, так 
и векторные данные, их обычно используют для переноса изо-
бражений между различными программными системами и ком-
пьютерными платформами. 

1.4. Цвет и цветовые модели в компьютерной графике

Цвет – очень сложное явление, он имеет как физическую, 
так и психофизиологическую природу. Цвет предмета зависит не 
только от самого предмета, но также и от источника света, ос-
вещающего предмет, и от системы человеческого видения. Более 
того, одни предметы отражают свет (доска, бумага), а другие его 
пропускают (стекло, вода). В зависимости от способа образова-
ния в природе различают цвет излучаемый и отражаемый:

 y источники света (солнце, лампочка и т. д.) излучают свет. 
Этот свет глаз воспринимает как цветной;

 y свет отражается и поглощается, попадая на поверхность не-
светящихся предметов. Отраженное излучение глаз воспринима-
ет как цвет предметов.

Из курса физики известно, что цвет – это форма световой 
энергии, передаваемая в виде электромагнитных волн. Челове-
ческий глаз может воспринимать цветовые волны с длинами от 
380 до 780 нм (нанометр – одна миллиардная метра, единица 
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измерения длины световых волн). Если длины волн светового 
потока 700 нм, то свет воспринимается как красный. Если длины 
волн сконцентрированы у нижнего края видимого спектра (около 
400 нм), то свет воспринимается как синий. Если длины волн 
сконцентрированы в середине видимого спектра (около 550 нм), 
то свет воспринимается как зеленый. Эти цвета – красный, зе-
леный и синий – называют основными, при их смешении обра-
зуется белый цвет.

Световые волны попадают на сетчатку глаза, где воспри-
нимаются светочувствительными рецепторами, передающими 
сигналы в мозг, в котором формируется ощущение цвета. Это 
ощущение зависит от длины волн и интенсивности излучения. 
Длина волны формирует ощущение цвета или цветность, а ин-
тенсивность – его яркость. Интенсивность света есть мера энер-
гии света, воздействующего на глаз, а яркость – мера восприятия 
глазом этого воздействия.

Исходя из вышеизложенного описание цвета может опирать-
ся на составление любого цвета на основе основных цветов или 
на такие понятия, как светлота, насыщенность, цветовой тон. 

В связи с необходимостью описания различных физических 
процессов воспроизведения цвета были разработаны различные 
цветовые модели.

Цветовая модель – это способ концептуального и количе-
ственного описания цвета. 

Модель RGB (Red, Green, Blue) описывает излучаемые цвета 
и образована на трех основных цветах; обычно ее так и называ-
ют – модель аддитивных основных цветов.

Аддитивной модель называют потому, что цвета получаются 
путем добавления (англ. addition) к черному цвету (рис. 1.4), т. е. 
если цвет экрана, освещенного цветным прожектором, обозна-
чается в RGB как (r1, g1, b1), а цвет того же экрана, освещенного 
другим прожектором, – (r2, g2, b2), то при освещении двумя про-
жекторами цвет экрана будет обозначаться как (r1 + r2, g1 + g2, 
b1 + b2).

Каждая составляющая представляет собой значение яркости 
(интенсивности) одного из базовых цветов в результирующем 
цвете и может принимать 256 дискретных значений: от 0 до 255. 
При минимальных интенсивностях всех базовых цветов получа-
ется черный цвет, при максимальных – белый. При максималь-
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ной интенсивности одного цвета и минимальной двух других – 
красный, зеленый и синий цвета. Наложение зеленого и синего 
цветов образует голубой цвет (Cyan), красного и зеленого – жел-
тый (Yellow), красного и синего – пурпурный (Magenta):

Black = Rmin + Gmin + Bmin = 0 + 0 + 0 = (0, 0, 0);
Red = Rmax + Gmin + Bmin= 255 + 0 + 0 = (255, 0, 0);
Green = Rmin + Gmax + Bmin = 0 + 255 + 0 = (0, 255, 0);
Blue = Rmin + Gmin + Bmax = 0 + 0 + 255 = (0, 0, 255);
Magenta = Rmax + Gmin + Bmax = 255 + 0 + 255 = (255, 0, 255);
Yellow = Rmax + Gmax + Bmin = 255 + 255 + 0 = (255, 255, 0);
Cyan = Rmin + Gmax + B max = 0 + 255 + 255 = (0, 255, 255);
White = Rmax + Gmax + Bmax = 255 + 255 + 255 = (255, 255, 255).

Рис. 1.4. Сложение цветов в модели RGB

При равных значениях каждой из составляющих получается 
серый цвет.

Модель RGB описывает цвета, получаемые в результате сме-
шения лучей света различной окраски. Таким образом, она соот-
ветствует представлению цветов, видимых на мониторе, а также 
получающихся при сканировании изображений, но не подходит 
для печатающих устройств, так как печатная страница отражает 
цвет. Смешение красок, которое делают печатающие устройства, 
описывает модель C M Y (Cyan, Magenta, Yellow).

К отражаемым относят цвета, которые сами не излучают, 
а используют белый свет, вычитая из него определенные цвета. 
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Такие цвета называют субтрактивными («вычитательными») или 
вторичными, так как они остаются после вычитания основных 
аддитивных (рис. 1.5): 

Cyan (Голубой) = RGB (Белый) – R (Красный) = G (Зеле-
ный) + B (Синий);

Magenta (Пурпурный) = RGB (Белый) – G (зеленый) = 
= R (Красный) + B (Синий);

Yellow (Желтый) = RGB (Белый) – B (Синий) = R (Красный) +  
+ G (Зеленый). 

Белая  

бумага

Пурпурный 

краситель
Желтый 

краситель

Отражает красный, 

синий, зеленый
Поглощает  

зеленый

Поглощает  

синий

R
R

R
B

B

G

Рис. 1.5. Вычитание цветов в модели CMY

При полном отсутствии краски остается белый цвет (белая 
бумага). При смешении всех трех (субтрактивных) должен полу-
читься черный цвет. В реальном субтрактивном синтезе тремя 
красками невозможно воспроизвести все цвета, доступные при 
аддитивном синтезе. В частности, невоспроизводим черный цвет, 
для компенсации чего в процесс воспроизведения в полиграфии 
вводят черную краску. Модель CMY с добавлением черного цвета 
носит название C M Y K (черный компонент сокращается до бук-
вы К, поскольку эта краска является ключевой (Key) в процессе 
цветной печати). 

Субтрактивные цвета составляют так называемую поли-
графическую триаду. Каждому пикселю в CMYK-изображении 
присваиваются значения, определяющие процентное содержание 
триадных красок.

Модели RGB и CMYK являются аппаратно-зависимыми. На 
разных мониторах одно и то же изображение выглядит неодина-
ково. Для CMYK различие еще более очевидно, поскольку речь 
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идет о реальных красках, особенностях печатного процесса и но-
сителя.

Перцепционная (базирующаяся на восприятии цвета челове-
ком) модель HSB построена на основе трех параметров:

 y Н – цветовой тон (Hue) – свет с доминирующей длиной волны;
 y S – насыщенность (Saturation) – характеризует чистоту 

цвета; 
 y В – яркость (Brightness) – характеризует интенсивность, с 

ко торой энергия света воздействует на рецепторы глаза.
Графическое представление модели HSB показано на рисун-

ке 1.6. Параметр Н измеряют в угловых градусах: от 0 до 360°. 
Параметр S измеряют в процентах: от 0 (в центре) до 100 %. Па-
раметр В отображается на линейке, перпендикулярной плоскости 
цветового круга, и измеряется в процентах.

Цветовой 

тон (Hue)

Насыщенность 

(Saturation)

Я
р

ко
с
ть

 

(B
ri

g
h

tn
es

s)

0°180°

Рис. 1.6. Модель HSB

На внешнем крае круга находятся чистые спектральные цве-
та с максимальной яркостью. Насыщенность цвета показывает, 
насколько данный цвет отличается от монохроматического («чи-
стого») излучения того же светового тона. Нулевая насыщенность 
соответствует серому цвету, а максимальная насыщенность – 
наиболее яркому варианту данного цвета. Можно считать, что 
изменение насыщенности связано с добавлением белой краски. 

Яркость понимают как степень освещенности. При нулевой 
яркости цвет становится черным. Максимальная яркость при 
максимальной насыщенности дает наиболее выразительный ва-
риант данного цвета. Можно также считать, что яркость изменя-
ют путем добавления черной краски. 
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В некоторых графических редакторах используют модель 
HLS (Hue, Lightness, Saturation), которая похожа на HSB. В ней, 
в отличие от HSB, вместо яркости используют параметр L – ос-
вещенность (Lightness). Уменьшение освещенности приближает 
цвет к черному, а увеличение – к белому. Чистый спектральный 
цвет получают при освещенности 50 %.

Модели HSB и HLS не ориентированы ни на какое техниче-
ское устройство воспроизведения цветов, поэтому их называют 
еще аппаратно-независимыми.

Модель Lab (рис. 1.7) основана на трех параметрах: яркости 
(Luminosity) – L и двух цветовых параметрах – а и b. Параметр а 
содержит цвета от темно-зеленого через серый до ярко-розового. 
Параметр b содержит цвета от светло-синего через серый до яр-
ко-желтого.

Яркость L

Насыщенность с
+b Ярко-желтый

–b Светло-синий

Темно-зеленый

Ярко-розовый

Цветовой тон

–а

+а
10 20 30 40 50 60

Рис. 1.7. Модель Lab

Это стандартная колориметрическая система. Она была при-
нята в 1971 году на VIII сессии Международной комиссии по осве-
щению – МКО (фр. CIE – Commission Internationale de L'Eclairage). 

Модель Lab соответствует биологическому механизму восприятия цвета 

человеком. За это открытие американцы Дэвид Хьюбл и Торстен Вайзел 

получили в 1981 году Нобелевскую премию. 

Цветовое разрешение (глубина цвета) определяет метод ко-
дирования (количество бит, необходимое для кодировании цвета 
одного пикселя) цветовой информации для ее воспроизведения 
на экране монитора.

Для отображения черно-белого изображения достаточно двух 
бит (белый и черный цвет). Восьмиразрядное кодирование по-
зволяет отобразить 256 (28) градаций цветового тона. Два байта 
(16 бит) определяют 65 536 (216) цветов (режим High Color). При 
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24-разрядном способе кодирования возможно определить более 
16,7 млн (224) цветов (режим True Color).

Контрольные вопросы
1. Перечислите основные вехи в истории компьютерной графики. Когда были 

разработаны основные алгоритмы компьютерной графики?

2. Изложите понятие цифрового изображения. 

3. Назовите основные понятия векторной графики. 

4. Опишите структуру векторной иллюстрации. 

5. Перечислите преимущества и недостатки векторной графики.

6. Назовите основные понятия растровой графики. 

7. От каких параметров зависит качество растрового изображения?

8. Что включает понятие «формат графического файла»?

9.  Какие форматы относят к растровым?

10. Какие форматы относят к векторным?

11. Какие системы описания цвета существуют? Назовите принципы их опреде-

ления.

12. Какие цвета являются аддитивными, какие субтрактивными? 

13. Назовите параметры описания цвета модели Lab, укажите особенности ее ис-

пользования. 
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РАЗДЕЛ 

2
ОСНОВЫ РАСТРОВОЙ ГРАФИКИ 

2.1. Редакторы растровой графики 

Для создания и обработки изображений на компьютере ис-
пользуют графические редакторы. К наиболее популярным рас-
тровым редакторам относят Adobe Photoshop, Adobe Fireworks, 
Corel PHOTO-PAINT, GIMP, Microsoft Paint и др. Основные 
функции растровых графических редакторов приведены на ри-
сунке 2.1.

Работа с файлом 

изображения

Работа  

с изображением

Работа с текстом

Работа с цветом

 y Создание нового файла изображения

 y Импорт и экспорт файла изображения

 y Загрузка изображения из файла

 y Сохранение файла изображения

 y Создание изображения с помощью панели инструментов

 y Выделение фрагментов изображения

 y Преобразование изображения

 y Коррекция изображения 

 y Изменение параметров изображения

 y Создание текста

 y Оформление текста

 y Выбор цветового режима

 y Управление цветом (установка основного фонового цвета,  

параметров заливки, обводки и т. д.)

Рис. 2.1. Основные функции растровых графических редакторов

Безусловный лидер программ в категории «редакторы рас-
тровой графики» – Adobe Photoshop – многофункциональ-
ный графический редактор, распространяемый фирмой Adobe 
Systems. Первая версия программы была создана в 1987 году для 
компьютеров Macintosh и названа Display. В сентябре 1988 года 
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Adobe Systems купила права на графический редактор, его пе-
реименовали в Photoshop и в 1990 году появился Photoshop 1.0. 
В 2003 году Adobe включила Photoshop в пакет Adobe Creative 
Suite, в комплекте которого уже были программы Illustrator, 
InDesign и Acrobat, а в следующем году программа была переиме-
нована в Adobe Photoshop CS (Creative Suite). В 2013 году название 
сменили на Adobe Photoshop CC. Аббревиатура CC означает, что 
продукт интегрирован в пакет программ Adobe Creative Cloud, 
к новым версиям добавили год выпуска.

Растровый графический редактор, разработанный корпора-
цией Corel, Corel PHOTO-PAINT не так популярен, как Adobe 
Photoshop, хотя приближается к нему по техническим возмож-
ностям. PHOTO-PAINT теряется в тени своего «собрата» – век-
торного графического редактора CorelDRAW, который явля-
ется лидером среди векторных графических редакторов. Corel 
PHOTO-PAINT поставляется совместно с CorelDRAW в пакете 
CorelDRAW Graphics Suite.

Бесплатный растровый графический редактор GI M P созда-
вался как свободный проект с открытым кодом, для которого 
каждый программист мог разработать различные модули. Проект 
был основан в 1995 году, и в настоящее время GIMP поддержи-
вается и развивается большим сообществом энтузиастов. По мне-
нию пользователей, GIMP является прямым конкурентом Adobe 
Photoshop, хотя сами создатели проекта так не считают.

Графический редактор Paint, созданный компанией Micro-
soft, входит в состав всех операционных систем семейства Win-
dows, начиная с самых первых версий. Ввиду простоты и до-
ступности известен практически каждому пользователю системы 
Windows, но из-за ряда функциональных ограничений практиче-
ски непригоден для серьезного редактирования графики. В част-
ности, редактор не поддерживает цветовые режимы, за исклю-
чением RGB.

Контрольные вопросы
1. Перечислите основные функции растровых графических редакторов.

2. Приведите примеры растровых графических редакторов.

3. Назовите основные версии и аббревиатуры редактора Adobe Photoshop.

4. Каково основное преимущество графического редактора GIMP?

5. Опишите основные преимущества и недостатки Microsoft Paint.
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2.2. Интерфейс программы Adobe Photoshop.  
Настройка рабочего пространства

Интерфейс программы является удобным и логичным. Рабо-
чее окно редактора с загруженным растровым документом содер-
жит панели, палитры и рабочую область, в которой размещаются 
текущий документ или открывающиеся диалоговые окна (рис. 2.2).

Рис. 2.2. Рабочее окно редактора Adobe Photoshop

Панели бывают стационарными (неподвижными) и плава-
ющими (их можно перемещать по своему усмотрению). Самая 
верхняя панель – стационарная панель меню редактора, содер-
жащая команды меню и специальную кнопку PS управления 
окном редактора. Начиная с Adobe Photoshop CS6 эта кнопка 
и модифицированный переключатель между рабочими средами 
заменяют панель управления.

В левой части окна программы расположена панель Tools 
(Панель инструментов). Сходные по назначению инструменты 
группируются. Доступ к инструментам группы можно получить, 
нажав на отображаемый инструмент. Панель инструментов мо-
жет быть отображена в виде одной или двух колонок. Для смены 
отображения панели используют кнопку в верхней части панели 
(заголовок панели). Многие инструменты ассоциированы с кла-
вишами на клавиатуре. Для переключения между инструментами 
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одной группы необходимо нажимать нужную клавишу в сочета-
нии с клавишей Shift.

Свойства выбранного инструмента настраиваются с помощью 
плавающей панели Options (Свойства), расположенной в верхней 
части интерфейса непосредственно под меню. В левой части па-
нели свойств находится пиктограмма текущего инст румента. С ее 
помощью можно получить доступ к предварительно сохранен-
ным наборам свойств инструмента – Tool Presets (Предустановки 
инструмента). Контекстное меню пиктограммы содержит наборы 
функций, разделенных горизонтальной прямой по группам на-
значения (табл. 2.1). 

Таблица 2.1 

Функции меню Tool Presets

Группа функций Назначение 

New Tool Preset (Новая настройка инструмента) Задать и сохранить собственные параметры

Rename Tool Preset (Переименовать настройку); 

Delete Tool Preset (Удалить настройку)

Действия с существующими настройками 

инструмента: переименовать или удалить

Sort by Tool (Сортировать по инструментам);

Show All Tool Presets (Показать настройки всех 

инструментов)

Cпособ отображения настроек инструмента

Text Only (Только текст); Small List (Малый 

список); Large List (Большой список) 

Вид списка настроек

Reset Tool (Сброс текущего инструмента);

Reset All Tools (Сброс всех инструментов)

Установить параметры текущего или всех 

инструментов «по умолчанию»

Preset Manager (Управление настройками) Позволяет Load (Загрузить),  

Save (Сохранить), Rename (Переименовать),  

Delete (Удалить) настройки

Справа обычно расположены плавающие палитры, которые 
также соединены в группы. Каждая палитра представляет со-
бой вкладку и имеет ярлык с названием. Палитры содержат соб-
ственное меню, которое вызывается кнопкой в правом верхнем 
углу палитры. В этом меню собраны команды, управляющие ви-
дом палитры (пункт Panel Options), а также связанные с функци-
ями палитры.

Отображение плавающих палитр:
 y Window (Окно) + имя палитры – показать/скрыть палитру;
 y Tab – показать/скрыть все открытые палитры;
 y Shift + Tab – показать/скрыть все открытые палитры, за ис-

ключением панели инструментов. 
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В палитре History (История) отображается список всех при-
мененных ранее инструментов и внесенных в изображение из-
менений. Чтобы вернуться к любому из предыдущих состояний, 
отменив результаты выполнения всех выполненных последую-
щих действий, активизируют его в палитре History. 

Для отмены последнего выполненного действия и повтор-
ного его выполнения достаточно воспользоваться комбинацией 
клавиш Ctrl + Z. Для отмены целой серии предыдущих действий 
используют комбинацию клавиш Ctrl + Alt + Z.

Конфигурацию панелей, удобную для текущих задач, мож-
но сохранить, чтобы быстро вернуться к ней в дальнейшем. Для 
этого используют команду меню Window  ⇒  Workspace  ⇒  Save 
Workspace… (Окно ⇒ Рабочее пространство ⇒ Сохранить рабочее 
пространство…). Сохраненная настройка появится в виде допол-
нительной команды меню в подменю Window ⇒ Workspace. Поми-
мо положения панелей, при сохранении рабочего пространства 
сохраняются также и конфигурация меню (выполняемая с по-
мощью команды Edit ⇒ Menus…), и настройка «горячих» клавиш 
(Edit ⇒ Keyboard Shortcuts…).

Основные настройки Adobe Photoshop доступны в окне Pre-
fe rences (Настройки), которое открывается с помощью коман-
ды Edit ⇒ Prefe rences ⇒ General (Редактирование ⇒ Настройки ⇒  
Общие).

Контрольные вопросы

1. Какова структура окна графического редактора Adobe Photoshop?

2. Опишите структуру строки меню и назначение отдельных ее пунктов.

3. Для чего предназначена панель инструментов Tools?

4. Для чего предназначена панель свойств Options?

5. Какая информация отображается в строке состояния?

6. Как скрыть или показать на экране панель инструментов, основные палитры?

7. Для чего предназначена палитра History?

8. Что такое рабочее пространство редактора и как им управлять? 

2.3. Обработка готовых изображений

2.3.1. Операции с файлами. Дублирование изображения

Adobe Photoshop поддерживает все стандартные операции 
с файлами (табл. 2.2), которые доступны в меню File (Файл). 
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Таблица 2.2

Операции с файлами

Команда меню
Комбинация 

клавиш
Назначение

New (Новый) Ctrl + N Создать новый файл

Оpen (Открыть) Ctrl + O Загрузить файл с диска

Save (Сохранить) Ctrl + S Сохранить файл на диске

Save As... (Сохранить как) Shift + Ctrl + S Сохранить файл с другим именем, в дру-

гом формате или в другом месте

Close (Закрыть) Ctrl + W Закрыть файл

Open Rеcent (Открыть последние) – Открыть один из последних рабочих файлов

Документ Adobe Photoshop отображается в отдельном окне. 
Заголовок окна открытого документа содержит имя, масштаб 
отображения и цветовой режим изображения. 

Чтобы создать новое окно с независимым изображением-ко-
пией, необходимо выполнить команду Image ⇒ Duplicate (Изобра-
жение ⇒ Создать дубликат).

У нижней границы окна документа размещается панель со-
стояния, которая отображает текущее состояние документа: мас-
штаб, размер, активный инструмент. Установить строку состо-
яния на отображение нужной информации можно с помощью 
серой стрелки-треугольника рядом с полосой прокрутки.

2.3.2. Изменение масштаба отображения изображения

Способы изменения масштаба отображения изображения: 
 y ввод с клавиатуры нужного масштаба в строке состояния;
 y использование сочетаний клавиш и пунктов меню View (Вид): 

Ctrl + «+» – увеличить масштаб;
Ctrl + «–» – уменьшить масштаб;
Ctrl + 0 – показать во весь экран;
Alt + Ctrl + 0 – масштаб 100 %;
 y View ⇒ Print Size (Вид ⇒ Печатный размер) – эта команда 

отображает изображение с таким масштабом, при котором раз-
мер изображения на экране приближен к размеру изображения 
на печати (вычисляется автоматически на основе значения раз-
решения изображения);

 y использование инструмента Zoom (Масштаб, клавиша Z). 
Инструмент Zoom имеет ряд свойств, настраиваемых на па-

нели Options. Первые две кнопки переключают режим масшта-
бирования: Zoom In – увеличение масштаба; Zoom Out – умень-
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шение масштаба (автоматически активируется при удерживании 
клавиши Alt). При активном флажке Resize Windows to Fit (Мас-
штабировать размер окна) на панели свойств инструмента будут 
меняться не только масштаб, но и размеры окна.

Переключиться на инструмент Zoom, не отменяя текущего ин-
струмента, можно, удерживая комбинацию клавиш Ctrl + пробел.

Для навигации по изображению можно использовать инст-
румент Hand (Навигатор, клавиша H) и палитру Navigator (Win-
dow ⇒ Navigator, Окно ⇒ Навигатор). В окне палитры Navigator 
выводится уменьшенное изображение, красная рамка показывает 
видимую часть. Слайдер внизу служит для изменения масштаба.

2.3.3. Цветовой режим изображения

Цветовой режим открытого изображения отображается в стро-
ке заголовка изображения. Adobe Photoshop поддерживает следу-
ющие режимы: 

 y Bitmap (битовый) – черно-белое изображение;
 y Grayscale (в градациях серого) – изображение в 256/65 536 от-

тенках серого в зависимости от глубины цвета (соответственно 
8/16 бит на канал);

 y Duotone (дуплекс) – изображение, в котором используется 
256 оттенков не более чем четырех цветов;

 y Indexed Color (индексированные цвета) – изображение с па-
литрой от 2 до 256 цветов;

 y RGB – полноцветное изображение, цвет в модели RGB;
 y C M Y K – полноцветное изображение, цвет в модели CMYK;
 y Lab – полноцветное изображение, цвет в модели Lab;
 y Multichannel – многоканальный.

Изменить цветовой режим можно с помощью команды 
Image ⇒ Mode (Изображение ⇒ Режим). Чтобы контролировать 
изменение цветов при переходе между цветовыми режимами 
RGB и CMYK, надо установить флажок Gamut Warning (Пред-
упреждение о недопустимом цвете) в меню View (Вид). При этом 
другим цветом будут выделяться области, которые при печати 
визуально отличаются от видимых на экране.

2.3.4. Изменение размера и разрешения изображения

Определить или изменить размер и разрешение изображения 
можно в окне, открываемом командой Image ⇒ Image Size (Изо-
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бражение ⇒ Размер изображения...). Изменить размер изображе-
ния можно двумя способами: 

1) изменить размер в единицах длины, сохранив размер в пик-
селях. Для этого в окне Image Size нужно снять флажок Resample 
(Интерполяция) и задать нужный размер в единицах длины. При 
снятом флажке изменение размера в пикселях будет недоступно 
(рис. 2.3). При этом изменится разрешение изображения; 

Рис. 2.3. Окно Image Size

2) изменить размер в пикселях и единицах длины, сохранив 
неизменным разрешение изображения. Для этого нужно задать 
новый размер изображения при включенном флажке Resample. 
При этом изменится размер файла изображения.

2.3.5. Изменение размеров и вращение холста

С помощью команды Image ⇒ Canvas Size (Изображение ⇒ 
Размер холста) можно изменить размеры холста, на котором 
находится изображение. В окне Canvas Size (рис. 2.4) надо вве-
сти новое значение в поле Width (Ширина) и/или Height (Высо-
та) в выбранных единицах измерения. Если установлен флажок 
Relative (Относительная), изменение размера осуществляется на 
заданные величины относительно текущих значений. 

Для выбора направления изменения размеров предназначена 
область Anchor (Привязка). В поле Canvas Extension Color (Цвет 
холста) задается цвет дополнительной области изображения.

Изображение можно повернуть на определенный угол с помо-
щью команды Image ⇒ Image Rotation (Изображение ⇒ Поворот).
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Рис. 2.4. Установка параметров холста

2.3.6. Кадрирование изображения

Кадрирование – это «отсечение» пикселей вокруг выбранной 
области. К средствам, позволяющим выполнить кадрирование, 
относят:

 y инструмент Crop (Кадрировать, 
клавиша С) – выделение области и 
кадрирование;

 y инструмент Perspective Crop (Кадрирование перспективы, 
клавиша С) – кадрирование с выравниванием;

 y команду Image ⇒ Crop (Изображение ⇒ Кадрировать) – кад-
рирование выделенной области; 

 y команду Image ⇒ Trim (Изображение ⇒ Обрезать) – авто-
матическое удаление лишних прозрачных или цветных областей 
вокруг изображения;

 y команду File ⇒ Automate ⇒ Crop and Straighten Photos (Файл ⇒ 
Автоматизация ⇒ Кадрировать и выровнять фото) – средство ав-
томатического кадрирования.

При выборе инструмента Crop (Кадрировать) по краям изо-
бражения появятся границы – рамка кадрирования. Можно 
изменить размеры имеющейся рамки с помощью маркеров или 
выделить прямоугольник, ограничивающий нужный фрагмент 
изображения. Часть изображения, находящаяся вне рамки ка-
дрирования, затеняется. Чтобы задать фиксированный размер 
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рамки кадрирования, необходимо на панели свойств инстру-
мента установить значения параметров Widht (Ширина), Height 
(Высота) и Resolution (Разрешение). Начиная с версии Adobe 
Photoshop CS6, можно задать пропорции для размеров (параметр 
Ratio (Соотношение)) и поменять местами ширину и высоту на-
жатием на кнопку с противоположно направленными стрелка-
ми. На панели свойств инструмента можно выбрать вид направ-
ляющих, задающих границы рамки, – кнопка Set the Overlay 
Options (Задать параметры наложения). Если установить курсор 
за границы рамки, можно вращать изображение в рамке кадри-
рования. При нажатой кнопке Determines if Pixel Data Outside the 
Crop Box is Remained or Deleted (Определяет, удалить или оставить 
пиксели вне рамки кадрирования) области вне рамки кадриро-
вания будут удалены, в противном случае скрыты. 

Изображение можно выровнять во время кадрирования. Для 
этого необходимо нажать кнопку Straighten (Выпрямить) и нари-
совать опорную линию.

Чтобы завершить кадрирование, необходимо нажать клави-
шу Enter, кнопку  на панели свойств инструментов или вы-
полнить двойной щелчок мышью на выделенной области. Для 
отмены надо нажать Esc или кнопку . 

Чтобы настроить классический режим кадрирования (вер-
сии CS5 и ранее), в котором перемещать нужно не изображение, 
а рамку, следует использовать кнопку Set Additional Crop Options 
(Задать дополнительные параметры) или нажать клавишу P.

2.3.7. Сохранение изображения

Adobe Photoshop сохраняет изображения практически во 
всех растровых форматах: BMP, GIF, JPEG, PNG, TIFF и др. 
Собственный формат программы – PSD, в нем можно полно-
стью сохранить все специальные эффекты, примененные к изо-
бражению.

Практические задания по пункту 2.3

Задание 1. Задание 1. Настройка среды редактора Adobe Photoshop. Из-
менение масштаба отображения изображения. 

Рекомендации по выполнениюРекомендации по выполнению
1. Загрузите Adobe Photoshop. 

При загрузке нажмите комбинацию клавиш Ctrl + Shift + Alt, чтобы восста-

новить настройки программы по умолчанию.
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2. Откройте файл 2_31.jpg. Используя палитру Navigator, уста-
новите масштаб 100 %. 

3. Разместите панель инструментов в две колонки слева. 
4. Сгруппируйте панели History, Info, Navigator, Histogram.
5. Переключитесь на инструмент Zoom. Последовательно из-

мените масштаб на значения Fit Screen (Уместить в экране), 100 % 
(Реальные пиксели), Fill Screen (Весь экран).

6. Определите размер изображения и размер файла изобра-
жения с помощью строки состояния. 

7. Сохраните рабочее пространство. 
Задание 2. Задание 2. Преобразование изображения из одного цветового 

режима в другой. 
Рекомендации по выполнениюРекомендации по выполнению
1. Определите, какие области изображения 2_31.jpg в режиме 

C M Y K будут визуально отличны от видимых на экране (View ⇒ 
Gamut Warning). Отмените предупреждение об изменении цвета.

2. Создайте дубликат изображения с именем 2_31-1. Преоб-
разуйте дубликат изображения в режим C M Y K.

3. С помощью команды Window ⇒ Arrange ⇒ ... (Окно ⇒ Орга-
низовать ⇒ ...) расположите изображения рядом и сравните цвета 
в различных режимах. 

При подготовке изображения для печати обычно готовое изображение 

преобразовывают в режим CMYK, а обрабатывают в RGB. 

4. Создайте два дубликата изображения с именами 2_31-2, 
2_31-3.

5. Преобразуйте изображение 2_31-2 в режим Grayscale (Гра-
дации серого), затем в режим Bitmap (Битовый), метод преобра-
зования – Diffusion Dither (Случайная диффузия).

6. Вернитесь к изображению в режиме Grayscale с помощью 
палитры History. 

7. Исследуйте остальные методы преобразования в режим 
Bitmap. Оставьте понравившийся вариант. 

8. Для изображения 2_31-3 измените режим на Grayscale. За-
тем переведите в режим Duotone (Дуплекс). В окне Duotone Op-
tions установите параметр Type (Тип) – Duotone. ฀

9. Щелкните на образце цвета Ink2 в раскрывающемся спи-
ске Book диалогового окна Color Libraries, выберите палитру 
Pantone + Solid Coated и задайте цвет второй краски, например 
PANTONE 149 C (см. рисунок). 
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PANTONE – определенный цвет, созданный с помощью смеси нескольких 

цветов (для каждого указано процентное соотношение базовых цветов 

CMYK) и имеющий свой собственный номер по классификации Pantone 

Matching System. 

10. Откройте файл 2_32.jpg. Создайте дубликат изображения 
с именем 2_32-1.

11. Для изображения 2_32-1 измените режим RGB на Indexed 
Color.

12. Поэкспериментируйте с изображением, увеличивая и 
уменьшая количество цветов в изображении, – параметр Colors 
(Цвета) в окне Indexed Color.

13. Вернитесь к исходному изображению.
14. Измените режим RGB на Indexed Color. Используя пали-

тру Black and White, установите количество цветов в изображении 
равным 8.
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15. Измените оттенки цветов с помощью команды Image ⇒ 
Mode ⇒ Color Table (Изображение ⇒ Режим ⇒ Цветовая таблица). 

16. В диалоговом окне Color Table (Цветовая таблица) щелч-
ком выберите 3-й цвет и в окне Color Picker (Выбор цвета) (см. 
рисунок) установите следующие значения параметров: H (Hue, 
Цветовой тон) – 45°; S (Saturation, Насыщенность) – 29 %; 
B (Brightness, Яркость) – 75 %. 

В диалоговом окне Color Picker (Выбор цвета) можно выбрать цвет визу-

ально с помощью цветового поля и цветовой полосы либо ввести в со-

ответствующие цифровые поля параметров любой из цветовых моделей. 

Установка флажка Only Web Colors (Только Web-цвета) позволяет отобра-

зить только цвета, адекватно отображаемые всеми браузерами в сети Ин-

тернет. Значок с восклицательным знаком указывает, что цвет не входит в 

печатаемую гамму цветов цветовой модели CMYK, значок в форме куба – 

цвет не относится к Web-цветам.

17. Для других цветов задайте следующие значения параме-
тров H, S, B: 5 – 37°, 31 %, 93 %;  6 – 35°, 42 %, 71 %; 7 – 29°, 70 %, 
32 %.

Задание 3. Задание 3. Кадрирование и выравнивание изображения с по-
мощью инструмента Crop (Кадрировать). Изменение размеров 
холста. 



35

2.3. Обработка готовых изображений2.3. Обработка готовых изображений

РеРекомендации по выполнениюкомендации по выполнению
1. Создайте дубликаты изображения 2_32.jpg с именами 

2_32-1, 2_32-2, 2_32-3.
2. Выберите инструмент Crop (Кадрировать). Выделите об-

ласть для кадрирования изображения 2_32-1 и скадрируйте.
3. Отобразите линейки и установите две вертикальные на-

правляющие в 1 см от левой и правой границ изображения.
4. На панели свойств инструмента Crop установите параме-

тры Widht (Ширина) = 15 см, Height (Высота) = 10 см, выдели-
те все изображение 2_32-2, совместите левый верхний и правый 
нижний маркеры рамки с левой и правой направляющими соот-
ветственно и скадрируйте.

5. Откройте файл 2_33.jpg и создайте дубликат с именем 
2_33-1. 

6. Инструментом Perspective Crop выделите все изображение.
7. Сместите угловые маркеры таким образом, чтобы рамка 

кадрирования совпала с рамкой на изображении (см. рисунок).

8. На панели свойств инструмента Perspective Crop (Кадрирова-
ние перспективы) установите параметр Resolution = 300 pixels/inch. 
и скадрируйте изображение.

9. Увеличьте ширину и высоту холста изображения 2_33-1 
на 1 см. Для этого в окне Canvas Size установите значения полей 
Widht (Ширина) = 1 см и Height (Высота) = 1 см при включенном 
флажке Relative. Значения других параметров не изменяйте.

Задание 4. Задание 4. Изменение размеров открытых изображений.
Рекомендации по выполнениюРекомендации по выполнению
1. Установите в окне Image Size новую ширину для изобра-

жения 2_32-1, равную 30 см без изменения размера в пикселях 
с сохранением пропорций (флажок Resample отключен). Оцените 
расположение на листе бумаги исходного и измененного изобра-
жений. 

2. Установите разрешение (параметр Resolution) изображения 
2_31-2 (флажок Resample Image отключен) равным 300 pixels/inch. 
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Оцените размер файла изображения и физический размер изо-
бражения.

3. Уменьшите размер изображения 2_32_1 в 2 раза. Для этого 
установите единицы измерения – percent (проценты), значение – 
50 %, флажок Resample включите. Оцените размеры изображения 
в пикселях и единицах длины, размер файла изображения.

4. Установите разрешение (параметр Resolution) изображения 
2_32-3 (флажок Resample отключен) равным 300 pixels/inch. Срав-
ните размеры изображений и размеры файлов изображений.

Задание 5.Задание 5.  Cохранение изображения.
Рекомендации по выполнениюРекомендации по выполнению
1. Закройте все исходные изображения 2_31.jpg, 2_32.jpg, 

2_33.jpg без сохранения.
2. Выполните команду Window ⇒ Arrange ⇒ Consolidate all to 

Tabs, чтобы все окна документов расположить последовательно 
на одной вкладке.

3. Сохраните изображения 2_31-1 в формате .tiff (без сжатия), 
2_31-2 в формате .bmр с глубиной цвета, равной 1 бит, 2_31-3  
в формате .psd, 2_33-1 в формате .gif. Обратите внимание, что 
для цветовых режимов списки доступных форматов различаются.

4. Сохраните изображения 2_32-2, 2_32-3, 2_33-1 в форма-
те .jpg. С помощью раскрывающегося списка Quality установите 
различные значения данного параметра (Maximum, High, Medium) 
при сохранении изображений.

5. Оцените размеры файлов исходных и преобразованных 
изображений. 

Контрольные вопросы
1. Для чего предназначена палитра Navigator (Навигатор)?

2. Какие способы управления масштабом изображения используют в программе 

Adobe Photoshop?

3. Какие форматы следует выбирать для сохранения документа в программе 

Adobe Photoshop? Почему?

4. Что такое холст? Как редактировать размеры и положение холста?

5. Как изменить размеры и разрешение изображения?

6. Как осуществляется кадрирование изображения? Что позволяют делать ин-

струмент Crop (Кадрировать) и команда Image ⇒ Crop (Изображение ⇒ Кадри-

ровать)?

7. Опишите отличие инструмента Perspective Crop (Кадрирование перспективы) 

от инструмента Crop (Кадрировать).

8. Поясните, как изменить цветовой режим изображения.
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9. Изложите назначение команды View ⇒ Gamut Warning (Вид ⇒ Предупрежде-

ние о недопустимом цвете).

10. Как можно изменить разрешение изображения? 

2.4. Цветовая и тоновая коррекция

Тоновая коррекция – операция перераспределения уровней 
яркостей исходного изображения. Для анализа яркости изобра-
жения предназначена палитра Histogram (Гистограмма), на кото-
рой отображается гистограмма. Расширенный вид палитры (вид 
изменяется в меню палитры, кнопка открытия которого располо-
жена в верхнем правом углу) показан на рисунке 2.5.

Рис. 2.5. Гистограмма

Гистограмма – график специального вида, отображающий распределение 

пикселей по яркости от белого к черному. Вертикальные линии показыва-

ют количество пикселей, имеющих одинаковую яркость, от самых темных 

(слева) до самых светлых (справа). Под графиком приводится статистиче-

ская информация: Mean – среднее значение яркости; Std Dev – стандарт-

ное отклонение значений яркости; Median – срединное значение в диапа-

зоне значений яркости и др.

Для тоновой коррекции изображения используют команды 
меню Image ⇒ Adjustments (Изображение ⇒ Коррекция): 

 y Brightness/Contrast (Яркость/Контраст) – установка значе-
ний параметров Brightness и Contrast в одноименном окне диалога; 

 y Levels (Уровни, Ctrl + L) – настройка уровней яркости изо-
бражения перемещением регуляторов черной и белой точек, ко-
эффициента гаммы или вводом числовых значений в соответ-
ствующие поля Input Levels и Output Levels (рис. 2.6):
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Рис. 2.6. Окно Levels (Уровни)

 –Input Levels (Входные уровни) – увеличение контрастности 
изображения за счет затемнения темных цветов и осветления са-
мых светлых;

 –Output Levels (Выходные уровни) – уменьшение диапазона 
уровней яркости за счет осветления самых темных пикселей и за-
темнения самых светлых;

 –Shadows – слайдер черной точки;
 –Midtones – слайдер полутонов (гамма-слайдер); 
 – Highlights – слайдер белой точки;
 y Сurves (Кривые, Ctrl + M) – сложная корректировка диа-

пазона яркостей с использованием кривой (рис. 2.7);
 y Shadow/Highlight (Тени/Света) – отдельная регулировка свет-

лых и темных областей, а также контраста изображения; 
 y команда HDR Toning… (Тонирование HDR) – позволяет  улуч-

шить контрастность изображения (параметры Radius (Радиус) и 
Strength (Интенсивность)), увеличить или уменьшить экспозицию 
(параметр Exposure в диалоговом окне команды) и детализацию 
(параметр Detali), корректировать яркость средних тонов (пара-
метр Gamma), а также регулировать яркость светлых и темных 
областей слайдерами Shadow (Тени) и Highlight (Света) и насы-
щенность, изменяя значения параметров Vibrance (Вибрация) и 
Saturation (Насыщенность).
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Рис. 2.7. Окно Curves (Кривые)

На горизонтальной оси графика откладывают яркость до преобразования, 
на вертикальной – после преобразования. Щелчком мыши можно устано-
вить точки на кривой, которые затем переместить в нужное положение. Для 
удаления ненужной точки надо выдвинуть ее за пределы графика. Если 
кривая в определенном месте идет выше диагонали квадрата, эти тона  
осветляются, если ниже – затемняются. 

Также можно использовать средства автоматической коррек-
ции, доступные в меню Image:

 y Auto Levels (Автотон, Ctrl + Shift + L) – автоматически пре-
образует самые светлые пиксели в белые, а самые темные – в 
черные и распределяет между ними уровни серого для каждого 
цветового канала;

 y Auto Contrast (Автоконтраст, Ctrl + Alt + Shift + L) – дей-
ствует аналогично Auto Levels для изображения в целом, сохраняя 
цвета без изменений.

Цветовая коррекция изображения – это изменение цветовых 
параметров пикселей (яркости, цветового тона, насыщенности).

Следующие команды меню Image ⇒ Adjustments (Изображе-
ние ⇒ Коррекция) используют для цветокоррекции: 

 y Auto Color (Автоматическая цветовая коррекция, Сtrl + 
Shift + B) – задает нейтральные значения для ярких оттенков и 
теней по отдельным каналам;
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 y Color Balance (Цветовой баланс) – позволяет регулировать 
баланс между комплиментарными цветами (голубым и красным, 
фиолетовым и зеленым, желтым и синим) с помощью соответ-
ствующих ползунков; 

 y Hue/Saturation (Цветовой тон/Насыщенность) – позволяет 
настраивать цвета согласно их цветовым тонам и насыщенности, 
тонировать изображения;

 y Selective Color (Выборочная коррекция цвета) – позволяет 
выделить область близких цветов и настроить цвета в изображе-
нии в модели CMYK, добавляя определенное количество краси-
теля к выбранному базовому цвету или убавляя его;

 y Replace Color (Замена цвета) – позволяет выделить область 
близких цветов и настроить для нее оттенок и насыщенность с 
помощью регуляторов Hue (Тон или цвет), Saturation (Насыщен-
ность) и Lightness (Яркость); 

 y Fhoto Filter (Фотофильтр) – позволяет корректировать от-
тенки изображения, имитируя фильтры, используемые в фото-
графии;

 y Variations (Вариации) – позволяет добавить основные цве-
та моделей RGB и CMYK, а также сделать рисунок светлее или 
темнее;

 y Desaturate (Обесцветить) – позволяет заменить цвета оттен-
ками серого;

 y Gradient Map (Карта градиента) – позволяет корректировать 
цвета в соответствии с цветовым переходом; 

 y Channel Mixer (Микширование каналов) – позволяет сфор-
мировать результирующее изображение в целевом канале путем 
смешивания в заданной пропорции исходных канальных изобра-
жений;

 y Match Color (Подобрать цвет) – позволяет согласовать от-
тенки одного изображения с оттенками другого.

Для цветовой коррекции можно использовать команды Levels 
и Curves, изменяя значение яркости пикселей отдельного цвето-
вого канала. 

Практические задания по пункту 2.4

Задание 1. Задание 1. Тоновая коррекция изображения с помощью ко-
манд меню Image ⇒ Adjustments (Изображение ⇒ Коррекция).

Рекомендации по выполнениюРекомендации по выполнению
1. Откройте файл 2_41.jpg. 
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Команда Brightness/Contrast (Яркость/Контраст)
2. Создайте дубликат изображения с именем 2_41-1. Выпол-

ните команду Brightness/Contrast (Яркость/Контраст).
3. Установите значение яркости +6 (перемещение регулятора 

затемняет или осветляет изображение).
4. Установите значение контрастности +40 (перемещение ре-

гулятора позволяет улучшить четкость изображения).
5. Сохраните дубликат изображения.
Команда Levels (Уровни)
Способ 1: настройка темных и светлых тонов с использованием 

слайдеров.
6. Создайте дубликат изображения с именем 2_41-2.
7. Активизируйте палитру Histogram (Гистограмма) и оцени-

те тоновый диапазон.
8. Выполните команду Levels (Уровни). Установите (если он 

сброшен) флажок Prewiev (Просмотр).
9. Переместите черный слайдер вправо до точки, от которой 

берут начало пиксели на диаграмме (≈30).
10. Переместите белый слайдер влево, совместив с точкой, 

где расположены последние пиксели на диаграмме (≈220). Таким 
образом определены белая и черная точки изображения.

11. Переместите средний слайдер вправо, чтобы слегка освет-
лить средние тона (точку определите самостоятельно).

12. Сохраните дубликат изображения.
Способ 2: настройка темных и светлых тонов с использованием 

инструмента Eyedropper (Пипетка).
13. Создайте дубликат изображения с именем 2_41-3.
14. Активизируйте палитру Info (Инфо). Выполните команду 

Levels. 
15. В окне диалога команды выберите инструмент White 

Eyedropper (правую пипетку). Щелчком мыши установите самый 
освещенный участок в качестве белой точки, используя для поис-
ка самой светлой точки значения яркостей каналов модели RGB, 
отображаемые на панели Info. 

16. В окне диалога выберите инструмент Black Eyedropper (ле-
вую пипетку). Таким же образом найдите наиболее затемненный 
участок изображения, имеющий минимальные значения ярко-
стей, и установите его в качестве черной точки.

17. Переместите средний слайдер (коэффициента гаммы) 
вправо, чтобы слегка осветлить средние тона (точку определите 
самостоятельно).
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18. Сохраните дубликат изображения.
Команда Curves (Кривые)
19. Создайте дубликат изображения с именем 2_41-4.
20. Выполните команду Curves. Расположите верхнюю пра-

вую и нижнюю левую точки кривой, как на рисунке. 

21. Сохраните дубликат изображения.
22. Чтобы сделать сетку, на которой отображен график, мель-

че, щелкните на графике при нажатой клавише Alt.
23. Выполните команду Window ⇒ Arrange ⇒ Tile Vertically 

(Окно ⇒ Организовать ⇒ Расположить все по вертикали). Срав-
ните результаты коррекции различными инструментами.

Задание 2. Задание 2. Цветовая коррекция изображения с помощью ко-
манд меню Image ⇒ Adjustments (Изображение ⇒ Коррекция). 

Рекомендации по выполнениюРекомендации по выполнению
1. Откройте файл 2_42.jpg.
2. Для того чтобы убедиться в наличии избыточного цвето-

вого оттенка, выполните команду Hue/Saturation (Цветовой тон/
Насыщенность). Переместите слайдер Saturation вправо до конца 
полосы. Очевидно, что избыточным является желтый оттенок. 

3. Для устранения оттенка используйте команду Auto Color 
(Автоматическая цветовая коррекция).

4. Отмените автоматическую настройку цвета.



43

2.4. Цветовая и тоновая коррекция2.4. Цветовая и тоновая коррекция

Команда Levels (Уровни)
5. Создайте дубликат изображения с именем 2_42-1.
6. Выполните команду Levels (Уровни). Выберите для рабо-

ты канал Blue, тоновый диапазон которого следует сделать более 
контрастным, поскольку синий цвет комплиментарен желтому.

7. Установите белый маркер на значении 230. Переместите 
влево регулятор гаммы (≈1,2). 

При нажатии клавиши Alt кнопка Cancel (Отмена) заменяется кнопкой 

Reset (Сброс), что позволяет отменить действия.

8. Сохраните дубликат изображения. 
Команда Color Balance (Цветовой баланс)
9. Создайте дубликат изображения с именем 2_42-2.
10. Выполните команду Color Balance (Цветовой баланс). 
11. В диалоговом окне Color Balance в области Midtones (Сред-

ние тона) переместите нижний регулятор на значение +50; в об-
ласти Highlight установите нижний регулятор на значение +25. 

12. Сравните результаты цветовой коррекции различными 
инструментами.

13. Сохраните полученное изображение в формате .jpg.
Задание 3. Задание 3. Создание пейзажной сепии с помощью команды 

Hue/Saturation (Цветовой тон/Насыщенность). 
Рекомендации по выполнениюРекомендации по выполнению
1. Откройте файл 2_43.jpg.
2. Выполните команду Image ⇒ Adjustments ⇒ Hue/Saturation 

(Изображение  ⇒  Коррекция  ⇒  Цветовой тон/Насыщенность), 
установите флажок Colorize (Тонирование).

3. Задайте значения следующих параметров: Hue (Цветовой 
тон) 150°, Saturation (Насыщенность) 25 %, Lightness (Яркость) 
–10 %.

4. Для усиления тональных отношений выполните команду 
Shadow/Highlight (Тени/Света). В области Highlight (Света) пере-
местите слайдер до значения 75 %.

Автоматически устанавливаются режимы корректировки для случая съем-

ки против света или со вспышкой. Иногда использование ручной настрой-

ки позволяет улучшить результат, для этого необходимо установить фла-

жок Show More Options (Показать дополнительные параметры).

5. Создайте паспарту для данного изображения с помощью 
команды Image ⇒ Canvas Size (Изображение ⇒ Размер холста):
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 y для построения тонкой белой окантовки установите следу-
ющие значения параметров: Widht (Ширина) – 6 px; Height (Вы-
сота) – 6 px; флажок Relative (Относительно) установлен; Anchor 
(Привязка) – в центре;

 y для создания более широкой цветной окантовки измените 
следующие значения по отношению к предыдущему действию: 
Widht (Ширина) – 50 px, Height (Высота) – 50 px. Цвету окантов-
ки присвойте параметры R = 68, G = 103, B = 85. 

6. Сохраните полученное изображение под именем 2_43-1.jpg.
Задание 4. Задание 4. Преобразование цветного изображения в черно-

белое полутоновое. 
Рекомендации по выполнениюРекомендации по выполнению
1. Откройте файл 2_44.jpg. 
Команда Hue/Saturation (Цветовой тон/Насыщенность)
2. Создайте дубликат изображения с именем 2_44-1.
3. Выполните команду Hue/Saturation и установите значение 

параметра Saturation (Насыщенность) равным –100 %.
4. Сохраните полученное изображение в формате .jpg.
Команда Gradient Map (Карта градиента)
5. Создайте дубликат изображения файла с именем 2_44-2.
6. Выполните команду Image ⇒ Adjustments ⇒ Gradient Map 

(Изображение ⇒ Коррекция ⇒ Карта градиента), используйте ва-
риант градиента Foreground to Background (От основного к фоно-
вому, должны быть установлены цвета по умолчанию).

7. Сохраните полученное изображение в формате .jpg.
Команда Channel Mixer (Микширование каналов)
8. Создайте дубликат изображения с именем 2_44-3.
9. Выполните команду Image ⇒ Adjustments ⇒ Channel Mixer 

(Изображение ⇒ Коррекция ⇒ Микширование каналов). 
10. В диалоговом окне установите флажок Monochrome (Мо-

нохромный), значения в цветовых каналах: R = +40; G = +60;  
B = +5.

11. Сохраните полученное изображение в формате .jpg.
Команда Desaturate (Обесцветить)
12. Создайте дубликат изображения с именем 2_44-4.
13. Выполните команду Image ⇒ Adjustments ⇒ Desaturate (Изо-

бражение ⇒ Коррекция ⇒ Обесцветить).
14. Сохраните полученное изображение в формате .jpg.
15. Сравните все варианты преобразования, в том числе вы-

полненные в предыдущей теме.
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Задание 5. Задание 5. Замена цвета в изображении. 
Рекомендации по выполнениюРекомендации по выполнению
1. Откройте файл 2_45.jpg. Создайте дубликат изображения 

с именем 2_45-1.
2. Выполните команду Image ⇒ Adjustments ⇒ Replace Color 

(Изображение ⇒ Коррекция ⇒ Замена цвета). 
3. В диалоговом окне команды (см. рисунок) установите па-

раметр Fuzziness (Разброс), определяющий диапазон выделяемых 
цветов, равным 80 %, активизируйте переключатель Selection 
(Выделенная область), чтобы в области предварительного про-
смотра отображалась маска. 

4. С помощью инструмента Add Sample (Добавить к образцу) 
выделите области зеленого цвета. В окне предварительного про-
смотра эти области будут отображаться белым цветом.

5. В нижней области окна установите значение параметров: 
Hue (Цветовой тон) = –40°, Saturation (Насыщенность) = +10 %. 
Отрегулируйте яркость с помощью кривых.

6. Сохраните полученное изображение в формате .jpg.
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Контрольные вопросы
1. Что такое гистограмма изображения?

2. Что такое тоновый диапазон? Для чего необходимо расширять, сужать тоно-

вый диапазон?

3. Что такое черная, серая, белая точки изображения? Для чего необходимо их 

определять?

4. Перечислите команды, используемые для тоновой коррекции. Каковы их осо-

бенности? 

5. В чем заключается цветовая коррекция? 

6. Перечислите команды, используемые для коррекции цвета. Каковы их особен-

ности? 

7. Какие команды позволяют выполнять и тоновую, и цветовую коррекцию? 

8. Назовите инструменты, используемые для локальной тоновой коррекции.

2.5. Инструменты рисования

2.5.1. Выбор цвета

В Adobe Photoshop используются два цвета: основной и фо-
новый. Образцы основного (кнопка 1) и фонового (кнопка 4) 

цветов расположены в нижней части панели инст- 
рументов. 

Кнопка 2 (клавиша D) позволяет установить 
в качестве основного – черный, фонового – белый 
цвета, а кнопка 3 (клавиша Х ) – инвертировать ос-
новной и фоновый цвета.

Самый общий способ выбора цвета – диалоговое окно Color 
Picker (Выбор цвета), вызываемое щелчком мыши на образце 
цвета.

Установить основной и фоновый цвета можно также с по-
мощью:

 y палитры Swatches (Образцы) – щелчком левой кнопки 
мыши по образцу цвета – основной цвет, при нажатой клавише 
Ctrl – фоновый;

 y палитры Color (Цвета) – ввести значения в соответствую-
щие цифровые поля или переместить ползунки;

 y инструмента Eyedropper (Пипетка, клавиша I) – щелчком 
левой кнопки мыши по образцу цвета на изображении – основ-
ной цвет, при нажатой клавише Alt – фоновый.

3

41

2
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2.5.2. Рисование и редактирование

Инструменты рисования окра-
шивают пиксели в основной цвет:

 y Brush (Кисть, клавиша В);
 y Pencil (Карандаш, клавиша В);
 y Color Replacement (Замена цве-

та, клавиша B); 
 y Mixer Brush (Микс-кисть, клавиша В).

Справа от иконки выбранного инструмента на панели 
свойств (рис. 2.8) стандартно расположен значок выпадающе-
го меню Tool Preset (Набор инструментов), содержащего пред-
варительно установленные параметры инструмента, в том числе 
пользовательские, и кнопку контекстного меню. Наборы кистей 
имеют расширение .abr и хранятся в папке Program Files/Adobe/
Adobe Photoshop CС…/Presets/Brushes.

Рис. 2.8. Панель свойств инструмента Brush

К общим параметрам инструментов Brush и Pencil, устанав-
ливаемым на панели свойств, относят Diameter (Диаметр), Mode 
(Режим смешивания пикселей) и Opacity (Непрозрачность).

В выпадающем меню The Brush Preset параметра Size можно 
установить размер кисти в пикселях, «смягчить» края кисти – 
параметр Hardness (Жесткость), а также выбрать кисть из загру-
женного набора. 

Чем больше значение жесткости кисти, тем более четкие у нее края. Для 

карандаша параметр игнорируется, так как он имеет жесткость 100 %, т. е. 

края всегда резкие.

Режим смешивания определяет результирующий цвет пиксе-
лей в зависимости от базового (исходного) цвета, цвета смешива-
ния (цвета, который наносится инструментом редактирования или 
рисования) и метода расчета. Первая группа содержит 4 режима:

 y Normal (Нормальный) – применяет кисть без какого-либо 
изменения в пикселях; это наиболее часто используемый режим;

 y Dissolve (Растворение) – добавляет немного шума краям 
кисти;

 y Behind (Позади) – позволяет рисовать позади объекта;
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 y Сlear (Очистить) – позволяет применить кисть в качестве 
ластика.

Режимы смешивания будут подробно рассмотрены в подпун-
кте 2.7.2.

С помощью Opacity можно менять прозрачность кисти, т. е. 
снижать или увеличивать интенсивность цвета кисти.

Изменить размер кисти можно нажатием клавиш «[» и «]», жесткость ки-

сти – нажатием клавиш Shift + «[» и Shift + «]» (жесткость меняется на 

25 %). Изменить непрозрачность кисти можно нажатием клавиш цифр от 

1 до 9; нажим кисти – нажатием клавиш Shift + цифр от 1 до 9. Значения 

параметров – двузначные числа. Например, однократное нажатие цифры 

4 – 40 %, нажатие 5 и 6 – 56 %.

На панели свойств кисти (см. рис. 2.8) также можно задать 
параметры:

 y Flow (Нажим) – определяет скорость вытекания краски из 
кисти от 0 % (самый слабый поток) до 100 % (максимум);

 y Airbrush (Аэрограф) – позволяет создать эффект постепен-
ного натекания краски при удержании курсора с нажатой кноп-
кой мыши в одной точке;

 y Smoothing (Сглаживание) – позволяет при рисовании изба-
виться от острых углов и делает переходы плавными.

У инструмента Brush (Кисть) есть много дополнительных пара-
метров, устанавливаемых на палитре Brushes (Window ⇒ Brush, F5):

 y Shape Dynamic (Динамика формы) – настройка параметров 
Size jitter (Колебание размера), Roundness jitter (Колебание формы), 
Angle jitter (Колебание угла);

 y Scattering (Рассеивание) – параметр, позволяющий уста-
новить рассеивание отпечатков кисти относительно линии дви-
жения;

 y Сolor Dynamic (Динамика цвета) – позволяет изменять цвет 
во время работы от цвета переднего плана до фонового; и др. 

Инструмент Color Replacement (Замена цвета) используется 
для замены цвета элементов изображения на основной с учетом 
яркости пикселей. Замена цвета осуществляется после щелчка 
мышью на цвете, который нужно заменить на основной, с учетом 
дополнительных параметров:

 y Sampling (Образец цвета) – определяет способ перенесения 
новых цветовых данных: Continuous (Непрерывный); Once (Одно-
кратный); Background Swatch (Образец фона);
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 y Limits (Ограничения) – задает область действия инструмен-
та: Discontiguous (Несмежные) – все пиксели данного цвета в изо-
бражении; Contiguous (Непрерывно) – пиксели выб ранного цвета 
в смежных областях; Find Edges (Выделение краев) – пиксели 
выбранного цвета в смежных областях, но при тщательном со-
хранении контуров изображения;

 y Tolerance (Допуск) – определяет значение близости цвета.
Инструмент Mixer Brush (Микс-кисть) позволяет моделиро-

вать реалистические приемы живописи. Микс-кисть использует 
два цветовых хранилища: в первом, называемым резервуаром, хра-
нится цвет, определяемый пользователем. Второе хранилище хра-
нит смешанный цвет, полученный в результате движения кисти 
по холсту. На панели свойств доступны следующие параметры:

 y раскрывающийся список Сurrent Brush Load (Текущая за-
груженность кисти) – отображает текущий цвет резервуара и по-
зволяет задать новый; 

 y кнопка Load the Brush After Each Stroke (Загружать кисть по-
сле каждого штриха) – устанавливает, что после каждого штриха 
кисть обмакивается в тюбик и приобретает исходный цвет;

 y кнопка Clean the Brush After Each Stroke (Очистить кисть 
после каждого штриха) – устанавливает, что после выполнения 
каждого штриха кисть автоматически очищается от примесей;

 y слайдер и поле ввода Wet (Влажность) – определяет влаж-
ность кисти, т. е. сколько краски кисть размажет с холста;

 y слайдер и поле ввода Load (Заполнение) – определяет коли-
чество краски на кисти;

 y слайдер и поле ввода Mix (Смешение) – определяет, какое 
количество краски на кисти поступает из резервуара, а какое – 
с холста. При нулевых значениях вся краска на кисти получена с 
холста, при значении 100 % – из резервуара.

2.5.3. Удаление фрагментов изображения 

Для удаления фрагментов изобра-
жения используют инструменты:

 y Eraser (Ластик, клавиша E) –
служит для удаления фрагментов 
изображения. Удаление заключается в том, что пиксели окраши-
ваются в цвет фона. Если изображение имеет прозрачный фон, 
то ластик делает пиксели прозрачными. 



50

Раздел 2. Основы растровой графики 

На панели свойств инструмента Eraser устанавливается один 
из трех режимов: Brush (Кисть); Pencil (Карандаш); Block (Ква-
дратный блок);

 y Background Eraser (Фоновый ластик) – делает прозрачными 
пиксели фона изображения по принципу близости цвета. Ис-
пользуют для обработки края объектов, особенно полезен при 
удалении фона на фотографиях. 

Параметры Sampling и Limits аналогичны Color Replacement. 
Флажок Protect Foreground Color (Сохранить основной цвет) за-
щищает от удаления основной цвет, определенный в палитре ин-
струментов;

 y Magic Eraser (Волшебный ластик) – выделяет близкие по 
цвету пиксели и окрашивает их в фоновый цвет или делает про-
зрачными. Параметры: 

 –Tolerance (Допуск) – определяет диапазон от 0 до 255 вы-
деляемых цветов. При значении 0 выделяется область, залитая 
одним цветом. Если допуск равен 255, выделяются все пиксели;

 –Smoothes Edge Transition (Сглаживать переходы) – кнопка 
для сглаживания переходов на краях;

 –Erase Only Contiguous Pixels (Удалить только смежные пик-
сели) – кнопка для удаления только смежных пикселей. При на-
жатой кнопке удаляется одна непрерывная область, в противном 
случае удаляются все пиксели выбранного цвета во всем изо-
бражении.

При активации инструмента курсор изменится на круг с не-
большим перекрестием в центре для выбора удаляемого цвета. 

Практические задания по пункту 2.5

Задание 1. Задание 1. Использование ин-
струментов рисования для создания 
пейзажа.

Рекомендации по выполнениюРекомендации по выполнению
1. Создайте новое изображение 

размером 800×600 рх с белым фоном 
в режиме RGB.

2. Установите темно-зеленый ос-
новной цвет, светло-зеленый – фо-
новый. 
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3. Загрузите набор кистей, используемый по умолчанию 
(Reset Brushes). Для установки параметров кисти используйте па-
литру Brushes (Кисти).

4. Нарисуйте траву инструментом Brush (Кисть) с параметрами: 
 y тип Grass (номер 154), диаметр 50 px;
 y Shape Dynamics: Size Jitter (Колебания размера) – 50 %; 

Minimum Diameter (Минимальный диаметр) – 0; Angle Jitter (Коле-
бания угла наклона) – 10 %;

 y Scattering: Scatter (Разброс) – 200; Count (Количество) – 10; 
Count Jitter (Колебания количества) – 0;

 y Color Dynamics: Foreground/Background Jitter (Колебания меж-
ду цветами переднего и заднего плана) – 100; Hue Jitter (Колеба-
ния тона) – 10 %; Saturation Jitter (Колебания насыщенности) – 
10 %; Brightness Jitter (Колебания яркости) – 10 %.

5. Экспериментируя с разными кистями, нарисуйте на холме 
цветы. Используйте режим аэрографа.

6. Установите на панели инструментов голубой в качестве ос-
новного, белый – фонового цветов. 

7. Выберите мягкую круглую кисть. Нарисуйте небо.
8. Облака нарисуйте инструментами Smudge (Палец, ) и 

Dodge (Осветлитель, ), выберите мягкую кисть, установите па-
раметры: Hardness (Жесткость) – 0 %; Mode (Режим) – Normal; 
Strenght (Нажим) – 50 %.

Инструмент Smudge (Палец, клавиша R) размазывает цвета на изображе-

нии, смещая пиксели соответствующих цветов. Он расположен на панели 

инструментов в одной группе с инструментами Blur (Размытие) и Sharpen 

(Резкость). 

9. Сохраните файл с именем 2_51.psd.
Задание 2. Задание 2. Удаление фона изображения инструментами груп-

пы Eraser.
Рекомендации по выполнениюРекомендации по выполнению
1. Откройте файл 2_52.jpg. Создайте дубликат с именем 2_52-1.
2. Инструментом Magic Eraser (Волшебный ластик) с пара-

метром Tolerance (Допуск) 20 % удалите фон изображения вокруг 
корабля.

3. С помощью инструмента Background Eraser (Фоновый ла-
стик) с параметром Tolerance (Допуск) 10 % удалите оставшиеся 
фрагменты фона изображения, оставив только корабль (см. рису-
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нок). Для улучшения результата изменяйте параметр Tolerance и 
диаметр кисти.

4. Сохраните полученное изображение в формате .jpg.

Горячая точка определяет 

удаляемый цвет

При действии инструмента 

выбранный цвет удаляется

ЗадЗадание 3. ание 3. Изменение цвета элементов изображения.
Рекомендации по выполнениюРекомендации по выполнению
1. Откройте файл 2_53.jpg. Создайте дубликат с именем 2_53-1.
2. Выберите инструмент Color Replacement (Замена цвета), 

установите параметры согласно рисунку.

3. Установите основной цвет – светло-серый. Измените цвета 
здания и его отражения в воде, используя различные размеры 
кисти инструмента.

4. Сохраните полученное изображение в формате .jpg.

Контрольные вопросы
1. Перечислите основные инструменты рисования графического редактора 
Adobe Photoshop. Каковы их общие свойства и различие?
2. Как изменить размер и жесткость кисти?
3. Как изменить форму кисти? Как изменить набор кистей?
4. Как выбрать цвет рисования? Как инвертировать цвета и установить цвета по 
умолчанию?
5. Как создать новую кисть? 
6. Опишите палитру кистей. Какие дополнительные параметры можно настроить 
с ее помощью?
7. Перечислите инструменты для удаления фрагментов изображения.
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8. Как работает Волшебный ластик? Назовите его отличие от фонового.
9. Какие комбинации клавиш позволяют изменять параметры кисти?

2.6. Инструменты выделения

2.6.1. Выделение областей изображения

Для построения выделенной области правильной формы 
предназначены инструменты: 

 y Rectangular Marquee (Прямо-
угольная область, клавиша М);

 y Elliptical Marquee (Оваль-
ная область, Shift + M);

 y Single Row Marquee (Выде-
ление строки пикселей);

 y Single Column Marquee (Вы-
деление столбца пикселей). 

Для создания выделенной области в форме квадрата или 
круга удерживают нажатой клавишу Shift. При нажатой клавише 
Alt область выделяется от центра, а не от угла.

Существуют три стиля выделения, устанавливаемые на пане-
ли свойств инструментов Rectangular Marquee и Elliptical Marquee:

 y Normal (Обычный) – выделение области с произвольными 
размерами рамки;

 y Constrained Aspect Ratio (Фиксированные пропорции) – вы-
деление области с заданным соотношением высоты и ширины;

 y Fixed Size (Фиксированный размер) – построение области 
выделения точных размеров.

Для построения выделенной области неправильной формы 
используются инструменты: 

 y Lasso (Лассо, клавиша L) – выделение области произвольной 
формы с помощью мыши, кривая замыкается в момент отпускания 
мыши;

 y Polygonal Lasso (Многоуголь-
ное лассо) – щелчком левой кнопкой 
мыши последовательно фиксируют-
ся все узлы ломаной, ограничиваю-
щей область выделения. Чтобы замкнуть ломаную, необходимо 
щелкнуть около первой точки либо выполнить двойной щелчок 
мышью;
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 y Magnetic Lasso (Магнитное лассо) – используется для вы-
деления объектов с достаточно четкими границами. Определе-
ние границ основывается на поиске областей максимальной кон-
трастности, которые обычно и соответствуют краям объекта. 

Параметр Contrast (Контрастность) задается в поле на пане-
ли свойств: чем больше значение, тем меньше чувствительность. 
В поле Wight (Ширина) задается в пикселях радиус, в области 
которого производится анализ контрастности, а в поле Feather 
(Растушевка) – размер смягчения краев выделения.

Удалить неверно установленные последние узлы можно с по-
мощью клавиш Delete или Backspace. Клавиша Alt позволяет пере-

ключаться между инструментами 
Lasso и Polygonal Lasso.

Quick Select (Быстрое выделе-
ние, клавиша W ) – инструмент, 

предназначенный для быстрого выделения области, «нарисован-
ной» кистью этого инструмента.

Для выделения областей с близкими цветами предназначен 
инструмент Magic Wand (Волшебная палочка, клавиша W ). За 
базовый цвет принимается цвет пикселя, на котором сделан щел-
чок мышью. Параметры инструмента аналогичны параметрам 
Magic Eraser.

Если в изображении есть выделенная область, большинство команд и ин-

струментов Adobe Photoshop действуют только в ее пределах.

2.6.2. Общие свойства инструментов и режимы выделения

К параметрам, задаваемым на панели свойств практически 
всех инструментов выделения, относят:

 y Smoothes Edge (Сглаживание) – сглаживание границы вы-
деления;

 y Feather (Растушевка) – растушевка границы выделенной об-
ласти.

В левой части палитры свойств всех инструментов выделения 
расположены четыре переключателя, которые обозначают режим: 

1 – новая выделенная область, старое выделение отменяется;
2 – сложение (клавиша Shift) – новая об-

ласть добавляется к уже выделенной;
3 – вычитание (клавиша Alt) – новая об-

ласть вычитается из уже выделенной;21 3 4
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4 – пересечение (сочетание Alt + Shift) – выделенной будет об-
ласть перекрывания предыдущей и новой областей (общая часть).

2.6.3. Модификация границы выделенной области

Переместить границу выделенной области можно с помощью 
мыши, когда активен инструмент выделения. Чтобы скрыть гра-
ницу выделенной области, нажмите сочетание Ctrl + H; повторное 
нажатие Ctrl + H снова отобразит границу выделенной области.

C помощью команд меню Select (Выделение) можно изме-
нить границы выделенной области (табл. 2.3). 

Таблица 2.3

Изменение границы выделенной области

Операция Команда

Снять выделение Deselect (Отменить выделение, Ctrl + D)

Инвертировать выделенную область Inverse (Инвертировать выделенную область, 

Shift + Ctrl + I)

Выделить границу области заданной тол-

щины 

Modify ⇒ Border (Модифицировать ⇒ 
Граница)

Расширить или сжать область на заданное 

количество пикселей

Modify ⇒ Expand/Contract (Модифициро-

вать ⇒ Расширить/Сжать)

Сгладить границу выделенной области Modify ⇒ Smooth (Модифицировать ⇒ 
Сгладить)

Растушевать на заданное число пикселей 

границу выделенной области

Modify ⇒ Feather (Модифицировать ⇒ 
Растушевать)

Добавить в выделенную область соседние 

пиксели в пределах допуска инструмента 

Magic Wand 

Grow (Добавить смежные пиксели)

Включить в выделенную область все пиксели 

изображения в пределах допуска инструмен-

та Magic Wand 

Similar (Добавить схожие пиксели)

Трансформировать границу выделенной 

области

Select ⇒ Transform Selection (Выделение ⇒ 
Трансформировать выделенную область)

После активации команды Select and Mask (Выделить и ма-
скировать) открывается диалоговое окно с настройками режи-
ма отображения выделенной области и параметрами изменения 
границ области, в котором собраны часто применяемые инст- 
рументы.

Команда Focus Area (Область фокусировки) дает возможность 
автоматически выбирать элементы изображения, которые нахо-
дятся в фокусе.
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2.6.4. Операции с выделенной областью

С выделенной областью можно осуществить операции пере-
мещения (копирования) и трансформации (табл. 2.4).

Таблица 2.4

Операции с выделенной областью

Операция Команда/Инструмент/Клавиша

Удаление Клавиша Del или Backspace

Перемещение/копирование Инструмент Move (Перемещение)  

или инструмент выделения + Сtrl.

Для копирования необходимо дополнительно 

удерживать Alt

Трансформация:

масштабирование

вращение

наклон

искажение

перспектива

деформация

отразить горизонтально/вертикально

Команда Edit ⇒ Transform ⇒
Scale

Rotate

Skew 

Distort 

Perspective

Warp

Flip Horizontal/Vertical

Свободная трансформация Edit ⇒ Free Transform (Редактирование ⇒ Свободное 

трансформирование, Ctrl + T)

Залить выделенную область одним цветом можно с помощью:
 y комбинации клавиш Alt + Back space – основным цветом 

(Foreground);
 y комбинации клавиш Ctrl + Alt + Backspace – фоновым цве-

том (Background);
 y команды Edit ⇒ Fill (Редактиро-

вание ⇒ Заливка, Shift + F5) – любым 
цветом. Дополнительно можно уста-
новить непрозрачность (Opacity) от 

0 % (полностью прозрачна) до 100 % (полностью непрозрачна) и 
режим смешивания пикселей Mode;

 y инструмента Paint Bucket (Заливка, клавиша G) – любым 
цветом. 

Назначение параметров, устанавливаемых на панели свойств 
этого инструмента, аналогичны рассмотренным ранее для других 
инструментов.

Для заливки области плавным цветовым переходом использу-
ется ин струмент Gradient (Градиент, клавиша G), который находит-
ся в той же группе, что и Paint Bucket.
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Инструмент Gradient имеет следующие параметры:
 y список из стандартных градиентов (по умолчанию устанав-

ливается переход между основным цветом и цветом фона); 
 y тип градиента (слева направо): линейный, радиальный (кру-

говой), конический, зеркальный (отраженный) и ромбовидный;
 y Mode (Режим) – режим смешивания пикселей;
 y Opacity (Непрозрачность) – интенсивность цвета кисти;
 y Reverse the Fradient Colors  (Обратно) – изменение направле-

ния перехода;
 y Dither the Reduce Banding (Сглаживание) – сглаживание цве-

товых переходов;
 y Transparency (Прозрачность) – кнопку необходимо нажать, 

если в градиенте есть прозрачные и полупрозрачные области.
Модифицировать текущий или определить новый градиент 

можно в редакторе градиентов (чтобы открыть окно редактора, 
необходимо щелк нуть по текущему образцу градиента на панели 
свойств).

Практические задания по пункту 2.6

Задание 1.Задание 1.  Создание изображения с использова-
нием инструментов выделения областей изображе-
ния, заливки цветом и обводки.

Рекомендации по выполнениюРекомендации по выполнению
1. Создайте новое изображение размером 10½10 см в режиме 

RGB с белым фоном.
2. Установите фоновый цвет R = 253, G = 233, B = 80, основ-

ной R = 255, G = 192, B = 0.
3. Создайте круглую выделенную область (растушевка = 0 px). 

Залейте фоновым цветом.
4. Выполните обводку области шириной 2 px основным цве-

том, задайте значение параметра Location – Center (Расположе-
ние – в центре).

5. Сформируйте прямоугольную выделенную область для 
солнечного луча, трансформируйте его с помощью команд меню 
Edit (Редактирование).

6. Залейте область фоновым цветом, обведите основным.
7. Скопируйте выделенную область с помощью инструмента 

Move (Перемещение). Копию трансформируйте. 
8. Аналогично создайте еще 6 копий солнечных лучей. 
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9. Создайте 2 эллиптические выделенные области для глаз, 
залейте основным цветом.

10. Сформируйте круглую область для рта, выполните обводку.
11. Сохраните файл изображения с именем 2_61.jpg.
Задание 2. Задание 2. Создание изображения с использованием инстру-

ментов выделения и градиентной заливки.
Рекомендации по выполнениюРекомендации по выполнению
1. Создайте новое изображение размером 100½100 px в режи-

ме RGB с прозрачным фоном. 
2. Установите в качестве основного цвета серый (R = 153, G = 

= 153, B = 153), фонового – белый.
3. Создайте круглую выделенную область разме-

ром 100½100 px. Залейте область линейным градиентом 
от основного цвета к фоновому.

4. Сожмите выделенную область с помощью ко-
манды Transform Selection (Трансформировать выделен-

ную область). Используйте параметры Widht и Height на панели 
свойств или комбинацию клавиш Shift + Alt для пропорциональ-
ного уменьшения размера. Залейте область градиентом в обрат-
ном направлении. 

5. Сохраните файл изображения с именем 2_62.gif.

Формат GIF способен хранить только индексированные изображения. При 

сохранении необходимо указать палитру, желаемое количество цветов 

в изображении (максимально 256), вариант преобразования исходных 

цветов в индексированные. При установке флажка Transparency (Прозрач-

ность) сохраняется прозрачность участков изображения.

Задание 3. Задание 3. Разукрашивание черно-белой фотографии с ис-
пользованием инструментов выделения, рисования и заливки.

Рекомендации по выполнениюРекомендации по выполнению
1. Откройте файл 2_63.jpg. Создайте дубликат с именем 2_63-1  

и преобразуйте его в многоцветное изображение в режиме RGB.
2. Установите цвет R = 250, G = 207, B = 172 в качестве ос-

новного.
3. С помощью инструмента Lasso (Лассо) с параметром Fea-

ther (Растушевка) = 2 рх выделите область лица и рук. Залейте 
выделенную область, используя команду Edit ⇒ Fill (Редактиро-
вание ⇒ Заливка), c параметрами: Mode (Режим) – Color (Цвет), 
Opacity (Непрозрачность) – 70 %.
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В режиме смешивания Color (Цвет) пиксели не меняют яркость, поэтому 

этот режим удобно использовать для изменения цвета.

4. Выделите и окрасьте волосы в подходящий цвет. 
5. Инструментом Lasso (Лассо) выделите бант (растушевка =  

= 3 px), окрасьте выделенную область, используя радиальный 
градиент, переход от розового к светло-розовому. Режим выбери-
те самостоятельно.

6. Выделите платье (растушевка = 3 рх), закрасьте цветом  
R = 102, G = 9, B = 123 в режиме Darken (Затемнение).

7. Используя мягкую кисть в режиме Color (Цвет), создайте 
румянец.

8. Закрасьте стол однородным цветом, а фон фотографии 
градиентом. 

9. Сохраните изображение в формате .jpg.
Задание 4. Задание 4. Оформление виньетки.
Рекомендации по выполнениюРекомендации по выполнению
1. Откройте файл 2_64.jpg.
2. Выделите эллиптическую область, пред-

варительно установив на панели свойств ин-
струмента Elliptical Marquee параметр Feather = 
= 10 px.

3. Инвертируйте выделенную область. 
4. Удалите выделенную область. В резуль-

тате эта область будет окрашена в цвет фона 
(по умолчанию – белый). Снимите выделение.

5. Для создания сепии преобразуйте изображение в режим Duo-
tone (Дуплекс), тип Duotone (2 цвета): Черный и PANTONE 159 С. 

6. Cохраните файл изображения с именем 2_64.psd.

Контрольные вопросы
1. Что включает понятие «выделенная область»?

2. Какие инструменты выделяют области геометрической формы?

3. Перечислите инструменты выделения, позволяющие задавать границы выде-

ленных областей произвольной формы.

4. Какие инструменты выделения автоматически определяют границы выделен-

ной области?

5. Какие инструменты используют для выделения областей с близкими цве-

тами?

6. Какую клавишу необходимо удерживать нажатой для выделения области пра-

вильной геометрической формы (квадратной или круглой)?
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7. Какие параметры необходимо установить в палитре параметров для выделе-

ния области фиксированного размера?

8. Назовите инструмент из группы Lasso, наиболее удобный для выделения 

фрагментов изображения с четким контрастным контуром.

9. Какой параметр инструмента Magic Wand (Волшебная палочка) определяет 

диапазон цветов пикселей, которые будут включены в область выделения?

10. Какую область изображения выделит инструмент Волшебная палочка при 

значении допуска, равном 255?

11. Как отменить выделение области? 

12. Опишите операции, выполняемые над границей выделенной области.

13. Изменится ли изображение после перемещения границы выделения?

14. Какой инструмент используют для перемещения выделенной области?

15. Поясните, как выделить в изображении несколько областей.

16. Как переместить копию выделенной области? Какие операции можно выпол-

нить над выделенной областью?

17. Как выполнить заливку и обводку выделенной области? Укажите типы за-

ливок.

2.7. Работа со слоями

2.7.1. Понятие слоя и операции над слоями 

Изображение в Adobe Photoshop может содержать несколько 
слоев. Слои позволяют разделить весь рисунок на независимые 
части, каждую из которых можно редактировать и перемещать 
отдельно, не затрагивая другие. 

При создании изображения оно содержит особый непрозрач-
ный слой – Background (Фоновый). Сверху можно добавлять но-
вые слои. В изображениях с прозрачными областями фоновый 
слой отсутствует (его удаляют или преобразуют в обычный слой). 
Слои накладываются друга на друга, и изображение отобража-
ется на экране так, как если бы на него смотрели сверху: через 
прозрачные области верхнего слоя видны нижние слои. 

Для работы со слоями предназначены палитра Layers (Слои) 
и команды меню Layer (Слой).

В палитре Layers (Слои, клавиша F7) отображается список 
слоев изображения снизу вверх: фоновый слой в самой нижней 
позиции. Содержимое каждого слоя отображается в виде мини-
атюры, рядом с миниатюрой в строке палитры слоев – имя слоя 
(рис. 2.9). Активный слой на рисунке – new.

Fill (Заливка) в отличие от параметра Opacity не действует на слоевые эффекты.
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Рис. 2.9. Палитра Layers: 1 – выбор типа фильтра для отображения слоя; 2 – контекстное 
меню палитры; 3 – Opacity (Непрозрачность слоя); 4 – Fill (Заливка); 5 – заблокированный 

слой; 6 – Delete (Удалить); 7 – Create New Layer (Создать новый слой); 8 – Create New 
Group (Создать новую группу); 9 –  Add Layer Style (Добавить эффект слоя); 10 – видимый 
слой; 11 – группа кнопок Lock (Блокировка); 12 – Normal (Режим смешивания пикселей)

С помощью кнопок группы Lock (Блокировка) можно (слева 
направо на рис. 2.9):

 y защитить от изменений прозрачные пиксели слоя;
 y защитить от изменений закрашенные пиксели;
 y заблокировать перемещение;
 y защитить от автоматического вложения/удаления монтаж-

ных областей;
 y сохранить все перечисленное.

Контекстное меню палитры содержит команды работы со 
слоями. Большинство операций, выполняемых над слоем, до-
ступно и в меню Layer, и в контекстном меню палитры. Основные 
операции, выполняемые над слоями, приведены в таблице 2.5.

Таблица 2.5
Операции, выполняемые над слоями

Операция Способ выполнения

Активизация слоя Щелчок мыши на имени слоя в палитре;

Сtrl + щелчок на фрагменте изображения – активизация слоя,  

на котором находится фрагмент
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Операция Способ выполнения

Изменение порядка

следования слоев

Перемещение с помощью мыши в палитре;

команда Layers ⇒ Arrange (Cлои ⇒ Организовать)

Переименование слоя Двойной щелчок на имени слоя в палитре;

команда меню Layers ⇒ Layer Properties  

(Слои ⇒ Переименовать слой)

Создание нового слоя Кнопка Create New Layer (Создать новый слой) палитры;

команда Layers ⇒ New (Слои ⇒ Новый, Shift + Ctrl + N);

команда New Layer (Новый слой) меню палитры

Перемещение/копирова-

ние выделенной области 

на новый слой

Команда Layers ⇒ New ⇒ Layer Via Cut (Слой ⇒ Новый ⇒  
Вырезать на новый слой, Shit + Ctrl + J);

Команда Layers ⇒ New ⇒ Layer Via Copy (Слой ⇒ Новый ⇒ 
Скопировать на новый слой, Ctrl + J)

Дублирование слоя Перемещение пиктограммы слоя на кнопку Create New Layer 

(Создать новый слой) палитры Layers;

команда Layers ⇒ Duplicate Layer (Слои ⇒ Дублировать слой);

команда Duplicate Layer (Дублировать слой) меню палитры

Удаление слоя Команда Layers ⇒ Delete (Слои ⇒ Удалить);

команда Delete Layer контекстного меню слоя в палитре;

перемещение имени слоя на кнопку Delete палитры

Связывание слоев Кнопка Link Layers (Связать слои) в палитре или одноименная 

кнопка меню Layers (позволяет применять операции преобразо-

вания к нескольким слоям одновременно)

Преобразование фоново-

го слоя в обычный

Команда Layers ⇒ New ⇒ Background From Layer (Слой ⇒  
Новый ⇒ Из фонового) 

Трансформация слоя Команда Edit ⇒ Transform (Free Transform) (Редактирование ⇒ 
Трансформировать

Слияние слоев Команды меню Layer:

Merge Down (Объединить с нижним) – объединение активного 

слоя с расположенным ниже;

Merge Visible (Объединить видимые) – объединение видимых слоев;

Flatten Image (Выполнить сведение) – сведение всех видимых 

слоев в единый слой Background

Выделение содержимого 

активного слоя

Ctrl + щелчок на имени слоя в палитре;

команда Select ⇒ Load Selection (Выделение ⇒ Загрузить  

выделенную область)

Автоматическое создание нового слоя происходит при помеще-
нии выделенной области из другого изображения:

 y с использованием буфера обмена способами, принятыми в 
MS Windows;

 y перемещением слоя одного изображения в другое с помо-
щью мыши при активизированном инструменте Move (Переме-
щение).

Окончание табл. 2.5
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Если слоев очень много, может возникнуть необходимость 
навести порядок в палитре слоев – разложить слои по папкам. 
Создается группа слоев. В нее можно поместить любое количе-
ство слоев и другие папки. Затем эту группу слоев можно сво-
рачивать (для компактного отображения) и, соответственно, 
разворачивать, чтобы показать ее содержимое. Создать пустую 
группу слоев можно с помощью кнопки Create New Group (Соз-
дать новую группу) палитры Layers. Чтобы поместить в нее слои, 
нужно выбрать слой в палитре с помощью мыши и переместить 
на значок группы. Цeлесообразно предварительно выделить слои 
с помощью клавиши Shift (смежные) или Ctrl (несмежные). Так-
же для создания группы можно воспользоваться командой меню 
Layers ⇒ New ⇒ Group Layers (Слои ⇒ Новый ⇒ Группа из слоев, 
Ctrl + G).

2.7.2. Режимы смешивания слоев 

По умолчанию каждый новый слой имеет режим смешива-
ния Normal (Нормальный). При использовании для слоя режи-
ма, отличающегося от нормального, пиксели активного и ниже 
расположенных слоев взаимодействуют и позволяют либо кор-
ректировать изображение, либо создавать интересные эффекты. 
В Adobe Photoshop режимы смешивания слоев группируются со-
гласно создаваемым с их помощью эффектов. 

1. Основные режимы (Basic) аналогичны рассмотренным ра-
нее режимам смешивания пикселей при рисовании кистью: в ре-
жимах Normal и Dissolve полностью заменяются пиксели ни-
жележащего слоя при 100 % непрозрачности; при уменьшении 
непрозрачности пиксели нижнего слоя либо проступают сквозь 
пиксели верхнего (Normal), либо частично замещают их (Dissolve).

2. Затемняющие режимы (Darken) – игнорируется белый цвет:
 y Darken (Замена темным) – в качестве результирующего вы-

бирается цвет текущего или нижележащего слоя в зависимости 
от того, какой из них темнее, т. е. на текущем слое для каждого 
канала пиксели с большей яркостью заменяются более темными 
ниже расположенного слоя, а более темные пиксели остаются 
неизменными;

 y Multiply (Умножение) – значение цвета текущего слоя ум-
ножается на значение цвета нижнего. Результирующий цвет всег-
да представляет собой более темный цвет. В результате умноже-
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ния значения любого цвета на значение черного цвета получает-
ся черный цвет. В результате умножения значения любого цвета 
на значение белого цвета цвет остается неизменным; 

 y Color Burn (Затемнение основы) – темные участки верхнего 
слоя используются для затемнения нижнего слоя. Используются 
умножение цветов и увеличение насыщенности. Смешивание с 
белым цветом не приводит к изменениям; 

 y Linear Burn (Линейный затемнитель) – в каждом канале 
основной цвет заменяется более темным для отражения цвета 
смешивания в результате уменьшения яркости. Смешивание с 
белым цветом не приводит к появлению каких-либо изменений;

 y Darker Color (Цвет темнее) – похож на Darken (Замена тем-
ным), но сравниваются все цветовые каналы, затем выбирается 
цвет с наименьшим значением.

3. Осветляющие режимы (Lighten) – игнорируется черный цвет: 
 y Замена светлым (Lighten) – выполняет противоположное 

режиму Darken действие: сравнивает поканально яркости пиксе-
лей верхнего и нижнего слоев и в результрующий цвет записыва-
ет более светлые пиксели;

 y Screen (Экран) – производит те же вычисления, как и ре-
жим Multiply (Умножение), но использует при этом инверти-
рованные значения, чтобы проявить конечный результат. Этот 
режим осветляет изображение. Его можно применять для освет-
ления темных фотографий путем дублирования и установления 
для верхнего слоя этого режима;

 y Color Dodge (Осветление основы) – похож на режим Screen, 
но черный цвет на верхнем слое не влияет на результат. Основной 
цвет заменяется более ярким для отражения цвета смешивания в 
результате уменьшения контраста между двумя цветами;

 y Linear Dodge (Add) (Линейный осветлитель (добавить)) – 
цвета сочетаются путем повышения яркости, светлые цвета за-
меняются более светлыми. Представляет собой комбинацию ре-
жимов Screen и Color Dodge;

 y Lighter Color (Светлее) – этот режим функционирует про-
тивоположно режиму Darker Color, отображая цвет с наиболь-
шим значением.

4. Контрастные режимы (Contrast) – игнорируется цвет 50 % 
серого, за исключением режима Hard Mix (Жесткое смешение):

 y Overlay (Перекрытие) – равномерно смешиваются цвета 
обоих слоев, отсеиваются светлые части и умножаются темные. 
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При низком уровне прозрачности он похож на режим Normal, но 
с более интенсивными цветами;

 y Soft Light (Мягкий свет) – в этом режиме осветляются и 
затемняются цвета нижерасположенных слоев в зависимости от 
цвета текущего слоя. Если цвет текущего слоя (источник света) 
является более светлым, чем 50 % серого, то изображение стано-
вится светлее, как после осветления. Если цвет является более 
темным, чем 50 % серого, изображение становится темнее, как 
после затемнения. Полученный эффект аналогичен освещению 
изображения расплывчатым светом прожектора;

 y Hard Light (Жесткий свет) – в этом режиме цвета умножа-
ются или осветляются в зависимости от цвета текущего слоя. По-
лученный эффект аналогичен освещению изображения резким 
светом прожектора;

 y Vivid Light (Яркий свет) – применение этого режима при-
водит к затемнению или осветлению цвета в результате увели-
чения или уменьшения контраста в зависимости от цвета теку-
щего слоя. Если цвет (источник света) является более светлым, 
чем 50 % серого, то изображение становится светлее в результате 
уменьшения контраста. Если цвет (источник света) является бо-
лее темным, чем 50 % серого, то изображение становится темнее 
в результате увеличения контраста;

 y Linear Light (Линейный свет) – применение этого режи-
ма приводит к затемнению или осветлению цвета в результате 
увеличения или уменьшения яркости в зависимости от цвета те-
кущего слоя. Если верхний слой яркий, то нижний слой будет 
осветляться, если темный – то затемняться;

 y Pin Light (Точечный свет) – применение этого режима 
приводит к замене цвета в зависимости от цвета текущего слоя. 
С помощью этого режима можно получить разные результаты; 
работает путем перемещения цветов на изображение в зависимо-
сти от того, светлые или темные цвета на активном слое;

 y Hard Mix (Жесткое смешение) – добавляет значения крас-
ного, зеленого и синего каналов цвета к значениям RGB основ-
ного цвета. Если результирующее значение для какого-либо ка-
нала равно 255 или больше, то каналу присваивается значение 
255, в противном случае – 0. Поэтому для всех пикселей сме-
шанного цвета значения красного, зеленого и голубого каналов 
будут равняться 0 или 255. Все пиксели заменяются основными 
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аддитивными цветами (красным, зеленым или синим), белым 
или черным.

5. Сравнительные режимы (Comparative) – итоговое изображе-
ние напрямую зависит от разницы в цвете слоев:

 y Difference (Разница) – использует вычитание верхнего слоя 
из нижнего. Если пиксель на верхнем слое белый, то пиксель на 
нижнем слое инвертируется. Если пиксель на верхнем слое чер-
ный, то пиксель на нижнем слое не изменяется. Если пиксель на 
верхнем слое совпадает с нижним, результат – черный пиксель, 
т. е. совпадающие цвета будут черными;

 y Exclusion (Исключение) – похож на Difference, но с мень-
шей контрастностью;

 y Subtract (Вычитание) – вычитает 8-битовые цвета из кана-
лов основы каждого пикселя на каждом слое. Если результатом 
является негатив, то отображается черный цвет;

 y Divide (Разделение) – делит друг на друга цвета верхнего и 
нижнего изображений.

6. Режимы HSL:
 y Hue (Цветовой тон) – комбинирует тон верхнего слоя с на-

сыщенностью и свечением нижнего слоя;
 y Saturation (Насыщенность) – комбинирует насыщенность 

верхнего слоя с тоном и свечением нижнего слоя;
 y Color (Цветность) – комбинирует тон и насыщенность 

верхнего слоя со свечением нижнего слоя;
 y Luminosity (Свечение) – комбинирует свечение верхнего 

слоя с тоном и насыщенностью нижнего слоя.

2.7.3. Применение эффектов к слою изображения

К слою можно применить специальные эффекты: Drop Shadow 
(Отбросить тень), Inner Shadow (Внутренняя тень), Outer Glow 

(Внешнее свечение) и др. Эффект слоя автоматически влияет на 
все непрозрачные точки слоя и обновляется при добавлении, из-
менении или удалении пикселей со слоя. Эффекты применяются 
и редактируются с помощью диалогового окна Layer Style (Эф-
фект слоя), в котором также можно установить дополнительные 
параметры смешивания пикселей. 

Открыть окно Layer Style (Эффект слоя) можно с помощью:
 y команды Layer ⇒ Layer Style (Слой  ⇒ Эффект слоя);
 y кнопки Add Layer Style (Добавить эффект слоя) палитры 

Layers;
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 y команды Blending Options (Параметры смешивания) кон-
текстного меню слоя;

 y двойного щелчка мышью на миниатюре слоя.
На палитре Layers (Слои) эффекты отображаются в виде 

списка под слоем, к которому они применены.
Удалить эффект слоя можно, переместив его имя на кнопку 6 

палитры Layers (см. рис. 2.9) либо отключив в окне Layer Style 
(Эффект слоя). Для удаления всех эффектов текущего активного 
слоя используют команду Layer Style ⇒ Clear Layer Style (Эффект 
слоя ⇒ Очистить эффект слоя) меню Layer (Слой) или контекст-
ного меню слоя.

Стиль – это сочетание одного или нескольких эффектов 
слоя. Чтобы добавить стиль к текущему слою, нужно щелкнуть 
мышью на пиктограмме стиля в палитре Styles (Стили). 

2.7.4. Макетные группы слоев

Несколько слоев можно сгруппировать таким образом, что 
нижний будет являться маской для верхнего. Когда нижний слой 
прозрачен, верхние слои скрыты; там, где он непрозрачен, ото-
бражается содержимое других слоев.

Способы создания маскированных (макетных) групп слоев:
 y команда Layer ⇒ Create Clipping Mask (Слой ⇒ Создать об-

травочную маску) – должен быть активным верхний слой;
 y комбинация Ctrl + G – активен верхний слой;
 y щелчок мышью + Alt на разграничительной линии между 

слоями.
Чтобы разгруппировать слои, выполните команду Layer ⇒ 

Release Clipping Mask (Слой ⇒ Удалить обтравочную маску) или 
нажмите комбинацию клавиш Shift + Ctrl + G (должен быть ак-
тивным верхний слой).

2.7.5. Типы слоев

Adobe Photoshop поддерживает работу со следующими ти-
пами слоев: пиксельные (собственно изображение), контурные, 
текстовые, коррекции и смарт-объекты. 

Корректирующий (подчиненный) слой 
Корректирующий слой не содержит изображения, но выпол-

няет некоторую операцию с пикселями изображения под ним: 
изменяет уровни, кривые, яркость, контраст, цветовые оттенки. 
Преимущество состоит в том, что исходное изображение на ниж-



68

Раздел 2. Основы растровой графики 

нем слое не изменяется и всегда можно начать работу с ориги-
нального рисунка, удалив корректирующие слои. 

Иногда для коррекции изображения используются слои за-
ливки, которые могут содержать однородную, градиентную или 
узорчатую заливку. При создании корректирующего слоя или 
слоя заливки автоматически создается и слой маски, связанный 
с ним.

Для создания корректирующего слоя (слоя заливки) исполь-
зуют:

 y команду Layer ⇒ New Adjustment (Fill) Layer (Новый коррек-
тирующий слой (слой заливки)); 

 y кнопку New Fill or Adjustment Layer (Новый заливочный или 
корректирующий слой, ) палитры Layers.

Текстовый слой
Текст в Adobe Photoshop вставляется в виде отдельного слоя 

в векторном формате и отображается в палитре Layers. Все тексто-
вые слои обозначаются буквой T. Для создания надписей служат 

четыре инструмента, которые 
связаны с одной кнопкой и кла-
вишей T: 

 y Horizontal Type (Горизон-
тальный текст);

 y Vertical Type (Вертикаль-
ный текст);

 y Horizontal/Vertical Type Mask (Горизонтальная/вертикальная 
текстовая маска) – создание выделенной области, которая повто-
ряет форму текста. Затем эту область можно залить (например, 
узором), изменить ее свойства (тон, яркость и т. п.), переместить 
и преобразовать границы выделенной области и саму область. 
При использовании текстовых масок новый слой не создается. 

Текст можно вводить двумя способами:
 y щелкнуть мышью на изображении в месте вставки текста 

и ввести его;
 y выделить прямоугольную область для размещения много-

строчного текста (текстовый блок), а затем ввести текст. Перенос 
на другую строку выполняется автоматически, для досрочного 
перехода надо нажать клавиши Shift + Enter. Размеры и положе-
ние ограничивающей рамки можно менять в любой момент. 

Чтобы зафиксировать введенный текст, следует нажать кла-
вишу Enter или кнопку  в правой части панели свойств инст-
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румента. Также можно просто выбрать другой инструмент. Для от-
мены ввода текста надо щелкнуть по кнопке  или нажать клави- 
шу Esc. 

К текстовым слоям применимы эффекты и стили, как 
и к обычным слоям. Параметры текста устанавливают на панели 
свойств. Свойства (параметры) текста можно изменить в любой 
момент как для всех, так и для некоторых (выделенных) букв. 
Для того чтобы изменить текст или его свойства, нужно акти-
визировать соответствующий текстовый слой в палитре Layers, 
включить инструмент Type и щелкнуть в области текста на ри-
сунке. Мигающий текстовый курсор показывает, что текст мож-
но редактировать, как в текстовом редакторе.

Расширенные возможности форматирования символов до-
ступны в палитре Character (Символ), открываемой кнопкой  
(клавиши Ctrl + T). Параметры форматирования абзаца, распо-
ложенные в палитре Paragraph (Абзац), применимы только к тек-
стовым блокам, за исключением выравнивания.

Текст можно поворачивать, отражать, трансформировать 
с помощью команд Edit ⇒ Free Transform (Редактирование ⇒ Сво-
бодная трансформация) и Edit ⇒ Transform (Редактирование ⇒ 
Трансформация), кроме операций Distort (Искажение) и Perspective 
(Вид в перспективе). Adobe Photoshop позволяет деформировать 
текстовый слой, изгибая текст по заранее заданным контурам. 
Для их применения надо при редактировании текстового слоя 
щелкнуть по кнопке Create Wrapped Text (Создать текст в оболоч-
ке, ) панели свойств. Текст в оболочке можно редактировать.

Помимо текстовых, Adobe Photoshop поддерживает вектор-
ные контурные слои. Для создания контура используют инст-
рументы группы Pen. В простейшем случае щелчками мыши 
устанавливают углы ломаной линии. Если при этом удерживать  
клавишу Shift, все звенья будут  
иметь наклон, кратный 45°. Для 
за мыкания линии надо щелкнуть  
на начальной точке (к указателю 
мы ши добавляется кружок). Для 
создания открытого контура нуж-
но еще раз щелкнуть по кнопке 
инструмента Pen или в любом ме-
сте изображения при нажатой кла-
више Ctrl. 
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Режимы применения контуров устанавливают на панели 
свойств:

1.  Shape (Контурные слои) – слои особого типа, состоящие 
из заливки и контуров, играющих роль маски.

2. Patch (Обычные контуры) – это служебные объекты, суще-
ствующие внутри документа, но невидимые. На основе контуров 
создаются выделенные области.

3. Pixels (Пиксели) – создание выделенной области заданной 
формы без создания слоя или пути.

Чтобы применить инструменты рисования или фильтры 
к слоям, которые заключают в себе векторное содержимое (тек-
стовый слой, контурный слой или векторную маску), необходимо 
выполнить растеризацию слоя с помощью команды меню Layer ⇒ 
Rasterize (Слой ⇒ Растеризовать) либо Rasterize Layer (Растеризо-
вать слой) в меню палитры слоев Layers. После этой операции 
текст либо контур нельзя редактировать.

Смарт-объекты
Смарт-объекты – это слои, содержащие данные из растровых 

или векторных изображений. Смарт-объекты сохраняют перво-
начальное содержимое изображения со всеми исходными харак-
теристиками, позволяя производить обратимое редактирование 
слоя, к которому относят:

 y трансформации. Можно масштабировать, поворачивать, на-
клонять, деформировать слой, применять к нему перспективное 
преобразование или произвольную деформацию без потери ис-
ходных данных изображения или качества;

 y применение фильтров. В любое время можно изменить па-
раметры фильтров, примененных к смарт-объектам;

 y работу с векторными данными, такими как векторные изо-
бражения из Adobe Illustrator, которые иначе пришлось бы рас-
трировать.

Смарт-объект может быть создан следующими способами:
 y из обычного слоя с помощью команды контекстного меню 

Convert to Smart Objects (Преобразовать в смарт-объект) или ко-
манды Smart Objects ⇒ Convert to Smart Objects (Смарт-объект ⇒ 
Преобразовать в смарт-объект) меню Layer;

 y автоматически при перемещении файла с изображением на 
открытый документ Adobe Photoshop.

Эти два способа позволяют создать связанные объекты. Это 
значит, что при любом изменении, внесенном в копию или ори-
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гинал, такие же изменения произойдут и со вторым объектом, 
а также с другими копиями, если они имеются. Создать не-
связанный смарт-объект можно методом копирования с помо-
щью команды Layer ⇒ Smart Objects ⇒ Nev Smart Objects via Copy  
(Слои ⇒ Смарт-объект ⇒ Создать смарт-объект путем копиро-
вания).

Чтобы редактировать содержимое смарт-объекта, достаточно 
дважды кликнуть на его иконку, произвести необходимые из-
менения и нажать комбинацию клавиш Ctrl + S для сохранения 
изменений.

Смарт-объект можно преобразовать в обычный слой (ко-
манда Rasterize Layer), если больше не нужно редактировать его 
данные. После растрирования смарт-объекта трансформации, 
деформации и фильтры, примененные к нему, изменять нельзя.

Практические задания по пункту 2.7

Задание 1. Задание 1. Действия со слоями изображения.
Рекомендации по выполнениюРекомендации по выполнению
1. Откройте файл 2_71.psd. Создайте дубликат изображения 

2_71-1.
2. Изучите палитру Layers (Слои). Обратите внимание на ви-

димость слоев. 
3. Переименуйте слой Background (Фоновый) в Стена.
4. Поочередно сделайте видимыми слои Штора 1, Што-

ра 2, ... Штора 7, отключая видимость предыдущего слоя.
5. Оставьте видимым наиболее понравившийся вариант слоя 

и сохраните файл в формате .jpg. 
6. Откройте файл 2_71-1.jpg. Обратите внимание, что файл 

изображения содержит только один слой Background (Фоновый). 
Закройте файл.

7. Создайте дубликат изображения с именем 2_71-2.
8. Сделайте видимыми слои Штора 6 и Штора 7.
9. Установите для слоя Штора 6 Opacity (Непрозрачность) 

82 %.
10. Увеличьте размер (длину) слоя Штора 7 с помощью ко-

манд меню Edit (Редактирование).
11. Удалите невидимые слои, используя команду Layers  ⇒ 

Delete Hidden Layers (Слои ⇒ Удалить невидимые слои).
12. Сохраните файл изображения.
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Задание 2. Задание 2. Изменение режима смешивания слоев.
Рекомендации по выполнениюРекомендации по выполнению
1. Откройте файл 2_72.jpg. Создайте дубликат с именем 2_72-1.
2. Переведите изображение в режим RGB.
3. Создайте новый 100 % непрозрачный слой. 
4. Выберите инструмент Gradient (Градиент), установите 

тип – линейный. Создайте новый градиент. Для этого:
 y щелкните мышью на раскрывающемся списке градиентов 

панели свойств инструмента Gradient (не на треугольнике, а вну-
три поля);

 y в открывшемся окне Gradient Editor (Редактор градиента) 
отредактируйте градиент так, чтобы слева был коричневый цвет, 
правее – зеленый, справа – голубой (см. рисунок). Для установ-
ки цвета дважды щелкните на нижнем маркере (маркере цвета) 
цветовой полосы и выберите цвет в окне Color Picker.

5. Нажмите кнопку New (Новый) и введите имя градиента – 
My. Новый градиент будет последним в списке.

6. Залейте новый слой градиентом My снизу вверх.
7. В палитре Layers (Слои) установите режим смешивания 

слоев Color Burn (Затемнение цвета) и уровень непрозрачности 
Opacity (Непрозрачность) 50 %. 

8. Сохраните файл изображения.
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Задание 3. Задание 3. Преобразование изображения в черно-белое с ис-
пользованием корректирующих слоев. 

Рекомендации по выполнениюРекомендации по выполнению 
1. Откройте файл 2_44.jpg. Создайте дубликат с именем 

2_73-1.
2. Создайте 3 корректирующих слоя: Hue/Saturation, Gradient 

Map, Curves поверх фонового. 
3. Для слоя Gradient Map используйте вариант градиента 

Foreground to Background (От основного к фоновому) (должны 
быть установлены цвета по умолчанию) – этот слой переводит 
изображение в черно-белое полутоновое.

4. Откорректируйте слой Hue/Saturation, выполнив двойной 
щелчок по миниатюре слоя. В диалоговом окне Hue/Saturation 
установите регуляторы Hue +10°, Saturation +25 %; Lightness +10 %.

5. Слой Curves регулирует итоговый контраст изображения. 
Скорректируйте вид кривой, чтобы увеличить контрастность.

6. Установите для слоя режим смешивания 50 %.
7. Сравните полученный результат с изображениями пункта 2.4.
8. Сохраните файл изображения.
Задание 4. Задание 4. Создание текстового слоя и применение эффектов 

к тексту.
Рекомендации по выполнениюРекомендации по выполнению 
1. Создайте новое изображение размером 300×100 px в режи-

ме RGB.
2. Создайте новый слой. Залейте черным цветом.
3. Выберите инструмент Horizontal Type. Установите параме-

тры текста в палитре Character (Символ), как показано на рисун-
ке, цвет текста – белый. Введите текст 
«Design». 

4. Примените эффекты для слоя:
 y Outer Glow (Внешнее свечение) 

с параметрами: Blend Mode – Screen; 
Opacity – 81 %, цвет 02fd08; Spread – 
1 %; Size – 16 px; 

 y Bevel and Emboss (Скос и тиснение) 
с параметрами: Style – Inner Bevel; 

 y Technique – Smooth; Depth – 100 %; 
Size – 0 px; Softens – 0 px;

 y Gradient Overlay (Наложение гра-
диента) – установите флажок Reverse 
(Обратить); 
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 y Stroke (Обводка) с параметрами: Color – #02fd08, Size – 1 px. 
5. Сохраните файл с именем 2_74.psd.
Задание 5. Задание 5. Создание вертикального текста и маскирование 

группы слоев. 
Рекомендации по выполнениюРекомендации по выполнению 
1. Откройте файл 2_75.jpg. Создайте дубликат.
2. Создайте вертикальный текстовый слой «Мирский замок».
3. Преобразуйте изображение, сгруппировав текстовый слой 

и копию фонового. Палитра слоев должна иметь вид согласно 
рисунку. 

4. Добавьте эффекты к текстовому слою.
5. Сохраните файл с именем 2_75.psd.

Контрольные вопросы

1. В чем заключается преимущество использования слоев?

2. Сколько слоев содержит документ при открытии файла с фотографией?

3. Чем отличается фоновый слой от обычного слоя? 

4. Как сделать прозрачным изображение на фоновом слое?

5. Где отображаются сведения о слоях и порядке их расположения?

6. Что отображается в миниатюре слоя на палитре Layers (Слои)? Какой слой 

называют активным?

7. Поясните, как скрыть содержимое слоя в результирующем изображении.

8. Как создать новый пустой слой? 
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9. Может ли повлиять на результирующее изображение изменение порядка рас-

положения слоев? 

10. Каким образом поместить фрагмент изображения на отдельный слой?

11. Как в палитре Layers выделить несколько смежных/несмежных слоев?

12. Как создать и использовать связь между слоями? 

13. Опишите, что происходит со слоями в результате выполнения операции све-

дения изображения.

14. Дайте определение группы слоев.

15. Как применить эффекты к слою? Как модифицировать или удалить эф-

фекты? 

16. Что такое маскированная группа слоев и как ее создать? 

17. Назовите способы ввода текста и различия при их использовании.

18. Как типы слоев существуют в Adobe Photoshop?

19. Как создать текстовый слой?

20. Назовите операции, применимые к текстовому слою.

21. Что такое контурный слой? Как его создать?

22. Дайте определение смарт-объекта. Какие возможности он предоставляет?

23. Что произойдет в результате растеризации векторного слоя?

24. Чем различаются связанный и несвязанный смарт-объекты?

2.8. Работа с каналами и масками

2.8.1. Палитра Channels

Каждое изображение имеет от одного до нескольких каналов, 
а их общее количество зависит от выбранного цветового режима. 
Каждый канал содержит информацию о наличии определенно-
го цвета в изображении. Например, в режиме RGB изображение 
содержит четыре канала: яркости красного, зеленого и синего, 
а также композитный канал RGB. 

Отдельный цветовой канал – это черно-белое полутоно-
вое изображение, на котором каждому пикселю соответствует 
8/16 бит данных (256 значений яркости).

Для работы с каналами предназначена соответствующая па-
литра – Channels (Каналы, Ctrl + «∼») (рис. 2.10). 

Как и на палитре слоев, можно управлять видимостью кана-
лов, активизировать нужный из них. 

В нижней части палитры Channels находятся кнопки созда-
ния и удаления канала и так же, как и в любой другой палитре, 
в правом верхнем углу расположено контекстное меню, содержа-
щее функции работы с каналами. 
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Рис. 2.10. Палитра Channels (Каналы)

Помимо цветовых каналов, существуют также альфа-каналы, 
в которых можно сохранить выделенную область. Для работы 
с альфа-каналами предназначены кнопки внизу палитры и одно-
именные команды меню Select (Выделение):

1 – Save Selection as Chan nel (Сохранить вы-
деленную область как канал) – cо хра нить вы-
деленную область в альфа-канал;

2 – Load Channel as Selection (Загрузить ка-
нал как выделенную область) – загрузить об-

ласть из канала. При этом можно определить, как взаимодейству-
ет эта выделенная область с существующей: новая область может 
быть добавлена, вычтена из существующей или построена как 
пересечение двух областей.

Плашечные каналы определяют дополнительные формы для 
печати при помощи плашечных красок. Плашечный канал может 
быть создан заново при помощи команды New Spot Channel (Но-
вый плашечный канал) меню палитры либо образован из суще-
ствующего альфа-канала. Во втором случае для активного аль-
фа-канала в меню палитры необходимо выбрать пункт Channel 
Options (Параметры канала), в открывшемся диалоговом окне 
указать Spot Color (Плашечный цвет) и задать плашечный цвет.

1
2
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В изображении может быть до 56 каналов. Все новые каналы имеют те же 

размеры в пикселях и то же число пикселей, что и исходное изображение. 

До тех пор, пока изображение сохраняется в файле, формат которого под-

держивает цветовой режим изображения, цветовые каналы не изменяются. 

Альфа-каналы сохраняются только тогда, когда файл сохранен в форматах 

PSD, PDF, TIFF, PSB или RAW. Только формат DCS 2.0 сохраняет каналы пла-

шечных цветов. 

2.8.2. Режим быстрой маски

Маски в программе Adobe Photoshop позволяют защитить от 
изменений некоторые части изображения. Любой пиксель может 
быть не выделен (0 %), выделен полностью (100 %) или толь-
ко частично, например на 80 %. Всего существует 256 градаций, 
которые кодируются числами от 0 (защищенный пиксель) до 
255 (полностью выделен). Считается, что защищенному пиксе-
лю соответствует черный цвет (код 0), а выделенному – белый 
(код 255). Таким образом, маска может быть закодирована как 
черно-белое полутоновое изображение, т. е. как канал.

В Adobe Photoshop предусмотрено два режима выделения об-
ласти: стандартный и режим Quick Mask (Быстрая маска). Режим 
Quick Mask используют, чтобы редактировать маску как черно-
белое изображение, добавляя белым цветом прозрачные области 
и закрывая черным непрозрачные пиксели с помощью инстру-
ментов рисования, заливки и других, использующих кисть. По-
скольку маска представляет собой изображение, к ней примени-
мы функции их обработки. 

Для переключения в режим быстрой маски и обратно ис-
пользуют кнопку Edit in Quick Mask Mode (Редактировать в режи-
ме быстрой маски, ), расположенную в нижней части палитры 
инструментов, и клавишу Q.  

В палитре Channels (Каналы) в режиме Quick Mask (Быстрая 
маска) появляется новый канал – Quick Mask. Чтобы редакти-
ровать только маску как черно-белый канал, необходимо отклю-
чить канал RGB в палитре Channels (Каналы). 

Настройку режима Quick Mask (Быстрая маска) выполняют 
в окне Quick Mask Options (Настройка режима маски), откры-
ваемом двойным щелчком по кнопке Edit in Quick Mask Mode 
(Редактировать в режиме быстрой маски). Она предполагает за-
дание цвета и прозрачности маски, а также области цветовой 
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индикации: Selected Area (Выделенная область) или Masked Area 
(Маскированная область).

2.8.3. Маска слоя

Редактор Adobe Photoshop позволяет вместе с каждым сло-
ем, кроме Background, хранить его маску. Изображение открыто 
только в тех местах, где пиксели маски белые. Черные пиксели 
в маске обозначают закрытое изображение – в этих местах слой 
считается прозрачным.

Создать белую маску, которая открывает весь слой, можно:
 y щелчком мыши по кнопке Add Layer Mask (Добавить маску 

слоя, ) в нижней части палитры Layers (Слои);
 y командой Layer ⇒ Layer Mask ⇒ Reveal All (Слой ⇒ Маска 

слоя ⇒ Показать все).
Создать черную маску, скрывающую все изображение, можно: 
 y щелчком мыши по кнопке  палитры Layers (Слои) при 

нажатой клавише Alt;
 y командой Layer ⇒ Layer Mask ⇒ Hidden All (Слой ⇒ Маска 

слоя ⇒ Скрыть все).
Другой способ создания маски – предварительно выделить 

нужную область и использовать для создания белой маски: кноп-
ку  палитры Layers и команду меню Layer ⇒ Layer Mask ⇒ 
Reveal Selection (Слой ⇒ Маска слоя ⇒ Показать выделение); для 
создания черной маски: кнопку  палитры Layers при нажа-
той клавише Alt и команду меню Layer ⇒ Layer Mask ⇒ Hidden 
Selection (Слой ⇒ Маска слоя ⇒ Скрыть выделение).

Операции с маской слоя:
 y выключить – Layer  ⇒  Layer Mask ⇒ Disable Layer Mask 

(Слой ⇒ Маска слоя ⇒ Отключить маску слоя) – временно от-
менить действие маски, в палитре Layers (Слои) маска перечер-
кивается красным крестом; 

 y включить – щелкнуть по маске в палитре Layers (Слои) 
или выбрать пункт меню Layer ⇒ Layer Mask ⇒ Enable Layer Mask 
(Слой ⇒ Маска слоя ⇒ Включить маску слоя); 

 y удалить, оставив все изображение, – Layer ⇒ Layer Mask ⇒ 
Re move Layer Mask (Слой ⇒ Маска слоя ⇒ Удалить маску слоя);

 y удалить, оставив только изображение, открытое маской, а 
остальные части сделать прозрачными – Layer ⇒ Layer Mask ⇒ 
Apply (Слой ⇒ Маска слоя ⇒ Применить маску слоя).
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Редактирование маски слоя осуществляют с помощью пали-
тры Channels (Каналы), где маска слоя отображается как допол-
нительный канал.

Практические задания по пункту 2.8

Задание 1. Задание 1. Изучение взаимодействия основных цветов режи-
мов RGB и CMYK.

Рекомендации по выполнениюРекомендации по выполнению
1. Откройте файл 2_81.jpg. Создайте дубликаты 2_81-1, 2_81-2.
2. Установите цвета по умолчанию. Отобразите на экране ли-

нейки. Используя направляющие, разбейте изображение 2_81-1  

на области (см. рисунок). Выделите  
верхний левый прямоугольник на изо - 
бражении. 

3. Перейдите на палитру Channels. 
Активизируйте красный канал, выде-
лив его мышью или комбинацией кла-
виш Crtl + 1. Удалите его содержимое 
клавишей BackSpace или с помощью 
команды Edit  ⇒  Clear (Редактирова-
ние ⇒ Очистить). Посмотрите, как из-
менилось изображение, включив ото-
бражение всех каналов в режиме RGB 
в палитре Channels (Каналы).

4. Выделите верхний правый прямоугольник на изображении 
и удалите содержимое зеленого канала.

5. Выделите прямоугольник по се редине слева и удалите со-
держимое синего канала.

6. Выделите прямоугольник по середине справа и удалите со-
держимое красного и зеленого каналов.

7. В следующем прямоугольнике удалите содержимое зеле-
ного и синего каналов и в последнем – содержимое синего и 
красного каналов.

8. Включите отображение всех каналов RGB в палитре. В ре-
зультате на данном изображении можно увидеть аддитивные 
(красный, зеленый и синий) и субтрактивные (желтый, голубой, 
пурпурный) цвета.

9. Сохраните файл под именем 2_81-1.jpg.
10. Переведите изображение 2_81-2 в цветовой режим C M Y K.
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11. Выделите все изображение (Ctrl + A) и удалите черный 
канал (в данной цветовой модели он выступает как дополнитель-
ный, технологический).

12. Проделайте действия, описанные в предыдущих пунктах, 
поочередно удаляя каналы Cyan, Magenta, Yellow и их сочетания.

13. Включите отображение всех каналов C M Y K в палитре.
14. Сохраните файл изображения под именем 2_81-2.jpg.
Задание 2. Задание 2. Удаление эффекта «красных глаз» на фотографии 

с использованием работы в цветовых каналах.
Рекомендации по выполнениюРекомендации по выполнению
1. Откройте файл 2_82.jpg. Создайте дубликат.
2. С помощью инструмента Zoom (Масштаб, клавиша Z) уве-

личьте изображение.
3. Выделите один зрачок так, чтобы красный круг находился 

полностью в выделенной области. 
4. Задайте радиус растушевки Feather границы выделенной 

области 1 px. 
5. На палитре Channels (Каналы) активизируйте синий канал 

(Crtl + 3). 
6. Скопируйте в буфер обмена область, выделенную в синем 

канале.
7. Активизируйте красный канал. Вставьте содержимое бу-

фера обмена в красный канал с помощью команды Edit ⇒ Paste 
(Редактирование ⇒ Вставить) или клавиш Ctrl + V.

8. Включите отображение всех каналов RGB в палитре Channels.
9. Отмените выделение.
10. Аналогично отредактируйте изображение второго глаза.
11. Сохраните файл изображения под именем 2_82-1.jpg.
Задание 3. Задание 3. Работа с каналами в режиме Lab.
Рекомендации по выполнениюРекомендации по выполнению
1. Откройте файл 2_83.jpg. Создайте два дубликата – 2_83-1, 

2_83-2.
2. Преобразуйте изображение 2_83-1 в режим Lab, откройте 

палитру Channels (Каналы) и активизируйте канал Lightness (Яр-
кость), а остальные каналы удалите, перетянув строки цветных 
каналов (канала a, а затем канала Alpha2) на кнопку Trash (Кор-
зина), расположенную внизу палитры.

3. Преобразуйте изображения 2_83-1 и 2_83-2 в режим 
Grayscale (Градации серого). Сравните результат.

4. Сохраните оба файла в формате .jpg.
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Задание 4.Задание 4.  Использование маски слоя. 
Рекомендации по выполнениюРекомендации по выполнению
1. Откройте файлы 2_84а.jpg и 2_84b.jpg.
2. Переместите c помощью мыши, удерживая клавишу Shift, 

чтобы центрировать изображение, миниатюру слоя Background 
файла 2_84b.jpg на изображение файла 2_84а.jpg. 

3. Создайте белую маску для слоя Layer 1. Для этого:
 y активизируйте слой и сделайте его невидимым;
 y создайте область выделения вокруг елки;
 y выполните растушевку выделения (Alt + Ctrl + D) с ради-

усом 50;
 y выполните команду Layer ⇒ Layer Mask ⇒ Reveal Selection 

(Слой ⇒ Маска слоя ⇒ Показать выделение); 
 y сделайте видимым слой Layer 1. Должна получиться маска 

(см. рисунок).

4. Откорректируйте расположение маски или рисунка в ней. 
Для этого разорвите связь между изображением и маской, вы-
полнив щелчок на значке .

Таким образом можно перемещать при помощи инструмента 
Move либо изображение (активизировав его миниатюру на пали-
тре слоев с помощью мыши), либо маску (активизировав мини-
атюру маски). 

Достигнув оптимального результата, установите связь между 
изображением и маской.

5. Активизируйте слой с маской, на палитре Channels (Кана-
лы) активизируйте канал с маской. Откорректируйте, при необ-
ходимости, маску слоя: используйте инструменты Brush (Кисть) 
для добавления пикселей в выделенную область и Eraser (Ластик) 
для удаления пикселей из области (параметр Hardness = 0 %).

Можно использовать только инструмент Brush (Кисть). Чтобы исключить 

пиксели из выделенной области, инвертируйте основной и фоновый цвета. 

6. Зафиксируйте размер файла (см. строку состояния). При-
мените маску к слою. Обратите внимание на размер файла.

7. Сохраните файл изображения с именем 2_84.psd.
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Задание 5. Задание 5. Цветокоррекция изображения с использованием 
альфа-каналов. 

Рекомендации по выполнениюРекомендации по выполнению
1. Откройте файл 2_85.jpg. Необходимо провести цвето-

коррецию, чтобы город не сливался по цвету с окружающим 
фоном.

2. Установите цвета по умолчанию.
3. Выделите изображение города инструментом Magnetic Lasso 

(Магнитное лассо) с параметрами Feather (Растушевка) = 15 px; 
Widht (Ширина) = 10 px, Contrast (Контраст) = 5 %. 

4. В открывшемся окне диалога откорректируйте нейтраль-
ные цвета, задав параметры согласно рисунку слева).

5. Для уплотнения теней выполните команду Levels (Уровни), 
в диалоговом окне измените положение черного маркера (см. ри-
сунок справа).

6. Сохраните выделенную область в альфа-канале. 
7. Перейдите в режим Quick Mask (Быстрая маска). С помо-

щью круглой мягкой кисти выделите скалу, на которой располо-
жен город. Вернитесь в обычный режим.

8. Измените оттенок скалы с помощью одной из команд цве-
токоррекции.

9. Для цветокоррекции гор создайте новое выделение в режи-
ме Quick Mask (Быстрая маска). Для этого с помощью инст румента 
Gradient (тип – линейный, переход Foreground to Transparent (От 
основного к прозрачному)) проведите линию от верхнего края 
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рисунка, захватив часть скалы (см. рисунок слева). В результате 
должна получиться маска согласно рисунку справа). В настрой-
ках режима Quick Mask должен быть установлен переключатель 
Selected Area (Выделенная область). Инвертируйте выделенную 
область.

Такую коррекцию можно выполнить с использованием корректирующих 

слоев. В этом случае вместо каждой команды коррекции создается соот-

ветствующий корректирующий слой с маской.

10. Вернитесь в обычный режим и загрузите селекцию горо-
да, вычитая ее из текущего выделения.

11. Измените оттенок, выполнив преобразования в зеленом 
канале команды Curves. Увеличьте контрастность, произведя из-
менения в композитном канале команды Curves.

12. Сохраните файл с именем 2_85.psd.

Контрольные вопросы
1. Что такое режим быстрого маскирования?

2. Для чего используются альфа-каналы?

3. Опишите процесс создания и редактирования альфа-канала.

4. Что происходит с быстрой маской после отмены выделения?

5. Куда помещается маска, сохраненная на основе выделенной области?

6. Назовите назначение панели Channels (Каналы).

7. Что такое маска слоя?

8. Каким образом можно скрыть фрагмент изображения на отдельном слое?

9. Для чего используют плашечные каналы?

10. Перечислите способы создания плашечного канала.
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2.9. Инструменты ретуширования

Ретушь – устранение дефектов фотографий: пятен, царапин, 
трещин, вуали, дефектов съемки и обработки, эффекта «красных 
глаз».

Ретуширование изображения осуществляют инструментами:
 y Clone Stamp (Клонирующий штамп, 

клавиша S) – используют для дублиро-
вания фрагментов изображения. 

Алгоритм использования инструмента: при нажатой клавише 
Alt щелкните мышью в точке, которая будет являться образцом 
(курсор примет форму перекрестья), затем перемещайте мышь 
при нажатой левой кнопке в те области изображения, куда необ-
ходимо скопировать образец. При нажатии левой кнопки мыши 
крестик показывает, откуда берется образец для копирования. 
Если на панели свойств инструмента нажата кнопка Use Same 
Offset for Each Stroke (Использовать одинаковое смещение для 
каждого штриха), которая соответствует параметру Align (Вырав-
нивание) в ранних версиях, то точка-образец будет смещаться 
соответственно перемещению мыши от первой рабочей точки; 
при отключенной кнопке при каждом новом щелчке мышью бу-
дет применяться один и тот же образец. Список Sample (Образец) 
позволяет указать положение источника клонирования: Current 
Layer (Текущий слой), Current & Below (Текущий и нижние види-
мые слои), All Layers (Все слои).

Панель свойств инструмента со держит так же кнопки откры-
тия палитр Brush (Кисть) (параметры идентичны параметрам ки-
сти) и Clone Sourse (Источник клонов), список вы бора режима сме-
шивания пикселей и другие настройки, рассмотренные ранее для 
инструментов рисования;

 y Pattern Stamp (Узорный штамп) – рисует повторяющимся 
фрагментом изображения, определенные командой Edit ⇒ Define 
Pattern (Редактирование ⇒ Определить узор);

 y Healing Brush (Лечащая кисть, 
клавиша J) – работает подобно штам-
пу, но с учетом тонового и цветового 
диапазона корректируемой об ласти.

У этого инструмента отсутству-
ют параметры Opacity (Непрозрач-
ность) и Flow (Нажим). При установ-
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ке флажка Pattern инструмент Healing Brush (Лечащая кисть) ра-
ботает аналогично Pattern Stamp (Узорный штамп);

Инструмент Healing Brush хорошо подходит для восстановления равно-
мерных фрагментов изображения (например, поверхности кожи на пор-
трете). При наличии сильных неоднородностей (толстых линий, полос) ис-
пользуйте инструмент Clone Stamp.

 y Spot Healing Brush (Точечная лечащая кисть) – предназна-
чен для устранения небольших точечных пятен, которые можно 
закрыть за один раз. На панели свойств устанавливают размер 
кисти, который должен быть немного больше ретушируемого де-
фекта, и режим смешивания. В большинстве случаев для ретуши 
лучше использовать режим Replace (Заменить);

 y Patch (Заплата, клавиша J) – копирует одну область изо-
бражения на другую или закрашивает ее готовым узором, учи-
тывая цветовой и тоновый диапазоны фрагмента изображения, 
куда ставится «заплата». Инструмент можно использовать двумя 
способами в зависимости от режима работы, который устанавли-
вается переключателями на панели свойств:

 –Patch Source from Destination (Источник) – создайте выде-
ленную область вокруг фрагмента изображения, который тре-
буется восстановить, и переместите выделенную область на тот 
участок изображения, откуда берется «заплата»;

 –Patch Destination from Source (Назначение) – создайте вы-
деленную область вокруг фрагмента изображения, который не-
обходимо клонировать, и переместите область на участок изо-
бражения, который требуется восстановить.

При выделении фрагмента изображения инструмент Patch 
(Заплата) аналогичен инструменту Lasso (Лассо). К границе вы-
деленной области, созданной инструментом Patch, применимы 
все команды ее модификации;

 y Content-Aware Move (Перемещение с учетом содержимого) – 
используют при создании различных фотокомпозиций, а так-
же в случаях, когда нужно аккуратно перенести фрагмент изо-
бражения в другое место или выполнить клонирование участка 
фотографии. Как и Patch, этот инструмент позволяет выделить 
фрагмент изображения аналогично инструменту Lasso (Лассо), а 
затем переместить или скопировать;

 y Red Eye (Красные глаза) – позволяет устранить эффект 
«красных глаз». Параметры инструмента: Pupil Size (Величина 
зрачка) и Darken Amount (Степень затемнения).
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Чтобы восстановить фрагмент изображения, используют ин-
струменты:

 y History Brush (Архивная кисть, 
клавиша Y ) – избирательно возвра-
щает к любому из нескольких преды-

дущих состояний кисти в соответствии с палитрой History. Па-
раметры аналогичны инструменту Brush. Перед использованием 
инструмента необходимо выбрать состояние на палитре History;

 y Art History Brush (Художественная архивная кисть) – рабо-
тает аналогично архивной кисти, но позволяет добавлять художе-
ственные эффекты.

К корректирующим относят инструменты:
 y Blur (Размытие) – уменьшает четкость 

элементов изображения за счет снижения 
цветового контраста между соседними пик-
селями;

 y Sharpen (Резкость, клавиша R) – увеличивает резкость эле-
ментов изображения;

 y Smudge (Палец, клавиша R) – размазывает цвета на изо-
бражении, смещая пиксели соответствующих цветов. Установка 
флажка Finger Painter (Рисование пальцем) позволяет добавлять 
в изображение еще и основной цвет, как будто палец предвари-
тельно обмакнули в краску.

Все корректирующие инструменты используют кисть. Поми-
мо параметров кисти инструмента Diameter (Диаметр) и Hardless 
(Жесткость), для них можно настроить режим смешивания пик-
селей Mode (Режим) и интенсивность воздействия инструмента 
Strength (Сила) (рекомендуется устанавливать не более 20 %).

Для локальной тоновой коррекции используют три инст-
румента, которые связаны с одной кнопкой в палитре инстру-
ментов и клавишей O:

 y Dodge (Осветлитель) – осветляет обла-
сти, через которые проходит кисть;

 y Burn (Затемнитель) – затеняет об-
ласти;

 y Sponge (Губка) – позволяет увеличить или уменьшить на-
сыщенность цвета.

Эти инструменты также используют кисть.
Параметры инструментов Dodge и Burn:
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 y Range (Диапазон) – диапазон яркостей, на которые воз-
действует инструмент: Highlight – светлые; Shadow – темные; 
Midtones – средние тона;

 y Exposure (Экспозиция) – степень воздействия инструмента 
на изображение.

Чтобы вносимые изменения были плавными и результат выглядел есте-

ственно, для осветления и затемнения используйте мягкую кисть с жест-

костью менее 50 %, параметр Exposure – не более 10 %.

При значении Desaturate (Уменьшить) параметра Mode (Ре-
жим) инструмент Sponge (Губка) позволяет снизить насыщенность 
участка изображения, а при значении Saturate (Повысить) – по-
высить насыщенность.

Практические задания по пункту 2.9

Задание 1. Задание 1. Удаление эффекта «красных глаз» инструментами 
Color Replacement и Red Eye.

Рекомендации по выполнениюРекомендации по выполнению
1. Откройте файл 2_82.jpg. Создайте дубликат изображения. 

Увеличьте масштаб.
2. Активизируйте инструмент Color Replacement (Замена цве-

та), установите параметры: Diameter (Диаметр) = 18 px; Hardness 
(Жесткость) = 80 %.

3. Выберите образец цвета (темный участок на краях области 
глаза) и закрасьте красные участки.

4. Сохраните дубликат с именем 2_92-1.jpg. 
5. Создайте дубликат файла изображения 2_92-2.jpg.
6. Устраните эффект «красных глаз» инструментом Red Eye 

(Красные глаза) с параметрами Pupil Size (Размер зрачка) – 50 %, 
Darken Amount (Степень затемнения) – 50 %.

7. Сохраните дубликат.
Задание 2. Задание 2. Удаление дефектов с фотографии с помощью ин-

струмента Clone Stamp (Клонирующий штамп).
Рекомендации по выполнениюРекомендации по выполнению
1. Откройте файл 2_91.jpg. Создайте дубликат фонового слоя.
2. Увеличьте фрагмент изображения файла с грушей до 

200 %. На груше хорошо виден «природный» дефект.
3. Устраните дефект инструментом Clone Stamp (Клонирую-

щий штамп) с параметрами, установленными согласно рисунку. 
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4. Сохраните изменения в файле.
Задание 3. Задание 3. Удаление дефектов на фотографии с помощью ин-

струмента Patch (Заплата).
Рекомендации по выполнениюРекомендации по выполнению
1. Откройте файл 2_93.jpg. Создайте дубликат фонового слоя.
2. С помощью инструмента Rectangular Mar quee (Прямоугольное 

выделение) выделите фрагмент изображения с дефектом (датой).
3. Инструментом Patch (Заплата) в режиме 

Source (Источник) переместите выделенную об-
ласть на фрагмент изображения (чуть выше), с 
которого и будет сделана «заплата». 

4. Инструментом Patch выделите объекты, расположенные 
справа внизу (на асфальте) и переместите выделенную область 
влево, на дублируемый участок изображения.

5. Сохраните файл изображения с именем 2_93.psd.

Контрольные вопросы
1. Перечислите основные инструменты ретуширования.

2. Каким образом задать образец для копирования при использовании инст-

румента Clone Stamp (Клонирующий штамп)?

3. Как влияет на работу инструмента Clone Stamp (Клонирующий штамп) кнопка 

Use Same Offset for Each Stroke (Использовать одинаковое смещение для каждо-

го штриха)?

4. В каких случаях целесообразно применять инструмент Spot Healing Brush (То-

чечная лечащая кисть)?

5. Назовите назначение инструмента Patch (Заплата). В каких режимах он работает?

6. В чем различие использования инструментов Clone Stamp (Клонирующий 

штамп) и Healing Brush (Лечащая кисть)? В каких случаях каждый из этих ин-

струментов предпочтительней? 

7. В чем преимущество использования инструмента Content-Aware Move (Пере-

мещение с учетом содержимого) в сравнении с инструментом Patch (Заплата)?

8. Перечислите способы устранения эффекта «красных глаз».

9. Для чего используют инструмент History Brush (Архивная кисть)? Каким об-

разом можно задать его параметры?

2.10. Работа с фильтрами

Фильтр в Adobe Photoshop – это программа, в ходе выпол-
нения которой обрабатывается и пересчитывается по заданному 
алгоритму информация о цвете и расположении каждого пик-
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селя. Фильтры представляют собой файлы специального фор-
мата с расширением .8bf. Сама программа содержит несколько 
десятков стандартных фильтров, кроме того, можно подключать 
фильтры, разработанные другими фирмами.

Условно фильтры можно разделить на три группы:
 y корректирующие (Sharpen, Blur, Noise);
 y искажающие (Distort, Pixelate, Render, Stylize);
 y эффектов (Artistic, Brush Strokes, Sketch, Texture).

Все фильтры расположены в меню Filter (Фильтр). Если дей-
ствие фильтра надо повторить, выполните команду Filter ⇒ Last 
Filter (Фильтр ⇒ Последний фильтр) или нажмите клавиши Ctrl + 
F (Ctrl + Alt + F), чтобы открыть диалоговое окно последнего ис-
пользовавшегося фильтра и изменить параметры. Если действие 
фильтра надо ослабить, выберите пункт меню Edit ⇒ Fade (Редак-
тирование ⇒  Ослабить) или нажмите клавиши Shift + Ctrl + F.

Для повышения резкости применяют фильтры группы Sharpen 
(Резкость), среди которых три полностью автоматические: Sharpen 
(Резкость); Sharpen More (Резкость +); Sharpen Edges (Резкость на 
краях) и два настраиваемых фильтра:

 y Unsharp Mask (Контурная резкость) – увеличение резкости 
контрастных областей изображения. Параметры:

 –Amount (Величина) – степень увеличения контрастности 
(рекомендуется 150–200 %);

 –Radius (Радиус) – толщина контура резкости (рекоменду-
ется 1–4 px);

 –Threshold (Порог) – разность значений яркости двух со-
седних пикселей, при которой программа увеличивает контраст-
ность между ними;

 y Smart Sharpen («Умная» резкость) – увеличение резкости 
темных, светлых, средних тонов в отдельности. 

Фильтры группы Blur (Размытие) уменьшают контрастность 
соседних пикселей для размытия изображения. Автоматические 
фильтры:

 y Blur (Размытие) – создает эффект размытия в соответствии 
с нормальным распределением;

 y Blur More (Размытие +) – 3–4 раза Blur;
 y Average (Усреднение) – определяет средний цвет изображе-

ния или его выделенной области, а затем заполняет этим цветом 
изображение или его выделенную область.
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Настраиваемые фильтры: 
 y Gaussian Blur (Размытие по Гауссу) – размытие в соответ-

ствии с нормальным распределением в зависимости от значения 
радиуса размытия – параметр Radius (0,1–250 рх);

 y Motion Blur (Размытие движения) – создает эффект движе-
ния камеры или объекта съемки;

 y Radial Blur (Радиальное размытие) – направленное размы-
тие (по кругу или из одной точки);

 y Smart Blur («Умное» размытие) – обрабатывает низкокон-
трастные области изображения, не внося изменений в контуры;

 y Lens Blur (Размытие при малой глубине резкости) – позво-
ляет создать на одном изображении области с различной степе-
нью размытости.

В этой группе также находятся фильтры Box Blur (Размытие 
по рамке); Surface Blur (Размытие по поверхности с имитацией 
сияющих поверхностей); Shape Blur (Размытие по фигуре).

Для устранения (добавления) шума используют фильтры 
группы Noise (Шум). Фильтр Add Noise (Добавить шум) позволяет 
добавить шум (эффект зернистости в изображении). Параметры:

 y Amount (Величина) – диапазон изменения цвета пикселей;
 y Distribution (Распределение): Uniform (Равномерное) – равно-

мерно распределенный цветной шум; Gaussian (по Гауссу) – но-
вые цвета распределяются в соответствии с нормальным законом;

 y Monochromatic (Монохроматический) – установка флажка 
позволяет распределить шум по различным цветовым каналам, 
создает «серый» шум.

Фильтр Despeckle (Удалить шум) автоматически ослабляет 
резкость, не затрагивая областей с резким изменением яркости 
пикселей (границ); Median (Медиана) уменьшает шум, усредняя 
цвета изображения; Reduce Noise (Уменьшить шум) устраняет 
цветовой и яркостный шумы; Dust & Scratches (Пыль и царапи-
ны) удаляет мелкие дефекты, которые выделяются на фоне со-
седних пикселей. Параметры: 

 y Radius (Радиус) – определяет радиус действия фильтра, 
больший радиус дает большее размытие; 

 y Threshold (Граница) – минимальная разность яркостей пик-
селей, при которой выделяющийся элемент удаляется. 
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Практические задания по пункту 2.10

Задание 1. Задание 1. Улучшение резкости изображения с помощью 
фильтров Sharpen (Резкость) и Blur (Размытие).

Рекомендации по выполнениюРекомендации по выполнению
1. Откройте файл 2_101.jpg. Создайте дубликат изображения.
2. Создайте дубликат фонового слоя, который будет редакти-

роваться. 
3. Усильте резкость изображения, используя фильтр Sharpen 

(Резкость).
4. Повторите пункт 3 несколько раз, пока не получите изо-

бражение достаточной резкости.
5. Размойте полученное изображение в первоначальное с по-

мощью фильтра Blur (Размытие).
6. Верните изображению резкость, используя фильтр Unsharp 

Mask (Контурная резкость) с параметрами: 
 y Amount (Величина) – 500 % (максимальное значение);
 y Radius (Радиус) ≈ 0,5 px для экранных и ≈ 1,4 px для печат-

ных изображений;
 y Threshold (Порог) ≈ 4.

7. Сохраните файл.
Задание 2. Задание 2. Улучшение резкости изображения в режиме Lab. 
Рекомендации по выполнениюРекомендации по выполнению
1. Откройте файл 2_102.jpg. Создайте дубликат с именем 

2_102-1.
2. Переведите изображение в режим Lab.
3. Активизируйте канал Lightness (Яркость, Сtrl + 1), нажми-

те клавишу «∼», чтобы видеть изображение в цвете.
4. Примените к данному каналу фильтр Unsharp Mask (Кон-

турная резкость) с параметрами: 
 y Amount ≈ 80–150 %; 
 y Radius ≈ 1,4 px (до появления видимых артефактов); 
 y Threshold ≈ 12 (до исчезновения шероховатостей, но с со-

хранением резкости контуров).
5. Нажмите Ctrl + «∼», чтобы выбрать композитный канал. 
6. Переведите изображение обратно в RGB. Сохраните файл.
7. Создайте еще один дубликат изображения с именем 2_102-2.
8. Примените к изображению фильтр Unsharp Mask (Контур-

ная резкость) с приведенными выше параметрами. Сравните ре-
зультаты применения фильтра в разных режимах. 

9. Сохраните файл.
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Задание 3. Задание 3. Улучшение резкости изображения с помощью 
фильтра High Pass (Цветовой контраст).

Фильтр High Pass (Цветовой контраст) усиливает резкость изображения за 

счет увеличения контрастности на краях объектов. Параметр Radius (Ради-

ус) контролирует насыщенность краевых контрастов. Остальные области 

изображения остаются заполненными нейтральным серым цветом.

Рекомендации по выполнениюРекомендации по выполнению
1. Создайте еще один дубликат с именем 2_102-3. 
2. Создайте дубликат фонового слоя. Преобразуйте его в 

смарт-объект, чтобы в дальнейшем применить фильтр как ре-
дактируемый. Для этого в контекстном меню палитры слоев вы-
берите команду Convert to Smart Object (Преобразовать в смарт-
объект). 

3. Примените к нему фильтр Filter  ⇒ Others  ⇒ High Pass 
(Фильтр ⇒ Другие ⇒ Цветовой контраст). В диалоговом окне 
фильтра перетащите слайдер Radius (Радиус) влево до мини-
мального значения 0,1 рх. Все изображение заполнилось серым 
цветом. 

4. Перемещайте слайдер вправо, пока не проявятся четкие 
контуры объектов. Значение радиуса зависит от фотографии. Чем 
больше изображение, тем выше должно быть значение. В основ-
ном оно варьируется от 1 до 5 рх.

5. Измените режим смешивания слоя на Overlay (Пере-
крытие), в котором игнорируются области нейтрального серого 
цвета, в результате серый фон исчезнет, светлые участки станут 
светлее, а темные – темнее, усилится контрастность и создастся 
иллюзия более четкого изображения. 

6. Если эффект усиления резкости от примененного режима 
смешивания слишком насыщенный, то измените режим на Soft 
Light (Мягкий свет), а если наоборот – недостаточный, то попро-
буйте Hard Light (Жесткий свет).

7. Если результат неприемлем, измените параметр фильтра, 
выполнив двойной клик по названию фильтра. 

8. При необходимости уменьшите непрозрачность слоя. 
9. Растрируете слой, если получили удовлетворительный ре-

зультат. 
10. Сохраните файл.
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Контрольные вопросы
1. Что представляет собой фильтр?

2. На какие группы условно можно разделить фильтры?

3. Поясните, как усилить или ослабить действие фильтра.

4. Приведите примеры корректирующих фильтров.

5. К каким слоям невозможно применить фильтры?

2.11. Допечатная подготовка растровых файлов

Полиграфический процесс создания печатной продукции 
можно упрощенно представить следующим образом. На первом 
этапе создают оригинал-макет продукции с графическими изо-
бражениями и текстовыми блоками. Изображения могут быть как 
растровыми, так и векторными. Обычно растровые изображения 
для дальнейшей верстки сохраняют в формате TIFF в цветовой 
модели CMYK, а векторные рекомендуется сохранять в универ-
сальном формате EPS. Далее непосредственно в программе вер-
стки создают оригинал-макет полиграфической продукции. Гра-
фические изображения располагают между текстовыми блоками, 
производят форматирование текста и применяют другие спосо-
бы обработки текста. Оригинал-макет сохраняют во внутреннем 
формате программы верстки. На втором этапе выполняют  цве-
тоделение продукции, выбирают триадные или плашечные цве-
та, создают цветоделенные пленки. Далее из этих пленок создают 
печатные формы и печатают тираж. 

Требования к иллюстрациям:
 y форматы TIFF, EPS; запрещено использовать растровые 

форматы JPEG, GIF, BMP;
 y цветовые модели: CMYK (полноцветная печать), Grayscale 

(неполноцветная печать), Bitmap (неполноцветная печать);
 y разрешение: для полноцветного изображения – 300×400 dpi; 

для черно-белого – 150×200 dpi;
 y растровые эффекты (тени, прозрачности, градиенты, филь-

тры) – любые;
 y слои в изображении обязательно должны быть сведены в 

один слой;
 y масштаб: размер изображения должен соответствовать ре-

альному размеру в макете (100 %), если изображение идет в об-
рез – вынос картинки на обрез не менее 3 мм;

 y сжатие файла: без компрессии;
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 y каналы: файл с иллюстрацией не должен содержать ни-
каких дополнительных каналов, за исключением формата EPS 
(Photoshop DCS 2.0), имеющего дополнительные каналы (spot 
colors), применяемые для печати дополнительных PANTONE-
цветов в офсетной печати.

В связи с этим допечатная подготовка растрового изображе-
ния включает следующие этапы:

1) определение размеров иллюстрации в единицах длины. 
Далее определяют размеры припусков на обрезку. Для высокока-
чественной офсетной печати необходимо разрешение 300 dpi. На-
пример, дообрезной размер визитки должен составлять 92×52 мм, 
разрешение 300 dpi. Параметры устанавливают в меню Image ⇒ 
Image Size… (Изображение ⇒ Размер изображения…);

2) преобразование цветных растровых изображений в цвето-
вую модель CMYK, 8 бит на канал с помощью команды Image ⇒ 
Mode (Изображение ⇒ Режим);

3) объединение слоев растрового изображения: Layer ⇒ Flatten 
Image (Слой ⇒ Выполнить сведение); 

4) сохранение в формате TIFF без сжатия. 

Контрольные вопросы
1. Какие растровые форматы используют для печати файлов?

2. Какие параметры полноцветного (неполноцветного) изображения необходимо 

установить для печати?

3. Укажите размер обрезных полей.
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3

ОСНОВЫ ВЕКТОРНОЙ ГРАФИКИ 

3.1. Редакторы векторной графики: 
графические редакторы  

CorelDRAW, Аdobe Illustrator

К программным средствам создания и обработки вектор-
ной графики относят графические редакторы (Adobe Illustrator, 
CorelDRAW, Adobe FreeHand) и векторизаторы (трассировщи-
ки) – специальные пакеты преобразования растровых изображе-
ний в векторные (Adobe Streamline, CorelTRACE). 

Векторные графические редакторы предоставляют возмож-
ность создавать и редактировать векторные изображения не-
посредственно на экране компьютера, а также сохранять их 
в различных векторных форматах. Пакеты векторной или ил-
люстративной графики основаны на объектно-ориентированном 
подходе, который заключается в следующем:

 y все операции, выполняющиеся в процессе создания и из-
менения изображений, пользователь проводит с объектами – се-
мантически нагруженными элементами изображения как единым 
целым, от стандартных (кругов, прямоугольников, текстов и т. д.) 
до составных объектов. Таким образом, изображение становит-
ся иерархической структурой, на самом верху которой находится 
иллюстрация в целом, а в самом низу – стандартные объекты; 

 y каждому стандартному классу объектов ставится в соответ-
ствие уникальная совокупность управляющих параметров, или 
атрибутов класса. Если мы говорим о прямоугольнике высотой 
200 мм и шириной 300 мм, залитом синим цветом, обведенном 
желтой линией шириной 3 пт, с центром, расположенным в 150 мм 
по вертикали и в 250 мм по горизонтали от левого нижнего угла 
страницы, с углом наклона длинной стороны к горизонтали 32°, 
то мы имеем дело с экземпляром класса – объектом, для которо-
го зафиксированы значения управляющих параметров;

 y для каждого стандартного класса объектов определен пере-
чень стандартных операций. Например, описанный выше пря-
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моугольник можно развернуть, масштабировать, закруглить его 
углы, преобразовать его в объект другого класса – замкнутую 
кривую.

Векторный графический редактор CorelDRAW канадской фир-
мы Corel Corporation получил известность благодаря широким воз-
можностям, наличию огромных библиотек готовых изображений, 
мощной встроенной системе обучения и подсказок. CorelDRAW 
представляет собой интегрированный объектно-ориентированный 
пакет программ для работы с иллюстративной графикой, ориенти-
рованный на решение множества различных задач, возникающих 
при работе пользователя в области иллюстративной графики. Про-
граммы могут легко обмениваться данными или последовательно 
выполнять различные действия над одними и теми же данными. 
В состав пакета входят приложения:

 y CorelDRAW – редактор векторных изображений;
 y Corel PHOTO-PAINT – редактор растровых изображений;
 y Corel R.A.V.E. – векторная анимация объектов;
 y Corel CAPTURE – граббер захвата изображения;
 y Corel TRACE – утилита преобразования растровых изобра-

жений в векторные (векторизатор) и др.
Начиная с 12-й версии, официальное наименование пакета 

программного обеспечения для работы с графической информаци-
ей производства компании Corel – CorelDRAW Graphics Suite. 

Документы CorelDRAW имеют файловое расширение .cdr. 
Программа хорошо совместима с другими графическими пакета-
ми, поддерживает несколько форматов: .ai, .psd, .eps, .pdf. Суще-
ствует возможность создания Web-страниц с помощью мастера 
преобразования в формат .html.

Графический векторный редактор Adobe Illustrator разра-
ботан фирмой Adobe System, имеет интерфейс, схожий с Adobe 
Photoshop, полностью интегрирован с программой верстки Adobe 
InDesign. Adobe Illustrator обладает хорошими возможностями для 
создания и редактирования рисунков, художественного оформле-
ния текстов, создания логотипов, подготовки изображений к пе-
чати или размещения их в сети Интернет. Он корректно работа-
ет с EPS-документами и PDF-файлами, имеет развитую систему 
цветовоспроизведения, позволяет увидеть, каким получится ма-
кет на печати. 

Трассировщик Adobe Streamline занимает ведущее место в сво-
ем классе программ. Он позволяет проводить тонкую настройку 
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параметров векторизации, что улучшает его точность. Более всего 
векторизация удобна для преобразования чертежей, черно-белых 
рисунков и другой простой графики без полутонов.

Adobe FreeHand (бывший Macromedia FreeHand) – векторный 
графический редактор, разрабатываемый фирмой Adobe System 
для Microsoft Windows и для Mac OS. FreeHand намного быстрее 
и проще своих конкурентов – CorelDRAW и Adobe Illustrator. Эта 
программа предназначена как профессиональным художникам 
и дизайнерам, так и любителям, не имеющим особой подготовки. 
Adobe FreeHand отлично подходит для создания логотипов, ре-
кламы, Web-графики и анимации. Интерфейс программы прост 
и нагляден, имеется множество инструментов, с помощью кото-
рых можно быстро и легко выполнить сложные преобразования 
объектов или достичь самых разных художественных эффектов. 
Adobe FreeHand умеет экспортировать и импортировать файлы 
практически во всех популярных форматах. Более того, в его со-
став входят настройки «горячих» клавиш, эмулирующие другие 
распространенные программы (Adobe Illustrator, CorelDRAW), 
так что их пользователям не надо переучиваться, переходя на 
Adobe FreeHand.

Контрольные вопросы

1. В чем заключается объектно-ориентированный подход применительно к век-

торной графике?

2. Какие программы входят в состав пакета CorelDRAW Graphics Suite?

3. Какие возможности предоставляет редактор Adobe Illustrator? Что можно от-

нести к преимуществам программы?

4. Перечислите основные преимущества Adobe FreeHand.

3.2. Интерфейс программы CorelDRAW.  
Настройка рабочего пространства

Интерфейс программы, несмотря на кажущуюся сложность, 
организован достаточно логично и содержит средства настройки 
в соответствии с предпочтениями пользователя.

После запуска программы на экране открывается главное 
окно CorelDRAW (рис. 3.1) с основными элементами пользова-
тельского интерфейса и печатной страницей в центре. 
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Рис. 3.1. Главное окно CorelDRAW

Основными элементами окна CorelDRAW являются:
 y строка заголовка с тремя кнопками управления размером 

окна;
 y строка меню (Menu Bar): каждое меню содержит множество 

пунктов, которые открывают подменю, выводят на экран диало-
говые окна или выполняют конкретные команды;

 y стандартная панель инструментов (Standart) содержит кноп-
ки для выполнения стандартных операций: создание, открытие, 
сохранение, импорт/экспорт, печать документа, копирование, пе-
ремещение, вставка объектов, изменение масштаба отображения 
документа;

 y панель графики (Toolbox) содержит инструменты для соз-
дания объектов, изменения их формы, применения специальных 
эффектов, работы с цветом и т. п. В правом нижнем углу боль-
шинства кнопок инструментов имеется маленький треугольник, 
который означает, что данная кнопка отвечает за целую группу 
инструментов;

 y панель атрибутов, или свойств (Property Bar): ее содержа-
ние зависит от класса выбранного (активного) объекта. Если же 
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ни один объект не выбран, то на ней представлены элементы 
управления свойствами документа в целом;

 y цветовая палитра (Color Palette): служит для задания пара-
метров абриса (контура) и заливки объектов;

 y навигатор (Navigator) – панель элементов управления для 
перехода по страницам, используется, если документ включает 
в себя несколько страниц. Для добавления страницы нужно на-
жать на ;

 y пристыковываемые окна, или докеры (Dockers): элементы, 
предназначенные для настройки параметров выполнения тех или 
иных действий; они обычно открываются в служебной области в 
правой части окна.

В нижней части окна программы расположена строка со-
стояния (Status Bar), где отображаются текущая информация об 
активном (выбранном) объекте, а также координаты положения 
курсора, для определения которых используется система коорди-
нат, состоящая из двух взаимно перпендикулярных осей: X и Y. 
Ось X ориентирована горизонтально (слева направо), а ось Y – 
вертикально (снизу вверх). Начало отсчета системы координат XY 
совпадает с левым нижним углом печатной страницы.

Для отображения/скрытия панелей используют команду Win-
dow ⇒ Toolbars (Окно ⇒ Панели инструментов). В списке панелей 
инструментов напротив названия панели необходимо установить 
(чтобы отобразить) либо снять (чтобы скрыть) флажок.

Чтобы отобразить/скрыть цветовые палитры, необходимо 
выполнить команду Window ⇒ Color Palettes (Окно ⇒ Цветовые 
палитры). 

Цветовая палитра по умолчанию – стандартная палитра CMYK. Для залив-

ки выделенного объекта нужно щелкнуть левой кнопкой мыши на нужном 

цвете, для обводки – правой.

Пользователь имеет возможность сформировать любые элемен-
ты интерфейса по своему вкусу в специализированном окне Option 
(Настройка), открываемом командой Tools ⇒ Option (Инструмен-
ты ⇒ Настройка).

Размер рабочей области достаточно большой в отличие от 
размеров печатной страницы, параметры которой устанавливают 
на панели свойств или с помощью команды Layout ⇒ Page Setup 
(Макет ⇒ Параметры страницы). К параметрам страницы от-
носят:
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 y Paper Type/Size (Тип/Формат бумаги) – программа поддер-
живает обширный набор размеров страниц документа, соответ-
ствующих стандартам многих стран мира;

 y Paper Width and Height (Ширина и высота бумаги) – значе-
ния этих параметров (ширины (Width) и высоты (Height)) авто-
матически обновляются в соответствии с выбранным форматом 
бумаги. Однако можно задать для них и собственные, независи-
мые значения; 

 y Portrait (Книжная) и Landscape (Альбомная) – кнопки, 
управляющие ориентацией страницы;

 y Drawing Units (Единицы измерения). 

Если на панели свойств не отображаются параметры страницы, необходи-
мо выбрать на панели графики инструмент Pick (Выбор, ) и щелкнуть на 
свободном месте рабочей области.

Для управления объектами в документе используют докер 
Object Manager (Диспетчер объектов), открываемый командой 
Window ⇒ Dockers ⇒ Object Manager (Окно ⇒ Докеры ⇒ Диспетчер 
объектов). Структура, представленная в окне Диспетчера объек-
тов, полностью соответствует иерархии объектов в текущем до-
кументе. Понимание функций докера и свойств представленных 
в нем объектов является ключом к освоению приемов работы 
в программе CorelDRAW. 

Сложные векторные иллюстрации могут состоять из сотен, 
а иногда и тысяч объектов. Объекты могут перекрывать друг 
друга или выглядеть как одно целое. Выделение для редактиро-
вания отдельных объектов при обычном их представлении ча-
сто вызывает некоторые трудности, а их отображение на экране 
занимает продолжительное время. В связи с этим в програм-
ме предусмотрены различные команды отображения объектов 
и всей иллюстрации. Эти команды находятся в пункте меню 
View (Вид).

Существуют следующие режимы отображения изображений: 
 y Sample Wireframe (Простой контурный) – на экране все 

объекты представляются в контурном режиме без обводок и за-
ливок, а также без эффектов, примененных к объектам. Закра-
шивать объекты нельзя. Используется для быстрой перерисовки 
изображений с большим числом объектов и для выделения пере-
крывающихся объектов; 

 y Wireframe (Контурный) – объекты представляются без за-
ливок и обводок; 
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 y Draft (Черновой) – предназначен для упрощенного вывода 
сложных заливок (градиентов, двухцветных заливок, импорти-
рованной растровой графики);

 y Normal (Нормальный) – в этом режиме поддерживается 
отображение всех параметров заливок и обводок, кроме заливок 
PostScript; 

 y Enhanced (Расширенный) – отображаются все обводки и 
заливки объектов и импортированная графика с высоким раз-
решением;

 y Pixels (Пиксельный) – представление векторного изображе-
ния в пиксельном виде; 

 y Full-Screen Preview (Полноэкранное отображение) – ото-
бражается только страница документа (меню и панели, включая 
панель инструментов, на экране не отображаются); 

 y Preview Selected Only (Отображение только выделенных объ-
ектов) – режим похож на предыдущий, за исключением того, что 
отображаются только выделенные объекты; 

 y Page Sorter View (Сортировка страниц) – в уменьшенном 
масштабе выводятся все страницы документа, перетаскиванием 
можно изменять последовательность страниц документа.

По умолчанию при создании нового документа в нем имеет-
ся только одна страница. Для управления страницами предна-
значены следующие элементы интерфейса: 

 y команды меню Layout (Макет); 
 y докер Object Manager (Диспетчер объектов);
 y докер Object Properties (Свойства объекта);
 y навигатор;
 y контекстное меню ярлыка страницы;
 y диалоговое окно Go to Page (Перейти к странице), вызыва-

емое щелчком левой кнопкой мыши между кнопками Next Page 
(Следующая страница) и Previous Page (Предыдущая страница) в 
блоке управления страницами.

К средствам повышения точности построения рисунка от-
носят:

 y линейки (View ⇒ Rulers);
 y координатную сетку (View ⇒ Grid); 
 y направляющие линии (View ⇒ Guidelines). 

Настройку параметров сетки и линеек осуществляют в ди-
алоговом окне Options (Параметры) меню Tools  ⇒ Options ⇒ 
Document (Инструменты ⇒ Настройки ⇒ Документ).
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Кроме статических направляющих, в программе реализован 
механизм динамических «умных» направляющих (Dynamic). Для 
привязки объектов, размещаемых в непосредственной близости 
от точек координатной сетки, направляющих или других объ-
ектов, используют режимы Snap to (Document, Baseline) Grid, Snap 
to Guidelines, Snap to Objects, Page (Привязать к сетке, Привязать 
к направляющим, Привязать к объектам, Странице), устанавли-
ваемые выбором команд в меню View (Вид). Настройку вариантов 
объектной привязки выполняют в диалоговом окне Options (Па-
раметры), вызываемом командой Tools ⇒ Options ⇒ Workspace ⇒ 
Snap to ... (Инструменты ⇒ Настройки ⇒ Рабочее пространство ⇒ 
Притягивание к объекту ...). В списке Modes (Способ) имеются 
следующие варианты объектной привязки:

 y Node (Узел) – к узлу объекта или контура; 
 y Intersection (Пересечение) – к геометрической точке пере-

сечения контуров объектов; 
 y Midpoint (Середина) – к середине между двумя узлами объ-

екта или контура; 
 y Quadrant (Квадрант) – к одной из четырех точек, располо-

женных под углами 0, 90, 130 и 270° на окружности, эллипсе или 
дуге; 

 y Tangent (Касательная) – к касательной дуги, окружности 
или эллипса; 

 y Perpendicular (Перпендикуляр) – к точке, находящейся на 
перпендикуляре, проведенном к объекту; 

 y Edge (Край) – к точке на контуре объекта; 
 y Center (Центр) – к центру объекта (дуги, многоугольника, 

эллипса или круга); 
 y Text Baseline (Базовая линия) – к точке на базовой линии 

заголовочного или абзацного текста. 

Практическое задание по пункту 3.2

Настройка рабочей области.
Рекомендации по выполнениюРекомендации по выполнению
1. Выберите из раскрывающегося списка Paper Type/Size (Тип/

Формат бумаги) значение А4.
2. С помощью соответствующей кнопки установите ориента-

цию бумаги – Landscape (Альбомная).
3. Из раскрывающегося списка Drawing Units (Единицы из-

мерения) выберите значение millimeters (миллиметры). Из списка 
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Zoom Levels (Уровни увеличения) выберите значение To Page (На 
страницу). 

4. Проверьте наличие в окне программы CorelDRAW следу-
ющих панелей:

 y панель инструментов;
 y панель свойств;
 y стандартная;
 y цветовая палитра – стандартная палитра CMYK.

5. При отсутствии включите их отображение.
6. Отобразите сетку и линейки. Установите шаг сетки рав-

ным 1 мм.

Контрольные вопросы
1. Назовите элементы рабочей среды CorelDRAW. 

2. Для чего предназначена панель свойств? Что означают кнопки этой панели 

в случае, если ни один объект не выделен? 

3. Какая информация отображается в строке состояния?

4. Поясните, для чего используют навигатор документа. 

5. Как изменить настройки рабочей среды CorelDRAW? 

6. Как добавить/удалить палитру цветов? 

7. Как отобразить или удалить с экрана панель инструментов?

8. Что такое докер? Как отобразить/скрыть докер?

9. Назовите средства повышения точности построения рисунка в CorelDRAW.

3.3. Операции с объектами

Простейшие геометрические объекты (примитивы) в Corel - 
DRAW: прямоугольники и эллипсы, многоугольники и звезды,  
спирали, прямые и кривые линии. Создание объектов в CorelDRAW  
осуществляется с помощью соответствующей кнопки на пане-
ли инструментов Toolbox, клавиатуры или команды Create Object … 
(Создать объект…) контекстного меню печатной страницы. В про-
цессе рисования примитива и после его завершения на панели 
свойств и в строке состояния отображаются точные значения 
размеров объекта и координаты центра. Для построения фигуры 
правильной формы (квадрата, круга, равностороннего много-
угольника и т. п.) необходимо удерживать нажатой клавишу Ctrl, 
при нажатии клавиши Shift создание объекта осуществляется из 
центра. 

В таблицу 3.1 сведены способы создания графических при-
митивов и их параметры, настраиваемые на панели свойств. 
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Таблица 3.1

Создание и свойства графических примитивов

Создание объекта Параметры, настраиваемые на панели свойств

Прямоугольник

Инструмент Rectangle, 
клавиша F6, 
команда  
Create Object ⇒  
Rectangle,
инструмент  
3-Point Rectangle  
(Прямоугольник по трем 
координатам противопо-
ложных вершин)

 y Scale Factor (Коэффициенты масштабирования) – ко-

эффициенты линейного растяжения и сжатия объекта.

 y Nonproportional Scaling/Sizing Ratio (Блокировка раз-

дельного масштабирования).

 y Left Rectangle Corner Roundness, Right Rectangle Cor-

ner Roundness (Коэффициенты закругления углов) – ве-

личины закругления каждого из углов прямоугольника. 

Значения выражены в процентах относительно половины 

длины меньшей стороны прямоугольника.

 y Round Corners Together (Блокировка раздельного за-

кругления углов).

 y Outline Width (Толщина контура) – задание толщины 

контура прямоугольника.

 y Angle of Rotation (Угол поворота) – поворот объекта на 

заданный угол

Эллипс

Инструмент Ellipse, 

клавиша F7, 

команда Create Object ⇒ 

Ellipse,

инструмент  

3-Point Ellipse  

(Эллипс по трем коор-

динатам и направление 

диаметра эллипса)

 y Режимы построения: Ellipse (Эллипс), Pie (Сектор), 

Arc (Дуга). Выбор любой кнопки преобразует выделен-

ный предварительно эллипс соответственно в сектор или 

дугу.

 y Starting and Ending Angles (Начало и конец дуги) – ве-

личины углов поворота точек начала и конца дуги, об-

разующих радиусы, по умолчанию отсчитываемых в на-

правлении против часовой стрелки. 

 y Clockwise/Counterclockwise Arcs or Pies (Отсчет по ча-

совой стрелке/против часовой стрелки)

Многоугольник

Инструмент Polygon,

клавиша Y, команда  

Create Object ⇒ Polygon

Счетчик Number of Points or Sides on Polygon, Star and 

Complex Star (Количество узлов и сторон многоугольни-

ка, звезды и составной звезды): по умолчанию 5 сторон

Звезда (расположен в группе Polygon)

Инструмент Star (Сплош-

ная звезда), команда 

Create Object ⇒ Star

Счетчик Number of Points or Sides on Polygon, Star and 

Complex Star (Количество узлов и сторон многоугольни-

ка, звезды и составной звезды): минимальное значение – 

3, максимальное – 500

Инструмент Complex Star 

(Составная звезда),

 y Счетчик Number of Points or Sides on Polygon, Star and 

Complex Star (Количество узлов и сторон многоугольника,
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Создание объекта Параметры, настраиваемые на панели свойств

команда

Create Object ⇒  

Complex Star

звезды и составной звезды): минимальное значение – 5, 

максимальное – 500.

 y Счетчик Sharpness (Заостренность углов)

Спираль (расположен в группе Polygon)

Инструмент Spiral,  

клавиша A,

команда  

Create Object ⇒ Spiral

 y Счетчик Spiral Revolutions (Количество витков спира-

ли): допустимые значения – от 1 до 100. 

 y Symmetrical Spiral (Симметричная спираль) и Loga-

rithmic Spiral (Логарифмическая спираль) – определение 

типа спирали.

 y Spiral Expansion Factor (Коэффициент расширения 

спирали) – определение степени расширения спирали 

при создании логарифмической спирали. Значение в 

этом поле указывают в процентах

Сетка (расположен в группе Polygon)

Инструмент Graph Paper,

клавиша D, команда  

Create Object ⇒  

Graph Paper

Graph Paper Columns and Rows (Строки и столбцы диа-

граммной сетки) – задание количества столбцов по 

горизонтали и строк по вертикали в создаваемой сетке; 

максимальное значение – 50

Для создания часто применяемых фигур в CorelDRAW пред-
назначена панель инструментов Perfect Shape Flyout (Панель 
стандартных фигур). Для выбора инструмента группы можно 
воспользоваться кнопкой инструмента, командой Create Object 
Perfect Shape контекстного меню либо выбрать нужный на панели 
инструментов в группе Polygon.

В CorelDRAW все операции проводятся с выделенными объ-
ектами. После создания объекта он остается выделенным. На-
пример, вновь созданный прямоугольник (рис. 3.2) окружают во-
семь черных точек – маркеров выделения; центр прямоугольника 
отмечен крестиком – это маркер центра объекта (геометрическо-
го); в вершинах находятся узлы объекта.

Чтобы выделить отдельный объект, достаточно щелкнуть на 
нем инструментом Pick (Выбор), для выделения нескольких объ-
ектов необходимо последовательно выделять их при нажатой кла-
више Shift либо обвести рамкой, чтобы все выделяемые объекты 
целиком в нее попали. Если при выделении рамкой удерживать 
нажатой клавишу Alt, то в состав группы выделения будут вклю-
чены в том числе объекты, которые пересеклись с ее границами.

Окончание табл. 3.1
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Курсор  

для инструмента Rectangle

Узлы объекта

Маркеры рамки выделения

Маркер центра 

объекта

Рис. 3.2. Выделенный прямоугольник

К операциям, выполняемым над объектом, относят (рис. 3.3):
 y перемещение, копирование;
 y масштабирование (scale);
 y поворот (rotate);
 y наклон или скос (skew);
 y зеркальное отражение (mirror).

Перемещение Масштабирование Поворот Наклон
Зеркальное 

отражение

Рис. 3.3. Операции трансформации

Существует три способа создания копий объектов:
 y традиционное копирование через буфер обмена;
 y дублирование: команда Edit ⇒ Duplicate (Редактирование ⇒ 

Дублировать), Ctrl + D;
 y клонирование: команда Edit  ⇒  Clone (Редактирование  ⇒ 

Клонировать).
При первом использовании команды Duplicate необходимо за-

дать расстояние смещения копии объекта по горизонтали и вер-
тикали в диалоговом окне Duplicate Offset (Смещение дубликата). 

Изменить параметры смещения копии, установленные по 
умолчанию, можно также при отсутствии выделения на экра-
не в счетчиках Duplicate Distance (Дистанция при дублировании) 
на панели свойств или в диалоговом окне Options (Параметры) 
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на вкладке Document ⇒ General (Документ ⇒ Главная) в области 
Duplicate Offset (Смещение дубликата).

Для дублирования объекта без смещения относительно ис-
ходного достаточно нажать клавишу «+» (плюс). Создаваемая ко-
пия будет располагаться точно поверх копируемого объекта. 

В отличие от дублирования, при клонировании создается 
связь между оригинальным объектом-шаблоном (эталоном) и но-
вым объектом (клоном). Это означает, что все модификации эта-
лона будут применены и к клону. 

Перемещение объекта осуществляют следующими способами:
 y с помощью мыши или кнопок управления курсором на 

клавиатуре;
 y установкой на панели свойств точных координат располо-

жения объекта. 
Удалить выделенный объект можно нажатием клавиши Delete.
Поворот и наклон выполняют инструментом Pick в режи-

ме преобразования (рис. 3.4). Для этого следует щелкнуть на 
уже выделенном объекте инструментом Pick. Маркеры поворо-
та располагаются в углах вокруг прямо-
угольника и имеют вид изогнутой стрел-
ки. Для поворота необходимо подвести 
курсор к одному из маркеров и повернуть 
объект на произвольный угол, удерживая 
на выбранном маркере нажатой кнопку 
мыши. Поворот будет осуществляться от-
носительно точки, называемой центром 
вращения и по умолчанию совпадающей 
с геометрическим центром объекта. Если во время поворота 
удерживать клавишу Ctrl, то поворот будет осуществляться на 
угол, кратный 15°.

Маркеры скоса располагаются в серединах сторон вокруг 
прямоугольника и имеют вид двунаправленной стрелки. Для 
скоса объекта необходимо подвести курсор к одному из марке-
ров, при этом курсор принимает вид двух стрелок, направленных 
в разные стороны, и потянуть в одну из сторон. Скос объекта 
происходит относительно стороны, противоположной положе-
нию маркера.

Изменение размеров и зеркальное отражение осуществля-
ют инструментом Pick в режиме выделения и с помощью панели 

Рис. 3.4. Прямоугольник 

в режиме преобразования
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свойств. В первом случае для изменения размеров объекта необ-
ходимо перемещать маркеры выделения. Для пропорционального 
изменения размеров объекта нужно перемещать один из угловых 
маркеров выделения, для изменения только высоты или толь-
ко ширины – один из серединных маркеров (см. рис. 3.2). При 
нажатии на клавишу Alt можно одновременно изменять высоту 
и ширину объекта перемещением угловых маркеров выделения, 
на клавишу Ctrl – увеличивать размер в два раза (на 100 %) при 
каждом шаге перемещения мыши, на клавишу Shift – масштаби-
ровать объект симметрично от геометрического центра объекта. 

Для создания горизонтального или вертикального отраже-
ния выделенного объекта следует двигать боковой маркер вы-
деления до тех пор, пока курсор не переместится за противопо-
ложный край объекта. 

Щелчок правой кнопкой мыши при нажатой левой позволяет 
создать копию и сохранить первоначальный объект. 

Для получения зеркальной копии объекта необходимо пе-
реместить один из боковых маркеров, удерживая клавишу Ctrl, 
и в конце операции щелкнуть правой кнопкой мыши для полу-
чения копии. 

Зеркальное вертикальное или горизонтальное отражение 
объекта можно также получить, используя кнопки Mirror Horizon-
tally (Отразить по горизонтали) и Mirror Vertically (Отразить по 
вертикали) панели свойств (рис. 3.5). 

Координаты центра Масштабирование

Пропорциональное 

масштабирование

Ширина / 

высота

Угол поворота Отразить  

по вертикали

Отразить  

по горизонтали

Рис. 3.5. Панель свойств

В группу инструментов панели Pick (Выбор) входит также 
инструмент Free Transform (Произвольное преобразование), ко-
торый позволяет переместить, повернуть, отразить, перекосить 
выделенный объект или изменить его размеры. Параметры пре-
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образования задаются настройками на панели свойств, нажатие 
одной из четырех кнопок на которой определяет, какой вид пре-
образования можно производить с помощью мыши: Free Rotation 
(Произвольный поворот); Free Angle Reflection (Отражение отно-
сительно произвольной оси); Free Scale (Произвольное измене-
ние размеров); Free Skew (Произвольный наклон).

Точные трансформации можно осуществить в докере Trans-
for mations (Трансформации). Для его открытия используют ко-
манду Window  ⇒ Dockers  ⇒ Transformations (Окно  ⇒ Докеры  ⇒ 
Трансформации). Окно докера состоит из пяти вкладок, соот-
ветствующих операции трансформации (рис. 3.6): 

 y Position (Положение), клавиши Alt + F7;
 y Rotate (Поворот), Alt + F8;
 y Size (Размер), Alt + F10;
 y Scale and Mirror (Масштабирование и отражение), Alt + F9;
 y Skew (Наклон), Alt + F11.

Рис. 3.6. Докер Transformations

Процедура задания параметров преобразований следующая: 
выделить объект, перейти на нужную вкладку докера и ввести 
необходимые значения параметров, в завершение выбрать Apply 
(Применить) или Apply to Duplicate (Применить к копии). Можно 
указать количество копий для применения выбранной операции.

Состав управляющих элементов зависит от типа выбранного 
преобразования. Для всех вкладок в нижней части окна можно 
указать точку привязки, относительно которой будет осуществ-
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ляться преобразование (см. рис. 3.6). Положения точек привязки 
соответствуют девяти маркерам выделения. По умолчанию точка 
привязки располагается в геометрическом центре объекта.

Повтор последнего преобразования возможен с помощью ко-
манды Repeat … (Повтор…) меню Edit (Редактирование) или со-
четания клавиш Ctrl + R. 

Операции над несколькими объектами:
 y группирование – предоставляет возможность обработки 

нескольких объектов как единого целого без нарушения их вза-
имного расположения и свойств;

 y выравнивание – обеспечивает размещение всех выделен-
ных объектов таким образом, чтобы их определенные области 
располагались на одной прямой; 

 y распределение – обеспечивает размещение объектов, при 
котором соблюдается равенство расстояний между маркерами их 
рамок выделения. Как правило, используется совместно с их вы-
равниванием.

В таблице 3.2 приведены способы выполнения указанных 
операций. 

Таблица 3.2

Операции над несколькими объектами

Операция Способ выполнения

Группирование/ 

разгруппирование

Команда Object ⇒ Group (Сгруппировать)/UnGroup (Разгруппировать); 

комбинация клавиш Ctrl + G

Выравнивание Команда Object ⇒ Align and Distribute (Объект ⇒ Выровнять и рас-

пределить): Left – L; Right – R; Top – T; Bottom – B; Center Horizontally – E; 

Center Vertically – C; Centre to Page (По центру страницы), Centre to Page 

Horizontally (По центру страницы по горизонтали), Centre to Page Vertically 

(По центру страницы по вертикали)

Распределение Команда Object ⇒ Align and Distribute  (Объект ⇒ Выровнять и распреде-

лить) открывает диалоговое окно Align and Distribute

При выделении нескольких объектов эти команды доступны 
на панели свойств. 

Практические задания по пункту 3.3

Задание 1. Задание 1. Построение прямоугольников. Скругление углов.
Рекомендации по выполнениюРекомендации по выполнению
1. Постройте прямоугольник шириной 30 мм и высотой 

35 мм. 
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2. Расположите объект на странице, задав координаты: x = 
= 25 мм, y = 20 мм. 

3. Создайте три копии прямоугольника и расположите их 
следующим образом: x = 25 мм, y = 50 мм; x = 60 мм, y = 50 мм; 
x = 60 мм, y = 20 мм. 

4. Задайте всем углам остальных прямоугольников скругле-
ние, равное 20.

5. Снимите блокировку раздельного скругления углов, отжав 
кнопку Round Corners Together.

6. Задавая значения скругления для углов отдельных прямо-
угольников, приведите изображение к виду, показанному на ри-
сунке.

Задание 2. Задание 2. Построение многоугольников. 
Рекомендации по выполнениюРекомендации по выполнению
1. Постройте шестиугольник с размером стороны 30 мм и 

расположите его в координатах x = 100 мм, y = 100 мм. 
2. Создайте шесть копий данного объекта и задайте для них 

такие координаты: x
1
 = 115 мм, y

1
 = 122,5 мм; x

2
 = 130 мм, y

2
 = 

= 100 мм; x3 = 115 мм, y3 = 77,5 мм; x4 = 85 мм, y4 = 77,5 мм; x5 = 
= 70 мм, y5 = 100 мм; x6 = 85 мм, y6 = 122,5 мм.

Задание 3. Задание 3. Наклон и поворот объекта.
Рекомендации по выполнениюРекомендации по выполнению
1. Постройте прямоугольник размером 12½10 мм. 
2. Наклоните его вправо на 30°. Сместите 

центр вращения в правый верхний угол объекта. 
Создайте две копии полученных ромбов и повер-
ните их на 120 и 240° (см. рисунок).
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3. Установите для объектов черный цвет заливки. Для этого 
щелкните левой кнопкой мыши на маркере черного цвета в цве-
товой палитре. 

Задание 4. Задание 4. Построение кругов, секторов, эллипсов. Дублиро-
вание и отражение объектов. 

РекомендацииРекомендации по выполнению по выполнению
1. Постройте круг диаметром 40 мм. 
2. Преобразуйте круг в Pie (Сектор), установите 

Starting and Ending Angles (Начальный и конечный 
углы) равными 90 и 270° (против часовой стрелки). 

3. Внутри сектора постройте круг диаметром 
4 мм. Установите для объекта черный цвет заливки.

4. Создайте 2 дубликата круга и разместите, как показано на 
рисунке. Сгруппируйте сектор и 3 круга.

5. Выделите группу и создайте ее дубликат, отразив его по 
горизонтали. Расположите сектора на расстоянии 1 мм друг от 
друга и выровняйте по центру. 

6. Постройте эллипс черного цвета. Расположите его вверху 
на стыке двух секторов.

7. Постройте круг диаметром 5 мм и преобразуйте его в дугу, 
начальный и конечный углы – 0° и 180°, против часовой стрелки. 
Создайте 3 дубликата дуги.

8. Создайте еще 4 дубликата дуги, отразив их по горизонта-
ли. Расположите дуги согласно рисунку. 

Задание 5. Задание 5. Построение спиралей. 
Рекомендации по выполнениюРекомендации по выполнению
1. Постройте симметричную спираль с двумя витками и ко-

эффициентом расширения 1. Создайте дубликат и отразите его 
по горизонтали.

2. Объедините спирали в группу, создайте дубликат группы, 
отразив по горизонтали. В центре расположите круг (см. рисунок).

3. Объедините в группу все объекты и создайте дубликат, 
сместив его таким образом, чтобы начало и окончание спиралей 
соединились. 
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4. Постройте между группами круг такого же диаметра, как 
в задании 4.

Контрольные вопросы
1. Какие геометрические объекты относят к графическим примитивам и как их 

создают? 

2. Поясните, как с помощью панели свойств закруглить углы прямоугольника, 

преобразовать эллипс в дугу или сектор.

3. Назовите режимы функционирования инструмента Pick (Выбор)?

4. Какие преобразования можно осуществить над объектом?

5. Какие преобразования можно осуществить над несколькими объектами? 

6. Какие возможности для трансформации объекта предоставляет докер?

7. Что означает выравнивание и распределение объектов?

8. Перечислите способы зеркального отражения объекта.

3.4. Операции со слоями

CorelDRAW позволяет организовать в пределах страницы до-
кумента несколько слоев объектов. Слои можно уподобить стоп-
ке прозрачных листов бумаги с «наклеенными» на них объекта-
ми. У каждого из слоев имеются свои атрибуты.

В документе CorelDRAW всегда есть главная страница – 
Master Page, которая объединяет в себе главные слои: Gr i d (Ко-
ординатная сетка), Guides (Направляющие) и Desktop (Рабочий 
стол). Слои Guides и Desktop по умолчанию не выводятся на пе-
чать. Слой Gr i d недоступен для вывода на печать и для редак-
тирования. В слой Guides автоматически помещаются все вновь 
создаваемые направляющие линии, которые отображаются на 
всех страницах документа и могут быть использованы в качестве 
направляющих.

Пользователь может создавать новые главные слои. Главный 
слой отличается от прочих слоев тем, что расположенные на нем 
объекты появляются на всех страницах документа CorelDRAW. 

По умолчанию в каждом новом документе создается один 
слой с именем Layer 1 для хранения объектов рисунка. В даль-
нейшем можно создавать новые слои, переименовывать их, раз-
мещать объекты, изменять порядок следования слоев. Создава-
емые слои будут размещаться на всех страницах документа, но 
содержание их на каждой странице будет индивидуальным.

Для создания новых слоев и управление ими в CorelDRAW 
используется докер диспетчера объектов Object Manager (рис. 3.7). 
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Редактировать 

послойно

Показывать 

свойства объекта

Вид диспетчера слоев

Слой

Объект

Страница

Рис. 3.7. Докер Object Manager

Слой имеет атрибуты:
 y имя слоя;
 y цвет слоя;
 y Visible (видимость, );
 y Lock or Unlock (редактируемость, ) – дает возможность 

делать слой доступным или недоступным для редактирования, 
при этом он остается видимым;

 y Printable (печатаемость, ) – при выводе документа на 
принтер объекты, находящиеся на этом слое, будут напечатаны 
или не напечатаны

Объект имеет атрибуты:
 y тип объекта;
 y имя объекта;
 y поясняющая информа-

ция об атрибутах (при вклю-
ченной кнопке Show Object 
Properties (Показывать свой-
ства объекта)).

Все вышеперечисленные свойства слоя можно включать 
и отключать с помощью контекстного меню слоя, раскрываемо-
го щелчком правой кнопки мыши на имени слоя. Контекстное 
меню также включает команды удаления (Delete), переименова-
ния (Rename) слоя и команду Properties (Свойства), которая рас-

Имя объекта

Тип  

объекта Свойства объекта
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крывает диалоговое окно Layer Properties (Свойства слоя) для 
точной настройки свойств слоя.

Кнопка Edit Across Layers (Редактировать послойно) включает 
или выключает режим, позволяющий выделять объекты любого 
слоя, доступного для редактирования.

Внизу докера расположены кнопки создания и удаления сло-
ев: New Layer (Новый слой), New Master Layer (Новый главный 
слой), Delete (Удалить). Создаваемый новый слой будет распола-
гаться поверх активного.

Для управления слоями можно также использовать контекст-
ное меню диспетчера объектов, которое раскрывается щелчком 
на кнопке Object Manager Options, расположенной в правом верх-
нем углу диспетчера. 

Новый объект создают на активном слое. Для изменения по-
рядка следования объектов, лежащих на одном слое, используют 
команды меню Arrange (Монтаж):

 y То Front of Layer (На передний план) – перемещает выде-
ленный объект наверх объектов слоя;

 y To Back of Layer (На задний план) – перемещает выделен-
ный объект в самый низ объектов слоя;

 y Forward One (Вперед) – перемещает выделенный объект на 
одну позицию вверх в стопке объектов слоя;

 y Back One (Назад) – перемещает выделенный объект на одну 
позицию вниз в стопке объектов слоя;

 y In Front Of (Перед объектом) – позволяет поместить выде-
ленный объект непосредственно поверх какого-либо другого объ-
екта в стопке объектов слоя;

 y Behind (После объекта) – позволяет поместить выделен-
ный объект непосредственно под каким-либо другим объектом в 
стопке объектов слоя;

 y Reverse Order (Обратный порядок) – используется для из-
менения порядка следования выделенных объектов на обратный. 

Для изменения порядка следования объектов можно также 
использовать клавиши: Shift + Page Up – на передний план, Shift + 
Page Down – на задний план, Ctrl + Page Up – на один уровень 
вверх, Ctrl + Page Down – на один уровень вниз.

Для блокировки (разблокировки) необходимо выделить объ-
ект или несколько объектов и применить команду Object ⇒ Lock ⇒  
Lock (Unlock) Object (Объект ⇒ Блокировать  ⇒ Блокировать (Раз-
блокировать) объект). При выделении блокированного объекта 
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вокруг него появляются маркеры выделения, в статусной стро-
ке – сообщение Locked Rectangle on Layer.

Практическое задание по пункту 3.4

Работа со слоями. 
Рекомендации по выполнениюРекомендации по выполнению
1. Cоздайте новый документ формата A4.
2. С помощью команд Grid и Snap to Grid меню View (Вид) 

включите координатную сетку и привязку к узлам сетки.
3. Установите шаг сетки 5 мм.
4. Вытащите и установите четыре вертикальные направля-

ющие: первая – с отступом 20 мм вправо от левой границы стра-
ницы, вторая – в горизонтальной координате 125, третья – на 
10 мм правее, четвертая – с отступом 10 мм влево от правой 
границы страницы.

5. Вытащите и установите шесть горизонтальных направля-
ющих: первая – на вертикальной координате 280, вторая – на 
вертикальной координате 200, третья – на 10 мм ниже, четвер-
тая – на вертикальной координате 100, пятая – на 10 мм ниже, 
шестая – на вертикальной координате 20. 

6. Откройте окно диспетчера, используя команду Tools  ⇒ 
Object Manager.

7. Переименуйте слой Layer 1, дав ему имя Текст. 
8. Создайте еще один слой с именем Иллюстрации. 
9. Отключите видимость сетки и привязку к узлам сетки. 

Направляющие должны быть видимыми.
10. Включите режим привязки к направляющим (View ⇒ Snap 

to Guidelines).
11. Активизируйте слой Текст и, пользуясь режимом привяз-

ки к направляющим, нарисуйте в левой части страницы серый 
прямоугольник.

12. Активизируйте слой Иллюстрации и постройте три пря-
моугольника.

Контрольные вопросы
1. Изложите понятие слоя в CorelDRAW. 

2. Что такое главная страница и главные слои? 

3. Перечислите атрибуты слоя. Назовите способы изменения атрибутов слоя.

4. Как защитить слой от изменений?

5. Перечислите атрибуты объекта. Как их просмотреть?
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6. Как создать/удалить слой? 
7. Каким образом изменить порядок следования объектов на одном слое? 

3.5. Работа с кривыми

Все создаваемые в CorelDRAW линии являются кривыми  
Безье. В основе принятой в программе модели линий лежат два 
понятия: узел и сегмент. 

Узел – точка на плоскости изображения, фиксирующая по-
ложение одного из концов сегмента. 

Сегмент – часть линии, соединяющая два смежных узла. По ха-
рактеру предшествующих сегментов выделяют три типа узлов: на-
чальный узел незамкнутой кривой, прямолинейный (Line) и криволиней-
ный (Curve). Начальный узел не имеет предшествующего сегмента.

Узлы, смежные хотя бы с одним криволинейным сегментом, 
классифицируют на острые, или точки излома (Cusp), и гладкие 
(Smooth) узлы. 

Узел называют точкой излома в том случае, когда касательные, 
проведенные в узле к двум прилегающим к нему сегментам, не 
лежат на одной прямой, образуя угол, отличный от развернутого. 

Узел называют гладким, если касательные, проведенные к двум 
прилегающим к нему сегментам, лежат на одной прямой. Частным 
случаем сглаженного узла является симметричный узел (Symmetrical), 
направляющие точки которого равноудалены от него.

Тип узла (рис. 3.8) отображается в строке состояния и опре-
деляет возможное взаимное расположение его направляющих  
точек.

Точки излома (Cusp) Гладкие узлы (Smooth)

Симметричный узел (Symmetrical)

Рис. 3.8. Типы узлов
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Для создания кривых используют следующие инструменты 
панели Curve (Кривая):

 y Freehand (Произвольная форма);
 y 2-Point Line (Прямая по двум точкам).
 y Bezier (Кривая Безье);
 y Pen (Перо);
 y B-Spline (Сплайн);
 y Polyline (Полилиния);
 y 3-Point Curve (Кривая по трем точкам).

По умолчанию на панели графики расположена кнопка ин-
струмента Freehand (Произвольная форма), при нажатии на ко-
торую можно получить доступ к остальным инструментам по-
строения кривых.

Инструмент Freehand (Произвольная форма) преобразует тра-
екторию перемещения мыши в кривую. При этом узлы и сегмен ты 
линии формируются автоматически в соответствии со значением 
параметра Freehand Smoothing (Сглаживание кривой) инструмента. 
Чем меньше значение параметра, тем меньше будет отклонение 
формируемой линии от траектории перемещения мыши и тем ме-
нее гладкой получится кривая, поскольку на ней образуется боль-
ше узловых точек. Максимальное значение этого параметра – 100 
(установлено по умолчанию). Значение параметра сглаживания 
устанавливают до начала рисования на панели свойств при ак-
тивном инструменте Freehand. 

Для рисования прямого отрезка с помощью мыши отмечают 
начальный и конечный узлы. Для создания прямой линии под 
углом, кратным 15°, необходимо при рисовании удерживать на-
жатой клавишу Ctrl. Информация об угле наклона линии отобра-
жается в строке состояния. Для замыкания контура необходимо 
подвести курсор к первому узлу линии так, чтобы появился знак 
автозамыкания.

Инструмент Bezier (Кривая Безье) также позволяет строить 
кривые и прямые линии. Рисование прямых выполняют анало-
гично работе с инструментом Freehand (Произвольная форма). 

Построение кривой инструментом Bezier заключатся в соз-
дании узлов перемещением направляющих точек, положение 
которых определяет кривизну предшествующего сегмента. По-
строение начинают с позиционирования указателя инструмен-
та в точку расположения будущего узла. Затем нажимают левую 
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кнопку мыши и, удерживая ее, тянут курсор. В момент отпуска-
ния кнопки мыши фиксируются тип узла и положение направ-
ляющих точек, после чего начинается определение следующего 
узла. Для завершения следует нажать пробел или замкнуть кон-
тур так, как и инструментом Freehand. По умолчанию создаются 
гладкие узлы, но если в момент отпускания кнопки мыши на-
жать клавишу С, будет создана точка излома. 

С помощью инструмента Artistic Media (Художественное сред-
ство) строят составные объекты класса Artistic Media Group (Худо-
жественные средства). Каждый из этих объектов состоит из двух 
частей: линии, играющей роль управляющего объекта и опреде-
ляющей основные параметры формы составного объекта в целом, 
и подчиненного объекта, определяющего детали этой формы. 
В роли подчиненного объекта может выступать замкнутая кри-
вая или произвольный объект CorelDRAW, причем и управляю-
щая линия, и подчиненный объект могут как строиться заранее, 
до построения суперлинии, так и создаваться в ходе него.

Панель свойств инструмента (рис. 3.9) позволяет задать ре-
жимы его работы и некоторые настройки. Она содержит следую-
щие элементы управления:

 y кнопки Preset (Заготовка), Brush (Кисть), Sprayer (Распыли-
тель), Calligraphic (Каллиграфия) и Pressure (С нажимом), с по-
мощью которых выполняют переключение режимов работы ин-
струмента;

 y поле и слайдер Freehand Smoothing (Сглаживание кривой) 
позволяют регулировать частоту узлов и, следовательно, степень 
гладкости управляющей линии;

 y счетчик Artistic Media Tool Width (Ширина инструмента ху-
дожественного средства) устанавливает значение максимальной 
ширины подчиненного объекта при построении суперлинии;

 y раскрывающийся список Preset (Схема заготовки) позволя-
ет выбрать схему подчиненного объекта при работе в режиме за-
готовки.

Для построения и изменения суперлиний можно пользо-
ваться одноименным пристыковываемым окном: Windows  ⇒ 
Dockers ⇒ Artistic Media (Окно ⇒ Докеры ⇒ Художественное сред-
ство). Использование докера позволяет существенно упростить 
работу с тремя режимами построения суперлиний: заготовки, 
кисти и распылителя.
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Заготовка Список заготовок Толщина кисти

Сглаживание кривой Масштабировать кисть 

вместе с объектом

Рис. 3.9. Панель свойств инструмента Artistic Media

В CorelDRAW любому имеющемуся в области рисования 
контуру можно присваивать свойства заготовок, кистей или рас-
пыляемых объектов, создаваемых инструментом Artistic Media 
(Художественное средство).

Чтобы преобразовать кривую в управляющую кривую, доста-
точно выбрать в одном из двух списков пристыковываемого окна 
нужное изображение заготовки, кисти или шаблона распылителя 
и переместить его с помощью мыши на эту кривую.

Для того чтобы сохранить изображение как заготовку или 
шаблон распылителя, достаточно выделить его и переместить мы-
шью в нижний список докера либо щелкнуть мышью на кноп-
ке Save Artistic Media Stroke (Сохранить шаблон художественного 
средства) панели свойств. В открывшемся диалоговом окне Save 
as (Сохранить как) необходимо ввести имя нового файла, которо-
му будет присвоено расширение .cmx.

Инструмент Реn (Перо) работает аналогично инструменту 
Bezier (Кривая Безье) по принципу «узел за узлом». Отличие со-
стоит в том, что в процессе перемещения курсора в точку рас-
положения очередного узла кривой на экране отображается 
внешний вид следующего, еще не построенного сегмента кон-
тура. Кроме этого, имеется возможность редактировать контур 
до завершения его создания. При активизации инструмента Pen 
(Перо) курсор приобретает вид пера. На панели свойств можно 
установить параметры:

 y Preview Mode (Режим просмотра) – кнопка  задает режим 
отображения будущего сегмента контура линии;

 y AutoAddDelete (Автодобавление) – кнопка  включает ре-
жим добавления и удаления узлов к контуру линии. Если во 
время рисования контура при включенном режиме AutoAddDelete 
подвести курсор к уже нарисованному сегменту данного контура, 
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щелчок на линии добавляет новый узел, если подвести курсор к 
узлу данного контура, щелчок в узле удалит этот узел.

Для завершения построения незамкнутого контура инст-
рументом Pen необходимо дважды щелкнуть мышью в конечной 
точке или нажать клавишу Пробел. Для замыкания контура кур-
сор следует поместить на начальный узел контура так, чтобы по-
явился знак замыкания, и щелкнуть мышью.

Инструмент Polyline (Полилиния) позволяет создавать про-
извольные линии, в состав которых входят как прямолинейные, 
так и криволинейные участки. Прямолинейные участки контура 
строят с помощью щелчков мыши, для рисования криволиней-
ных участков нужно перемещать курсор, удерживая нажатой ле-
вую кнопку мыши (как при рисовании инструментом Freehand). 
Завершение построения выполняется так же, как и для других 
инструментов. 

Инструмент 3-Point Curve (Кривая по трем точкам) создает 
криволинейные контуры с двумя узловыми точками. 

Соединительные линии представляют собой особый класс объ-
ектов, очень удобных для построения всевозможных схематиче-
ских изображений, в особенности блок-схем. Они находятся на 
отдельной всплывающей палитре. Оба конца соединительной ли-
нии должны присоединяться к объекту в точках присоединения, 
при изменении положения этих объектов связь не нарушается. 
Варианты соединения:

 y отрезок прямой (прямая со-
единительная линия);

 y ломаная линия, состоящая из 
строго горизонтальных и строго вер-
тикальных прямолинейных сегмен-
тов (ломаная соединительная линия);

 y соединительная линия под скругленным углом.
Для соединения объектов необходимо выбрать тип соеди-

нительной линии, подвести курсор к точке присоединения на 
объекте, пока она не будет выделена цветом, после чего нажать 
левую кнопку мыши и, не отпуская ее, зафиксировать точку при-
соединения линии ко второму объекту, а затем отпустить кнопку 
мыши. Тип можно изменить после создания, выделив инстру-
ментом Pick (Выбор) и щелкнув на соответствующей кнопке па-
нели свойств. 



122

Раздел 3. Основы векторной графики 

Специальные инструменты Pa rallel Dimension (Параллельные 
размерные линии), Horizontal or Vertical Dimension (Горизонталь-
ные или вертикальные размерные линии), Angular Dimension 

(Угловые размерные линии), Segment 
Dimension (Размерные линии сег-
мента), 3-Point Callout (3-точечная 
выноска) используют для оформле-
ния планов и чертежей. В процессе 
установки размеров автомати чески 
включается режим Snap to Objects 
(Привязка к объектам), по этому при 

приближении курсора к определенным точкам объекта появля-
ется соответствующее сообщение (например, Node – точка-узел, 
Midpoint – середина линии и т. д.). 

Процесс построения размера лучше начинать с установки его 
параметров на панели свойств (рис. 3.10). 
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Префикс 

размера
Двойной 
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Рис. 3.10. Панель свойств  

инструмента Dimension (Размерные линии)

Любой объект, за исключением растровых рисунков, групп 
и некоторых специальных типов объектов, можно преобразовать 
в кривые. Для этого следует выполнить команду меню Objects ⇒ 
Convert to Curves (Объект  ⇒  Преобразовать в кривые), одно-
именную команду контекстного меню или нажать одноименную 
кнопку на панели свойств объектов.

Любой контур в любой момент можно отредактировать. Для 
этого предназначен инструмент Shape (Форма), который позво-
ляет:

 y добавлять узлы; 
 y удалять узлы; 
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 y изменять тип узла;
 y масштабировать траектории; 
 y вращать сегменты; 
 y разрывать кривую; 
 y объединять два незамкнутых сегмента в один.

Все преобразования над выделенными узлами доступны на 
панели свойств (рис. 3.11). Для того чтобы выделить узел, до-
статочно щелкнуть на нем указателем инструмента Shape (Фор-
ма). В строке состояния слева появится сообщение о выделенном 
узле, например: Selected Node: Curve Smooth (17,56; 19,45), в скоб-
ках указаны координаты узла. 

Выделить несколько узлов можно рамкой выделения или 
удерживая клавишу Shift при щелчке мышью на узле, выделить 
все узлы контура можно с помощью кнопки Select All Nodes (Вы-
делить все узлы) панели свойств. 

Выделенные узлы, соответствующие прямолинейным сег-
ментам, отображаются квадратами без заливки, криволиней-
ным – с заливкой черным цветом.

Чтобы переместить выделение на начальный узел кривой, используют 

клавишу Ноmе, на конечный узел – клавишу End. Нажатие клавиши Tab 

перемещает выделение к следующему узлу кривой, Shift + Tab – к пре-

дыдущему узлу. Для выделения всех узлов кривой достаточно выделить 

любой из ее узлов и нажать клавиши Ctrl + Shift + Home.
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Рис. 3.11. Панель свойств инструмента Shape (Форма)

В группу инструментов панели Shape входят также инст-
рументы Smudge Brush (Размывающая кисть), Roughen Brush (Гру-
бая кисть) и Free Transform (Произвольное преобразование).
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Инструмент Smudge Brush (Размывающая кисть) позволяет 
в интерактивном режиме искажать форму замкнутого контура. 

Степень и форма искажения определяются 
значениями управляющих параметров ин-
струмента, которые устанавливаются на па-
нели свойств инструмента.

Инструмент Roughen Brush (Грубая кисть) 
позволяет создавать зигзаг на контуре кри-

вой. Для этого необходимо курсором провести по контуру ли-
нии. Частоту, направление и амплитуду зубцов задают с помо-
щью управляющих элементом панели свойств.

Инструмент Free Transform (Произвольное преобразование) 
позволяет переместить, повернуть, отразить, перекосить выде-
ленный объект или изменить его размеры. Параметры преобразо-
вания задаются настройками на панели свойств. Нажатие одной 
из четырех кнопок на панели свойств определяет, какой вид пре-
образования можно производить с помощью мыши: Free Rotation 
(Произвольный поворот); Free Angle Reflection (Отражение отно-
сительно произвольной оси); Free Scale (Произвольное изменение 
размеров); Free Skew (Произвольный наклон).

Группа инструментов Crop (Обрезка) содержит четыре инстру-
мента, которые используют для обрезки и удаления фрагмен тов 
объектов. 

Инструмент Crop (Обрезка) позволя-
ет удалять области векторных и точечных 
объектов, которые расположены вне пря-
моугольной области (область обрезки). По-
ложение рамки обрезки и ее размер мож-
но изменять как вручную (перетаскивая 

с помощью мыши), так и на панели свойств инструмента. С ее 
помощью можно также задать угол поворота рамки обрезки от-
носительно первоначального положения и удалить рамку без вы-
полнения обрезки. Если в область обрезки попадет текст или 
фигура, то они автоматически будут переведены в кривые.

Инструментом Knife (Нож) можно разъединить открытый 
контур на отдельные подконтуры. Кнопки 2-Point Line Mode, 
Freehand и Bezier определяют способ разрезания объекта. В спи-
ске Cut Span (Интервал обрезки) на панели свойств инструмента 
задаются параметры разрезания: None (Нет), Gap (Зазор), Overgap 
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(Наложение). При нажатой кнопке Auto Close on Cut (Автомати-
чески замыкать контур при разделении) для замкнутого объекта 
будут созданы два отдельных объекта. Если кнопка не нажата, 
создается два отдельных незамкнутых контура.

Инструмент Eraser (Ластик) позволяет не только разделить 
объект или открытый контур на независимые элементы произ-
вольной формы, но и «стереть» любую часть объекта или конту-
ра. Основной параметр инструмента – Eraser Thickness (Толщина 
ластика) определяет ширину разреза и принимает значения от 
0,025 до 2540 мм. Кнопка Auto-reduce Nodes (Сокращение чис-
ла узлов) позволяет удалить лишние фрагменты кривых. С по-
мощью кнопок Circle/Square (Круг/Квадрат) переключают форму 
рабочей области инструмента.

Инструмент Virtual Segment Delete (Удаление сегмента) позво-
ляет удалить замкнутый путь из скомпонованных или сгруппи-
рованных объектов. 

Функции формирования объектов позволяют преобразовы-
вать форму объектов, создавать сложные объекты из простых. 
К ним относят: 

 y Combine (Комбинирование) – за-
крашивание участков, на которых ко-
личество пересекающихся объектов не-
четное; преобразование в прозрачные  
участков, на которых ко личество пере-
секающихся объектов четное;

 y Weld (Объединение) – удаление 
пересекающихся частей объединяемых 
объектов и составление новой границы 
по линии общего абриса;

 y Trim (Исключение) – удаление у 
целевого объекта части, перекрываемой 
выделен ным(ыми) объектом(ами);

 y Intersect (Пересечение) – создание 
нового объекта из области пересечения 
двух или более объектов, участвующих 
в операции;
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 y Create Boundary (Создание грани-
цы) – создание нового объекта без за-
ливки и с абрисом, установленным по 
умолчанию, по границе всех объектов, 
участвующих в операции;

 y Simplify (Упрощение) – для каж-
дого выделенного объекта, начиная с 
самого нижнего, исключение всех вы-
деленных объектов, расположенных вы - 
ше него;

 y Front Minus Back (Передние минус 
задние) – исключение, при котором в 
качестве целевого объекта выступает 
верхний из выделенных, все остальные 
объекты из него исключаются и удаля-
ются;

 y Back Minus Front (Задние минус 
передние) – исключение, при котором 
в качестве целевого объекта выступает 
нижний из выделенных, а все осталь-
ные объекты из него исключаются и 
удаляются.

Функции формирования нельзя применять к простому тек-
сту, размерным линиям и шаблонам клонов. Объект, получен-
ный в результате выполнения этих операций, является объектом-
кривой.

Выполнить операции преобразования можно: 
 y с помощью команд меню Object ⇒ Shaping ⇒  ... (Объект ⇒ 

Формирование  ⇒ ...), за исключением операции комбинирования; 
 y в докере Shaping (Формирование);
 y с помощью кнопок на панели свойств при выделении не-

скольких объектов.
Для комбинирования используют команду Object ⇒ Combine 

(Объект ⇒ Комбинирование), при этом все выделенные объекты 
преобразуются в совокупность кривых. При разъединении (ко-
манда Break Apart (Разъединить) или Break Object Apart (Разъеди-
нить объект)) все объекты сохраняют заливку и атрибуты линии 
контура составного объекта.
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При выполнении операций формообразования новый объ-
ект, как правило, наследует свойства (цвет и т. п.) целевого объ-
екта. Исходные объекты в случае использования панели свойств 
сохраняются, при использовании докера можно указать, какие 
объекты сохранить: источник, целевой или оба (табл. 3.3).

Таблица 3.3

Операции формообразования 

Инструмент Порядок выполнения

Докер Shaping Открыть вкладку требуемой операции, выделить объект-источник, 

нажать кнопку соответствующей команды и щелкнуть на целевом 

объекте

Панель свойств Выделить совокупность объединяемых объектов с помощью рамки 

выделения – целевой объект расположен внизу;

выделить совокупность объединяемых объектов с помощью клавиши 

Shift – целевой объект выделен последним

Контур имеет абрис (Outline), или обводку, который обладает 
следующими свойствами: цвет, начертание и толщина, для не-
замкнутых линий – форма начала и оконча-
ния. Присвоить контуру параметры можно 
с помощью панели Property Bar (Свойства), 
панели инструментов Outline Flout (Обводка), 
диалогового окна Outline Pen (Параметры об-
водки) или пристыковывающегося диалого-
вого окна Object Properties (Свойства объек-
та). Наиболее полный набор параметров об-
водки содержит диалоговое окно Outline Pen 
(Параметры обводки), которое открывается 
с помощью одноименной кнопки панели ин-
струментов Outline Flout.

В диалоговом окне устанавливают следу-
ющие свойства:

 y толщину абриса. Используется счетчик Width (Ширина);
 y цвет контура в палитре Color (Цвет);
 y тип линии в раскрывающемся списке Style (Стиль); 
 y форму контура на угловых и концевых точках переключате-

лями Corners (Углы) и Line Caps (Концы линий). 
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Практические задания по пункту 3.5

Задание 1. Задание 1. Преобразование формы объекта. 
Рекомендации по выполнениюРекомендации по выполнению

1. Выберите инструмент Ellipse (Эллипс) и, 
удерживая нажатой клавишу Ctrl, нарисуйте 
круг.

2. Преобразуйте круг в кривые (команда 
Convert Tо Curves контекстного меню). При этом 
круг превращается в контур, содержащий четы-
ре узла: по центру сверху, снизу, справа и слева.

3. Выделите верхний и нижний узлы при помощи инст-
румента Shape (Форма) и измените их тип на Cusp (Острый).

4. Выделите верхний и нижний узлы, нажмите на нижний 
узел и потяните его вниз. 

5. Выделите верхний узел и переместите обе управляющие 
точки вниз таким образом, чтобы их касательные были симме-
тричны относительно узла и образовали букву V.

6. Аналогичную процедуру выполните для нижнего узла, 
чтобы получить фигуру, напоминающую сердце.

Задание 2. Задание 2. Построение кривых. 
Рекомендации по выполнениюРекомендации по выполнению
1. В диалоговом окне настройки параметров сетки (View  ⇒ 

Grid and Ruler Setup) включите отображение сетки и активизи-
руйте привязку к линиям сетки. 

2. Установите интервалы (переключатель 
Spacing) по горизонтали и по вертикали рав-
ными 2 мм. 

3. Выберите инструмент Bezier (Кривая  
Безье). 

4. Постройте фигуру, изображенную на ри-
сунке.

Задание 3. Задание 3. Построение объектов с помощью функций формо-
образования. 

Рекомендации по выполнениюРекомендации по выполнению
1. Постройте три треугольника разных раз-

меров. Выровняйте треугольники по вертикали 
по центру. 

2. Примените операцию объединения. 
3. Постройте треугольник.
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4. Создайте дубликат, отразите по горизон-
тали и по вертикали.

5. Постройте три круга разных размеров.
6. Расположите круги на треугольниках так, 

как на рисунке.
7. Примените операцию исключения (целе-

вой объект – треугольник).
8. Постройте круг диаметром 20 мм.
9. Постройте звезду размером 25×25 мм.
10. Совместите центры звезды и круга.
11. Примените операцию пересечения (це-

левой объект – круг). 
12. Постройте эллипс размером 70×40 мм.
13. Создайте копию эллипса и сдвиньте ее 

вправо.
14. Примените операцию Back Minus Front 

(Задние минус передние).
15. Поверните полученную фигуру на 30° против часовой 

стрелки.
16. Создайте копию фигуры и задайте для нее поворот на 195°.
Задание 4. Задание 4. Комбинирование объектов. 
Рекомендации по выполнениюРекомендации по выполнению
1. Постройте круг диаметром 30 мм и расположите его в ко-

ординатах x = 125 мм и y = 125 мм. 
2. Постройте прямоугольник размером 

30×5 мм и расположите его в следующих коор-
динатах: x = 125 мм и y = 137,5 мм. 

3. Создайте еще четыре копии прямо-
угольника. Задайте для данных копий следую-
щие координаты: x

1
 = 125 мм и y

1
 = 131,25 мм; 

x
2
 = 125 мм и y

2
 = 125 мм; x3 = 125 мм и y3 = 

= 118,75 мм; x4 = 125 мм и y4 = 112,5 мм.
4. Выделите объекты и выполните их ком-

бинирование. Установите для итоговой фигуры 
черный цвет заливки.

Задание 5. Задание 5. Преобразование формы объектов. 
Рекомендации по выполнениюРекомендации по выполнению
1. Создайте прямоугольник размером 30×40 мм. 
2. Выберите инструмент Eraser (Ластик).
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3. Установите толщину ластика 2 мм. 
4. Удалите фрагмент прямоугольника, чтобы 

получилось изображение, представленное на ри-
сунке. 

5. Постройте треугольник. Установите для не-
го черный цвет заливки. 

6. Создайте копию треугольника, сместите 
вправо на 15 мм и установите для нее белый цвет 
заливки.

7. Выберите инструмент Roughen Brush 
и установите на панели свойств следующие 
параметры: размер кисти – 30 мм; частота 
пиков – 10; изменение размера кисти – 0; 
наклон – 45°; направление – 90°.

8. Исказите один из треугольников. 
9. Создайте прямоугольник. 
10. Примените инструмент Smudge Brush 

со значениями параметра Add Dryout to the 
Effect (Добавить изменение размера пятна) – 
0 (слева), 8 (в центре) и –10 (справа). 

Задание 6. Задание 6. Создание художественных эффектов инструмен-
том Artistic Media (Художественное средство) в разных режимах. 

Рекомендации по выполнениюРекомендации по выполнению

1. Постройте опорную кривую.
2. Установите на панели свойств Artistic 

Media параметры: режим Preset (Заготовка), 
Freehand Smoothing (Сглаживание кривой) – 88, 
Artistic Media Tool Width (Ширина инструмента 
художественного средства) = 1,762 мм.

3. Примените к опорной кривой ин-
струмент Artistic Media.

Контрольные вопросы по теме 3.5

1. Что такое узел объекта-кривой? Перечислите типы узлов кривой. Чем они раз-

личаются?

2. Что такое сегменты? Опишите, какие бывают сегменты и чем они различа-

ются.

3. Что такое кривизна кривой? Как ее изменить? 

4. Перечислите инструменты панели Curve (Кривая) и изложите их назначение.
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5. В каких режимах работает инструмент Artistic Media (Художественное сред-

ство)? Опишите его назначение и возможности. 

6. Как создать произвольную кривую с помощью инструмента Freehand (Произ-

вольная форма)? 

7. Как построить ломаную линию, состоящую из прямолинейных отрезков? 

8. Чем инструмент Pen (Перо) отличается от инструмента Bezier (Кривая Безье)? 

9. Как создать произвольную кривую с помощью инструмента Bezier (Кривая 

Безье)?

10. Как отредактировать ранее созданную кривую? 

11. Как линейный сегмент преобразовать в криволинейный?

12. Как изменить тип узла кривой? Как найти начальный узел кривой? Как найти 

последний узел кривой? 

13. Назовите инструменты панелей Crop (Обрезка) и Shape (Форма). Объясните 

принцип их действия. 

14. Перечислите операции формирования объекта из нескольких объектов. Ка-

кими способами это можно выполнить?

15. Какие атрибуты имеет объект, сформированный с помощью операций Weld 

(Объединение), Trim (Исключение), Intersect (Пересечение)?

16. Какие настройки устанавливают в докере Shaping (Формирование)? Изложи-

те понятие исходных и целевого объектов. 

17. Назовите назначение команды Combine (Комбинирование). Что является ре-

зультатом ее выполнения?

18. Какие свойства имеет абрис? Поясните, каким образом его устанавливают.

3.6. Работа с заливками в CorelDRAW

Замкнутый контур может иметь заливку (быть закрашен) 
либо не иметь заливки (быть прозрачным). Открытый контур не 
имеет заливки, хотя формально может быть закрашен.

Обводке контура по умолчанию можно присвоить только од-
нотонный цвет. Чтобы обводке можно было присвоить любую из 
имеющихся в программе заливок, ее необходимо преобразовать 
в объект командой Object ⇒ Convert Outline to Object (Объект ⇒ 
Преобразовать обводку в объект). 

С помощью палитры Color Palette можно задать цвета абриса 
и заливки:

 y 1-й способ: выделить объект или совокупность объектов, 
затем щелкнуть на образце цвета левой кнопкой мыши для за-
крашивания объекта внутри и правой кнопкой мыши для закра-
шивания обводки объекта. Для присваивания им прозрачности 
использовать перечеркнутый цветовой образец в верхней части 
палитры;
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 y 2-й способ: захватить требуемый цвет на экранной пали-
тре и переместить его внутрь объекта или «положить» на кон-
тур объекта. При этом к курсору добавляется знак заливки или 
обводки.

С помощью экранной цветовой палитры можно назначить 
оттенок выбранного цвета. Для этого необходимо задержать кур-
сор на выбранном цветовом образце на непродолжительное время 
и выбрать оттенок цвета из расширившейся палитры. 

Кроме заливки сплошным цветом, объекты могут иметь сле-
дующие заливки:

 y Fountain Fill (Градиентная заливка): Linear (Линейная), Ra-
dial (Радиальная), Conical (Коническая), Square (Квадратная); 

 y Vector Pattern Fill (Заливка векторным узором);
 y Bitmap Pattern Fill (Заливка растровым узором) – заливка на 

основе растровых изображений (растровый полноцветный узор);
 y 2-color Pattern Fill (Заливка 2-цветным узором) – заливка 

при помощи монохромных битовых карт (двухцветный узор);
 y Texture Fill (Текстурная заливка) – заливка фрактальной 

текстурой. Можно получить неограниченное число нерегулярных 
заливок: абстрактных, имитирующих небо, море, воду, огонь, де-
рево, ткань, космические пейзажи и т. д.; 

 y PostScript Texture (PostScript-текстура) – заливка объектны-
ми текстурами, которые написаны на языке PostScript. 

Для заливки объекта используют следующие средства 
(рис. 3.12): 

 y инструменты Edit Fill (Редактировать заливку), Smart Fill 
(Интеллектуальная заливка), Interactive Fill (Интерактивная за-
ливка);

 y докер Object Properties (Свойства объекта); 
 y докер Color Styles (Цветовые стили);
 y докер Color (Цвет); 
 y инструмент Interactive Fill (Интерактивная заливка). 

Инструмент Edit Fill (Редактировать заливку) открывает диа-
логовое окно для установки параметров каждого типа заливки. 
Диалоговое окно Uniform Fill (Заливка однородным узором) со-
держит три вкладки: 

 y Models (Цветовые модели) – используют для установки цве-
та по любой из цветовых моделей программы; 

 y Mixers (Микшеры) – предназначена для смешения цветов и 
подбора гармоничных цветов;
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 y Palettes (Палитры) – используют для работы с цветовыми 
библиотеками (Fixed Palettes). 

Рис. 3.12. Средства заливки 

В диалоговом окне Fountain Fill (Градиентная заливка) вы-
бирают тип градиента в поле Type (Тип) и устанавливают следу-
ющие параметры: 

 y цвета начальной и конечной точек, прозрачность, направ-
ление градиента (линейное смешение, по часовой стрелке и про-
тив часовой стрелки) с помощью маркеров над цветной полосой;

 y положение Fill Midpoint (Средняя точка), которое определя-
ет положение точки с одинаковым соотношением смешивающих-
ся цветов;

 y варианты заливки с помощью кнопок Default Fountain Fill 
(Фонтанная заливка по умолчанию), Repeat and Mirror Fill (По-
вторная и зеркальная заливка), Repeat Fill (Повторная заливка), 
Reverse (Обратная заливка);

 y Acceleration (Ускорение) – принимает значения от –100 до 
100 и влияет на скорость нарастания градиента;

 y сглаживание цветовых переходов (Smooth); 
 y Steps (Шаги) – число цветовых переходов, принимает зна-

чения от 2 до 999 и должен быть согласован с параметрами печа-
ти (по умолчанию установлено 256). Для установки значений па-
раметра необходимо щелкнуть на кнопке с изображением замка, 
расположенной справа от счетчика параметра;

 y геометрическое положение центра, поворот, наклон, мас-
штабирование и др. 
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При использовании Bitmap Pattern Fill (Заливка растровым 
узором) или Vector Pattern Fill (Заливка векторным узором) из 
списка Fill Picker (Выбор заливки) с образцами моделей запол-
нения выбирают эскиз узора. В области Blend Transition (Пре-
образование перехода) можно изменить параметры смешивания, 
геометрические параметры (соотношение высоты и ширины, на-
клон, поворот и др.) задают в области Transformations (Трансфор-
мации).

Заливка двухцветным узором требует указания основного 
и фонового цветов. Для изменения параметров также используют 
области Blend Transition и Transformations.

В диалоговом окне Texture Fill (Текстурная заливка) варианты 
текстур хранятся в списке Texture Library (Библиотека текстур), 
а конкретные текстуры для выбранной библиотеки – в списке 
Texture List (Список текстур). Каждая текстура имеет несколько 
параметров, которые при щелчке на кнопке Preview (Просмотр) 
изменяются случайным образом, создавая похожее изображение.

Для выбора заливки PostScript используют средства интер-
фейса, аналогичные другим типам заливок. В состав PostScript 
входит около сотни различных узоров для заливки объектов, 
каждый из которых имеет собственное название. У каждого узо-
ра есть несколько управляющих параметров, позволяющих ме-
нять внешний вид заливки. 

Инструмент Interactive Fill (Интерактив-
ная заливка) динамически создает заливку, 
используя маркеры в рабочем окне, и изме-
няет на панели свойств угол, центр заливки 
и цвет.

С помощью сетчатой заливки можно создать плавные цве-
товые переходы в любом направлении. Для ее создания предна-
значен инструмент Mesh Fill (Интерактивная сетчатая заливка) 
панели инструмента Interactive Fill. Для заливки сетки требуется 
задать число столбцов и строк, а также точки пересечения сетки. 
Сетку можно отредактировать, добавляя или удаляя узлы или 
пересечения. Сетчатую заливку можно применять только к зам-
кнутым объектам или к одному пути. Можно добавлять цвет на 
отдельный участок в заливке сетки и на отдельные узлы пере-
сечения.

Инструмент Smart Fill предназначен для закрашивания лю-
бых замкнутых областей, полученных в результате пересечения 
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стандартных фигур, таких, например, как прямоугольник и эл-
липс, или областей, полученных пересечением произвольных 
контуров. Инструмент не имеет настроек. После его выбора не-
обходимо выполнить щелчок указателем в требуемой для заливки 
области.

Для переноса свойств объектов используют пару связанных 
инструментов: Eyedropper (Пипетка) и Paintbucket (Ведро). Они 
расположены в одной группе на панели инструментов, переклю-
чение между ними производят клавишей Shift.

Практические задания по пункту 3.6

Задание 1. Задание 1. Применение однородной заливки (светофор). 
Рекомендации по выполнениюРекомендации по выполнению
1. Создайте три круга диаметром 30 мм. Выровняйте их цен-

тры по горизонтали.
2. Примените заливку красного цвета к первому, желтого – 

ко второму и зеленого – к третьему кругу. 
Задание 2. Задание 2. Применение градиентной заливки. 
Рекомендации по выполнениюРекомендации по выполнению
1. К объекту, созданному в задании 1 по пункту 3.5, приме-

ните радиальную градиентную заливку со смещением центра по 
вертикали на 28 %. Переход от ярко-красного к белому. Обводку 
объекта удалите. 

2. Создайте квадрат размером 30×30 мм. Примените квадрат-
ную градиентную заливку с шагом 8. Переход от зеленого к белому. 

3. Создайте круг диаметром 30 мм. Примените коническую 
заливку с шагом 6 и углом 45°. Переход от зеленого к желтому. 

Задание 3. Задание 3. Применение заливки точечным узором. 
Рекомендации по выполнениюРекомендации по выполнению
1. Постройте прямоугольник размером 5×20 мм. 
2. Установите для него заливку точечным узором в виде 

текстуры дерева: ширина – 5 мм, высота – 15 мм; установи-
те флажок Transform Fill With Object (Преобразование заливки с 
объектом). 

3. Создайте еще три копии прямоугольни-
ка и выберите для них другие узоры в виде 
текстур дерева. 

4. Поверните копию прямоугольника на 
45° и прямоугольник на –45°. 
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Задание 4. Задание 4. Применение текстурной заливки. 
Рекомендации по выполнениюРекомендации по выполнению
1. Постройте квадрат размером 14×14 мм. Установите для 

него цвет, равный 10%-ному черному цвету заливки. 
2. Создайте копию квадрата и сместите ее на 0,5 мм вправо и 

на 0,5 мм вниз. Установите для нее черный цвет заливки. 
3. Выделите оба квадрата и сгруппируйте их. 
4. Постройте квадрат размером 13,5×13,5 мм. 
5. Установите для него текстурную заливку Stucco (Штука-

турка) из библиотеки текстур Samples (Образцы). 
6. Расположите объект таким образом, чтобы получилась 

плитка. 
7. Выделите объект, поверните его на 45° и создайте две ко-

пии плитки. 
8. Задайте для копий следующие текстурные заливки:

 y текстура Concrete (Бетон) из библио теки 
Samples7 (Образцы7); 

 y текстура Surfaces1 2C (Поверхности1 2С) 
из библиотеки Styles (Стили). 

9. Сгруппируйте отдельные элементы каждой плитки и вы-
полните горизонтальное выравнивание и распределение. 

Контрольные вопросы
1. Как присвоить градиентную заливку обводке объекта?

2. Какие параметры устанавливают в диалоговом окне Fountain Fill (Градиентная 

заливка)? 

3. Как изменить толщину (цвет, стиль) абриса объекта? 

4. Назовите типы заливок, используемых в CorelDRAW.

5. Какие средства работы с цветом имеет CorelDRAW? Как произвести однород-

ную заливку объекта? 

6. Что такое заливка двухцветным узором? 

7. Назовите назначение инструмента Smart Fill (Интеллектуальная заливка). 

8. Какая заливка позволяет создавать плавные цветовые переходы в любом на-

правлении?

3.7. Использование спецэффектов в CorelDRAW

Динамические графические эффекты CorelDRAW позволяют 
быстро создавать сложные группы объектов. К ним относят:

 y Blend (Перетекание); 
 y Contour (Ореол); 
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 y Envelope (Оболочка);
 y Lens (Линза); 
 y Perspective (Вид в перспективе); 
 y Drop Shadow (Тень); 
 y Distort (Искажение); 
 y Extrude (Экструзия);
 y Block Shadow (Блок-тень);
 y Transparency (Прозрачность); 
 y PowerClip (Фигурная обрезка);
 y Вevel (Скос).

Все эффекты, кроме Distort (Искажение) и Drop Shadow (Тень) 
содержатся в меню Effects (Эффекты) и, кроме того, могут быть 
реализованы с помощью докеров.

В программе CorelDRAW можно переносить эффекты с од-
них объектов на другие (не имеющие данных эффектов). Такие 
операции выполняют с помощью команд подменю Copy Effect 
(Скопировать эффект) и Clone Effect (Клонировать эффект) меню 
Effects (Эффекты). Команда меню Effects ⇒ Clear Effect (Эффек-
ты ⇒ Отменить эффект) позволяет удалить параметры эффекта.

1. Blend (Перетекание) 
Для создания перетеканий в программе используют следую-

щие средства: 
 y докер Blend (Перетекание), который вызывают из меню 

Window ⇒ Dockers ⇒ Effects ⇒ Blend (Окно ⇒ Докеры ⇒ Эффек-
ты ⇒ Перетекание) или командой Effects ⇒ Blend (Эффекты ⇒ 
Перетекание); 

 y инструмент Interactive Blend (Интерактивное перетекание);
 y панель Property Bar (Свойства).

Перетекание бывает трех видов:
 y перетекание вдоль прямой – промежуточные объекты рас-

полагаются по прямой, проведенной между двумя объектами;
 y перетекание вдоль траектории (траектория: фигуры, линии 

и фигурный текст);
 y составное перетекание, состоящее из двух или более свя-

занных друг с другом перетеканий.
Для создания эффекта перетекания с помощью докера 

(рис. 3.13) необходимо выделить начальный и конечный объекты, 
щелкнуть на кнопке Apply (Применить). По умолчанию перетека-
ния создаются по прямой линии. 
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В уже созданном переходе на первой вкладке докера можно:
1) изменить количество промежуточных объектов – параметр 

Blend Object (Число шагов);
2) задать угол поворота – пара-

метр Blend Direction (Направление 
перетекания);

3) увеличить либо уменьшить 
интенсивность изменения формы 
и цвета – слайдеры Object и Color 
области Acceleration (Ускорение);

В области Color Blend (Пере-
текание цвета) с помощью кнопок 
можно изменить направление из-
менения цвета: по прямой, по часо-
вой либо против часовой стрелки. 

Кнопка Blend Spacing (Интер-
вал перетекания) обеспечивает до-
ступ к параметрам изменения фор-
мы и интервала между объектами, 
расположенными вдоль пути. 

Для изменения параметров со-
зданного перетекания можно вос-
пользоваться панелью Property Bar 
(Свойства). Она позволяет изме-
нять начальную и конечную точки 

перехода, а также работать со сложными переходами. Можно 
разъединить переход, указав мышью один из промежуточных 
объектов в качестве разделителя. Объект-разделитель можно вы-
делить и сместить, а также преобразовать инструментом Shape 
(Форма).

Кнопка Path Properties (Свойства пути) от-
крывает командную панель для выбора новой 
направляющей объекта перехода. 

Для создания перетекания инструментом 
Interactive Blend (Интерактивное перетекание) 

необходимо зафиксировать указатель инструмента на начальном 
объекте, а затем, не отпуская кнопку мыши, протянуть инст-
румент до конечного объекта. Создается перетекание с параме-
трами, установленными по умолчанию. Для изменения параме-

Рис. 3.13. Докер Blend (Перетекание)
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тров созданного перетекания можно воспользоваться докером 
Blend (Перетекание) либо панелью Property Bar (Свойства). 

2. Contour (Ореол)
Эффект Contour (Ореол) используют для создания вокруг 

объекта или внутри него, а также вокруг открытого контура или 
группы объектов динамически связанных ореолов. Форма оре-
олов зависит от формы исходного объекта и при его редакти-
ровании автоматически также изменяется. При необходимости 
созданные ореолы могут быть отделены от исходного объекта 
и использоваться как самостоятельные объекты.

Для создания ореолов используют следующие элементы ин-
терфейса: 

 y докер Contour (Ореол), который вызывают из меню Win-
dow ⇒ Dockers ⇒ Effects ⇒ Contour (Окно ⇒ Докеры ⇒ Эффекты ⇒ 
Ореол) или командой Effects ⇒ Contour (Эффекты ⇒ Ореол); 

 y инструмент Interactive Contour (Интерактивный ореол); 
 y панель Property Bar (Свойства), которая дублирует параме-

тры управления создаваемыми ореолами.
В окне докера Contour (рис. 3.14) 

в верхней части расположены пе-
реключатели, определяющие, как 
именно будут создаваться концен-
трические фигуры: To Center (К цен-
тру), Inside (Внутри), Outside (Снару-
жи). Счетчик Offset позволяет задать 
расстояние между соседними объ-
ектами, а счетчик Contour Steps – 
количество создаваемых фигур.

Область Color Blend окна на-
стройки служит для регулировки 
окраски ореола. Вверху области рас-
положены кнопки для выбора траек-
тории перехода цвета, аналогичные 
окну настройки Blend. Под ними 
находятся раскрывающиеся списки, 
в которых можно выбрать цвета об-
водки и заливки последнего объекта 
в группе ореола.

Параметры Acceleration аналогичны параметрам, расположен-
ным в окне настройки Blend.

Рис. 3.14. Докер Contour (Ореол)
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Эффект Contour идеально подходит для создания внутреннего затенения 

объекта, а инструмент Blend непропорционально масштабирует части про-

межуточных объектов.

Для создания ореолов инструментом Interactive Contour (Ин-
терактивный ореол) необходимо зафиксировать его указатель 
внутри объекта, на его контуре, или снаружи вблизи ореола, а за-
тем протянуть указатель, не отпуская кнопку мыши, в сторону 
создания ореолов. Будет создан эффект ореолов с параметрами, 
установленными по умолчанию. Дальнейшая работа с эффек-
том выполняется на панели Property Bar (Свойства), на которой 
выводятся параметры, аналогичные параметрам панели Contour 
(Ореол).

3. Envelope (Оболочка)
Эффект Envelope (Оболочка) ори ентирован на автоматическую 

трансформацию объекта по выбранной форме. При этом считается, 
что объект помещается внутрь огиба-
ющей или оболочки, которая должна 
быть замкнутой. Фактически объект 
не обрезается, принимая в точности 
очертания оболочки, а искажается 
так, что становится несколько похо-
жим на нее. В качестве огибающей 
можно выбрать одну из заготовок, 
поставляемых с программой, соз-
дать собственную огибающую про-
извольной формы или отредакти-
ровать прямо угольную огибающую 
(рис. 3.15). Эффект огибающей мож-
но применить к замкнутому объекту, 
группе объектов, разомкнутому кон-
туру или текстовому блоку.

Для создания эффекта Envelope 
(Оболочка) используют те же сред-
ства, что и для рассмотренных вы-
ше эффектов:

 y докер Envelope (Оболочка);
 y инструмент Interactive Envelope (Интерактивная оболочка) 

совместно с параметрами, выводимыми на панель Property Bar 
(Свойства).

Рис. 3.15. Докер Envelope  

(Оболочка)
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4. Lens (Линза)
Эффект Lens (Линза) аналогичен рассматриванию объек-

та через реальную линзу, обладающую возможностью изменять 
свойства объекта. В эффекте задействованы два типа объектов. 
Верхний выделенный объект служит линзой для нижнего объек-
та или группы объектов. Для получения эффекта линза должна 
перекрывать нижние объекты. В качестве линзы можно исполь-
зовать замкнутый объект любой формы, цвет которого в некото-
рых линзах даже не влияет на результат эффекта. 

Для применения эффекта необходимо: 
1) создать объект, который будет играть роль линзы;
2) выделить объект инструментом Pick;
3) в докере Lens (Линза) (рис. 3.16) выбрать тип линзы;
4) если кнопка с изображением замка нажата, результат дей-

ствия линзы отображается сразу же после изменения настроек, 
в противном случае для просмотра результата необходимо вы-
брать Apply.

Флажок Viewpoint (Точка зре-
ния) позволяет установить смеще-
ние точки обзора линзы.

Флажок Frozen создает группу 
новых объектов, образующих точно 
такое же изображение, как то, что 
было видно через линзу с текущими 
значениями параметров преобразо-
вания. При этом сама линза удаля-
ется, а на ее месте остается преоб-
разование линзы.

По результату действия все линзы 
можно разделить на две группы: лин-
зы, имитирующие изменение фор мы 
изображения, – Fish Eye (Рыбий глаз) 
и Magnify (Увеличение); линзы, ими-
тирующие изменение цвета изобра-
жения, – все остальные.

Типы линз, используемые в программе: 
 y No Lens Effect (Без эффекта линзы) – отменяет воздействие 

примененной линзы; 
 y Brighten (Яркость) – изменяет яркость объекта под линзой в 

зависимости от значения параметра Rate (Уровень); 

Рис. 3.16. Докер Lens (Линза)
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 y Color Add (Сложение цветов) – смешивает цвет линзы и цвет 
объекта. Цвет линзы устанавливают с использованием кнопки 
Color (Цвет), а его количество, участвующее в смешении, опреде-
ляют значением параметра Rate (Уровень); 

 y Color Limit (Поглощение цвета) – в противоположность 
линзе Color Add (Сложение цветов) поглощает часть цвета объ-
екта, зависящую от цвета линзы и от значения параметра Rate 
(Уровень); 

 y Custom Color Map (Пользовательская палитра цветов) – по-
зволяет изменить цвет объектов под линзой заданием двух цветов 
цветовой растяжки и направления цветового перехода; 

 y Fish Eye (Рыбий глаз) – искажает форму объекта подобно 
широкоугольному объективу; 

 y Heat Map (Тепловая карта) изменяет цвета объекта как ин-
фракрасный фильтр. При этом светлые и теплые цвета заменя-
ются желтым и оранжевым, а темные и холодные – красным, 
пурпурным и синим; 

 y Invert (Инвертировать) – заменяет цвета модели CMYK до-
полняющими цветами, черный цвет заменяется белым, а белый 
черным. У цветов полутоновой шкалы яркость изменяется на 
противоположную; 

 y Magnify (Увеличение) – используется в качестве увеличи-
тельного стекла или лупы. Форма линзы может быть произволь-
ной. Коэффициент увеличения устанавливают из диапазона от 
0,1 до 100; 

 y Tinted Grayscale (Тонирование) – преобразует цвет объекта 
в серую шкалу с сохранением тонов и наложением цвета линзы, 
устанавливаемого с использованием кнопки Color (Цвет); 

 y Transparency (Прозрачность) – имитирует рассмотрение 
объекта с использованием линзы, цвет которой устанавливают с 
помощью кнопки Color (Цвет), а ее прозрачность – в поле Rate 
(Уровень); 

Больше возможностей для использования эффекта прозрачности предо-

ставляет инструмент Interactive Transparency (Интерактивная прозрач-

ность).

 y Wireframe (Ореольный режим) – позволяет заменить цвета 
обводки и заливки фрагмента объекта, попадающего в область 
действия линзы, любыми, устанавливаемыми с использованием 
кнопок Outline (Обводка) и Fill (Заливка).
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5. Perspective (Вид в перспективе).
Перспектива – прием имитации глубины за счет уменьше-

ния размеров изображаемых объектов пропорционально их уда-
ленности от зрителя. Преобразование перспективы, примененное 
к индивидуальному объекту или группе, искажает их форму в со-
ответствии с выбранной схемой перспективы

Для создания перспективы (рис. 3.17) используют команду 
меню Effects ⇒ Add Perspective (Эффекты  ⇒ Добавить перспекти-
ву). Для этого предварительно инструментом Pick (Выбор) необ-
ходимо выделить объект или группу объектов и вызвать команду 
Add Perspective (Добавить перспективу). После выполнения ко-
манды выделенные объекты разбиваются на восемь горизонталь-
ных и восемь вертикальных ячеек сетки, которые в дальнейшем 
будут отображать изменение объекта в перспективе. Дополни-
тельно вокруг объекта отображается четыре размерных маркера, 
предназначенных для создания перспективы, и активизируется 
инструмент Shape (Форма).

 

Рис. 3.17. Добавление перспективы
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Буксировка при нажатых клавишах Ctrl + Shift позволяет 
перемещать узлы на одинаковое расстояние в противоположных 
направлениях. 

6. Interactive Extrude (Интерактивная экструзия)
Трехмерное представление объекта выполняют с помощью 

эффекта Extrude (Экструзия), который заключается в добавле-
нии к исходному объекту боковых граней, построенных на ли-
ниях проекции объекта в направлении точки схождения пер-
спективы.

Эффект можно применять к произвольным кривым (замкну-
тым и незамкнутым), геометрическим фигурам или фигурному 
тексту.

Для создания экструзии используют следующие средства: 
 y докер Extrude (Экструзия); 
 y инструмент Interactive Extrude (Интерактивная экструзия); 
 y панель Property Bar (Свойства), на которой при выборе ин-

струмента Interactive Extrude (Интерактивная экструзия) дублиру-
ются параметры панели Extrude (Экструзия).

Докер Extrude (рис. 3.18) со-
держит пять вкладок, вызываемых 
с помощью кнопок, расположен-
ных в верхней части панели.

Список Vanishing Point (Точка 
схода) содержит шесть типов экс-
трузии, определяющих направле-
ние эффекта и трехмерные пре-
образования исходного объекта. 
Наглядно выбранный тип в виде 
условной схемы отображается 
в области просмотра и на панели 
Property Bar (Свойства):

 y по умолчанию установлен тип 
Small Back (Назад с уменьшением);

 y Small Front (Вперед с умень-
шением); 

 y Big Back (Назад с увеличени-
ем) – дает обратную перспективу; 

 y Big Front (Вперед с увеличе-
нием) – обеспечивает эффект, про-
тивоположный предыдущему типу.

Рис. 3.18. Докер Extrude (Экструзия)



145

3.7. Использование спецэффектов в CorelDRAW

Два последних типа создают параллельную экструзию. При 
их использовании размер поперечного сечения изображения эф-
фекта не изменяется. Вариант Back Parallel (Назад параллельно) 
создает экструзию от исходного объекта назад, а Front Parallel 
(Вперед параллельно) – наоборот, вперед. 

Вторым важным параметром эффекта является точка схо-
да, определяющая направление уменьшения объектов. Следует 
иметь в виду, что положение точки схода может не совпадать 
с направлением группы экструзии. Варианты управления точкой 
схода следующие: 

 y VP Locked To Object (Привязка точки схода к объекту) – при 
перемещении объекта точка схода сохраняет свое положение от-
носительно объекта;

 y VP Locked to Page (Привязка точки схода к странице); 
 y Copy VP From (Копировать точку схода) копирует точки 

схода с объекта, к которому применен эффект экструзии, на про-
извольный выделенный объект; после выполнения команды оба 
объекта будут иметь общую точку схода; 

 y Shared Vanishing Point (Объединить точки схода) объединяет 
точки схода выделенного объекта и другого объекта с аналогич-
ным эффектом, находящихся на одной странице документа. 

Поле Depth (Глубина) служит для задания глубины экстру-
зии. Глубину определяют как процентное отношение длины бо-
ковых ребер к расстоянию от исходного объекта до точки схода; 
она может принимать значения от 1 до 99 %. 

Вторая вкладка окна настройки Extrude позволяет повора-
чивать объемный объект на странице документа. Вращение мо-
жет быть применено только к объектам, полученным с помощью 
перспективного проецирования, точка схода которых привязана 
к объектам.

Третья вкладка дает возможность добавлять эффект освеще-
ния. Можно добавить от одного до трех источников света, щел-
кнув мышью на кнопках с лампочками. Положение каждого ис-
точника можно изменять. Шкала Intensity (Интенсивность) регу-
лирует яркость свечения источников.

7. Interactive Drop Shadow (Интерактивная тень)
Тени подчеркивают реалистичность и наглядность иллю-

страции. Существуют следующие типы теней:
 y собственная тень непрозрачного тела – часть поверхности 

тела, не освещенная источником света;



146

Раздел 3. Основы векторной графики 

 y падающая тень – часть поверхности, на которую упала тень 
от непрозрачного тела;

 y контур собственной тени – граница между освещенной ча-
стью поверхности предмета и частью, находящейся в собствен-
ной тени;

 y рефлекс – то место в собственной тени предмета, на кото-
рое падает отраженный свет, окрашивая его;

 y блик – световое пятно на поверхности освещенного пред-
мета в месте отражения источника света.

Реализованный в программе эффект тени позволяет задавать 
ее местоположение, цвет, прозрачность и другие параметры. Тень 
создается как пиксельный объект, поэтому к ней можно приме-
нить такие характеристики, как непрозрачность, размытие гра-
ниц с выбором вариантов и стилей размытия.

Для создания тени служит инструмент Interactive Drop Shadow 
(Интерактивная тень). В данном инструменте предусмотрено 
пять типов тени, определяющих положение плоскости, на ко-
торую объект отбрасывает тень: Flat (Плоский), Bottom (Снизу), 
Top (Сверху), Left (Слева), Right (Справа). Все параметры эффекта 
устанавливают на панели свойств Property Bar (рис. 3.19): 

1) раскрывающийся список заготовок Presets List предназна-
чен для выбора стиля оформления эффекта тени;

Список заготовок

Угол падения 

тени

Смещение тени Растяжение тени
Направление 

размытия
Копировать 

свойства
Непро - 

зрачность тени

Затухание тени
Размытие 

тени

Цвет 

тени
Удалить 

тень
Режим

смешивания

Рис. 3.19. Панель Property Bar (Свойства) инструмента 

Interactive Drop Shadow (Интерактивная тень)

2) кнопка добавление заготовки Add Preset создает новый 
стиль оформления;

3) кнопка удаление заготовки Delete Preset удаляет текущий 
стиль оформления эффекта;

4) в полях смещения тени Drop Shadow Offset указывают ко-
ординаты геометрического центра тени по отношению к центру 
объекта (недоступен для тени, тип которой отличен от Flat (Пло-
ский));
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5) слайдер Drop Shadow Angle (Угол падения тени) регулирует 
угол наклона изображения тени (недоступен для тени типа Flat);

6) слайдер Drop Shadow Opacity (Непрозрачность тени) задает 
уровень непрозрачности данного изображения;

7) слайдер Drop Shadow Feathering (Размытие тени) определяет 
уровень размытия краев;

8) кнопка Drop Shadow Feathering Direction (Направление раз-
мытия) открывает дополнительную панель управления для вы-
бора одного из четырех возможных направлений размытия краев 
тени;

9) кнопка Drop Shadow Feathering Edges (Края размытия) от-
крывает панель управления для выбора одного из четырех вари-
антов формы размытых краев тени;

10) слайдер Drop Shadow Fade (Затухание тени) регулирует 
уровень прозрачности изображения тени в области, удаленной от 
объекта (недоступен для эффекта тени типа Flat);

11) слайдер Drop Shadow Stretch (Растяжение тени) определя-
ет коэффициент удлинения тени (недоступен для эффекта тени 
типа Flat);

12) раскрывающийся список цветовых образцов Drop Shadow 
Color (Цвет тени) позволяет выбрать цвет тени;

13) кнопка Copy Drop Shadow Properties (Скопировать свойства 
тени) выполняет перенос на выделенный объект параметров тени 
из другого объекта документа;

14) кнопка Clear Drop Shadow (Удалить тень) удаляет эффект 
тени.

После создания тени она становится динамически связанной с объектом, 
и любые трансфигурации объекта или изменение его положения автома-
тически отображаются и на параметрах тени. Разделение объекта и тени 
происходит с помощью команды Object ⇒ Break Drop Shadow Group Apart 
(Объект ⇒ Отделить тень от объекта).

8. Distort (Искажение)
Эффект Interactive Distortion (Интерактивное искажение) соз-

дают с помощью инструмента Distort (Искажение). Суть эффек-
та – деформация векторного объекта по закону, определяемому 
выбранным типом искажения. Параметры эффекта регулируют 
с помощью управляющей конструкции инструмента, а также 
элемен тов управления панели свойств Property Bar. Предусмо-
трено три типа искажения: Push and Pull (Сжатие и растяжение), 
Zipper (Застежка-молния), Twister (Скручивание) (рис. 3.20). 
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Застежка-молния

Удалить

Скручивание
Дополнительный 

угол вращения

Копировать 

свойства

Деформация 

из центра

Полные 

обороты
Сжатие/ 

растяжение

Список  

заготовок
Направление

Преобразовать 

в кривые

Рис. 3.20. Панель Property Bar (Свойства) инструмента 

Distort (Искажение) с типом Twister (Скручивание)

Деформация Push and Pull (Сжатие и растяжение) увеличива-
ет или уменьшает амплитуду наклона кривых объекта. Амплиту-
да может быть установлена в диапазоне от –200 до + 200 %. От-
рицательные значения амплитуды вызывают смещение всех узлов 
объекта к центру деформации, что создает эффект растяжения. 
При положительных значениях амплитуды происходит смещение 
всех узлов от центра деформации, возникает состояние сжатия. 

Деформация Zipper (Застежка-молния) искажает пути объ-
екта таким образом, что он напоминает зигзаг или стежки шва. 
Интерактивные маркеры могут настроить три параметра эффек-
та: амплитуду, частоту и центр искажения. Амплитуда может 
быть только положительной и изменяться от 0 до 100 %.

Деформация Twister (Скручивание) искажает пути и узлы 
объекта, поворачивая внешние области вокруг центра. На панели 
свойств можно задать направление вращения (по часовой стрелке 
или против), число полных поворотов и угол дополнительного 
поворота. Также центр поворота и число поворотов можно задать 
с помощью интерактивных маркеров: ромбовидный используется 
для настройки центра поворота, а круглый – для задания числа 
полных оборотов. В зависимости от направления смещения круг-
лого маркера задается направление вращения. 

9. PowerClip (Фигурная обрезка)
Эффект PowerClip заключается в маскировании изображений 

по произвольной форме. Существуют два объекта: исходный объ-
ект, называемый содержимым (Сontents), и второй объект, кото-
рый называется контейнером (Сontainer). Содержимое помещают 
внутрь контейнера, а та часть, которая не помещается, становится 
невидимой, однако остается в документе. Таким образом, после 
применения эффекта можно снова вернуться к редактированию 
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содержимого контейнера. Эффект фигурной обрезки можно при-
менять как к отдельным векторным объектам, так и к группам 
объектов, а также к пиксельным изображениям. В один контей-
нер можно помещать несколько объектов. После создания эф-
фекта к полученному объекту можно применять любые коман-
ды трансформирования и дублирования, а также рассмотренные 
выше эффекты.

Для применения эффекта PowerClip (Фигурная обрезка) 
и управления им используют команды меню Object ⇒ PowerClip 
(Объект ⇒ Фигурная обрезка) или контекстного меню (рис. 3.21):

 y Place Inside Frame (Поместить в контейнер) – создание эф-
фекта; 

 y Extract Contents (Извлечь содержимое) – отделение объекта 
от контейнера; 

 y Edit PowerClip (Редактировать обрезку) – редактирование 
содержимого контейнера;

 y Finish Editing PowerClip (Закончить редактирование) – после 
редактирования содержимого снова помещает его в контейнер. 

Рис. 3.21. Команды меню Object ⇒ PowerClip (Объект ⇒ Фигурная обрезка)

10. Bevel (Скос)
Различают два типа эффекта скоса:
1) Soft Edge (Мягкий край) – создание скошенных поверх-

ностей с тенями; 
2) Emboss (Рельеф) – придание объекту рельефного вида.
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Для создания эффекта Bevel (Скос) необходимо:
1) выбрать замкнутый объект с заливкой;
2) выполнить команду Effects ⇒ Bevel (Эффекты ⇒ Скос);
3) в появившемся окне Bevel в верхнем списке выбрать тип 

Soft Edge (Мягкий край) или Emboss (Рельеф);
4) установить параметры скоса и нажать кнопку Apply.
Объект с эффектом скоса освещен белым рассеянным (окру-

жающим) светом и светом из точечного источника. Рассеянный 
свет обладает низкой интенсивностью и не может быть изменен.

Свет от точечного источника также является белым по умол-
чанию, однако его цвет, интенсивность и положение можно из-
менять. При модификации цвета точечного источника изменя-
ется цвет поверхности со скосом. При изменении интенсивности 
точечного источника поверхности со скосом делаются светлее 
или темнее.

При изменении положения точечного источника свет падает 
на другую поверхность со скосом. Положение точечного источ-
ника можно изменить, указав его направление и высоту. Кроме 
того, можно изменить цвет теней на поверхностях со скосом пу-
тем указания цвета тени.

11. Transparency (Прозрачность)
Под прозрачностью понимают способность твердого тела 

пропускать в той или иной степени через себя лучи света. Любой 
объект программы CorelDRAW может характеризоваться боль-
шей или меньшей прозрачностью. Прозрачными могут быть фи-
гуры с любой заливкой и растровые изображения.

Для придания объекту прозрачности и ее редактирования 
предназначен интерактивный инструмент Transparency. Панель 
свойств инструмента Transparency (Прозрачность) (рис. 3.22) со-
держит:

Тип прозрачности Степень прозрачности

Режим прозрачности «Заморозить»

Способ  

применения

Положение  

средней точки

Редактировать

Копировать 

свойства

Рис. 3.22. Панель свойств инструмента Transparency (тип Uniform)

 y кнопки выбора типа прозрачности: Uniform (Сплошная), 
Fountain (Градиентная), Vector Pattern (Прозрачность векторного  
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узора), Bitmap Pattern (Прозрачность растрового узора) и т. д.  
По умолчанию объект непрозрачен, т. е. в списке активен пункт 
None (Нет), параметры прозрачности зависят от выбранного  
типа;

 y раскрывающийся список Transparency Operation (Режим 
про зрачности). В режиме слияния Normal (Обычный) цвет про-
зрачного объекта замещает цвет фона. При этом не важно, ка-
кой из цветов светлее. Белый полупрозрачный объект на черном 
фоне будет серым, желтый на красном – оранжевым. Прозрач-
ность 0 % соответствует непрозрачному, 100 % – невидимому 
объекту;

 y выбор степени прозрачности и слайдер положения средней 
точки;

 y способ применения: к объекту в целом, к заливке или 
абрису.

Операция «заморозки» изображения приводит к преобразо-
ванию выделенного объекта с эффектом прозрачности в растро-
вый объект, копирующий полученное изображение. 

Кнопка Edit (Редактировать) открывает окно редактирования 
параметров прозрачности.

Практические задания по пункту 3.7

Задание 1. Задание 1. Изображение в перспективе (построение симме-
тричной перспективы). 

Рекомендации по выполнеРекомендации по выполнениюнию

1. Создайте группу объектов (см. рисунок). 
Выделите ее.

2. Выберите команду Add Perspective (Доба-
вить перспективу) в меню Effects (Эффекты).

3. Удерживая нажатыми клавиши Ctrl и 
Shift, сместите угловой маркер в сторону, при 
этом противоположный маркер движется в об-
ратном направлении. Точка схода – точка пе-
ресечения граничных линий (обозначена как 
крестик). 

4. В случае необходимости для удаления 
перспективы выберите команду Clear Perspec-
tive (Отменить перспективу) в меню Effects 
(Эффекты).
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Задание 2. Задание 2. Оконтуривание объектов. 
Рекомендации по выполнениюРекомендации по выполнению

1. Постройте три звезды.
2. В докере Contour на первой 

вкладке установите переключатель 
типа контура разным для каждой 
звезды: To Centre (К центру), Inside 
(Внутрь) и Outside (Наружу).

3. Расстояние между контурами установите в поле Offset, ко-
личество контуров – в поле Steps.

4. Во второй вкладке установите характер цветового перехо-
да, цвет конечной контурной линии и цвет заливки последнего 
объекта в группе контура.

Можно разбить группу контура на отдельные объекты. Для этого выделите 

группу и выберите ко манду Object ⇒ Break Apart (Объект ⇒ Разделить). 

Затем разгруппируйте изображение командой Ungroup (Разгруппировать).

Задание 3.Задание 3.  Искажение объектов. 
Рекомендации по выполнениюРекомендации по выполнению
1. Постройте восьмиугольник инструментом Polygon (Много-

угольник).
2. Выберите инструмент Distort (Искажение). На панели 

свойств инструментов выберите режим Push and Pull (Сжатие и 
растяжение). Установите указатель в середине восьмиугольника 
ближе к его левому краю и, удерживая зажатой левую кнопку 
мыши, перемещайте указатель, чтобы получить изображение 
цветка.

3. К изображению контура цвет-
ка добавьте изображение серединки 
в виде окружности.

4. Примените к цветку градиентную залив-
ку, тип заливки Radial (Радиальная), от светло-
розового к темно-розовому.

5. Создайте изображение листочка. Для это-
го постройте эллипс и преобразуйте его с помо-
щью инструмента Distort (Искажение). На пане-
ли свойств инструментов выберите режим Zipper 
(Застежка-молния).
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6. Закрасьте изображение листочка в зеленый цвет. 
7. Нарисуйте стебелек, с помощью инструмента Bezier (Кри-

вая Безье). Установите толщину линии 2 мм и раскрасьте ее в 
зеленый цвет.

Задание 4. Задание 4. Объект в оболочке. 
Рекомендации по выполнениюРекомендации по выполнению
1. Постройте группу объектов размером 5×5 квадратов. 
2. Примените эффект Envelope ко-

мандой Effects ⇒ Envelope или инст-
рументом Interactive Envelope (Интерак-
тивная оболочка).

3. Выберите оболочку из списка го-
товых форм оболочек. 

4. Создайте три дубликата. 
5. Для первого примените режим Straight Line Mode (Режим 

прямолинейной оболочки), для второго – Single Arc (Режим обо-
лочки с единичной дугой), для третьего – Double Arc Mode (Ре-
жим оболочки с двойной дугой).

Задание 5. Задание 5. Имитация 3D-изображения. 
Рекомендации по выполнениюРекомендации по выполнению
1. Постройте шестиугольник инструментом Polygon, удержи-

вая нажатыми клавиши Shift и Ctrl. 
2. Инструментом Ellipse постройте окруж-

ность, удерживая нажатыми клавиши Shift и Ctrl. 
3. Инструментом Pick выделите оба объекта, 

выровняйте их центры и залейте серым цветом 
(30 % Black). Примените операцию Combine.

4. Примените команду Extrude или инст-
румент Interactive Extrude для получения объема. 
Переместите маркер редактирования положения 
точки схода в верхний правый угол листа. 

5. Инструментом Shape на исходном 6-уголь-
нике удалите два лишних узла, чтобы избавиться 
от линий на видимых боковых гранях объекта.

6. С помощью кнопки Light (Освещение) 
включите освещение, используя лампу под но-
мером 1. 

7. К полученному объекту примените эф-
фект падающей тени, предварительно применив
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операцию Group. Затем с помощью инструмен-
та Interactive Drop Shadow (Интерактивная тень) 
создайте внешнюю тень от всего объекта. По-
ложение и плотность тени можно регулировать 
ч฀ерным маркером-квадратиком, отображающим 
цвет тени, а также движком на линии, идущей 
от объекта.

ЗаданЗадание 6. ие 6. Применение эффектов Lens.
Рекомендации по выполнениюРекомендации по выполнению
1. С помощью инструмента Star нарисуйте элемент узора. 

 

2. Создайте заготовку узора (ском-
бинируйте или сгруппируйте элементы).

3. Поверх узора нарисуйте окруж-
ность. Примените Intersect, для узора 
установите Outline ⇒ None. 

4. Заготовку узора удалите.
5. Окружность закрасьте в тем-

ный цвет, например Dark Navy Blue; 
Outline ⇒ None. 

6. Окружность скопируйте в буфер 
обмена Windows Clipboard (Ctrl + C). 

При таком способе копирования команда Paste (Ctrl + V ) вставит 
копию в ту же точку страницы, где был расположен оригинал. 

7. Вставьте копию окружности из буфера. Примените к ней 
эффект Lens ⇒ Fish Eye – для придания выпуклости (Rate 90 %).

8. Еще раз вставьте копию окружности из буфера. Она будет 
играть роль линзы, создающей эффект блика от источника света, 
поэтому окрасьте ее в белый цвет: Fill ⇒ White.

9. С помощью инструмента Interactive Transparency (Интерак-
тивная прозрачность) задайте для окружности тип прозрачности 
Radial.

10. Откорректируйте параметры радиальной прозрачности в 
окне Fountain Transparency (рис. 3.23): 

 y черный цвет в поле From означает, что прозрачность равна 
100 %, т. е. в этом месте линза полностью прозрачна; 

 y белый цвет в поле To означает, что прозрачность равна 0 %, 
т. е. в этом месте линза непрозрачна; 

 y параметры X и Y задают смещение центра радиальной про-
зрачности от центра объекта, играющего роль линзы.
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Рис. 3.23. Применение эффекта Transparency (Прозрачность)

11. Добавьте еще одну копию окружности и задайте для нее 
цвет – 80 % Black. Это будет собственная тень шара, позволяю-
щая дополнительно подчеркнуть его объем. 

Располагаться тень должна на противоположной стороне от 
блика.

12. Инструментом Transparency задайте для окружности тип 
прозрачности – Fountain Radial, режим слияния – Multiply. От-
корректируйте параметры смещения прозрачности и установите 
вариант градиентной заливки Repeat and Mirror Fill.

13. Добавьте падающую тень с помощью эффекта Blend (или 
же инструментом Interactive Drop Shadow).

Задание 7. Задание 7. Применение эффекта Blend (Перетекание). 
Рекомендации по выполнениюРекомендации по выполнению
Постройте прямые линии. Параметры Blend указаны на ри-

сунке 3.24. 
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Start node

Center of rotation

Center of 

rotation

Blend: Steps – 20

Blend: Steps – 20   

Blend 40 (Rotate: 180°)

Blend 40 (Rotate: 360°)

Blend 40  

(Rotate: 180°, Loop)

Blend 40  

(Rotate: 360°, Loop)

Рис. 3.24. Применение эффекта Blend (Перетекание)

Контрольные вопросы
1. Как создать перспективу? Назовите типы перспектив.

2. Как изменить ранее созданный эффект, скопировать или удалить эффект? 

3. Опишите способы создания и режимы изменения оболочки.

4. Назовите назначение клавиш Ctrl и Shift при создании эффекта Envelope. 

5. Что определяет режим заполнения оболочки?

6. Что такое Extrude (Экструзия)? 

7. Приведите все типы проекции для создания эффекта Extrude (Экструзия). Как 

модифицировать созданный эффект? 

8. Что такое точка схода? Для чего она предназначена? 

9. Как осуществляется переключение между режимами поворота при примене-

нии эффекта Extrude (Экструзия)? 

10. Что такое эффект перетекания? Назовите типы перетеканий. 

11. Как создать перетекание вдоль прямой линии? вдоль траектории?

12. Как создать перетекание с поворотом промежуточных объектов? 

13. Как изменить цвет промежуточных объектов в перетекании? 

14. Как удалить траекторию перетекания таким образом, чтобы само перетека-

ние осталось без изменений? 

15. Как создать эффект Contour (Ореол)? Опишите процесс изменения цвета 

промежуточных объектов для данного эффекта. 

16.  Какой вид имеют маркеры исходного объекта и маркер направления контура 

при использовании инструмента Interactive Contour (Интерактивный ореол)? 

3.8. Работа с текстовыми объектами в CorelDRAW

Особое место среди средств CorelDRAW занимает инструмент 
Text (Текст), обозначенный на панели инструментов буквой А.

Текст не является графикой и обладает своими специфиче-
скими свойствами, например начертанием. Однако, при необхо-
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димости, любой текстовый объект можно преобразовать в графи-
ческий командой Object ⇒ Convert to Curve (Объект ⇒ Преобразо-
вать в кривые). Обратное преобразование невозможно.

Текстовые объекты в CorelDRAW бывают двух типов (рис. 3.25): 
 y Artistic Text (Фигурный текст) – свободно размещаемые 

строки текста;
 y Paragraph Text (Простой текст) – текстовые символы раз-

мещаются внутри текстового блока.

а б

Рис. 3.25. Объекты типа Artistic Text (а) и Paragraph Text (б)

Для ввода фигурного текста Artistic Text следует выбрать ин-
струмент Text, установить курсор в нужное место на экране и на 
панели свойств выбрать необходимые атрибуты – размер и тип 
шрифта. Далее просто ввести текст. 

Объект типа Artistic Text можно модифицировать как графи-
ческие объекты – вращать, растягивать. Фигурный текст можно 
разбить на части: предложение на слова, а слова на буквы. Для 
этого надо выделить текст инструментом Pick, выполнить коман-
ду Break Artistic Text контекстного меню или меню Object.

Средства форматирования текста находятся в пунктах меню 
Text и вызываются командой Text ⇒ Text Properties (Текст ⇒ Свой-
ства текста). Их набор аналогичен стандартным средствам тек-
стовых редакторов. Параметры форматирования символов пред-
ставлены на рисунке 3.26.

Форматирование абзаца имеет следующие параметры: 
1. Alignment (Выравнивание) – горизонтальное и вертикаль-

ное выравнивание строк. Каждый вариант содержит набор соот-
ветствующих видов выравниваний.

2. Spacing (Расстояние) включает две группы: 
 y Paragraph and Line (Абзац и строка) – устанавливает от-

ступы перед (Before Paragraph) и после (After Paragraph) абзаца, 
а также расстояние между строками абзаца (Line). Измеряется 
расстояние в выбранных в верхней части окна единицах: в про-
центах от размера символов (% of Char. height), в процентах от 
размера объекта (% of Pt. size) или в точках (points); 

 y Language, Character and Word (Язык, символ и слово) – уста-
навливает расстояние между символами, набранными в разных 
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раскладках клавиатуры (Language), просто между символами 
(Character) и между словами (Word). 

3. Indents (Отступы) – устанавливает отступы: для первой 
(красной) строки (First Line), левой (Left) и правой (Right) границ 
абзаца. 

Рис. 3.26. Форматирование символов

На вкладке Tabs (Табуляции) окна Format Text (Форматиро-
вание текста) определяются позиции и типы табуляций.

Вкладку Columns (Колонки) используют для разбиения тек-
ста на несколько колонок.

Вкладка Effects (Эффекты) служит для создания маркирован-
ных списков и буквицы (большой буквы в начале абзаца, занима-
ющей по высоте несколько строк). 

Вкладки  Tabs (Табуляции), Columns (Колонки) и Effects (Эф-
фекты) актуальны только для простого текста.

В главном меню Text (Текст) также расположены команды:
 y редактирования текста (Edit Text; Ctrl + Shift + T);
 y вставки символов (Insert Characters; Ctrl + F11);
 y выравнивания символов по базовой линии текста฀ (Align to 

Baseline; Alt + F12);
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 y выпрямления символов текста – Straighten Text (Выровнять 
текст).

Кроме того, в списке команд главного меню Text можно найти:
 y проверку орфографии, грамматики, выбор языка и др. – в 

выпадающем списке Writing Tools (Инструменты письма);
 y выбор кодировки – Encode (Кодировка);
 y смену регистра – Change Case (Регистр);
 y статистику по тексту – Text Statistic (Статистика текста) и др.

С точки зрения оформления наибольший интерес вызывают 
команды:

 y расположить текст вдоль некоторой линии – Fit Text to Path 
(Текст вдоль пути);

 y расположить текст внутри рамки – Fit Text to Frame (Под-
гонка текста под рамку).

Инструмент Fit Text to Path (Текст вдоль пути) позволяет раз-
местить текст по направляющей. Направляющими могут слу-
жить линия, эллипс, дуга эллипса. 

1-й способ. Ввести фигурный текст, создать направляющую. 
Последовательно выделить объект Artistic Text, затем направляю-
щую и выполнить команду Text ⇒ Fit Text to Path (Текст ⇒ Текст 
вдоль пути). 

2-й способ. Создать направляющую, например эллипс, вы-
брать инструмент Text на панели графики и подвести текстовый 
курсор к направляющей так, чтобы рядом с вертикальной чер-
той курсора появилась волнистая линия. После этого щелкнуть 
кнопкой мыши и ввести текст. 

В обоих случаях после создания совмещенного текстово-гра-
фического объекта на панели свойств появляются инструменты 
редактирования (рис. 3.27):

 y список ABC (Ориентация текста) – меняет ориентацию 
символов (сжимает, раздвигает веером);

 y Mirror Text Vertically (Отразить по вертикали) – позволяет 
перевернуть текст сверху вниз;

 y Mirror Text Gorizontally (Отразить по горизонтали) – меняет 
положение текста (слева, справа);

 y Distance from Path (Расстояние от пути) – позволяет подни-
мать и опускать текст относительно направляющей;

 y Horizontal Offset (Горизонтальное смещение) – позволяет 
смещать текст по горизонтали. 
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Ориентация текста
Горизонтальное 

смещение

Отразить по 

вертикали

Отразить по горизонтали
Расстояние от пути

Рис. 3.27. Расположение текста по направляющей

Для ввода и форматирования простого текста Paragraph Text 
выбирают объект Text (А) и растягивают текстовую рамку. Вну-
три рамки выбирают параметры текста и вводят текст, причем:

1) переход на новую строку осуществляется автоматически 
при достижении текстом правой границы рамки;

2) нажатие клавиши Enter выполняет переход на новый абзац;
3) при достижении нижней границы рамки вводимые симво-

лы пропадают из области отображения.
Учитывая вышеизложенное, при вводе больших текстовых 

фрагментов удобно использовать окно редактирования текста 
Edit Text или импорт текста из внешнего файла (например, соз-
данного в MS Word), инициализируемый командой Import того же 
окна редактирования текста.

Размеры текстового блока можно изменять с помощью ма-
нипуляторов. Если в нижнем манипуляторе находится черный 
треугольник, то это означает, что не весь текст отображается 
в текстовом блоке. Можно перенести часть текста в другой блок. 
Для этого необходимо щелкнуть по нижнему манипулятору бло-
ка. Курсор примет вид стрелки с текстовым листком. Протянув 
таким указателем по странице, можно создать новую рамку, в ко-
торую будет помещен текст, расположенный за пределами види-
мости исходной рамки (рис. 3.28).
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Рис. 3.28. Перетекание текста из одного блока в другой

Рамки из одной цепочки связаны синими стрелками, не ото-
бражаемыми при печати. По форме и заполнению верхних и ниж-
них маркеров-индикаторов рамок определяют местоположение 
рамки в цепочке и наличие в ней неразмещенного текста. Напри-
мер, у первой рамки в цепочке верхний индикатор пустой, а ниж-
ний имеет вид маленького листка с текстом. У последней рамки 
пустым является нижний индикатор или же он имеет вид стрел-
ки, направленной вниз (при наличии неотображенного текста).

Чтобы изменить форму следующей рамки в цепочке, необ-
ходимо:

1) создать криволинейный объект желаемой формы. Это мо-
жет быть эллипс, многоугольник, произвольная кривая и т. п.;

2) щелкнуть указателем инструмента Text на нижнем инди-
каторе последней рамки цепочки;

3) указать на контур или внутрь криволинейного объекта 
так, чтобы он принял форму широкой черной стрелки, направ-
ленной вправо;

4) выполнить щелчок на объекте, после чего создастся новая 
рамка.

Рамку в составе цепочки можно удалить клавишей Delete, 
при этом текст перераспределится по оставшимся рамкам по на-
правлению к последней.

Рамки в составе одной цепочки могут размещаться на разных 
страницах документа CorelDRAW непосредственно в процессе 
их создания. Перемещение готовой текстовой рамки на другую 
страницу выполняется инструментом Pick сначала за пределы 
страницы на рабочее пространство, а потом – на другую страни-
цу после ее отображения на экране.

После создания новой замкнутой рамки можно выполнить разъединение 

объектов командой Object ⇒ Break Apart (Ctrl + K) и удалить управляющий 

объект. При расположении текста вдоль незамкнутой кривой ее можно 

сделать невидимой, отменив контур.
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Вставка в текст графических объектов. Для того чтобы встав-
ленные в текст графические объекты обтекались текстом, необ-
ходимо выполнить команду Wrap Paragraph Text (Обтекание про-
стым текстом) контекстного меню объекта. Выполнение данной 
операции показано на рисунке 3.29.

Рис. 3.29. Обтекание графического объекта 

Обтекание текстом – это режим, при котором простой текст 
размещается с учетом формы объектов, перекрывающих рамку 
или цепочку связанных рамок. Обтекание текстом, отключен-
ное по умолчанию (None (Без обтекания)), предусмотрено для 
всех объектов CorelDRAW, у которых на панели свойств имеется 
кнопка Wrap Paragraph Text (Обтекание простым текстом) и свя-
занное с ней меню. 

Режимы обтекания делят на две группы:
 y по контуру объекта (список Contour), когда в качестве гра-

ницы области, вне которой размещается текст, выступает грани-
ца объекта;

 y по рамке выделения (список Square), когда в качестве гра-
ницы области, вне которой размещается текст, выступает прямо-
угольная рамка выделения объекта.

В том же меню с помощью счетчика Text Wrap (Перенос тек-
ста) указывают минимальное расстояние между текстом и обте-
каемым объектом.

Практические задания по пункту 3.8

Задание 1.Задание 1.  Текст вдоль пути. 
Рекомендации по выполнениюРекомендации по выполнению
1. Создайте фигурный текст «СБЕРЕЖЕМ ПЛАНЕТУ!». Гар-

нитура – Arial; кегль – 18 пт. Придайте тексту зеленый цвет. 
2. С теми же параметрами создайте текст «ДЛЯ БУДУЩИХ 

ПОКОЛЕНИЙ!».
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3. Выберите символ (например, земного шара). Для этого 
выполните команду Text ⇒ Insert Character ⇒ Webdings (Текст ⇒ 
Вставить символ ⇒ Символьный набор) и в наборе иллюстраций 
выберите нужную.

4. Удерживая клавишу Shift, выделите инструментом Pick (Вы-
бор) изображение планеты и текст «СБЕРЕЖЕМ ПЛАНЕТУ!».

5. Выберите команду Text ⇒ Fit Text to Path (Текст ⇒ Текст 
вдоль пути) – и надпись окажется на окружности. 

6. Для того чтобы увеличить отступ текста от кривой, на па-
нели свойств введите в поле Distance from Path (Расстояние от 
пути) значение 2, а в поле Horizontal Offset (Горизонтальное сме-
щение) – значение –20.

7. Рядом с окружностью постройте кривую линию с помо-
щью инструмента Freehand (Произвольная форма). 

8. Удерживая клавишу Shift, выделите инструментом Pick 
кривую и текст «ДЛЯ БУДУЩИХ ПОКОЛЕНИЙ!».

9. Еще раз примените команду Text ⇒ Fit Text to Path (Текст ⇒ 
Текст вдоль пути), чтобы надпись оказалась на кривой.

10. В поле Horizontal Offset (Горизонтальное смещение) введи-
те значение 10.

11. Отделите текст от кривой (Break Apart) и удалите кривую.
Задание 2. Задание 2. Верстка в несколько колонок. 
Рекомендации по выполнениюРекомендации по выполнению
1. Вставьте блок простого текста. Откройте редактор текста. 
2. Скопируйте в буфер обмена большой фрагмент любого тек-

ста и вставьте в окно редактора. В появившемся диалоговом окне 
установите переключатель Maintain Fonts and Formatting (Поддер-
живать шрифты и форматирование).

3. Выполните команду Text ⇒ Format Text. В открывшемся 
окне выберите закладку Columns (Колонки) и введите нужное 
значение количества колонок в соответствующее поле – 2.
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4. Снимите флажок (или убедитесь, что он снят) Equal Co-
lumns Width (Колонки равной ширины). Теперь можно произволь-
но менять ширину колонок независимо друг от друга. 

5. Установите переключатель Maintain Current Frame Width 
(Сохранять ширину рамки) – ширина блока остается постоян-
ной при настройке колонок и средников, т. е. ширина колонки 
не может превысить размера блока. 

6. Измените ширину колонок: первая – 40 мм, вторая – 80 мм. 
7. Перейдите на вкладку Effect и создайте эффект буквицы 

(увеличенная первая буква текста).

Контрольные вопросы
1. Назовите основные классы текстовых объектов.

2. Что такое обтекание простым текстом?

3. Перечислите операции, которые недоступны для текста, но становятся до-

ступными после преобразования его в кривые.

4. Как изменить формы рамки в цепочке простого текста?

5. С помощью каких средств можно задать и настроить обтекание объектов тек-

стом?

6. Перечислите основные параметры символов и способы их изменения.

7. Можно ли ввести фрагмент, состоящий из нескольких абзацев, для фигурного 

текста? для простого текста?

8. Перечислите виды выравнивания по ширине.

9. Как можно отличить введенный фрагмент фигурного текста от фрагмента 

простого текста?

10. Перечислите виды интервалов между словами.

11. Какие способы получения копий объектов существуют в программе?

12. Назовите способы изменения масштаба объекта.

13. Опишите окно редактирования текста. Как оно отображается, каков состав 

окна?

14. Всегда ли можно разместить в несколько колонок фрагмент простого текста? 

Как это осуществить?

15. Опишите существующие возможности настройки текста вдоль контура.

16. Приведите порядок ввода фрагмента фигурного текста. Какой алгоритм при-

меняют при вводе простого текста?

17. Как вставить в текст символ, которого нет на клавиатуре?

3.9. Допечатная подготовка векторных файлов в CorelDRAW

Созданный в программе документ (визитная карточка, 
элемен ты фирменного стиля, буклет, брошюра, рекламный ли-
сток, плакат и др.) можно напечатать на офисном принтере или 
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другом устройстве вывода. Кроме того, в программе имеется воз-
можность создать PostScript-файл и выполнить цветоделение. 
При подготовке изображений для печати следует иметь в виду 
два обстоятельства. Во-первых, для воспроизведения цвета на 
мониторе и на бумаге используются разные цветовые модели. По-
этому для получения хороших результатов при печати необходи-
мо правильно указать цветовые профили монитора и выводного 
устройства. Для этого в CorelDRAW реализованы возможности 
управления цветовоспроизведением. Во-вторых, цветоделение 
и печать публикаций содержат множество аспектов, связанных 
с работой и настройками оборудования и программ, специаль-
ными условиями работы, поэтому обязательным условием для 
получения качественных оттисков является выполнение требо-
ваний по представлению изображений. 

Для макета, созданного в CorelDRAW, перед цветоделени-
ем все эффекты (прозрачность, тени, линзы и др.) необходимо 
командой Bitmapes ⇒ Convert to Bitmap (Растры ⇒ Преобразовать 
в растровую графику) преобразовать в пиксельные изображе-
ния. Обводки объектов командой Object ⇒ Convert Outline to Object 
(Объект ⇒ Преобразовать обводку в объект) необходимо преоб-
разовать в объекты. Текстовые блоки, особенно с малым кеглем, 
командой Text ⇒ Fit Text to Path (Текст ⇒ Текст вдоль пути) следу-
ет преобразовать в контуры. 

Команда File ⇒ Print (Файл ⇒ Печать) открывает диалого-
вое окно настроек печати, которые зависят от типа выбранного 
принтера. Все параметры диалогового окна Print (Печать) мож-
но сохранить в отдельном так называемом файле стиля печати. 
Для этого в нижней части диалогового окна необходимо нажать 
кнопку Save As (Сохранить как), в диалоговом окне Save Settings 
As (Сохранить установки как) отметить флажками те параметры 
печати, которые вы планируете включить в создаваемый стиль, 
и задать его имя.

На вкладке General (Общие) расположены элементы назна-
чения для печати принтера, задания диапазона печати и числа 
копий документа, создания стилей печати и перехода в диалого-
вое окно предварительного просмотра документа перед печатью. 

Вкладка Layout (Макет) диалогового окна печати предназна-
чена для настройки макета печатной страницы. Для распечатки 
документов, размер которых превышает размер печатной стра-
ницы принтера, необходимо установить флажок Print Tiled Pages 
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(Печать по частям) и указать необходимые значения в полях # of 
tiles (Количество частей), Tile Overlap (Перекрытие частей) или 
% of page width (Процент перекрытия от ширины страницы). Фла-
жок Tiling Marks (Метки разбивки) обеспечивает печать меток, 
позволяющих точно соединить фрагменты после их распечатки. 
В случае необходимости расположить изображение в углу до-
кумента без полей следует установить флажок Bleed Limit (Печать 
под обрез). При этом конечный размер изображения по отно-
шению к размеру печатной страницы будет меньше на заданное 
значение. 

Вкладка Layout (Макет) содержит список Imposition Layout 
(Компоновка макета) вариантов печати документа на отдельных 
листах, в виде книги, буклета и т. д. 

Как уже отмечалось, для создания полиграфической цвет-
ной публикации необходимо выполнить ее цветоделение. Перед 
цветоделением необходимо выполнить преобразование цветов из 
цветовой модели RGB в цвета модели CMYK. В процессе цвето-
деления все цвета изображения триадных цветов (Process Color) 
разделяются на основные цвета цветовой модели CMYK (Cyan, 
Magenta, Yellow, Black). Если в изображении присутствуют пла-
шечные цвета (Spot Color), то они не разделяются на составные 
цвета, а остаются дополнительными цветами печати. Конечным 
этапом цветоделения является создание пленок (цветоделенных 
форм) для каждого из триадных и плашечных цветов иллюстра-
ции. Для этого выполняют растрирование изображения в RIP 
(Raster Image Processor) фотонаборного автомата, в котором затем 
и экспонируют пленки. 

В CorelDRAW параметры цветоделения находятся на вклад-
ке Separation (Цветоделение). Они устанавливаются только тогда, 
когда нужно напечатать для каждого цвета пленки или создать 
PostScript-файл, который послужит источником для печати цве-
тоделенных полос на другом компьютере или фотонаборном ав-
томате. 

Первое, что необходимо сделать для задания параметров 
цветоделения, – установить флажок Print Separations (Печатать 
цветоделенные полосы) на вкладке Color (Цвет). После этого ото-
бразится вкладка Separation (Цветоделение) и станут доступными 
следующие флажки: 

 y Print Separations in Color (Печатать цветоделенные полосы 
в цвете). Обычно цветоделенные полосы печатаются в градаци-
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ях серого с плотностью соответствующего цвета в изображении. 
Этот флажок устанавливают исключительно тогда, когда хотят не 
получить пленки, а распечатать и оценить вклад каждого цвета 
модели CMYK в иллюстрацию;

 y Convert Spot Color to Process (Преобразование плашечных 
цветов в триадные);

 y Show Empty Plates (Отобразить пустые полосы) – позволяет 
напечатать и те пленки, цвета которых отсутствуют в изображе-
нии, и страницы без объектов;

 y Use Advanced Settings (Использовать усложненные настрой-
ки) – активизирует поля списка используемых в иллюстрации 
красок и их параметры. Так, если кроме четырех основных кра-
сок включены дополнительные плашечные цвета, то вывод цве-
тоделенной полосы для каждого из этих цветов можно отменить, 
если снять флажок перед названием цвета. 

Для каждого из цветов приведены следующие параметры: 
 y Order (Порядок) – определяет очередность печати каждой 

краски; 
 y Frequency (Линиатура) – одним из параметров, влияющих 

на назначение линиатуры (кроме, конечно, возможностей печат-
ной машины), является тип бумаги. Так, газеты печатают с ли-
ниатурой 70–90 lpi, обычные книги, журналы – с линиатурой 
100–133 lpi и высококачественные издания – 150 lpi и выше;

 y Angle (Угол наклона растра) – для того чтобы краски не на-
кладывались друг на друга при печати, каждая краска печатается 
под строго определенным углом, который практически никогда 
не изменяется;

 y Overprint (Перекрытие) – для каждого цвета можно устано-
вить перекрытие («запечатку», печать объекта по фону) для тек-
ста (щелкнуть на кнопке со значком в виде буквы А) или для 
графических изображений (значок в виде страницы). 

При задании параметров цветоделения следует учитывать 
особенности создания печатных пластин (фотоформ), а также 
задавать дополнительные элементы подготовки фотоформ и кон-
троля печати. Эти параметры устанавливают на вкладке Prepress 
(Допечатная подготовка). 

В разделе Paper/Film Settings (Настройки вывода на бумагу 
или пленку) устанавливают вариант Invert (Негатив) и/или Mirror 
(Зеркальное отображение) создания пленки. Эти варианты зави-
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сят от дальнейшего процесса создания печатных пластин и в обя-
зательном порядке должны согласовываться с типографией.

В разделе File Information (Сведения о файле) следует устано-
вить флажок Print File Information (Печатать сведения о файле), 
ввести рабочее имя документа и отметить, нужно ли печатать 
номера страниц. Флажок Print Page Numbers (Печатать номер 
страницы) добавляет к пленке номер страницы, а флажок Position 
Within Page (Разместить в пределах страницы) предназначен для 
печати служебной информации на рабочей странице документа. 

Раздел Crop/Fold Marks (Метки обрезки и сгиба) позволяет 
задать печать следующих меток, которые печатаются за преде-
лами макета страницы и предназначены для использования при 
обрезке листов после печати или их сгиба: 

 y Crop/Fold Marks (Метки обрезки и сгиба); 
 y External Only (За пределами листа) – в этом случае обрез-

ные метки в пределах листа не печатаются.
Флажок Marks to Objects (Метки рядом с объектами) предназна-

чен для печати обрезных меток на границе с объектами рисунка.
Раздел Registration Marks (Метки приводки) предназначен для 

задания стиля и печати приводных меток. Метки приводки по-
зволяют точно совместить отдельные печатные пластины и та-
ким образом обеспечить совмещение красок при печати. 

Следующий раздел вкладки Calibration Bar (Калибровочные 
шкалы) содержит флажки для задания печати калибровочных 
шкал основных цветов (Color Calibration Bar) и денситометриче-
ских шкал Densitometer Scales (Денситометрические шкалы). Ука-
занные шкалы печатники используют в процессе печати тиража 
для контроля, сверки и корректировки цветов. Список Densities 
(Плотности) содержит набор значений плотности тона, которые 
будут выводиться на печать. В случае необходимости их можно 
изменить, введя новые значения с клавиатуры.

Вкладка PostScript доступна при печати на принтере, под-
держивающем этот язык. Параметры вкладки определяют ка-
чество печати векторных объектов и пиксельных изображений 
документа, а также содержат параметры формата PDF и поддерж-
ки технологий OPI (Open Prepress Interface) и DCS (Desktop Color 
Separation). 

Последняя вкладка диалогового окна Print (Печать) Issue 
(Предварительная проверка) предназначена для пояснения при-
чин проблем печати и указания способов их устранения. 
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Практические задания по пункту 3.9

Задание 1. Задание 1. Печать композитного изображения. 
Рекомендации по выполнениюРекомендации по выполнению
1. Откройте документ, подготовленный для печати, и устано-

вите текущей страницу, которую необходимо распечатать. 
2. Выберите команду File ⇒ Print (Файл ⇒ Печать). 
3. В диалоговом окне Print (Печать) на вкладке General (Об-

щие) выберите принтер.
4. Установите количество печатных копий и стиль печати. 
5. Для задания расположения иллюстрации на печатной 

странице перейдите на вкладку Layout (Макет). 
6. В разделе Image Position and Size (Расположение на страни-

це и размер изображения) установите переключатель Reposition 
Images to (Сместить изображение к) и из списка вариантов рас-
положения выберите вариант Center of Page (В центре страницы).

7. Установите другие параметры и нажмите кнопку Print (Пе-
чать).

Задание 2. Задание 2. Печать по частям. 
Рекомендации по выполнениюРекомендации по выполнению
1. Создайте новый документ. 
2. Установите размер страницы А2 (420×594 мм), ориентацию 

Landscape (Альбомная). 
3. Создайте прямоугольник по размеру страницы инструмен-

том Rectangle (Прямоугольник). Закрасьте прямоугольник сплош-
ной светлой заливкой. 

4. Создайте макет плаката по размеру документа.
5. Выберите команду File ⇒ Print (Файл ⇒ Печать). 
6. В диалоговом окне Print (Печать) на вкладке General (Об-

щие) выберите принтер с размером рабочей страницы A4. 
7. Установите количество печатных копий и стиль печати.
8. Для задания параметров печати по частям перейдите на 

вкладку Layout (Макет). 
9. В разделе Image Position and Size (Расположение на стра-

нице и размер изображения) включите переключатель Reposition 
Images to (Сместить изображение к) и в списке справа выберите 
вариант Top Left Corner (В левом верхнем углу). 

10. Установите флажок Print Tiled Pages (Печать по частям) и 
в поле % of page width (Процент перекрытия от ширины страни-
цы) введите значение 2 %. Будет установлен размер перекрытия, 
равный примерно 4,2 мм.
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Следует иметь в виду, что части изображения, попадающие в перекрытие, 

при печати будут повторяться на обоих соседних фрагментах, что позво-

лит удобно выполнить соединение иллюстрации. 

11. Установите флажок Tiling Marks (Метки разбивки). 
12. Просмотрите документ перед печатью – Print Preview 

(Просмотр печати). В окне просмотра печати на панели свойств 
щелкните на кнопке Full Screen (Полноэкранное представление). 
Нажмите клавишу F9, чтобы вернуться в окно просмотра Print 
Preview (Просмотр печати). 

13. Нажмите кнопку Print (Печать), чтобы выполнить печать 
иллюстрации.

ЗадЗадание 3. ание 3. Цветоделение и создание PostScript-файла. 

Для создания PostScript-файла необходимо установить на компьютере 

драйвер любого PostScript-принтера или фотонаборного автомата. 

Рекомендации по выполнениюРекомендации по выполнению
1. Откройте иллюстрацию, для которой нужно создать 

PostScript-файл.
2. Выберите команду File ⇒ Print (Файл ⇒ Печать). 
3. В диалоговом окне Print (Печать) на вкладке General (Об-

щие) выберите принтер. 
4. Установите флажок Print to File (Печать файла). Обеспечи-

вает сохранение сепарированного файла. 
5. Установите флажок Use PPD (Использовать PPD) и под-

ключите файл описания принтера.
6. Щелкните на кнопке Properties (Свойства) и в диалоговом 

окне PPD Properties (Свойства PPD) в списке Paper Size (Размер 
бумаги) выберите подходящий размер бумаги. Поскольку слу-
жебная информация печатается за пределами макета страницы, 
размер бумаги должен быть больше размера документа.

7. В разделе Orientation (Ориентация) установите требуемую 
ориентацию страницы. 

8. Закройте диалоговое окно PPD Properties (Свойства PPD) 
и перейдите на вкладку Separation (Цветоделение). В области 
Color (Цвет) установите флажок Print Separation (Печатать цвето-
деленные полосы).

9. Установите флажки Preserve Document Overprints (Сохранять 
перекрытия) и Always Overprint Black (Всегда выполнять перекры-
тие черным цветом). 
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10. В списке цветов отметьте те цвета, цветоделенные полосы 
для которых нужно получить. Как правило, это все основные цве-
та модели CMYK и плашечные цвета, имеющиеся в изображении.

11. Перейдите на вкладку Prepress (Допечатная подготовка). 
Установите флажки Print File Information (Печатать сведения о 
файле), Print Page Numbers (Печатать номера страниц), Crop/Fold 
Marks (Метки обрезки и сгиба), Print Registration Marks (Печатать 
метки приводки), Color Calibration Bar (Калибровочные шкалы) и 
Densitometer Scales (Денситометрические шкалы).

12. Перейдите на вкладку PostScript. В списке Compatibility 
(Совместимость) выберите уровень языка Level 2. 

13. Отключите флажок Conform to DSC (Соответствие Do-
cument Structuring Convention). 

14. В разделе Bitmaps (Растры) установите вариант сжатия 
None (Без сжатия), так как при сжатии по формату JPEG проис-
ходят потери цветовой информации.

15. Оставьте включенными флажки Maintain OPI Links (Со-
хранять связи OPI) и Resolve DCS Links (Разрешить связи DCS). 

16. В списке Screen Frequency (Линиатура растра) выберите 
требуемую линиатуру растра – значение 150 lpi. 

17. В разделе Fonts (Шрифты) установите флажок Download 
Type 1 Fonts (Загрузить шрифты Type 1). 

18. В нижней части диалогового окна Print (Печать) щелкни-
те на кнопке Print Preview (Просмотр печати).

Контрольные вопросы
1. Как в CorelDRAW создать PostScript-файл? Укажите его назначение.

2. Какие настройки печати доступны на вкладке General?

3. Как сохранить настройки печати?

4. Каким образом масштабировать изображение, чтобы оно занимало всю пе-

чатную область страницы?

5. Как распечатать документ, размер которого превышает размер печатной стра-

ницы принтера, по частям?

6. Какие варианты печати содержит список Imposition Layout (Компоновка ма-

кета) вкладки Layout (Макет)? Назовите параметр, который необходимо устано-

вить, чтобы можно было задать параметры цветоделения.

3.10. Интерфейс графического редактора Adobe Illustrator

Принципы работы с элементами интерфейса и настройка ра-
бочей среды в редакторе Adobе Illustrator в основном аналогичны 
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Adobe Photoshop и другим продуктам от Adobе. Окно программы 
(рис. 3.30) содержит следующие элементы:

1 – панель приложения с переключателем рабочих про-
странств, строкой меню и другими элементами управления при-
ложением;

2 – палитры, которые упрощают отслеживание и изменение 
обрабатываемого объекта;

3 – окно документа, которое состоит из рабочей и монтаж-
ной областей, в которых отображается рисунок;

4 – строка состояния, на которой отображаются сведения 
о текущем состоянии выбранного инструмента;

5 – панель инструментов для создания и редактирования 
изображений, графических объектов, элементов страниц и т. д. 
Связанные инструменты располагаются в группах;

6 – панель управления (атрибутов или свойств) с параметра-
ми текущего выбранного объекта. К ней также можно перей ти 
c помощью команды меню Window ⇒ Properties (Окно ⇒ Свой-
ства).

1
6

5 4 2

3

Рис. 3.30. Окно программы Adobe Illustrator

Монтажная область – это часть окна программы, в кото-
рой отображается распечатываемый рисунок. Монтажная область 
обозначается прямоугольником с тонкой обводкой. Для настрой-
ки размера, ориентации и единиц измерения монтажной обла-
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сти используют диалоговое окно Document Setup (Параметры до-
кумента), для его отображения служит команда File  ⇒ Document 
Setup (Файл ⇒ Параметры документа). Скрыть или отобразить 
монтажную область можно с помощью команды меню View ⇒ 
Hide/Show Аrtboard (Вид ⇒ Скрыть/Отобразить монтажную об-
ласть). Количество монтажных областей можно устанавливать 
при создании документа, в процессе работы можно добавлять 
новые или удалять существующие. Задавать размеры монтажных 
областей и впоследствии изменять их можно с помощью пали-
тры Artboards (Монтажные области) либо инструмента Artboard 
(Монтажная область). 

В палитрах Adobe Illustrator содержатся наборы либо настрой-
ки. Полный перечень доступных палитр отображается в меню 
Window (Окно). Начальное расположение палитр восстанавлива-
ется командой Window ⇒ Workspace ⇒ Essentials (Окно ⇒ Рабочее 
пространство ⇒ Необходимое).

Перемещая и изменяя размеры окон документов, палитр 
и панелей, можно создать пользовательское рабочее простран-
ство для обеспечения максимального комфорта при работе с про-
граммой. Управление пользовательскими пространствами осу-
ществляют с помощью команд меню Window. 

Программа использует три различных режима экрана, пред-
ставленных тремя значками в нижней части панели инструментов: 

 y Standard Screen Mode (Стандартный режим экрана);
 y Full Screen Mode with Menu Bar (Полноэкранный режим со 

строкой меню);
 y Full Screen Mode (Полноэкранный режим). 

Для переключения между режимами используется клавиша F.
Для изменения режимов просмотра документа служат ко-

манды меню View (Вид). Программа по умолчанию использует 
режим просмотра Preview (Предварительный просмотр). Также 
существуют режимы просмотра: 

 y Outline (Макет) – отображаются только обводка всех объ-
ектов и прямоугольные контуры иллюстраций;

 y Overprint Preview (Отображение наложения) – отображают-
ся области наложения цветов;

 y Pixel Preview (Отображение в пикселях) – режим позволяет 
трансформировать векторные изображения в растровые, чтобы 
отобразить документ в стандарте Web-браузера.
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Для изменения масштаба отображения и перемещения по до-
кументу используют те же средства, что и в Adobe Photoshop. 
Также устанавливают параметры и отображение сетки, линеек, 
направляющих и работают с ними. 

Основные настройки Adobe Illustrator доступны в окне 
Preferences (Настройки), которое открывается с помощью коман-
ды Edit ⇒ Preferences (Редактирование ⇒ Настройки). 

Контрольные вопросы
1. Перечислите основные элементы окна Adobe Illustrator.

2. Что такое монтажная область? Как установить ее размер, скрыть и отобразить 

монтажную область?

3. Какие режимы отображения документа наиболее часто используют в Adobe 

Illustrator? Как изменить режим отображения документа?

4. Какие приемы работы с элементами интерфейса Adobe Photoshop применимы 

в Adobe Illustrator? Приведите примеры. 

3.11. Работа с графическими объектами в Adobe Illustrator

3.11.1. Создание контуров и фигур

Все инструменты Adobe Illustrator делят на следующие кате-
гории:

 y рисование;
 y выделение;
 y текст;
 y раскрашивание;
 y изменение;
 y навигация.

Все инструменты рисования создают контуры. Основные ин-
струменты построения контуров размещены в группе Pen (Перо):

 y Pen (клавиша P) – предна-
значен для рисования кривых;

 y Add Anchor Point (Добавить 
опорную точку, +) – позволяет до-
бавлять узлы в уже существующем 
контуре;

 y Delete Anchor Point (Удалить опорную точку, –) – позволяет 
удалять лишние узлы;

 y Convert Anchor Point (Преобразовать опорную точку, Shift + C) – 
предназначен для редактирования изгибов контура.
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Для создания графических примитивов используют следую-
щие инструменты:

 y Rectangle (Прямоугольник);
 y Rounded Rectangle (Прямо уголь-

ник со скругленными углами);
 y Ellipse (Овал);
 y Polygon (Многоугольник);
 y Star (Звезда);
 y Flare (Блик).

С помощью инструмента Polygon (Многоугольник) можно 
создавать геометрические объекты с определенным количеством 
одинаковых по размеру сторон, которые будут находиться на од-
ном расстоянии от центра фигуры. Параметры создаваемого объ-
екта:

 y Radius (Радиус) – расстояние от центра фигуры до одного 
из углов;

 y Sides (Количество сторон) – количество сторон много-
угольника.

Инструмент Star (Звезда) позволяет создавать фигуру звезды 
со следующими параметрами: количество лучей, внешний и вну-
тренний радиусы. Построение фигуры начинают из центральной 
точки.

Объекты создают как по заданным параметрам, так и про-
извольно.

Для создания пропорциональной фигуры необходимо удерживать клавишу 

Shift в процессе построения. Чтобы строить объекты из центра, в процессе 

создания необходимо удерживать клавишу Alt, а для создания пропорцио-

нальной фигуры из центра – клавиши Shift + Alt. С помощью клавиши Про-

бел можно перемещать фигуру в момент ее создания. Чтобы изменить ра-

диус округления углов при использовании инструмента Rounded Rectangle 

(Прямоугольник со скругленными углами), следует удерживать клавиши 

<↑> или <↓> во время создания объекта.

Чтобы задать параметры инструмента, следует выбрать не-
обходимый инструмент и щелкнуть левой кнопкой мыши по ра-
бочей области, затем в открывшемся окне задать требуемые па-
раметры (рис. 3.31). 

В текстовых полях для ввода цифровых значений можно использовать 

простые математические выражения, содержащие один математический 
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оператор: + (плюс), – (минус), × (умножение), / (деление) или % (процент). 

Например, 3 см × 50 % равняется 3 сантиметрам, умноженным на 50 %, 

или 1,50 см.

Рис. 3.31. Параметры инструмента Rectangle

Создание открытых (незамкнутых) контуров осуществляют 
с помощью инструментов:

 y Line Segment (Отрезок линии) – рисо-
вание прямых линий под разными углами;

 y Arc (Дуга) – создание изогнутых 
линий; 

 y Spiral (Спираль) – рисование спи-
рали;

 y Rectangular Grid (Прямоугольная 
сетка) – создание таблиц и сеток;

 y Polar Grid (Полярная сетка) – соз-
дание полярной сетки.

Инструмент Pencil (Карандаш) по-
зволяет рисовать открытые и замкнутые 
контуры. Инструмент Path Eraser (Стира-
ние контура) предназначен для стирания 
частей контура, а Smooth (Сглаживание) – 
для упрощения и сглаживания контуров.

При рисовании программа создает опорные точки и помеща-
ет их на контуре. Количество задаваемых опорных точек опреде-
ляется длиной и сложностью контура, а также установками до-
пуска Fidelity (Точность) (рис. 3.32) в диалоговом окне Pencil Tool 
Options (Параметры инструмента Карандаш).

Перед тем как изменить какой-либо объект, его нужно вы-
делить среди остальных на рабочей области документа Ado-
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be Illustrator. Выделенный объект обозначен вспомогательными 
элемен тами интерфейса:

 y Bounding Box (Габаритный контейнер) – с помощью 
данного контейнера можно совершать произвольную транс-
формацию (поворот, масштабирование). Габаритный контей-
нер отображается только при выделении объекта инструмен-
том Selection (Выделение);

 y Edges (Границы объекта) – показывают контур объекта и 
опорные точки.

Рис. 3.32. Параметры инструмента Pencil

Отображение вспомогательных элементов интерфейса осу-
ществляется с помощью команд меню View (Вид).

Для выделения объектов используют инструменты:
 y Selection (Выделение) – 

позволяет выделять объекты 
и группы объектов щелчком 
мыши на них или с помо-
щью рамки выделения, об-
водя необходимые объекты;

Для выделения нескольких объектов можно использовать клавишу Shift, 

удерживая ее в процессе выделения. Повторный щелчок кнопкой мыши на 

объекте при нажатой клавише Shift позволяет отсоединить его от группы 

выделения.

Lasso

Magic 

Wand

Selection
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 y Direct Selection (Частичное выделение) – дает возможность 
выделять и редактировать узлы объекта или части контура;

 y Group Selection (Выделение в группе) – позволяет выделить 
объект в группе, одну группу внутри нескольких или несколь-
ко групп в изображении. Каждый следующий щелчок кнопкой 
мыши по объекту выделяет объекты следующей группы;

 y Lasso (Лассо) – позволяет выделить объекты целиком, узлы 
либо части обводки объекта, перемещая курсор вокруг объекта 
или его части;

 y Magic Wand (Волшебная палочка) – выделяет по методу по-
добия заливки объектов, атрибутов контура, одинакового режи-
ма отображения.

Команды меню для выделения объектов приведены в табли-
це 3.4.

Таблица 3.4

Команды выделения объектов меню Select

Kоманда Описание

All (Все) Выделение всех объектов в документе

All on Active Artboard (Все на активной 

монтажной области)

Выделение всех объектов активной монтажной 

области

Deselect (Отменить выделение) Снятие выделения со всех объектов

Reselect (Повторить выделение) Повторение последней использованной команды 

выделения

Inverse (Инвертировать) Выделение всех невыделенных объектов и отмена 

выделения всех выделенных объектов

Next Object Above (Следующий объект 

над текущим)

Выделение объекта, находящегося над текущим 

Next Object Below (Следующий объект 

под текущим)

Выделение объекта, находящегося под текущим 

Object (Объект) Выделение объектов одинакового типа, например 

всех текстовых объектов

Same (Подобно) Выделение объектов по общему атрибуту

Save Selection (Сохранить выделение) Сохранение выделенных объектов

Edit Selection (Редактировать вы-

деление)

Редактирование или удаление ранее сохраненных 

выделений объектов

В таблице 3.5 приведены команды подменю Select ⇒ Same 
(Выделение ⇒ Подобно).
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Таблица 3.5

Команды выделения объектов подменю Select ⇒ Same 

Kоманда Описание

Appearance (Внешний вид) Выбор объектов, имеющих те же атрибуты внешнего 
вида, что и у выделенного

Appearance Attribute (Атрибут 
внешнего вида)

Выбор объектов, имеющих тот же атрибут внешнего 
вида, что и у выделенного

Blending Mode (Режим наложения) Выбор объектов с тем же режимом наложения, что и у 
выделенного 

Fill & Stroke (Заливка и обводка) Выделение всех объектов, окрашенных в одни и те же 
цвета и имеющих одинаковую толщину линий

Fill Color (Цвет заливки) Выделение всех объектов с одинаковым цветом заливки

Opacity (Непрозрачность) Выделение объектов с тем же значением непрозрачно-
сти, что и у выделенного

Stroke Color (Цвет обводки) Выделение всех объектов с одинаковым цветом обводки

Stroke Weight (Толщина обводки) Выделение всех объектов с одинаковой толщиной 
обводки

Graphic Style (Графический стиль) Выделение объектов, имеющих одинаковые атрибуты 
стиля

Symbol Instance (Образец  
символа)

Выделение объектов по образцу символа

Link Block Series (Связанные 
блоки текста)

Выделение всех связанных блоков текста

3.11.2. Способы заливки объектов. Оформление контуров

Каждый объект в Adobe Illustrator имеет два базовых атри-
бута: Fill (Заливка) и Stroke (Обводка). Заливкой может служить 
цвет, цветовой градиент либо узор. Заливку можно применить 
как к закрытым, так и к открытым контурам. Обводка может 
выглядеть как внешняя граница фигуры. Заливка и обводка вы-
деленного объекта отображаются вверху на панели управления. 

Блок управления цветом панели инструментов Adobe Illu-
strator содержит следующие элементы:

1 – Fill (Заливка) – индикатор цвета заливки;
2 – Swap Fill and Stroke (Переключатель 

за ливка/обводка) – переключатель атрибутов 
объекта, с помощью которого можно поменять 
местами цвет контура и заливки;

3 – Stroke (Обводка) – индикатор цвета 
контура;

4 – кнопки, которые обеспечивают отображение в активном 
индикаторе заливки или обводки цвета (слева направо): Color 

1

5

4

3

2
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(Цвет) обеспечивает отображение в активном индикаторе залив-
ки или обводки цвета, который определяется в палитре Color 
(Цвет); Gradient (Градиент) обеспечивает отображение в инди-
каторе заливки градиентной заливки, создаваемой в палитре 
Gradient (Градиент); None (Без атрибута) служит для исключения 
параметров для заливки или обводки: заливка исчезает, а об-
водка контура становится невидимой (хотя контур присутствует 
и отображается в режиме Outline (Контурный));

5 – Default Fill and Stroke (Заливка и обводка по умолчанию) – 
значения по умолчанию: заливка – белая, контур черный толщи-
ной 1 пт.

Выбрать цвет для активного атрибута (находится на переднем 
плане) выделенного объекта можно: 

 y в диалоговом окне Color Picker (Выбор цваета), которое 
открывается щелчком по пиктограмме Fill (Заливка) или Stroke 
(Обводка) панели инструментов;

 y в палитре готовых образцов Swatches (Каталог), которую 
можно вызывать командой меню Window ⇒ Swatches (Окно ⇒ 
Каталог).

Присвоить цвет или градиентную заливку объекту можно, не 
выделяя его перемещением из блока управления цветом или из 
палитр Color (Цвет) и Swatches (Каталог). При этом активный 
атрибут поменяет цвет, блок управления цветом цвет не поменяет.

Переносить цветовые параметры с одного объекта на дру-
гой можно с помощью инструментов Paint Bucket (Заливка) 
и Eyedropper (Пипетка).

Для работы с атрибутами используют также клавиши: активизация атри-

бута – X; установка атрибутов по умолчанию – D; смена цветов атрибу-

тов – Shift + X; назначение атрибуту None (Без атрибута) – </> (только на 

английской раскладке клавиатуры).

3.11.3. Транформации объектов

Над объектами в Adobe Illustrator выполняют такие же опера-
ции трансформации, как и в CorelDRAW (см. п. 3.3). 

Способы перемещения объекта:
 y с помощью мыши при активном инструменте Selection 

(Выделение). Нажатием клавиши Shift при выполнении действия 
можно ограничить перемещение строго по вертикали, по гори-
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зонтали или под углом 45°. Нажатие клавиши Alt в момент пере-
мещения объекта позволяет скопировать его;

 y с помощью клавиш управления курсором. Смещение по 
умолчанию составляет 1 пт (1/72 дюйма, или 0,3528 мм). Изме-
нить шаг можно в диалоговом окне General (Общие) (команда 
Edit ⇒ Preference (Редактирование ⇒ Настройки)).

В таблицу 3.6 сведены трансформации, выполняемые с помо-
щью команд меню Object (Объект) и палитры Transform (Транс-
формация). 

Таблица 3.6

Операции над объектами и их параметры

Операция Параметры

Команда Object ⇒ Transform (Объект ⇒ Трансформация)

Scale (Масштаби-

рование)

Параметры масштабирования задают по каждой оси в отдельности 

(Non-Uniform) или пропорционально сразу по двум (Uniform). Чтобы 

изменять размеры обводки и эффектов, примененных к объекту, вместе 

с самим объектом, необходимо установить флажок Scale Stroke & Effects 

(Масштабирование обводки и эффектов)

Move 

(Перемещение)

Параметры Horizontal и Vertical задают смещение: отрицательные значе-

ния влево и вверх, положительные – вправо и вниз. Чтобы переместить 

объект на угол относительно оси X объекта, необходимо задать поло-

жительную (перемещение против часовой стрелки) или отрицательную 

(перемещение по часовой стрелке) величину угла в текстовом поле Angle 

(Угол). Применить перемещение можно к создаваемой копии объекта

Reflect  

(Отражение)
Параметры: контрольная точка (центр трансформации), Flip Horizontal 

(Отразить по горизонтали) или Flip Vertical (Отразить по вертикали). Ось 

выбирают в меню палитры. Объект отражают относительно заданной 

точки габаритного контейнера

Rotate (Поворот) Параметр Angle (Угол). Для поворота по часовой стрелке нужно указать 

значение угла со знаком «–» (минус)

Shear (Наклон) Параметры: угол наклона Shear Angle, ось наклона Horizontal (Горизон-

тально) или Vertical (Вертикально). Если указать значение Angle (Угол), то 

объект наклонится относительно оси, проходящей под заданным углом

Палитра Transform (Трансформация)

Move  

(Перемещение)
Параметры: координаты X и Y контрольной точки выделенного объ-

екта. Координаты считают относительно точки (0; 0), которая по 

умолчанию находится в левом верхнем углу монтажной области. Для 

изменения контрольной точки нужно щелкнуть по одному из маркеров 

на пиктограмме габаритного контейнера в палитре Transform (Транс-

формация)

Scale (Масштаби-

рование)

Параметры: в поле W указывают ширину габаритного контейнера вы-

деленного объекта, а в поле H – высоту
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В случае использования команды меню открывается диало-
говое окно с параметрами соответствующей операции (рис. 3.33), 
в котором можно указать, как применить трансформацию – не-
посредственно к объекту или к создаваемой в процессе выполне-
ния копии. 

При использовании палитры Transform (рис. 3.34) для соз-
дания копии объекта необходимо после ввода значений нажать 
комбинацию клавиш Alt + Enter.

Рис. 3.33. Параметры перемещения 

в диалоговом окне Move

Рис. 3.34. Палитра Transform

Группировку объектов осуществляют с помощью команды 
Object ⇒ Group (Объект ⇒ Группировать, Ctr + G) главного меню. 
Можно создавать вложенные группы, образуя сложную структу-
ру групп.

Для обратного действия – разгруппировки – нужно вы-
полнить команду Object ⇒ Ungroup (Объект ⇒ Разгруппировать, 
Shift + Ctrl + G). Процесс разгруппировки сложных структур 
групп будет производиться в обратном порядке.

Инструмент Group Selection (Групповое выделение) позволя-
ет работать с одним из сгруппированных объектов, не разрывая 
группу.

Инструмент Selection (Выделение) выделяет всю группу, неза-
висимо от того, на каком из объектов произведен щелчок. Двой-
ной щелчок данным инструментом на объекте или группе объ-
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ектов вызывает режим Isolation Mode (Режим изоляции). В этом 
режиме доступны для редактирования только изолированные 
объекты. Вернуться к обычному режиму можно, выполнив двой-
ной щелчок кнопкой мыши за пределами изолированных объек-
тов при активном инструменте Selection (Выделение).

Все объекты в Adobe Illustrator располагаются в определенном 
порядке на рабочей области документа. Они имеют координаты 
по осям X (по горизонтали) и Y (по вертикали). Относительно 
друг друга объекты располагаются по воображаемой оси Z, т. е. 
в виде «стопки», перекрывая друг друга. Чтобы изменить порядок 
следования одного или нескольких объектов, используют коман-
ды контекстного меню Arrange (Монтаж) или команду Object ⇒ 
Arrange (Объект ⇒ Монтаж).

По умолчанию каждый новый документ содержит один слой 
и каждый создаваемый объект помещается в этот слой. 

Однако можно создавать новые слои и распределять объ-
екты по своему усмотрению с помощью палитры Layers (Слои) 
(рис. 3.35), отображаемой командой Window ⇒ Layers (Окно ⇒ 
Слои).

Рис. 3.35. Палитра Layers (Слои)

Принципы работы с ней аналогичны использованию одно-
именной палитры в Adobe Photoshop. Можно создавать шаблон-
ные слои, которые будут использоваться для трассировки изобра-
жения, и обмениваться слоями с программой Adobe Photoshop. 

Выравнивать объекты по одной линии или размещать их на 
равном расстоянии друг от друга позволяет палитра Align (Вырав-
нивание), которая отображается на экране командой Window ⇒ 
Show Align (Окно ⇒ Показать выравнивание).

Кнопки ряда Align Objects (Выровнять объекты) (рис. 3.36) 
позволяют выравнивать выделенные объекты по правому краю, 
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по горизонтальному центру, по левому краю, по верхнему краю, 
по вертикальному центру и по нижнему краю. 

Рис. 3.36. Палитра Align (Выравнивание)

Кнопки ряда Distribute Objects (Распределить объекты) по-
зволяют размещать выделенные объекты на равном расстоянии 
между верхними и нижними краями, между горизонтальными 
центрами, между правыми и левыми краями, между вертикаль-
ными центрами.

Кнопки ряда Distribute Spacing (Распределить с равными про-
межутками) позволяют обеспечить одинаковые расстояния меж-
ду объектами по вертикали и по горизонтали. 

Таким образом кнопки работают, если в списке справа вы-
бран вариант Auto (Автоматически). Если выбрано цифровое зна-
чение, то объекты отодвигаются друг от друга на расстояние, рав-
ное этому значению. Процесс начинается с исходного объекта, 
который определяется инструментом Selection (Выделение). Если 
кнопки нижнего ряда отсутствуют, следует выполнить команду 
Show Options (Показать опции) меню палитры.

3.11.4. Методы комбинирования объектов

В программе Adobe Illustrator можно создавать новые контуры 
или объекты, комбинируя существующие. Результат выполнения 
этих операций зависит от выбранного метода комбинирования.

Для создания составных контуров (Compound Path) и состав-
ных фигур (Compound Shape) используют палитру Pathfinder (Об-
работка контуров) (рис. 3.37), для быстрого объединения и соз-
дания новых фигур предназначен инструмент Shape Builder (Соз-
дание фигур, Shift + M).
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Рис. 3.37. Палитра Pathfinder

С помощью кнопок Shape Modes (Режимы фигур) 
палитры Pathfinder создают цельные контуры. Опера-
ции и результаты их выполнения над исходными объ-
ектами следующие: 

 y Unite (Объединение) – объединение всех участву-
ющих в операции контуров;

 y Minus Front (Вычесть верхние) – cоздание контура 
вычитанием из самого нижнего объекта в стопке всех 
объектов, лежащих выше него; 

 y Intersect (Пересечение) – создание контура, пред-
ставляющего собой пересечение всех выделенных объ-
ектов;

 y Exclude (Исключение) – создание контура, в ко-
торый входят все непересекающиеся детали выделен-
ных объектов. 

При выборе операции с нажатой клавишей Alt образуется 
составная фигура, которая представляет собой редактируемый 
объект, состоящий из двух или более сгруппированных объек-
тов, отображаемый в палитре Layers (Слои) как Compound Shape 
(Составная фигура). Для разгруппирования необходимо нажать 
кнопку Expand (Разобрать) палитры или выполнить команду 
Object ⇒ Expand (Объект ⇒ Разобрать).

При создании составной фигуры в режимах добавления, пересечения и ис-

ключения она получает атрибуты цвета и прозрачности верхнего объекта. 

Для создания составной фигуры можно использовать контуры, составные 

контуры, группы, другие составные фигуры, переходы, текст, оболочки и 
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деформации в составной фигуре. Все выбранные незамкнутые контуры 

автоматически замыкаются.

Одноименные кнопки палитры Pathfinder (Об-
работка контуров) используют для управления эф-
фектами обработки контуров. Ниже представлены 
результаты выполнения этих операций над исходны-
ми объектами: 

 y Divide (Разделение) – разделяет сложный объ-
ект на кусочки, соответствующие всем пересекаю-
щимся областям. Результатом выполнения этой ко-
манды будет группа непересекающихся объектов;

 y Trim (Подрезка) – удаляет скрытые части объ-
ектов и снимает все обводки (объектам присваивает-
ся «пустая» обводка); 

 y Merge (Слияние) – уничтожает скрытые ча-
сти объектов и объединяет прилежащие друг к дру-
гу одинаково окрашенные объекты в общую форму. 
Присваивает всем объектам «пустую» обводку;

 y Crop (Обрезка) – отрезает части объектов, вы-
ступающие за контур верхнего объекта в стопке. Так-
же присваивает всем объектам «пустую» обводку;

 y Outline (Преобразование в контур) – преобра-
зует весь массив объектов в группу контуров без за-
ливки; контуры рассекаются по точкам пересечения 
объектов;

 y Minus Back (Вычесть нижние) – вычитает из 
верхнего объекта все объекты, находящиеся ниже 
него.

Инструмент Shape Builder (Создание фигур) представляет со-
бой интерактивный инструмент для создания сложных форм пу-
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тем слияния и стирания простых фигур. Он выбирает края и об-
ласти объекта, которые можно объединить или удалить для фор-
мирования нового объекта. Край – это любой участок контура, 
который не пересекает контур дру-
гих выбранных объектов, а область 
является замкнутой. Инструмент 
также позволяет разбивать и редак-
тировать перекрывающиеся фи гу-
ры и интуитивно заполнять их цветом с помощью инструмента 
Live Paint Bucket (Выделение быстрых заливок). 

Для создания фигуры необходимо предварительно выбрать 
с помощью инструмента Selection (Выделение) контуры, слияние 
или вычитание которых необходимо выполнить, а затем инст-
рументом Shape Builder (Создание фигур) выделить нужную об-
ласть.

По умолчанию инструмент Shape Builder (Создание фигур) 
находится в режиме слияния; переключение в режим стирания 
осуществляют с помощью клавиши Alt. Нажатие клавиши Shift 
при перетаскивании отображает прямоугольную область для 
объединения нескольких путей.

Контрольные вопросы
1. Перечислите основные инструменты Adobe Illustrator для создания контуров. 

Какие из них предназначены для создания открытых контуров?

2. Назовите способы создания графических примитивов. Каким образом можно 

задать размеры создаваемого объекта?  

3. Перечислите способы выделения объектов. 

4. Как можно выделить объекты одного типа, объекты с одинаковыми атрибу-

тами?

5. Каким образом можно создать составной контур?

6. Перечислите способы создания составных фигур.

7. Какими способами можно назначить цвет заливки и обводки?

8. Назовите средство художественного оформления контуров Adobe Illustrator.

3.12. Работа с цветом. Заливки, обводки и внешний облик

При создании нового документа Adobe Illustrator формирует 
цветовой профиль, который определяет специфику использова-
ния цвета в документе. Изменить цветовую модель документа 
можно, выполнив команду главного меню File ⇒ Document Color 
Mode (Файл ⇒ Цветовая модель документа).
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В программе различают несколько типов цвета:
 y Global Process Color – глобальный триадный (составной) цвет; 
 y Process Color – неглобальный триадный цвет (non-global); 
 y Spot Color – плашечный цвет; 
 y Registration Color – цвет для меток приводки.

Глобальные триадные цвета являются производными по-
лиграфической триады: cyan (голубой), magenta (пурпурный), 
yellow (желтый) и black (черный), хотя могут определяться в лю-
бой из четырех цветовых моделей: CMYK, RGB, HSB и Grayscale 
(CMYK-эквиваленты программа формирует с учетом установок 
диалогового окна Color Settings (Настройка цветов) меню Edit 
(Редактирование)). Их особенностью является то, что они авто-
матически обновляются во всех объектах всего документа, если 
их параметры меняются в палитре Swatches (Образцы). 

Неглобальные составные цвета идентичны по содержанию, 
но сохраняют свои параметры, будучи присвоенными объекту, 
при изменении их в палитре Swatches (Образцы). По умолчанию 
все триадные цвета являются неглобальными.

Плашечные цвета всегда глобальны; при любых изменениях 
плашечного цвета он изменяется во всем документе. Это продик-
товано тем фактом, что каждый плашечный цвет при цветоделе-
нии выводится отдельным оттиском, поэтому желательно исклю-
чить возможность появления нескольких вариантов одного цвета.

Цвет для меток приводки предназначен для технологических 
целей, а именно для вывода объекта на всех цветоделенных от-
тисках.

Палитра Swatches (Образцы) (рис. 3.38) содержит образцы 
цветов, градиентов и узоров, загруженных в программу по умол-
чанию или созданных и сохраненных для последующего исполь-
зования. Библиотеки образцов представляют собой коллекции 
предварительно созданных цветов, градиентов или узоров, вклю-
чая библиотеки красок, такие как PANTONE, а также тематиче-
ские библиотеки, например библиотеки природных, золотисто-
белых и жемчужных тонов. Для загрузки библиотеки предназна-
чена команда Open Swatch Library (Открыть библиотеку образцов) 
меню палитры. 

Команда Window ⇒ Swatch Libraries (Окно ⇒ Библиотеки об-
разцов) предназначена для импортирования в текущую палитру 
цветовых образцов, градиентных растяжек и декоративных зали-
вок из других документов Adobe Illustrator. 
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Рис. 3.38. Палитра Swatches (Образцы)

Палитра Swatches (Образцы) и библиотеки образцов могут 
содержать, кроме цвета, следующие типы образцов:

 y Gradient (Градиент) – тип заливки, представляющий собой 
постепенный переход между двумя или несколькими цветами;

 y Pattern (Узор) – представляет собой группу повторяющихся 
объектов; �

 y None (Без атрибута) – при использовании данного образца 
у выделенного объекта удаляется активный атрибут (заливка или 
обводка); �

 y Color Group (Цветовая группа) – это средство програм-
мы, которое позволяет группировать образцы цветов в палитре 
Swatches (Образцы) по одному из принципов цветовых гармоний 
или представлять собой просто группы цветов, созданных поль-
зователем. Группы могут содержать только составные, плашеч-
ные и глобальные составные цвета. 

Для добавления нового образца необходимо в палитрах Color 
(Цвет) или Gradient (Градиент) подготовить цвет или растяжку 
или же создать объект – элемент декоративной заливки. Затем 
воспользоваться кнопкой New Swatch (Новый образец) в нижней 
части палитры (вторая кнопка справа), которая автоматически 
перенесет цвет или растяжку из цветового индикатора пали-
тры инструментов, или командой New Swatch (Новый образец) 
из меню палитры, которая выводит на экран диалоговое окно 
New Swatch (Новый образец). В окне New Swatch следует ввести 
имя, в списке Color Type (Тип цвета) выбрать один из вариантов: 
Process Color (Составной) – для определения триадного цвета, 
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Spot Color (Плашечный) – для определения плашечного цвета, 
установить флажок Global (Глобальный) в случае, если необходи-
мо глобально изменить параметры составного (триадного) цвета 
во всем документе. В поле Color Mode (Цветовой режим) мож-
но выбрать один из четырех режимов (CMYK, RGB, HSB или 
Grayscale), чтобы определить параметры цвета.

Команда Swatch Options (Параметры образца) из меню пали-
тры выводит на экран одноименное диалоговое окно, идентич-
ное диалоговому окну New Swatch (Новый образец). Его также 
можно вызвать двойным щелчком на конкретном образце.

Для выполнения замены одного образца другим в палитре 
Swatches (Образцы) необходимо удерживать нажатой клавишу Alt. 
При этом происходит глобальная замена в объектах, исключение 
составляют триадные (составные) цвета, у которых снят флажок 
Global (Глобальный).

Палитра Gradient (Градиент) содержит все необходимое для 
создания нового градиента или модификации уже существующе-
го. В раскрывающемся списке Туре (Тип) (рис. 3.39) можно вы-
брать один из двух типов градиента:

 y Linear (Линейный) – цветовой переход вдоль прямой линии; 
 y Radial (Радиальный) – цветовой переход распространяется 

по концентрическим окружностям.

Рис. 3.39. Палитра Gradient (Градиент)

Линейную растяжку можно наклонять, для этого в поле Angle 
(Угол) следует ввести соответствующее значение в диапазоне от 
–180° до 180°.
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Для определения начального цвета растяжки следует щелк-
нуть на левом маркере под полосой просмотра (признаком актив-
ного состояния является черный треугольник над ним) и выпол-
нить одно из следующих действий:

 y щелкнуть на одном из образцов палитры Swatches (Образ-
цы) при нажатой клавише Alt;

 y определить новый цвет в палитре Color (Цвет).
Для определения конечного цвета растяжки нужно щелкнуть 

на правом маркере под полосой просмотра и использовать ука-
занные возможности. 

Цвета для градиентной растяжки могут быть в моделях 
CMYK и RGB, используются также плашечные цвета. 

Начальный и конечный маркеры растяжки можно переме-
щать вдоль полосы, тем самым сужая или расширяя диапазон. 
По умолчанию центральная точка, в которой оба цвета содер-
жатся в одинаковых пропорциях, располагается строго посереди-
не. Если требуется сместить центральную точку, то необходимо 
переместить ромб над полосой просмотра или ввести соответ-
ствующее значение в поле Location (Положение).

Инструмент Gradient (Градиент) позволяет в объекте с рас-
тяжкой в интерактивном режиме изменить направление рас-
тяжки, переопределить начальную и конечную точки растяжки, 
а также присвоить параметры одной и той же растяжки одно-
временно нескольким объектам (растянуть ее на множество объ-
ектов).

Gradient Mesh (Градиентная сетка) – это цветовой переход 
по криволинейному сегменту со множеством значений на сетке. 
При создании сетчатого объекта линии сетки образуют решетку 
из опорных точек. С их помощью можно легко изменять цвето-
вые переходы в объекте. Сеточные объекты не имеют атрибута 
обводки и их нельзя отменить.

Способы создания сеточных объектов: 
1) создание сеточного объекта при помощи инструмента Mesh 

(Сетка);
2) использование команды Create Gradient Mesh (Создать гра-

диентную сетку);
3) разбор градиентной заливки с помощью команды Object ⇒ 

Expand (Объект ⇒ (Расширить)).
Команда Object ⇒ Create Gradient Mesh (Объект ⇒ Создать 

градиентную сетку) открывает диалоговое окно, в котором нуж-
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но указать количество Rows (Ряды) и Columns (Столбцы) сет-
ки, а также возможность подсветки в раскрывающемся списке 
Appearance (Оформление): 

 y Flat (Равномерно) – применяет исходный цвет объекта 
равномерно по всей поверхности, в результате чего подсветка не 
создается; 

 y To Center (К центру) – создает подсветку в центре объекта; 
 y Тo Edge (К краям) – создает подсветку по краям объекта.

Основные параметры обводки определяются с использовани-
ем палитры Stroke (Обводка) (рис. 3.40), которая вызывается на 
экран при помощи команды Window ⇒ Stroke (Окно ⇒ Обводка).

Рис. 3.40. Палитра Stroke (Обводка)

Инструменты панели Stroke (Обводка) позволяют выравни-
вать обводку фигуры относительно контура, т. е. она может про-
ходить по центру, внутри и снаружи линии контура.

В поле Weight (Толщина) устанавливают толщину контура 
в одной из единиц измерения: дюймах (in), миллиметрах (mm), 
сантиметрах (cm), пиках (pс), а Adobe Illustrator пересчитает это 
значение в пункты (pt).

Если в поле Weight (Толщина) установить значение толщины, равное 0, то 

при выводе на экран или при печати такая линия трактуется как линия 
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толщиной в 1 пиксель и ее конкретная толщина зависит от разрешения 

выводного устройства. Для того чтобы контур имел действительно нуле-

вую толщину контура, следует присвоить ее с помощью кнопки None (Без 

атрибута) в палитре инструментов.

В группе Сар (Окончание) представлены три кнопки, опре-
деляющие три типа окончания линии: Butt Cap (Срезанные кон-
цы), Round Cap (Скругленные концы), Projecting Cap (Квадратные 
концы).

Аналогично могут настраиваться и стыки (или углы) линии 
контура фигуры. В группе Corner (Угол) также представлены три 
кнопки, определяющие тип сочленения линий: Miter Join (Острый 
стык), Round Join (Закругленный стык) и Bevel Join (Срезанный 
стык). 

Если требуется пунктирная линия, то следует установить 
флажок Dashed Line (Пунктирная линия) и в ставших доступны-
ми полях ввести значения, определяющие длину штрихов (Dash) 
и зазоров (Gap) между ними. 

В программе пользователь может создавать стрелки и за-
давать пропорции при настройке их размера. Типы стрелок по 
умолчанию располагаются в раскрывающемся списке палитры 
Stroke (Обводка).

Для декоративного оформления контура в Adobe Illustrator 
существуют следующие типы кистей:

 y Calligraphic Brushes (Каллиграфические кисти) – создают 
линии, подобные нарисованным с помощью каллиграфического 
пера и нарисованные вдоль центральной оси контура;

 y Scatter Brushes (Разделенные (дискретные) кисти) – копии 
объекта (например, звездочки) многократно повторяются вдоль 
контура;

 y Art Brushes (Художественные кисти) – форма кисти (напри-
мер, «Грубый уголь») распределяется равномерно вдоль контура 
по всей длине;

 y Bristle Brushes (Кисти из щетины) – создают мазки, имити-
рующие мазки кистью из щетины;

 y Pattern Brushes (Узорные кисти) – узор создается из отдель-
ных элементов и повторяется вдоль контура. Бордюрные кисти 
могут сочетать до пяти элементов: для сторон, внутреннего угла, 
внешнего угла, начала и конца узора.

Все типы отображаются и настраиваются в палитре Brushes 
(Кисти), которая вызывается командой меню Window ⇒ Brushes 
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(Окно  ⇒ Кисти) либо сочетанием клавиш Ctrl + 5. Это меню со-
держит также команды для загрузки библиотек кистей из других 
документов. 

Чтобы применить кисть к контуру, необходимо выделить кон-
тур, а затем выбрать кисть на палитре либо переместить кисть на 
контур. Если к контуру уже применены мазки кисти, то прежняя 
кисть заменяется новой.

Для удаления мазков кисти используют команду меню па-
литры Delete Brush (Удалить кисть) или одноименную кнопку 
палитры.

В редакторе Adobe Illustrator внешний вид любого объекта, 
группы или слоя можно изменять с помощью палитры Аppearance 
(Внешний облик) (рис. 3.41). К внешнему облику относят параме-
тры заливок, обводок, прозрачности и разнообразные эффекты.

Рис. 3.41. Палитра Appearance (Внешний облик)

В палитре Appearance (Внешний облик) отображаются сле-
дующие данные:

 y параметры заливок (тип, цвет, прозрачность и эффекты);
 y параметры обводок (тип, вид кисти, цвет, прозрачность и 

эффекты);
 y параметры прозрачности (уровень непрозрачности и режи-

мы наложения);
 y тип и параметры эффектов. 

Следует обратить внимание, что в качестве параметров мож-
но включать дополнительные заливки и обводки. Например, 
можно создать объект с несколькими обводками или нескольки-
ми заливками, каждая из которых взаимодействует друг с другом 
через сложную систему эффектов, прозрачностей и режимов на-
ложения (blending mode).
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Эффекты – это особые параметры внешнего вида, присва-
иваемые объекту командами меню Effect (Эффект). Эти коман-
ды влияют не на форму объекта, а только на его внешний вид. 
В связи с этим к объекту можно применить деформацию, расте-
ризовать его и выполнить другие операции, но при этом исход-
ный объект останется неизменным (будут сохранены его размер, 
количество опорных точек и форма контура).

Меню Effect (Эффект) включает множество команд, которые 
дублируют команды других меню, например команды деформа-
ции, фильтры пиксельной графики программы Adobe Photoshop, 
команды растеризации, команды подменю Pathfinder (Обработка 
контуров), команды Create Outlines (Преобразовать в контуры), 
Outline Stroke (Определить границы обводки), команды транс-
формирования: Rotate (Поворот), Reflect (Зеркальное отражение) 
и т. д. Такие эффекты можно применять к любому объекту про-
извольное количество раз. 

Все используемые эффекты отображаются в палитре Appea-
rance (Внешний облик), следовательно, их можно не только ре-
дактировать в произвольном порядке и в любое время, но и со-
хранить в виде стиля.

Для применения эффекта следует сначала выполнить одно из 
следующих действий:

 y выделить требуемый объект в рабочем окне;
 y сделать объект, группу или слой целевыми в палитре Layers 

(Слои);
 y выделить в палитре Appearance (Внешний облик) требуе-

мую строку заливки или обводки.
Затем в меню Effect (Эффект) выбрать и выполнить соответ-

ствующую команду, в открывшемся диалоговом окне установить 
необходимые параметры.

Палитра Transparency (Прозрачность) (рис. 3.42) предназна-
чена для определения уровня прозрачности (параметр Opacity) 
объекта, группы или слоя в диапазоне от 0 % (полная прозрач-
ность) до 100 % (полная непрозрачность). 

По умолчанию эффект прозрачности распространяется на 
объект в целом. Чтобы обеспечить прозрачность только заливки 
или только обводки, следует выбрать соответствующую строку 
в палитре Appearance (Внешний облик). 

Для того чтобы сделать объект, группу или слой целевым 
(Target) и применить к ним параметр прозрачности, следует ис-
пользовать палитру Layers (Слои). 
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Рис. 3.42. Палитра Transparency (Прозрачность)

Opacity Mask (Маска непрозрачности) предназначена для 
создания полупрозрачной маски, уровень прозрачности кото-
рой определяется градациями серого. Любые цвета, декоратив-
ные и градиентные заливки, расположенные ниже и попадающие 
в пределы маски, становятся видимыми сквозь нее.

Маска непрозрачности создается по форме самого верхнего 
из выделенных объектов. Если выделен только один объект, то 
создается пустая маска.

Для того чтобы создать маску непрозрачности, следует вы-
делить все объекты, которые необходимо маскировать. При этом 
важно убедиться, что объект, форма которого будет являться ма-
ской, занимает самое верхнее положение. Затем следует выпол-
нить команду Make Opacity Mask (Создать маску непрозрачности) 
меню палитры Transparency (Прозрачность).

После создания маски непрозрачности миниатюра маски 
отображается рядом с миниатюрой маскируемых объектов. По 
умолчанию маска и объекты связаны друг с другом, о чем сви-
детельствует пиктограмма «цепочки». Для управления связью 
служат команды Unlink Opacity Mask (Разорвать связь с маской 
непрозрачности) и Link Opacity Mask (Установить связь с маской 
непрозрачности) меню палитры.

Для удаления маски непрозрачности необходимо выделить 
ее и выполнить команды меню палитры Release Opacity Mask 



197

3.12. Работа с цветом. Заливки, обводки и внешний облик3.12. Работа с цветом. Заливки, обводки и внешний облик

(Снять маску прозрачности) или Disable Opacity Mask (Отклю-
чить маску прозрачности), чтобы снять отображение маски. 

Чтобы изменить форму маски непрозрачности, нужно вы-
делить миниатюру маски в палитре Transparency (Прозрачность) 
и щелкнуть на ней с нажатой клавишей Alt. Объект, который слу-
жит маской, выделяется и становится доступным для редактиро-
вания. Все производимые изменения отображаются в палитре. 
По завершении операции необходимо снова щелкнуть на мини-
атюре маски.

При выделении объекта, которому присвоена маска непро-
зрачности, в палитре Transparency (Прозрачность) становятся до-
ступными флажки Clip (Обтравка) и Invert Mask (Инвертировать 
маску).

Флажок Clip (Обтравка) позволяет поменять местами маски-
рованные и немаскированные области.

Установленный флажок Invert Mask (Инвертировать маску) 
инвертирует характеристики яркости.

Флажок Isolate Blending (Изолировать режим наложения) в па-
литре Transparency (Прозрачность) предназначен для того, чтобы 
изменить наложение таким образом, что в нем участвуют только 
объекты выделенной группы, а объекты, не входящие в группу, 
«изолируются» от этого воздействия.

Список режимов (см. рис. 3.42) представлен в раскрывающем-
ся списке палитры Transparency (Прозрачность) и соответствует 
режимам наложения редактора Adobe Photoshop.

Контрольные вопросы
1. Какими способами можно назначить цвет заливки и обводки?
2. Как можно изменить цветовую модель документа?
3. Какие цветовые режимы поддерживает программа Adobe Illustrator?
4. Какие цвета являются глобальными (триадными) в Adobe Illustrator?
5. Перечислите основные приемы работы с образцами. Какие элементы можно 
использовать в качестве образца?
6. С какой целью используют библиотеки образцов? 
7. Как в Adobe Illustrator создать новый градиент, как его модифицировать?
8. Как создать сеточный объект? В чем особенность такого объекта?
9. Какие параметры обводки объекта можно настроить и как?
10. Какие атрибуты объекта составляют его внешний облик? Назовите способы 
их изменения.

11. Что такое маска непрозрачности? Как ее настроить?

12. Каким образом применить маску непрозрачности только к одному из атри-

бутов объекта?
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3.13. Работа с текстом в Adobe Illustrator
Текст в программе Adobe Illustrator является параметриче-

ским, к нему неприменимы операции работы с кривыми, а также 
градиентная заливка. 

Тип текста определяет способ его 
создания:

 y заголовочный текст начинается 
в месте щелчка кнопкой мыши и на-
бирается в виде горизонтальной или 
вертикальной строки; �

 y блочный текст (также текст в об-
ласти) учитывает границы области; 

 y текст по контуру располагается 
по открытому или закрытому контуру.

Создают заголовочный текст инструментами Type (Текст) или 
Vertical Type (Вертикальный текст). При выборе одного из них 
курсор принимает I-образную форму внутри пунктирного пря-
моугольника, горизонтальная линия в нижней части которого со-
ответствует положению базовой линии текста. Каждая строка за-
головочного текста является независимой – текст удлиняется или 
сокращается при редактировании, но не переходит на следующую 
строку. Для начала новой строки следует нажать клавишу Enter. 

Завершается ввод текста выбором инструмента Selection (Выде-
ление) либо шелчком кнопкой мыши на тексте при нажатой кла-
више Ctrl.

Для создания блочного текста необходимо сначала опреде-
лить объект, который будет использоваться в качестве ограничи-
тельной рамки, одним из следующих способов:

 y выбрать инструмент Type (Текст) или Vertical Type (Верти-
кальный текст) и переместить курсор по диагонали для определе-
ния прямоугольной ограничительной области (рис. 3.43, а);

 y создать объект, внутри которого будет располагаться текст, 
затем выбрать инструмент Type (Текст), Area Type (Текст в об-
ласти), Vertical Type (Вертикальный текст) или Vertical Area Type 
(Вертикальный текст в области) и указать на контур объекта. 
Атрибуты обводки или заливки объекта автоматически удаляют-
ся (рис. 3.43, б). 

При вводе блочный текст автоматически переносится на сле-
дующую строку, когда достигает границы ограничительной об-
ласти. Для начала нового абзаца следует нажать клавишу Enter. 
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а  

б  

Рис. 3.43. Создание блочного текста

Если введенный текст не помещается в пределах области, то 
рядом с нижней частью ограничивающей области появляется 
знак «плюс» (+).

Есть два способа для решения проблемы переполнения тек-
стом блока:

 y изменение размера блока или размера текста;
 y продолжение текста в другом связанном с ним текстовом 

блоке.
Чтобы установить связь с новым объектом, необходимо пере-

местить мышью знак «+» на пустое место в монтажной области. 
При щелчке создается объект того же размера и формы, что и ис-
ходный; перетаскивание позволяет создать прямоугольный объ-
ект любого размера. 

Управление блоками текста осуществляют командами меню 
Type ⇒ Blocks (Текст ⇒ Блоки). 

Текст, который связывается с объектом, может быть направ-
лен вдоль контура объекта как правильной, так и любой про-
извольной формы. Контур объекта и в этом случае теряет свои 
параметры и становится невидимым (впоследствии ему можно 
присвоить параметры снова).

Набор текста с помощью горизонтальных текстовых инст-
рументов осуществляют перпендикулярно контуру в каждой 
данной точке, набор с помощью вертикальных текстовых инст-
рументов – параллельно контуру.

Для того чтобы направить горизонтальный текст вдоль от-
крытого или закрытого контура, необходимо выбрать инструмент 
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Туре (Текст) или Type on a Path (Текст по контуру), подвести кур-
сор к требуемому контуру (курсор должен изменить свою форму) 
и щелкнуть кнопкой мыши. После появления текстового курсора 
можно начинать ввод текста.

Команда Object ⇒ Text Wrap ⇒ Make (Объект ⇒ Обтекание ⇒ 
Выполнить) обеспечивает автоматическую верстку текста вокруг 
любых графических объектов, в том числе текстовых, составных 
контуров и растровых картинок. Предварительно необходимо вы-
делить объект обтекания, поместив его на передний план перед 
текстовым блоком. Режим обтекания применим только к тексту, 
размещенному внутри области; текст, созданный инструментом 
Type (Текст) или Type on a Path (Текст по контуру), не может об-
текать другие объекты. Обтекание может быть задано сразу для 
нескольких текстовых контейнеров вокруг любого количества 
объектов.

Для выделения всего блока текста и его оформления исполь-
зуют инструмент Selection (Выделение).

Выделение текстового объекта позволяет применять гло-
бальные параметры форматирования ко всем символам объекта, 
включая параметры на палитрах Character (Символ) и Paragraph 
(Абзац), атрибуты заливки и обводки и настройки прозрачности. 
Кроме того, к выбранному текстовому объекту можно применять 
эффекты, различные заливки и обводки, а также непрозрачные 
маски, что невозможно сделать для отдельно выбранных симво-
лов. Если выделен текстовый объект, то в окне документа вокруг 
него появляется ограничительная рамка, а на палитре Appearance 
(Внешний облик) отображается Type.

Выделение контура текста позволяет изменить его форму 
и применить к нему атрибуты заливки и обводки. Этот уровень 
выделения недоступен для заголовочного текста. 

При выборе блочного текста с помощью инструмента Selection 
(Выделение) предоставляется возможность его трансформировать 
(осуществить вращение, масштабирование, сдвиг), причем текст 
и текстовая рамка получат одинаковые изменения. Для транс-
формирования блочного текста используют обычные инструмен-
ты и команды трансформирования: Rotate (Поворот), Scale (Раз-
мер) или Shear (Наклон). 

Для выделения рамки текста (контейнера) или контура, по 
которому направляется шрифт, используют инструмент Direct 
Selection (Частичное выделение) или Group Selection (Выделение 
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в группе). При выборе рамки с помощью этих инструментов ее 
трансформации приводят к переверстке текста в пределах новой 
(трансформированной) текстовой рамки. Если рамка текстового 
блока связана с другими рамками, то в этом случае она может 
трансформироваться индивидуально.

В рамке блочного текста можно обеспечить его организацию 
в виде отделенных друг от друга рядов и колонок, т. е. преобразо-
вать одну колонку в совокупность нескольких колонок.

Для этого нужно выделить инструментом Selection (Выделе-
ние) текстовую рамку и выполнить команду Туре Rows & Columns 
(Текст Ряды и столбцы), которая выводит на экран одноимен-
ное диалоговое окно. В этом диалоговом окне представлены две 
одинаковые группы, одна из которых служит для установки па-
раметров рядов – Rows (Ряды), а другая – столбцов – Columns 
(Столбцы). Поле Number (Число) предназначено для определения 
количества рядов или столбцов в диапазоне от 1 до 1000.

В остальных полях устанавливают размеры колонок или рядов: 
Width (Ширина) и Height (Высота), Gutter (Средник), а также сум-
марную ширину или высоту текстового блока — в поле Total (Всего).

В группе Options (Варианты) представлены четыре кнопки, 
которые управляют направлением «потока» текста из одной ко-
лонки в другую или из одного ряда в другой.

Флажок Add Guides (Добавить направляющие) при его уста-
новке добавляет в документ набор направляющих, совпадающих 
с линиями рядов и колонок. Их можно использовать в качестве 
модульной сетки.

Если в качестве рамки для текста использовался объект про-
извольной формы, то он превращается в прямоугольный, размер 
которого определяется по габаритным точкам исходного объекта.

При выделении текста, направленного вдоль кривой, с по-
мощью инструментов Selection (Выделение) и Direct Selection (Ча-
стичное выделение) появляется специальный маркер, используе-
мый для перемещения всего текста вдоль кривой (рис. 3.44). 

Для выделения отдельных символов, слов и абзацев следует 
использовать соответствующий инструмент группы Type (Текст). 

Рис. 3.44. Перемещение текста вдоль кривой
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Для изменения текстовых параметров используют специаль-
ные палитры Character (Символ) и Paragraph (Абзац), аналогич-
ные одноименным палитрам в Adobe Photoshop.

Для вставки и просмотра специальных символов использу-
ют палитру Glyphs (Глифы). Чтобы вставить символ, необходимо 
инструментом Type (Текст) установить текстовый курсор в том 
месте, где нужно вставить символ, а затем дважды щелкнуть на 
нужном символе в палитре Glyphs (Глифы).

Для преобразования шрифта в контуры используют команду 
Create Outlines (Создать контуры). После преобразования нельзя 
изменять текстовые параметры, так как вместо текста образуется 
набор сложных контуров (кривых).

В программе использованы специальные палитры Character 
Styles (Стили символов) и Paragraph Styles (Стили абзацев) для 
создания, применения, редактирования текста стилями символов 
и абзацев. Стиль символов – это набор атрибутов форматирования 
символов, который можно применить к выделенному диапазону 
текста. Стиль абзацев состоит из атрибутов форматирования как 
символов, так и абзацев и может применяться к одному или не-
скольким абзацам. Чтобы применить стиль, достаточно выделить 
текст и щелкнуть на имени стиля в одной из палитр. Если текст 
не выделен, то стиль применяется к вновь создаваемому тексту.

Контрольные вопросы
1. Назовите виды текста, существующие в Adobe Illustrator. Поясните, какой 

принцип лежит в основе данной классификации. 

2. К каким изменениям в тексте приводит нажатие клавиши Enter в процессе вво-

да заголовочного и блочного текстов?

3. Какие инструменты позволяют выделить текст как объект, только рамку блоч-

ного текста или контур, отдельные символы текста?

4. Каким образом можно задать разные заливку и обводку символам в тексте?

5. Какие возможности обработки текста доступны при выделении блочного тек-

ста инструментом Selection (Выделение)?

6. Как разместить текст вдоль кривой? 

7. Каким образом отразить текст по горизонтали (вертикали), растянуть или 

сжать его? В чем различие данных операций для текста в зависимости от его 

вида и от используемого инструмента выделения?

3.14. Импорт и экспорт изображений

Изображения из файлов Adobe Photoshop (.psd) открываются 
в Adobe Illustrator с помощью команды Open (Открыть), копиру-
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ются (перемещаются) с помощью буфера обмена Clipboard, а так-
же путем перемещения из окна программы. 

Программа поддерживает большую часть данных Adobe 
Photoshop, в том числе слои, редактируемый текст и контуры.

В программе Adobe Illustrator обеспечивается возможность 
открытия или импортирования документов, созданных и в дру-
гих программах (табл. 3.7).

Таблица 3.7

Форматы импортируемых в Adobe Illustrator файлов

Формат файла Команда импортирования Примечание

ЕPS (Encapsulated PostScript) Open (Открыть), Place (Поместить) –

PDF (Portable Document Format) Open (Открыть), Place (Поместить) Предлагает воз-

можность выбора 

отдельной страницы

WMF (Windows Metafile)/EMF Open (Открыть), Place (Поместить) Возможно 

перемещение не-

посредственно из 

программ MS

DXF/DWG Open (Открыть), Place (Поместить) –

FreeHand Open (Открыть), Place (Поместить) –

CDR (CorelDRAW) Open (Открыть) Возможны пробле-

мы с кириллицей

CMX (CorelDRAW),

CGM (Computer Graphics Metafile)

Open (Открыть) 
–

Форматы пиксельной графи-

ки, поддерживаемые Adobe 

Photoshop: GIF, JPEG, PCX, PIXAR, 

PNG, TIFF и TGA

Open (Открыть), Place (Поместить) –

Текстовые форматы: text, MS Rtf, 

MS Word, Corel WordPerfect

Open (Открыть), Place (Поместить) –

Контрольные вопросы
1. Какие возможности импортирования растровых изображений из других про-

грамм существуют в Adobe Illustrator? 

2. Файлы каких графических форматов можно импортировать в Adobe Illustrator, 

используя буфер обмена?

3. Назовите элементы растрового изображения, импортируемого из Adobe Pho-

toshop, которые поддерживаются редактором Adobe Illustrator.
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РАЗДЕЛ 

4

ОСНОВЫ ТРЕХМЕРНОГО МОДЕЛИРОВАНИЯ 

4.1. Редакторы трехмерной графики 

Трехмерная графика и анимация занимают особое место 
среди компьютерных технологий. Обозначение 3D происходит от 
английского three dimensions – три измерения, т. е. трехмерное 
пространство. Появились 3D-редакторы и связанное с ними по-
нятие 3D-графики в 90-х годах XX века, когда стало возможным 
создание третьего измерения – объема. Для визуализации объ-
ема нужна программная среда, которая работает одновременно 
в трех измерениях. Чертеж статичен, отражает деталь со строго 
регламентированных ракурсов: сверху, сбоку. Получить полное 
представление о конфигурации изделия сложно. Выполнение ак-
сонометрических изображений – трудоемкий процесс, но и та-
кой чертеж не дает объемного, цельного представления. Особен-
но если это не простая деталь, а проект промышленного объекта.

Программы для создания 3D-моделей эмулируют много-
векторное пространство, в котором можно повернуть проекти-
руемую деталь в любом направлении, редактировать ее по трем 
координатам. Интерфейс любой программы трехмерного моде-
лирования имеет четыре основных окна:

 y вид сверху (Top);
 y вид спереди (Front);
 y вид слева (Left);
 y вид в перспективе (Perspective). 

Для получения трехмерного изображения на плоскости тре-
буются следующие шаги: 

1) моделирование – создание трехмерной математической 
модели сцены и объектов в ней; 

2) текстурирование – назначение поверхностям моделей рас-
тровых или процедурных текстур; 

3) освещение – установка и настройка источников света;
4) анимация – придание движения объектам; 
5) динамическая симуляция – автоматический расчет взаи-

модействия частиц, твердых или мягких тел и прочего с модели-
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руемыми силами гравитации, ветра, выталкивания и др., а также 
друг с другом; 

6) рендеринг (визуализация) – построение проекции в соот-
ветствии с выбранной физической моделью;

7) композитинг – доработка изображения. 
Последние годы лидером в производстве профессиональных 

3D-программ является компания Autodesk. Сразу две программы 
разработчика востребованы у профессионалов: Autodesk 3ds Max 
и Autodesk Maya. 

Устойчивыми лидерами среди редакторов 3D-графики и ани- 
 мации также являются коммерческие продукты Cinema 4D, 
Hou dini, Modo, LightWave 3D. Кроме того, существуют и откры-
тые продукты, распространяемые свободно, например пакеты 
Blender, K-3D и Wings3D.

Autodesk 3ds Max (ранее 3D Studio MAX) – полнофункцио-
нальная профессиональная программная система для создания 
и редактирования трехмерной графики и анимации, доработан-
ная компанией Autodesk. Autodesk 3ds Max доступен в двух ли-
цензионных версиях: студенческой – бесплатной (требуется ре-
гистрация на сайте Autodesk), представляющей полную версию 
программы (однако ее нельзя использовать в целях получения 
прибыли), и полной (коммерческой). Autodesk 3ds Max располага-
ет обширными средствами для создания разнообразных по фор-
ме и сложности трехмерных компьютерных моделей, реальных 
или фантастических объектов окружающего мира с использова-
нием разнообразных техник и механизмов. 

Autodesk Maya на протяжении долгого периода является ос-
новным конкурентом Autodesk 3ds Max на рынке программного 
обеспечения, а опытными 3D-художниками используется даже 
чаще, например, такими известными студиями, как DreamWorks, 
The Walt Disney Company. В этом редакторе есть практически все, 
что необходимо для 3D-графики. Maya дает возможность пройти 
все этапы создания 3D – от моделирования и анимации до тек-
стурирования, композитинга и послойного рендеринга. Главной 
особенностью пакета является модуль PaintEffects, который пре-
доставляет возможность нарисовать кистью такие 3D-объекты, 
как трава, объемные узоры и др. 

Считается, что пакет Maya более удобен для создания ани-
мации, персонажей, но сложнее в изучении. 3d Max более при-



206

Раздел 4. Основы трехмерного моделирования 

кладной пакет. Однако споры о преимуществах и недостатках 
программного обеспечения среди сторонников этих двух при-
ложений не утихают.

Cinema 4D (сокращенно C4D) немецкой компании MAXON 
Computer является универсальной комплексной программой 
для создания и редактирования трехмерных эффектов и объ-
ектов. Отличается более простым интерфейсом, чем у аналогов, 
и встроенной поддержкой русского языка, что делает ее попу-
лярной среди русскоязычной аудитории. Содержит средства для 
создания персонажной анимации, высококачественного ренде-
ринга и удобные инструменты моделирования. Программа по-
зволяет просчитывать эффекты глобальной освещенности, кау-
стику и учитывает подповерхностное рассеивание света, которое 
можно наблюдать, например, при просвечивании воска свечи. 

Modo – полноценный продукт для моделирования, рисова-
ния, анимации и визуализации компании Luxology. Программа 
Modo получила широкое распространение среди профессио-
нальных дизайнеров. Ее используют при разработке компьютер-
ных игр, производстве сериалов и фильмов, обработке трехмер-
ной графики. Широкий набор функций сочетается с понятным 
и удобным интерфейсом. Программа дает возможность выпол-
нять настройку практически всех рабочих элементов. Многие из 
них для удобства использования выделены в отдельные модули. 
Они имеют возможность приближать принципы взаимодействия 
с набором инструментов к методам, которые используются в та-
ких программах для трехмерного моделирования, как 3ds Max 
и Maya.

Blender – бесплатный 3D-пакет, который практически не 
уступает по функционалу платным приложениям. Blender вклю-
чает в себя средства для 3D-моделирования, анимации, а также 
набор опций для создания игр, визуальных эффектов и скульп-
тинга. Благодаря поддержке Blender Foundation программа очень 
быстро и стабильно развивается.

Контрольные вопросы
1. Какие шаги необходимо выполнить для получения трехмерного изображения 

на плоскости?

2. Какие проекции используют для отображения трехмерной сцены в програм-

мах трехмерного моделирования? 

3. Перечислите редакторы 3D-графики компании Autodesk. Назовите их конку-

рентные преимущества.
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4. Опишите основные достоинства и направления применения редакторов 

3D-графики Cinema 4D и Modo.

5. Назовите наиболее популярный бесплатный пакет 3D-графики и его функцио-

нальные возможности.

4.2. Интерфейс программы 3ds Max.  
Настройка рабочего пространства

При запуске 3ds Max на экране компьютера появляется окно, 
содержащее пустую сцену (рис. 4.1).

Рис. 4.1. Общий вид окна программы 3ds Max

Если вид окна иной, выполните команду Customize  ⇒  Load Custom UI 

Scheme (Настройка  ⇒  Загрузить схему интерфейса). В появившемся 

окне укажите путь к файлу default.ui (по умолчанию это C:\Program Files\

Autodesk\3ds Max 20XX\ui; XX – год выпуска версии) и нажмите кнопку 

Открыть. В результате будет загружена схема интерфейса, которая исполь-

зуется по умолчанию. 

Основными видимыми элементами интерфейса являются: 
 y Main Menu (Главное меню) – располагается в верхней части 

окна программы, сразу под заголовком;
 y Main Toolbar (Главная панель инструментов) – обычно на-

ходится сразу под главным меню и содержит кнопки быстрого 
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доступа и другие элементы, расположенные в один ряд. При ра-
боте с программой Main Toolbar (Главная панель инструментов) 
может быть перемещена, форма ее может быть изменена, некото-
рые кнопки могут быть удалены, а некоторые – добавлены;

 y Viewports (Окна проекции, или Видовые окна) – распо-
ложены в центре окна, обычно содержат виды сцены Top (Вид 
сверху), Left (Вид слева), Front (Вид спереди), Perspective (Вид в 
перспективе). При этом в трех окнах объекты показаны схема-
тически, а в окне перспективы – в трехмерном представлении. 
Окно проекции, в котором на данный момент ведется работа, 
подсвечивается желтым цветом и называется активным. В про-
цессе работы имеется возможность изменить как соотношение 
размеров, так и конфигурацию расположения окон, используя 
Main Menu (Главное меню);

 y Command Panel (Командная панель) – обычно располага-
ется в правой части окна программы. Содержит несколько вкла-
док, с помощью которых можно получить доступ к следующим 
операциям:

 –Create – создание объектов;
 –Modify – модификация объектов: изменение параметров, 

преобразование, редактирование объектов (в том числе создание 
собственных моделей на основе каких-либо объектов), добавле-
ние модификаторов;

 –Hierarchy – настройка иерархии объектов (как объекты свя-
заны друг с другом);

 –Motion – управление движением объектов;
 –Utilites – утилиты, средства для совершения дополнитель-

ных действий над объектами, сценой и группами объектов;
 –Display – настройка отображения, можно скрыть (Hide) или 

заморозить (Frize) объекты. Скрытые объекты не видны, а замо-
роженные – недоступны для редактирования;

 y Lover Interface Bar (Нижняя панель управления интерфей-
сом) – содержит поля отображения состояния сцены и объектов, 
элементы управления окнами проекции, анимации и отображения.

Все закрепленные панели могут быть «плавающими». Для 
этого достаточно щелкнуть на двух вертикальных линиях в ле-
вой или верхней части панели и переместить ее. Двойной щелчок 
кнопкой мыши на заголовке окна панели вернет ее на место или 
«пристыкует» к любой стороне окна программы.
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Чтобы узнать предназначение кнопки на любой панели ин-
струментов, достаточно подвести к ней курсор. При этом возле 
кнопки возникнет всплывающая подсказка, содержимое которой 
также отобразится в строке состояния.

К элементам интерфейса также относят следующие компо-
ненты:

 y Flyout (Прикрепленная панель). Если в правом нижнем 
углу кнопки на панели инструментов имеется треугольная метка, 
то при нажатии на нее и удержании кнопки мыши нажатой более 
1 с появляется выпадающее графическое меню – набор кнопок, 
вызывающих однотипные действия, например выделение прямо-
угольной, круглой, многоугольной области;

 y Rollout (Свитки) – используют в случаях, когда требует-
ся отобразить значительный объем информации на ограничен-
ном пространстве, например при модификации объекта на ко-
мандной панели должны отображаться все его свойства. Rollout 
(Свитки) – диалоговые окна, прокручиваемые в пределах панели 
окна. Термин «свиток» используют потому, что окно сворачива-
ется и разворачивается щелчком мыши;

 y Floater (Плавающие окна). Для решения некоторых част-
ных задач можно вызывать дополнительные окна, которые 
остаются видимыми и при переключении к другим задачам, не 
препятствуя работе, например вызов Material Editor (Редактор 
материалов) приводит к появлению окна, которое может быть 
перемещено в любую часть экрана;

 y Modal Panel (Модальные окна) – при задании некоторых 
параметров, например параметров массивов, возникают окна, 
которые требуют закрытия для продолжения работы;

 y Quads (Меню в квадрантах, или Квадрантное меню) – при 
нажатии правой кнопкой мыши на объект или щелчке ею в окне 
проекции появляется контекстное меню. В отличие от большин-
ства других программ, в 3ds Max в зависимости от операций, 
которые можно осуществить с выделенным объектом, может по-
являться несколько списков. В этом случае в каждом из списков 
будет присутствовать название группы действий, которые объ-
единены в данном списке, например Display (Показать), Transform 
(Трансформировать).

В 3ds Max, как и во многих других программах Windows, 
предусмотрены операции отмены и возврата действий. Для них 
назначены стандартные сочетания клавиш Ctrl + Z и Ctrl + Y 
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соответственно. Кроме того, в меню Edit (Редактирование) на-
ходятся команды Undo (Отмена) и Redo (Возврат).

Основной для трехмерного мира 3ds Max является глобаль-
ная система координат (World Reference System) с началом в точке 
(0, 0, 0) пространства сцены. Условно можно считать, что в вир-
туальном трехмерном пространстве ось Z глобальной системы 
координат соответствует понятию высоты, ось X – ширины, 
а ось Y – длины или глубины сцены. Взгляд на сцену «спере-
ди» означает наблюдение вдоль оси Y в ее положительном на-
правлении. В соответствии с этим, например, на проекции «вид 
спереди» ось X глобальной системы координат будет направлена 
вправо, ось Z – вверх по экрану, а ось Y – от наблюдателя, пер-
пендикулярно экрану. На проекции «вид сверху» оси глобальных 
координат будут располагаться так: ось X направлена вправо, Y – 
вверх по экрану, Z – на наблюдателя, перпендикулярно экрану. 
Плоскостями, на которых изображаются проекции объектов сце-
ны, по умолчанию являются три плоскости, проходящие через 
оси глобальной системы координат. Для проекций «вид спереди» 
и «вид сзади» это будет плоскость ZX, проекций «вид сверху» 
и «вид снизу» – плоскость XY, проекций «вид слева» и «вид спра-
ва» – плоскость ZY.

В 3ds Max есть еще локальная (Local) система координат, ко-
торая назначается каждому объекту и определяет понятия «верх», 
«лево» и «право» для этого объекта. Начало локальной систе-
мы координат помещается в опорную точку (Pivot Point) объек-
та, а сама опорная точка располагается для некоторых объектов 
в геометрических центрах их габаритных контейнеров, а для не-
которых – в центре основания.

Для управления видом в окне проекции используют кнопки 
в правом нижнем углу окна программы:

 yZoom (Масштаб) – приближение/удаление 
сцены;

 yZoom All (Масштаб всего) – приближение/
удаление сразу всех объектов во всех окнах про-
екций;

 yZoom Extents/Zoom Extents Selected (Сцена 
целиком/Выделенные объекты целиком) – приближение/удале-
ние выбранного объекта/всех объектов в пределах видимости те-
кущего окна проекции;
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 y Zoom Extents All/Zoom Extents Selected (Сцена целиком во всех 
окнах проекций/Выделенные объекты целиком в окнах проек-
ций)  – приближение/удаление выбранного объекта/всех объек-
тов сцены в пределах видимости всех окон проекции. Эту кнопку 
удобно использовать в тех случаях, когда требуется посмотреть на 
сцену с такой точки, чтобы в окне проекции отображались все 
объекты;

 y Field-of-View/Region Zoom (Видовое поле зрения/Масштаб 
области) – изменение всего поля зрения/выделенного при по-
мощи мыши;

 y Pan View/Walk Through (Панорамирование/Перейти) – Кноп-
ка Pan (Панорамирование) служит для перемещения изображения 
на экране вручную. Кнопка Walk Through (Перейти) активирует 
режим перемещения по сцене от первого лица. При включении 
этого режима изменять вид в окне проекции можно при помо-
щи клавиш управления курсором. Режим Walk Through (Перейти) 
можно применять, только если активно окно Perspective (Вид в 
перспективе);

 y Orbit/Orbit Selected/Orbit SubObject (Вращение/Вращение во-
круг выделенного/Вращение вокруг подобъекта) – вращение во-
круг центра поля зрения, вращение вокруг центра выделенного 
объекта/подобъектов;

 y Min/Max Toggle (Увеличение окна проекции до размеров экра-
на) – увеличение активного окна проекции до размеров экрана.

Клавиши и комбинации клавиш для управления окнами про-
екций:

F – Front View (Вид спереди); 
V + K – Back View (Вид сзади); 
V + R – Right View (Вид справа); 
L – Left View (Вид слева); 
Т – Top View (Вид сверху); 
В – Bottom View (Вид снизу); 
Р – Perspective User View (Перспективный пользовательский вид); 
U – Orthogonal User View (Ортогональный пользовательский вид); 
C – Camera View (Вид из камеры). 
В меню Views (Виды) существует специальный графический 

инструмент Steering Wheel (Штурвал), который предоставляет бы-
стрый доступ к различным инструментам навигации.

По умолчанию объекты в окне Perspevtive (Вид в перспек-
тиве) отображаются в виде цветных непрозрачных фигур мак-
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симально реалистично. Такой вариант отображения объектов 
называется Realistic (Реалистичный), его упрощенный вариант – 
Shading. В остальных трех окнах проекций режим отображения  
Wireframe (Проволочный каркас).

К основным режимам отображения объектов относят:
 y Wireframe (Проволочный каркас) (рис. 4.2, а);
 y Facets (Грани) (рис. 4.2, б);
 y Shading (Реалистичный) – упрощенный вариант (рис. 4.2, в);
 y Bounding Box (Габаритный контейнер) – параллелепипеды, 

ограничивающие объект;
 y Edged Facets (Ограниченные грани).

а б в

Рис. 4.2. Проволочный каркас объекта (а), отображение в виде 

граней (б) и с примененным сглаживанием граней (в)

Клавиша F4 включает или выключает режим Edged Faces без доступа в 

меню вида. Комбинация клавиш Alt + X позволяет в режиме Shading 

cделать объект полупрозрачным.

Дополнительные режимы отображения находятся в группе 
Stylized (Стилизованный).

Перед тем как начать создавать заготовки модели и работать 
с объектами, необходимо выбрать и настроить единицы измере-
ния. По умолчанию в системе стоят дюймы (inches). Настрой-
ку единиц измерения осуществляют в пункте меню Сustomize ⇒ 
Units Setup (Настройка ⇒ Установка единиц измерения).

При запуске 3ds Max автоматически создает новую сцену. 
После внесения изменений сцену необходимо сохранить. Сцены 
хранятся в файлах с расширением .max – это собственный фор-
мат файлов программы 3ds Max. Все команды для работы с фай-
лами доступны в пункте File (Файл) Main Menu (Главное меню). 
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Контрольные вопросы
1. Перечислите основные компоненты окна программы 3ds Max.

2.  Что такое глобальная система координат? Как она соотносится с видами про-

екций?

3. Назовите виды панелей в 3ds Max. Изложите понятие и назначение свитка.

4. Где находятся настройки изменения режимов отображения проекций? 

5. Какие режимы отображения объектов существуют в 3ds Max? Как изменить 

режим отображения объекта? 

6. Как изменить основные настройки программы 3ds Max? 

7. Какие единицы измерения установлены по умолчанию? Как их изменить? 

4.3. Построение трехмерных объектов

Все геометрические объекты программы 3ds Max можно ус-
ловно разделить на две категории: параметрические и редакти-
руемые. 

Параметрические объекты – это объекты, которые опре-
деляются совокупностью установок или параметров (свиток 
Parameters (Параметры) на командной панели). Изменение зна-
чений параметров модифицирует геометрию самого объекта. 
Параметрическими объектами в 3ds Max являются все объекты, 
которые можно построить при помощи меню Create (Создание) 
и одноименной вкладки командной панели. 

Редактируемые объекты получают путем преобразования 
других типов объектов. После преобразования параметрического 
объекта в другой тип он теряет все свои параметрические свой-
ства и не может быть изменен путем указания параметров. В то 
же время редактируемый объект приобретает свойства, недоступ-
ные параметрическому, – возможность редактирования на уров-
не подобъектов.

В программе 3ds Max можно использовать несколько различ-
ных типов трехмерного моделирования. 

1. Моделирование на основе примитивов. Примитивы – про-
стейшие параметрические формы, например кубы, сферы и пира-
миды. При визуализации такой объект, как сфера, преобразуется 
в полигон (многоугольник), но получаемая поверхность выглядит 
намного более гладкой. Эффекта сглаживания поверхности до-
стигают за счет специальных алгоритмов закраски. 

2. Моделирование на основе сечений (Loft). Объекты на ос-
нове сечений названы по аналогии со способом, используемым 
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в судостроении, заключающемся в «натягивании» поверхности 
на произвольные сечения или плоские формы – двумерные объ-
екты. При создании трехмерных объектов несколько форм рас-
полагаются вдоль некоторого пути.

3. Моделирование на основе булевых операций. Булевы объ-
екты (Booleans) создаются посредством добавления, вычитания 
и пересечения перекрывающихся поверхностей.

4. Поверхностное моделирование основано на создании про-
извольных поверхностей с использованием различных математи-
ческих моделей и, соответственно, своих видов моделирования: 

 y многоугольных (полигональных) каркасов, редактируемых се-
ток – сложных моделей, созданных из множества многоуголь-
ных поверхностей, которые сглажены в процессе визуализации. 
Полигональное моделирование основано на манипулировании 
непосредственно вершинами, ребрами и гранями; 

 y лоскутков (patches) – строятся на основе сплайнов (гладких 
кривых) и могут изменяться с помощью контрольных точек. Об-
разующие сплайны располагаются по краям создаваемой поверх-
ности;

 y неоднородных рациональных B-сплайнов (NURBS) – техноло-
гии, предназначенной для создания плавных форм и моделей. 
С помощью управляющих вершин, в отличие от лоскутного мо-
делирования, можно воздействовать на любую локальную об-
ласть поверхности;

 y моделирования поверхности по сплайновой сетке – создается 
совокупность сплайнов, своеобразный каркас, на основе которо-
го формируется поверхность (surface).

4.3.1. Создание примитивов

Самые простые объекты в 3ds Max создают нескольки-
ми щелчками кнопки мыши. Для этого удобно использовать 
Command Panel (Командная панель). Кнопки для создания объ-
ектов находятся на вкладке Create (Создание). Простейшие объ-
екты, примитивы, расположены в категории Geometry (Геоме-
трия). Примитивы делят на две группы: Standard Primitives (Про-
стые примитивы) и Extended Primitives (Улучшенные примитивы), 
переключение между которыми выполняют при помощи списка. 
Простые примитивы представляют собой простейшие трехмер-
ные геометрические фигуры: 

 y Sphere (Сфера); 
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 y Box (Параллелепипед); 
 y Cone (Конус); 
 y Cylinder (Цилиндр);
 y Torus (Тор); 
 y Plane (Плоскость) и др. 

К группе Extended Primitives (Улучшенные примитивы) отно-
сятся более сложные примитивы, например Hedra (Многогран-
ник), Chamfer Cylinder (Цилиндр с фаской), Torus Knot (Торои-
дальный узел) и т. д. 

Поскольку 3ds Max довольно часто используют для создания 
различных архитектурных проектов, разработчики добавили в ка-
тегорию Geometry (Геометрия) несколько групп объектов, которые 
имеют сложную форму и часто используются в трехмерных сценах 
подобной направленности. К ним относят следующие группы:

1) Doors (Двери) – содержит три типа объектов, напоминаю-
щих входные двери, двери автобуса и двери купе;

2) Windows (Окна) – позволяет добавлять в сцену шесть раз-
ных типов окон, которые различаются по способу открытия;

3) Stairs (Лестницы) – используется для создания четырех 
разных типов лестниц: прямой, винтовой, L-образной и U-об-
разной;

4) AEC Extended (Дополнительные объекты для АИК) – со-
держит объекты для создания стен, оград и растительности. 

Чтобы создать объект, нужно нажать кнопку с названием 
примитива на командной панели (рис. 4.3), щелкнуть в окне про-
екции и, удерживая нажатой кнопку мыши, переместить указа-
тель в сторону. Когда объект достигнет желаемого размера, сле-
дует отпустить кнопку мыши.

В группе создания сами объекты представлены кнопками. 
При нажатии кнопки ниже на командной панели появляются 
свитки с параметрами создаваемого объекта. Первый из свит-
ков – Name and Color (Имя и цвет), в свитке Creation Method 
(Способ создания) можно выбрать, как создать объект: от края 
(Edge) или от центра (Center).

Для создания некоторых объектов нужно повторить последние действия 

несколько раз. Например, при выполнении цилиндра сначала нужно опре-

делить радиус объекта, а затем – высоту.

Объекты можно создавать и путем ввода параметров объекта 
в свитке Keyboard Entry (Ввод с клавиатуры). Для этого после 
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нажатия кнопки с названием примитива нужно перейти в по-
явившийся ниже свиток, ввести параметры объекта, координаты 
точки расположения и нажать кнопку Create (Создание). 

Рис. 4.3. Командная панель

Каждый объект имеет свои параметры, определяющие его раз-
меры и форму. Когда объект только создан, эти параметры нахо-
дятся в нижней части командной панели на вкладке Create (Созда-
ние). Если снять выделение с объекта, то параметры отображаться 
не будут. Для того чтобы их изменить, следует выделить объект 
и перейти на вкладку Modify (Изменение) командной панели. 

Объекты в окне проекции отличаются друг от друга цветом. 
При создании каждого объекта 3ds Max автоматически выбирает 
для него цвет. По умолчанию используются все цвета, кроме бе-
лого, так как на объекте белого цвета плохо заметно выделение. 
Цвет объекта можно изменить в окне Object Color (Цвет объек-
та), которое открывается щелчком мыши на поле с изображением 
цвета (см. рис. 4.3).

4.3.2. Выделение объектов

Как только объект создан, он выделен. Пока нажата кнопка 
создания выбранного примитива, можно создать другой такой 
же объект, и тогда выделенным будет он. Чтобы снять выделение, 
нужно выключить кнопку с названием и кликнуть мышью вне 
объекта. 
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Выделить объект можно с помощью мыши при активном ин-
струменте:

 y Select Object (Выделение объекта, ), который расположен 
на основной панели инструментов;

 y трансформации: перемещение, поворот и масштабирование.
В режиме отображения объектов Wireframe (Каркас) объект 

станет белым. В режиме Smooth + Highlights (Сглаживание + бли-
ки) вокруг выделенного объекта появятся квадратные скобки бе-
лого цвета.

Для выделения более одного объекта можно использовать 
клавишу Ctrl. Чтобы убрать объект из числа выделенных, исполь-
зуют клавишу Alt.

Другой способ одновременного выбора нескольких объек-
тов – выделение области (рис. 4.4): 

 y Rectangular Selection Region (Прямоугольная область) – по 
умолчанию;

 y Circular Selection Region (Круглая область);
 y Fence Selection Region (Произвольная область);
 y Lasso Selection Region (Выделение лассо);
 y Paint Selection Region (Выделение кистью).

Рис. 4.4. Инструменты выделения области

Расположенная справа кнопка Window/Crossing (Окно/Пере-
сечение) используется для переключения режимов. Если вклю-
чен режим Crossing (Пересечение), то выделенными станут все 
объекты, которые полностью или частично попадут в эту об-
ласть. Если включить режим Window (Окно), то выделенными 



218

Раздел 4. Основы трехмерного моделирования 

будут только те объекты, которые полностью попали в область 
выделения.

Выделить объект можно, выбрав его из списка в окне Select 
From Scene (Выбор из сцены), открываемого командой меню 
Edit ⇒ Select by ⇒ Name (Редактирование ⇒ Выбор по ⇒ Имя). 

Для вызова окна Select From Scene (Выбор из сцены) можно использовать 
клавишу H или кнопку Select by Name (Выбор по имени) на основной па-
нели инструментов.

4.3.3. Манипуляции с объектами 

К любым выделенным объектам могут быть применены три 
трансформации. Все они выведены в виде трех кнопок на глав-
ной панели с названиями:

 Select and Move (Перемещение); 
 Select and Rotate (Поворот);
 Select and Uniform Scale (Масштабирование).

При выборе любой трансформации в центре выделенного 
объекта появляются три координатные оси – X, Y и Z, кото-
рые определяют систему координат, привязанную к объекту. Эти 
координатные оси, как уже упоминалось ранее, составляют ло-
кальную систему координат объекта. Точку, из которой исходят 
оси локальной системы координат, называют опорной (Pivot Point). 
Если ось желтая – это значит, что она активна и можно выпол-
нять действия вдоль направления данной оси.

Включить/отключить систему координат можно с помощью горячей клави-
ши Х в английской раскладке клавиатуры.

Система координат определяет начало координат и направ-
ление текущего преобразования. Выбор системы координат для 
каждого преобразования осуществляется с помощью раскрываю-
щегося списка Reference Coordinate System (Выбор системы коор-
динат) основной панели инструментов. 

Системы координат: 
 y Screen – X и Y параллельны плоскости экрана, Z – перпен-

дикулярна; 
 y World – X, Y и Z выравниваются по глобальной системе 

координат; 
 y View – сочетание параметров Screen и World. X и Y располо-

жены на плоскости видимой сетки активного окна; Z – перпен-
дикулярна сетке; 
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 y Parent – X, Y и Z выравниваются по локальным координа-
там родительского объекта. Если последний отсутствует, то ис-
пользуются глобальные координаты; 

 y Local – X, Y и Z выравниваются по локальным координатам 
текущего объекта;

 y Gimbal – система координат, используемая для эйлеровско-
го вращения;

 y Grid – X, Y и Z выравниваются по системе координат ак-
тивной сетки;

 y Pick – X, Y и Z выравниваются по локальной координатной 
системе объекта сцены, который выбран. 

4.3.4. Способы осуществления трансформаций

1. Трансформации можно выполнять мышью, в этом случае 
следует пользоваться осями трансформации, представленными 
стрелками при перемещении (рис. 4.5, a), цветными кругами при 
повороте (рис. 4.5, б) или осями с квадратными наконечниками 
при масштабировании (рис. 4.5, в). Перемещать объект можно 
вдоль осей X, Y, Z или в плоскостях XY, YZ, XZ. Масштабировать 
объект можно вдоль осей X, Y, Z, в плоскостях XY, YZ, XZ или 
одновременно во всех направлениях. 

а б в

Рис. 4.5. Операции трансформации

Режимы масштабирования:
 y по умолчанию Uniform Scale (Равномерное масштабирова-

ние), при котором пропорции объекта остаются неизменными, 
поскольку масштабирование выполняется одинаково вдоль всех 
осей;

 y Non-uniform Scale (Неравномерное масштабирование) – 
пропорции объекта могут изменяться, масштабирование выпол-
няется для каждой оси отдельно;
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 y Squash (Расплющивание) – применяется, если необходимо 
масштабировать объект в одном направлении вдоль одной оси и 
одновременно в другом направлении вдоль других осей.

Для перемещения выделенного объекта также можно использовать 
клавишу W, для вращения – клавишу E, для масштабирования – клави- 
шу R. Также выбрать операцию трансформации можно в контекстном меню  
объекта.

2. Второй способ выполнения трансформаций – ввод конкрет-
ных значений в поля координат с клавиатуры в диалоговых ок-
нах Move Transform Type-In (Ввод значений перемещения), Rotate 
Transform Type-In (Ввод значений поворота) и Scale Transform 
Type-In (Ввод значений масштабирования). Причем координаты 
могут восприниматься как абсолютные или как относительные 
(переключение производится специальной кнопкой). Для вызова 
одного из этих окон нужно щелкнуть правой кнопкой мыши на 
соответствующем инструменте панели инструментов или выпол-
нить команду Edit ⇒ Transform Type-In (Редактирование ⇒ Ввод 
значений). 

При необходимости упорядочить положение объектов от-
носительно друг друга к ним следует применить выравнивание. 
Объекты выравниваются попарно. Первым должен быть выбран 
объект, который необходимо выровнять относительно другого. 
Для выравнивания используют команду Tools  ⇒ Align ⇒ Align 
(Инструменты ⇒ Выровнять ⇒ Выравнивание), после выполне-
ния которой указывают на объект, относительно которого про-
изводят выравнивание. В итоге откроется окно Align Selection 
(Выравнивание выделенных объектов), в котором необходимо 
указать принцип выравнивания (рис. 4.6):

 y X/Y/Z Position (Положение по осям X/Y/Z) – оси, по кото-
рым будет происходить выравнивание (можно настраивать как по 
одной оси, так и по двум или трем);

 y Current Object (Текущий объект) – настройки точки вы-
равнивания для выравниваемого объекта: Minimum – по низу; 
Center – посередине; Pivot Point – по опорной точке объекта; 
Maximum – по верху;

 y Target Object (Целевой объект) – настройки точки выравни-
вания по выравниваемому объекту;

 y X/Y/Z Align Orientation (Выравнивание ориентации) – вы-
равнивание ориентации (поворота) объекта относительно целе-
вого;
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 y X/Y/Z Match Scale (Масштабирование по осям) – выравни-
вание масштаба объекта по масштабу другого объекта;

 y Apply – применение настроек, не закрывая окна.

Рис. 4.6. Окно выравнивания объектов

Для выравнивания объектов также можно использовать сочетание клавиш 

Alt + A. Для быстрого выравнивания объекта по центру другого объекта ис-

пользуют инструмент Quick Align (Shift + A).

Можно создать зеркальное отражение объекта при помощи 
команды Tools ⇒ Mirror (Инструменты ⇒ Зеркало). 

Способы клонирования объектов:
1) трансформация, выполненная мышью с удержанием кла-

виши Shift на клавиатуре;
2) команда Edit ⇒ Clone (Редактирование ⇒ Клонирование). 

При этом координаты созданной копии совпадут с исходным 
объектом, поэтому объекты сольются;

3) сочетание клавиш Ctrl + V.
При этих способах клонирования появляется окно управ-

ления Clone Options (Параметры клонирования), где можно вы-
брать тип создаваемых клонов и их количество: 

 y Copy (Независимая копия объекта) – независимый дубли-
рующий объект;

 y Instance (Привязка) – дублирующий объект и оригинал вза-
имозависимы, изменение параметров одного влечет за собой из-
менение параметров другого;
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 y Reference (Экземпляр)  – дублирующий объект, разделяю-
щий все параметры и лишь некоторые модификаторы с оригина-
лом и его образцами.

Можно клонировать и выровнять выделенный объект с по-
мощью команды Tools ⇒ Align ⇒ Clone and Align (Инструменты ⇒ 
Выравнивание ⇒ Клонирование и выравнивание). В диалоговом 
окне Clone and Align (Клонирование и выравнивание) при помо-
щи кнопки Pick (Выбрать) необходимо выделить объекты, отно-
сительно которых будут выравниваться созданные копии, уста-
новить параметры смещения копий относительно выровненной 
точки.

Создание большого массива клонов выполняют с помощью 
команды Tools ⇒ Array (Инструменты ⇒ Массив), которая вызы-
вает окно с настройками массива (рис. 4.7):

Рис. 4.7. Окно с настройками массива 

1. Incremental (Наращивание) – значения X, Y, Z определяют 
смещение: фиксированное либо увеличивается при определен-
ном расстоянии, и значение. 

2. Totals (Всего) – то же самое, но используются стандартные 
единицы измерения, которые указаны в настройках Units Setup 
(Установка единиц измерения).

3. Type of Object (Тип объекта) – выбор типа будущего объекта 
(копия, образец или ссылка).
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4. Array Dimensions (Размерность массива) – число копируе-
мых объектов.

5. Reset All Parameters (Сброс всех параметров) – сброс на-
строек.

6. Total in Array (Всего в массиве) – общее количество элемен-
тов в массиве.

7. Preview (Предварительный просмотр).
Массив может быть трех типов:
 y 1D (Одномерный) – клонированные объекты будут распо-

ложены в ряд;
 y 2D (Двумерный) – клонированные объекты будут располо-

жены в несколько рядов;
 y 3D (Трехмерный) – клонированные объекты будут распо-

ложены в несколько рядов и в несколько этажей.
Чтобы наблюдать за изменением положения массива объ-

ектов в окне проекции, используют кнопку Preview (Предвари-
тельный просмотр). Если создают множество объектов, которые 
имеют сложную геометрию, то перед нажатием кнопки Preview 
(Предварительный просмотр) лучше установить флажок Display 
as Box (Отображать как параллелепипед). 

Если необходимо работать с трехмерными объектами как 
с единым целым, то их можно объединить в группу, которая 
будет иметь свое название. Для группировки объектов выделя-
ют в сцене объекты, которые нужно сгруппировать, выполняют 
команду Group ⇒ Group (Группировать ⇒ Группировка) и в диа-
логовом окне G r o u p (Группировка) указывают Group name (Имя 
группы).

Меню Group (Группировать) содержит команды, предназна-
ченные для управления объектами группы:

 y Ungroup (Разгруппировать) – используют, если группа объ-
ектов больше не нужна и с объектами снова можно работать по 
отдельности;

 y Open (Открыть) – используют, если необходимо внести из-
менения в один или несколько объектов, составляющих группу, 
не уничтожая группу полностью. Для наглядности вокруг объ-
ектов открытой группы показывается габаритный контейнер ро-
зового цвета;

 y Close (Закрыть) – используют для закрытия группы после 
того, как группа была открыта и все необходимые операции с 
объектами выполнены;
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 y Attach (Присоединить) – предназначена для присоединения 
выделенного объекта к текущей группе;

 y Detach (Отсоединить) – команда дает возможность исклю-
чать объекты из группы. Она активна только в том случае, если 
группа открыта;

 y Explode (Уничтожить) – используют, если необходимо раз-
группировать сложный объект, состоящий из нескольких под-
групп. При ее выполнении происходит разгруппировка в том 
числе и вложенных групп.

После группировки объекты помещаются в единый габарит-
ный контейнер, оси координат которого находятся в его центре, 
т. е. все операции с группой выполняются относительно этого ус-
ловного центра. Чтобы изменить их положение, необходимо вы-
делить сгруппированный объект, на вкладке Hierarchy (Иерар хия) 
командной панели нажать кнопку Pivot (Опорная точка), в свитке 
настроек Adjust Pivot (Установить опорную точку) щелкнуть на 
кнопке Affect Pivot Only (Влиять только на опорную точку) и за-
дать параметры размещения опорной точки в области Alignment 
(Выравнивание) или подкорректировать положение осей вруч-
ную инструментом Move (Перемещение).

4.3.4. Составные объекты 

Булевы операции пришли в 3D-графику из математики, точ-
нее, из булевой алгебры (названной в честь ее создателя Джорд жа 
Буля), и основаны на понятиях объединения, пересечения и ис-
ключения. Начиная с версии 3d Max 2017, в булевых операци-
ях могут принимать участие более двух операндов. Эти объекты 
должны пересекаться, т. е. содержать общие точки. Булевы опера-
ции позволяют создавать составные объекты (рис. 4.8).

1. Union (Объединение). Результирующий объект, получен-
ный объединением двух объектов, содержит все точки двух ис-
ходных объектов-операндов, за исключением дубликатов общих 
точек (см. рис. 4.8, б).

2. Intersection (Пересечение). Объект, полученный в резуль-
тате операции пересечения, содержит только те точки, которые 
являются общими для двух исходных объектов (см. рис. 4.8, в). 

3. Substraction (Вычитание). Объект, который получается 
в результате выполнения этой логической операции, содержит 
только точки первого объекта за исключением тех точек, которые 
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являются общими для двух объектов. Операция логического вы-
читания одного объекта из другого является некоммутативной. 
Другими словами, разность А – В (см. рис. 4.8, г) – это не то же 
самое, что разность В – А (см. рис. 4.8, д).

А

В

а б в г д

Рис. 4.8. Булевы операции: а – исходные объекты;  

б – объединение; в – пересечение; г, д – вычитание

4. Merge (Слияние) – операция, аналогичная объединению, 
но отличие состоит в том, что перекрывающиеся грани объектов 
сохраняются.

5. Attach (Присоединение) – объединяет два или более объ-
екта в один без изменения их топологии.

6. Insert (Вставка) – вычитает границу базового операнда из 
последующего, а затем замещает вырезанную часть первым опе-
рандом.

Базовый объект (объект А) необходимо предварительно вы-
делить до выполнения операции. Затем на вкладке Create (Созда-
ние) в категории объектов Geometry (Геометрия) выбрать Compound 
Objects (Составные объекты), в списке типов объектов – Boolean 
(Булевы) (рис. 4.9, а). В отрывшемся свитке в группе параметров 
Operand Parameters (Параметры операнда) нужно выбрать булеву 
операцию (рис. 4.9, б) и указать остальные объекты, участвую-
щие в операции, с помощью кнопки Add Operands (Добавить опе-
ранды). По умолчанию эти объекты удаляются после выполне-
ния операции. 

В группе параметров Material (Материал) можно задать со-
хранение материала удаленного объекта в области пересечения – 
переключатель Apply Operand Material (Добавить материал опе-
ранда). Вариант Retain Original Material (Сохранить исходный ма-
териал) позволяет применить материал базового объекта.

В последних версиях программы появились два более совер-
шенных инструмента: ProBoolean (Улучшенные булевы) и Pro-
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Cutter (Улучшенные вырезанные), но инструмент Boolean (Буле-
вы) сохранен для сопряжения с более ранними версиями.

а б

Рис. 4.9. Применение булевых операций: а – вкладка Compound Objects (Составные 

объекты); б – свитки с параметрами булевой операции и операндов

При использовании ProBoolean (Улучшенные булевы) можно 
выбрать метод создания булевых объектов, который устанавли-
вается с помощью переключателя в свитке Pick Boolean (Выбрать 
булев объект):

 y Copy (Копия) – оригинал объекта В сохраняется;
 y Move (Перенос) – оригинал объекта В не сохраняется;
 y Instance (Образец) – сохраняется оригинал объекта В; из-

менения булева объекта и объекта B взаимозависимы;
 y Reference (Экземпляр) –  сохраняется оригинал объекта В; 

если изменять оригинал, то булев объект тоже изменится; если 
же изменять булев объект, то оригинал изменяться не будет.



227

4.3. Построение трехмерных объектов4.3. Построение трехмерных объектов

Составные объекты ProCutter (Улучшенные вырезанные) соз-
даны на основе объектов Boolean (Булевы) с логической операци-
ей Cut (Вырезать).

Параметры операндов и порядок применения операций мож-
но редактировать после создания булева объекта.

Практические задания по пункту 4.3

Задание 1. Задание 1. Создание трехмерных примитивов и манипуляции 
с ними. 

Рекомендации по выполнениюРекомендации по выполнению
1. Загрузите программу, выполните команду меню File ⇒  

Create (Файл ⇒ Создать).
2. На Command Panel (Командная панель) перейдите на 

вкладку Create (Создание), выберите раздел Geometry (Геоме-
трия) ⇒ Standard Primitives (Стандартные примитивы).

3. Нажмите кнопку Plane (Плоскость).
4. Активизируйте проекции Perspective (Вид в перспективе).

Если нужное окно не было активизировано заранее, чтобы не прерывать 

вызванную команду, можно активизировать окно, щелкнув внутри правой 

кнопкой мыши.

5. Задайте основание объекта Plane (Плоскость): нажмите ле-
вую кнопку мыши, задав первую точку основания, затем переме-
стите курсор по диагонали от первой точки, формируя основание 
объекта.

6. Для завершения создания объекта Plane (Плоскость) щелк-
ните внутри окна проекции один раз правой кнопкой мыши.

7. Для выделенного объекта установите Length (Длина) = 300 см, 
Width (Ширина) = 400 см.

8. Сохраните файл.
9. Выберите на командной панели Create (Создание) объект 

Box (Параллелепипед) и создайте квадратную столешницу в пла-
не, растягивая ее основание в окне проекции Тор (Вид сверху) из 
точки (0; 0; 0) при нажатой клавише Ctrl, со следующими разме-
рами: Length (Длина) = 145 см, Width (Ширина) = 145 см, Height 
(Высота) = 5 см.

10. Установите координаты опорной точки столешницы рав-
ными (0; 0; 70).

11. Измените цвет объекта на светло-коричневый и назовите 
его «Столешница». 
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12. Постройте ножки стола. Для этого создайте в центре окна 
проекции Тор (Вид сверху) параллелепипед квадратного сечения 
с размерами: Length (Длина) = 7,5 см, Width (Ширина) = 7,5 см, 
Height (Высота) = 70 см. 

13. Назовите объект «НожкаСтола01» и переместите его в 
точку (40; –40; 0).

14. Измените цвет объекта, сделав его таким же, как у сто-
лешницы. 

15. Используя команду меню Edit ⇒ 
Clone (Редактирование ⇒ Клонирова-
ние), создайте три копии ножки, назовите  
их «НожкаСтола02», «НожкаСтола03», 
«НожкаСтола04» и переместите в точки 
(40; 40; 0), (–40; –40; 0), (–40; 40; 0). Со-
храните файл.

16. Выберите на командной панели Create объект Box (Па-
раллелепипед) и создайте сиденье стула со следующими разме-
рами: Length (Длина) = 45 см, Width (Ширина) = 45 см и Height 
(Высота) = 5 см, растягивая его квадратное сечение из точки 
(100; 0; 0) при нажатой клавише Ctrl. 

17. Назовите объект «Сиденье» и задайте глобальные коорди-
наты его опорной точки: X = 100, Y = 0, Z = 40.

18. Выберите цвет сиденья «под дерево», например светло-ко-
ричневый. 

19. Создайте передние ножки стула. Выберите объект Box, 
нажав и удерживая клавишу Ctrl, щелкните в точке (82; 18; 0) 
окна проекции Тор (Вид сверху) и растяните сечение ножки сту-
ла до размеров 5½5 см. Высоту ножки сделайте равной 45 см.

20. Задайте точные значения координат ножки: X = 82, Y = 18, 
Z = 0.

21. Назовите объект «НожкаСтула01».
22. Создайте копию ножки, назовите ее «НожкаСтула02» и 

переместите в точку (82; –18; 0).
23. Сделайте обе ножки того же цвета, что и сиденье стула. 
24. Теперь создайте две задние ножки, которые одновремен-

но будут играть роль опор спинки стула. Для этого постройте в 
окне проекции Тор (Вид сверху) два параллелепипеда размером 
5½5½90 см и разместите их в точках (120; 18; 0) и (120; –18; 0). 
Настройте цвет ножек, сделав его таким же, как цвет остальных 
деталей стула. 
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25. Создайте подушку сиденья и спинку стула. Выберите 
в раскрывающемся списке Create (Создание) вариант Extended 
Primitives (Расширенные примитивы) и щелкните на кнопке 
Chamfer Box (Параллелепипед с фаской). 

26. В окне проекции Тор (Вид сверху) постройте куб с фа-
ской, задав ему следующие размеры: Length (Длина) = 42 см, 
Width (Ширина) = 42 см и Height (Высота) = 4,5 см.

27.  Высоту фаски (Fillet) установите равной 2,5 см, параметр 
Fillet Segs (Сегменты по фаске) 4. Установите флажок Smooth 
(Сглаживание), чтобы закруглить фаску. На-
зовите объект «Подушка» и задайте для его 
опорной точки координаты (98; 0; 44). Выбе-
рите для подушки подходящий цвет. 

28. В качестве спинки стула создайте 
в окне проекции Тор (Вид сверху) еще один 
куб с фаской, придав ему следующие разме-
ры: Length (Длина) = 45 см, Width (Ширина) =  
= 2,5 см, Height (Высота) = 25 см, Fillet (Фа-
ска) = 1,3 см, Fillet Segs (Сегменты по фаске) 4.  
Задайте для опорной точки спинки координаты (117; 0; 66).

29. Приведите цвет спинки в соответствие с цветом сиденья. 
30. Выделите все объекты, входящие в состав стула, и создай-

те из них группу, назвав ее «Стул».
31. Сохраните файл с именем 4_3-1.max.
Задание 2. Задание 2. Создание составных объектов. Объединение. 
Рекомендации по выполнениюРекомендации по выполнению
1. Создайте новую сцену. 
2. В новом файле постройте три стандартных примитива – 

две сферы одного диаметра и цилиндр. 
3. Выровняйте их центры по вертикали и разместите их по 

отношению друг к другу согласно рисунку.
4. Выделите цилиндр, активируйте булеву операцию Union 

(Объединение) для определения операнда B, щелкните по кнопке 
Pick Operand (Выбрать операнд), а затем укажите курсором одну 
из сфер.

5. Выделите объединенный объект, активизируйте режим 
создания булевых объектов, щелкните по кнопке Pick Operand B 
(Выбрать операнд B) и укажите вторую сферу. 

6. Результатом станет получение одного единственного буле-
ва объекта. Сохраните файл с именем 4_3-2.max.
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Задание 3. Задание 3. Создание составных объектов. Вычитание. 
Рекомендации по выполнениюРекомендации по выполнению
1. Создайте новую сцену. 
2. В проекции Top (Вид сверху) создайте объекты Chamfer 

Cylinder (Цилиндр с фаской): Radius (Радиус) = 30 см; Height (Вы-
сота) = 8 см; Fillet (Фаска) = 1,5 см; Sides (Количество сторон) 50 
и Cylinder (Цилиндр): Radius (Радиус) = 6 см; Height (Высота) =  
= 20 см; Segments (Количество сегментов) 1; Sides (Количество 
сторон) 30.

3. В проекции Front (Вид спереди) расположите цилиндр так, 
чтобы он насквозь проникал в Chamfer Cylinder (Цилиндр с фа-
ской).

4. Клонируйте цилиндр как Copy (Копия) (удерживая нажа-
той клавишу Shift, переместите цилиндр и в открывшемся меню 
выберите Copy).
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В булевых операциях не могут участвовать Instance-клоны – клоны объ-

ектов, созданные как Instance (Образец)

5. Выделите Chamfer Cylinder (Цилиндр с фаской). На пане-
ли Create (Создание) в разделе Geometry (Геометрия) выберите 
из выпадающего списка Compound Objects (Составные объекты) и 
нажмите кнопку Boolean (Булевы) (после нажатия кнопка станет 
желтой).

6. В свитке Pick Boolean (Выбрать булев объект) нажмите на 
кнопку Pick Operand B (Выбрать объект В) и щелчком мыши вы-
делите цилиндр.

7. Щелчком правой кнопкой мыши в любой области актив-
ного окна выйдите из режима Boolean (Булевы) (кнопка станет 
серой). 

8. Повторите те же действия со вторым цилиндром.
9. Для придания пуговице более реа-

листичного вида сделайте выемку. Создай-
те сферу: Radius (Радиус) = 70 см; Segments 
(Количество сегментов) 60.

10. Выровняйте центр сферы по центру 
пуговицы, используя инструмент Align (Вы-
равнивание).

11. Расположите сферу в проекции Front (Вид спереди) так, 
чтобы она лишь слегка пересекала пуговицу.

12. Выполните булевую операцию вычитания сферы из пуго-
вицы (см. рисунок).

13. Сохраните полученный результат в файле с именем  
4_ 3-3.max.

Контрольные вопросы
1. Какие категории объектов присутствуют в 3ds Max? 

2. Перечислите типы примитивов свитка Geometry (Геометрия). Для чего их при-

меняют?

3.  В чем отличие стандартных примитивов от улучшенных? Как изменяются па-

раметры объектов? 

4. Какие способы копирования используют в 3ds Max? В чем разница между 

Copy  (Копия) и Instance (Образец)?

5. Как создать простейший геометрический объект? Какие у него параметры? 

6. В чем разница между масштабированием объекта и изменением его линейных 

размеров? Как задать эти параметры? 

7. Как переместить объект строго по вертикали?
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8. Как нарисовать плоскость строго вертикально? горизонтально? Какое окно 

проекции применяют для создания ножек стола? спинки стула?

9. Как расположить плоскость на нулевой отметке? центрировать поверхности 

между собой?

10. Дайте понятие составных объектов. 

11. Как изменить результат булевых операций?

12. Как выделить сразу несколько объектов? Перечислите способы выделения.

13. В каком случае операция А – В будет коммутативна? Приведите примеры.

14. Поясните разницу между параметрическими и редактируемыми объектами.

4.4. Полигональное моделирование

Любой параметрический объект, созданный на основе прими-
тива, может быть преобразован в объект типа Editable Mesh (Редак-
тируемая сетка) или Editable Poly (Редактируемая полисетка) с по-
мощью команды Convert to (Преобразовать) контекстного меню. 
К объектам типа Editable Mesh (Редактируемая сетка) относят гео-
метрические модели трехмерных тел, представленных оболочками 
в виде сеток с треугольными ячейками. Объекты типа Editable Poly 
(Редактируемая полисетка) отличаются от редактируемых сеток 
тем, что их оболочки состоят не из треугольных граней, а из по-
лигонов. Полигоны представляют собой многоугольники, у кото-
рых имеются как минимум четыре вершины; они заменяют сово-
купность двух или более смежных треугольных граней, лежащих 
в одной плоскости. Поэтому сетку, составленную из полигонов, 
называют полигональной сеткой, или полисеткой.

Вершины – это точки, в которых сходится и соединяется друг 
с другом любое число ребер. Для работы с вершинами предна-
значен уровень Vertex (Вершина).

Ребра – это линии границы грани. Ребра могут быть види-
мыми, если соседние грани не лежат в одной плоскости (тогда 
они отображаются сплошными линиями), или невидимыми; по 
запросу пользователя невидимые ребра могут отображаться пун-
ктирной линией. За управление видимостью и положением ребер 
отвечает уровень Edge (Ребро).

Грани – это участки плоскости треугольной формы, пред-
ставляющие собой элементарные ячейки сетки. В одной плоско-
сти объекта может находиться множество граней, которые внеш-
не будут совершенно неразличимы. Для работы с гранями пред-
назначен уровень Face (Грань).
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Смежные грани, лежащие в одной плоскости, могут быть 
объединены в многоугольники-полигоны. В случае преобразо-
вания объекта к типу Editable Poly (Редактируемая полисетка) 
процесс формирования полигонов из граней осуществляется ав-
томатически. В обычной сетке полигон – это просто подобъект 
(рис. 4.10), позволяющий выделить сразу все смежные грани, 
лежащие в одной плоскости. У полигональной сетки нет таких 
подобъектов, как грани, и вся она состоит только из полигонов, 
причем некоторые полигоны могут быть и треугольными. За ра-
боту с полигонами отвечает уровень Polygon (Многоугольник).

Polygon (Многоугольник)
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Рис. 4.10. Подобъекты

Кроме того, сеточные объекты можно редактировать на уров-
не Element (Элемент), который используют для работы с группа-
ми граней, объединенными в элемент каркаса, а объекты типа 
Editable Poly (Редактируемая полисетка) – и на уровне Border 
(Граница), что удобно, например, при вдавливании границ.

После преобразования на панели Modify (Изменение) при-
митива появятся свитки: 

 y Selection (Выделение) – отвечает за включение нужного под-
объектного уровня и управление режимами выбора подобъектов:

1 – Vertex – выбрать и работать с вершинами;
2 – Edge – выбрать и работать 

с ребрами (гранями);
3 – Border – работать с «пусты-

ми» границами модели;
4 – Polygon – работать с много-

угольниками (полигонами) модели;
5 – Element – выделить элементы модели.

          1        2     3       4      5
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Инструменты Grow (Выращивать) и Shrink (Сокращать) пред-
назначены для выделения субобъектов. Они позволяют увеличить 
и уменьшить радиус выделения. При нажатии кнопки Grow (Вы-
ращивать) к выделению добавляются субобъекты, которые примы-
кают к выделенным, а при щелчке на кнопке Shrink (Сокращать), 
наоборот, из выделения убираются крайние субобъекты. Флажок 
Ignore Backfacing (Игнорировать задние (невидимые) грани) позво-
ляет выделять области субобъектов, обращенные к зрителю;

 y Soft Selection (Мягкое выделение) – предназначен для рас-
ширения возможностей выделения подобъектов и определяет за-
кон распространения трансформаций по объему редактируемого 
каркаса. 

Чтобы включить функцию Soft Selection 
(Мягкое выделение), необходимо выбрать 
один из пяти подчиненных объектов и уста-
новить флажок напротив Use Soft Selection 
(Использовать мягкое выделение) (рис. 4.11). 
Параметры:

– Falloff – задает размер области мягкого 
выделения;

– Pinch – позволяет заострить верх;
– Bubble – закругляет выделение.
Определять характер мягкого выделения 

можно, используя виртуальную кисть (ин-
струменты области Paint Soft Selection (Мягкое 
выделение кистью);

 y Edit Geometry (Редактировать геометрию) – содержит ос-
новные инструменты изменения геометрии подобъектов. 

Некоторые инструменты одинаковы для всех уровней и для 
обоих типов сеток, а другие являются особыми для каждого 
уровня (и/или сетки). Перечень всех команд и уровней, на кото-
рых они применяются, приведен в таблице 4.1.

Таблица 4.1

Назначение инструментов редактирования сетки 

Название Уровень* Назначение кнопки

Create V, F, Poly Добавление элементов

Delete V, Edg, F, Poly Удаление элементов

Attach V, Edg, F, Poly Присоединение других (независимых) (Attach List) объектов 

сцены. Объекты другого типа автоматически конвертируются 

в объекты типа Mesh (Сетка)

Рис. 4.11. Свиток Soft 

Selection (Мягкое 

выделение)
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Название Уровень* Назначение кнопки

Detach V, Edg, F, Poly Отделение подобъектов с созданием на их основе неза-

висимого объекта. Появляется диалоговое окно, где нужно 

ввести имя; флажок Detach as Clone (Отделить как клон) 

позволяет отделить не сам подобъект, а его копию

Divide, Break V, Edg, F, Poly Операция Divide (Разделить) делит подобъект на две части. 

Операция Break (Разбить) разбивает выделенные вершины так, 

чтобы ни одна из них не принадлежала более чем одной грани

Turn Edg Поворот выделенной грани на 90° с образованием на ее 

основе двух треугольных граней, для которых данная грань 

является общей

Extrude Edg, F, Poly Выдавливание подобъектов. Величину выдавливания вводят 

в соседнее поле

Chamfer, Bevel V, Edg, F, Poly Кнопка Chamfer (Фаска) позволяет создать фаску на основе 

выбранных подобъектов. Bevel (Скос) позволяет стянуть или 

расширить выбранную совокупность

SlicePlane V, Edg, F, Poly Установка вспомогательной плоскости для операции Slice (Срез)

Slice V, Edg, F, Poly Создание новых элементов на месте пересечения плоскости 

и объекта

Cut Edg, F, Poly Создание вручную новых ребер и рассечение грани с до-

бавлением ребра. При установленном флажке Split (Разрыв) 
создаются две вершины на концах точек рассечения ребер. 

Установка флажка Refine Ends (Уточнить грани) разбивает 

примыкающие грани, чтобы предотвратить появление не-

нужных отверстий

Explode F, Poly Отделение подобъекта либо в подобъект, который находит-

ся внутри объекта (Element), либо в независимый объект 

(Object)

Selected V Удаление вершин путем их аппроксимации в одну усред-

ненную общую (слияние); минимальное расстояние между 

вершинами, при котором начинает действовать слияние, 

задается рядом. Операцию применяют к выделенной сово-

купности вершин

Target V Действие кнопки подобно Selected, но усредненную точку 

пользователь выбирает сам (значение в рядом расположен-

ном поле задает максимальную дистанцию между курсором 

и целью, при которой происходит слияние)

Tessellate F, Poly Добавление граней сразу ко всему объекту (т. е. происходит 

разбиение на более мелкие части)

Remove 

Isolated 

Vertices

V, Edg, F, Poly Удаление вершин, которые не связаны гранями

Select Open 

Edges

Edg Выделение ребер, которые входят только в одну грань

Продолжение табл. 4.1
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Название Уровень* Назначение кнопки

Create Shape 

from Edges

Edg Создание формы из ребра

View Align V, Edg, F, Poly Выравнивание по плоскости активной проекции

Grid Align V, Edg, F, Poly Выравнивание по активной решетке

Make Planar V, Edg, F, Poly Превращение набора граней в плоскость

Collapse V, Edg, F, Poly Объединение (сворачивание) всех вершин в одну

*V – вершина, F – треугольная грань, Edg – ребро, Poly – полигон 
(многоугольник).

Выбор нужного уровня подобъектов осуществляют щелч-
ком по соответствующей кнопке в свитке Selection (Выделение) 
вкладки Modify (Изменение). Для выбора самих подобъектов ис-
пользуют обычные инструменты выделения: Select Object (Выде-
лить объект), Select and Move (Выделить и передвинуть), Select and 
Scale (Выделить и масштабировать), Select and Rotate (Выделить 
и повернуть) и Selection Region (Форма области выделения). Чтобы 
последовательно выделить несколько объектов, при выполнении 
действия удерживают клавишу Ctrl.

Для того чтобы вернуться от редактирования объекта на 
уровне подобъектов к обычному редактированию, нужно подсве-
тить в списке подобъектов уровень Editable Mesh (Редактируемая 
сетка) или Editable Poly (Редактируемая полисетка).

Объекты, представленные в виде полигональных сеток, до-
вольно часто сглаживаются с помощью операции Smooth (Сгла-
живание) из свитка Edit Geometry (Редактировать геометрию).

Практические задания по пункту 4.4

Задание 1. Задание 1. Моделирование при помощи полигонов.
Рекомендации по выполнениюРекомендации по выполнению
1. Создайте новую сцену. 
2. Создайте примитив Box (Параллелепипед) с параметра-

ми: Length (Длина) = 100 см, Width (Ширина) = 100 см и Height 
(Высота) = 100 см, Length Segs (Количество сегментов по дли-
не) 3, Width Segs (Количество сегментов по ширине) 3, Height 
Segs (Количество сегментов по высоте) 3. Обратите внимание, 
что число сегментов по длине, высоте и ширине соответствует 
запланированному числу кубиков на каждой из сторон: по три  
сегмента.

Окончание табл. 4.1
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3. Преобразуйте объект к типу Editable Poly (Редактируемая 
полисетка) и установите режим редактирования полигонов. 

4. Выделите все полигоны и примените к ним операцию 
Bevel (Скос) при параметрах: Bevel Type (Тип фаски) – By Poligon 
(По грани), Height (Высота) = 5 см, Outline Amount (Величина кон-
тура) = 0 см. 

5. Повторите данную операцию в отношении полигонов, 
но уже при параметрах Height (Высота) = 0 см и Outline Amount 
(Величина контура) = 2 см. В итоге куб окажется разбитым на 
отдельные кубические фрагменты и будет похож на настоящий 
кубик Рубика.

6. Выделите полигоны, расположенные на одной стороне ку-
бика (рис. 4.12, а), и щелкните в свитке Edit Geometry (Редакти-
ровать геометрию) на кнопке Detach (Отсоединить) – подобъекты 
окажутся отделенными. Чтобы выделить отделенный объект, ис-
пользуйте команду Select By Name (Выделять по имени), выберите 
имя объекта, а потом перекрасьте его в другой цвет. 

7. Вновь перейдите к кубу, активизируйте режим редактиро-
вания полигонов и аналогичным образом выделите полигоны на 
другой стороне кубика, превратите их в отдельный объект коман-
дой Detach (Отсоединить), выделите созданный объект по имени 
и тоже перекрасьте. И так – для всех остальных сторон. Получен-
ный в результате кубик Рубика представлен на рисунке 4.12, б.

а б

Рис. 4.12. Создание кубика Рубика из куба: а – выделение 

отделяемых полигонов; б – кубик Рубика в готовом виде

8. Сохраните файл с именем 4_4-1.max.



238

Раздел 4. Основы трехмерного моделирования 

Задание 2. Задание 2. Моделирование при помощи полигонов.
Рекомендации по выполнениюРекомендации по выполнению
1. Создайте новую сцену. 
2. Создайте объект с помощью примитива Capsule (Капсула) 

со следующими параметрами: Radius (Радиус) = 7 см, Height (Вы-
сота) = 25 см, Sides (Количество сторон) 3, Height Segs (Количе-
ство сегментов по высоте) 1. Установите флажок Slice On (Обре-
зать) и выберите значение параметров Slice From (Обрезать от) 0, 
Slice to (Обрезать до) 180. Поверните объект на 90° вокруг оси Х. 

3. Преобразуйте объект в Editable Mesh (Редактируемая сетка). 
4. Переключитесь в режим редактирования Edge (Ребро), 

уста новите флажок Ignore Backfacing  (Игнорировать задние (не-
видимые) грани), чтобы при редактировании не задеть лишнее 
ребро, и выделите ребро, лежащее в центре объекта. 

5. В окне проекции Front (Вид спереди) или Left (Вид слева) 
передвиньте ребро вниз по оси Y. 

6. Для создания ручки ложки перейдите в режим Vertex 
(Вершина), выделите одну из острых вершин и нажмите кнопку 
Chamfer (Фаска), установив значение параметра 4,4. На месте вер-
шины будет образован новый полигон. 

7. Переключитесь в режим Polygon (Многоугольник). Выде-
лите созданный только что полигон. В свитке Edit Geometry (Ре-
дактировать геометрию) установите значение параметра Extrude 
(Выдавливание) равным 11, значение параметра Bevel (Скос) рав-
ным –0,5.

8. При помощи команды Rotate (Поворот) поверните выде-
ленный полигон на 100° вдоль оси Х. 

9. Трижды выполните операцию Extrude (Вы-
давливание со скосом), установив значение равным 
11. В результате получится ручка (см. рисунок). 

10. Не снимая выделение с полигона, выполни-
те команду Scale (Масштаб искажений) вдоль оси Х.

11. Выйдите из режима редактирования Poly-
gon, выделите весь объект и перейдите на вкладку 

Modify (Изменение). Из списка Modifier List (Стек модификаторов) 
выберите модификатор Mesh Smooth (Сглаживание сетки). 

12. В свитке Subdivision Amount (Количество делений) устано-
вите значение параметра Iterations (Итерации) равным 2. 

13. Сохраните файл с именем 4_4-2.max.
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Контрольные вопросы
1. Опишите структуру Editable Poly (Редактируемая полисетка). На каких уровнях 
возможно редактирование Editable Poly?
2. Какие возможности представляет редактирование Editable Poly (Редактируе-
мая полисетка) на уровне вершин? 
3. Назовите основные команды редактирования Editable Poly (Редактируемая по-
лисетка) на уровне сегментов.
4. Каким образом выбрать уровень редактирования?
5. Какие способы выделения подобъектов присутствуют в программе?
6. В чем различие между объектами типа Editable Mesh (Редактируемая сетка) 
и Editable Poly (Редактируемая полисетка)?
7. Опишите возможности, преимущества и недостатки полигонального модели-
рования. 

4.5. Создание трехмерных объектов на основе сплайнов

Сплайн (Spline) – двумерная самостоятельная геометрическая 
фигура, которая служит основой для построения сложных трех-
мерных объектов. Editable Spline (Редактируемый сплайн) – это 
объект, редактируемый по точкам, сегментам и линиям. 

Вершины – это точки, расположенные на сплайне и различа-
ющиеся по типу. Они же определяют степень кривизны сегмен-
тов сплайна, прилегающих к этим вершинам.

Сегмент – это часть линии сплайна между двумя соседними 
вершинами.

В 3ds Max используют четыре типа вершин:
1. Corner (Угловая) – вершина (рис. 4.13, а), примыкающие 

сегменты к которой не имеют кривизны.
2. Smooth (Сглаженная) – вершина (рис. 4.13, б), через кото-

рую кривая сплайна проводится с изгибом и имеет одинаковую 
кривизну сегментов с обеих сторон от нее.

3. Bezier (Безье) – вершина (рис. 4.13, в), подобная сглажен-
ной, но позволяющая управлять кривизной сегментов сплайна 
с обеих сторон от вершины.

4. Bezier Corner (Безье угловая) – вершина (рис. 4.13, г), ко-
торая, как и вершина типа Bezier, снабжена касательным векто-
ром. Однако у вершин Bezier Corner касательные не связаны друг 
с другом отрезком, и ручки Безье можно перемещать независимо.

Для построения плоских объектов нужно выбрать вкладку 
Create ⇒ Shapes (Создание ⇒ Формы), из раскрывающегося списка 
категорий Splines (Сплайны). Откроется свиток Object Type (Тип 
объекта), содержащий список доступных объектов (рис. 4.14, а).
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а б

в г

Рис. 4.13. Типы вершин

                          а                                                  б                                          в

Рис. 4.14. Параметры сплайна

Сплайновый инструментарий программы включает следую-
щие фигуры (см. рис. 4.14):

 y Line (Линия);
 y Circle (Окружность);
 y Arc (Дуга);
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 y NGon (Многоугольник);
 y Text (Сплайновый текст);
 y Egg (Яйцо);
 y Freehand (Свободное рисование);
 y Rectangle (Прямоугольник);
 y Ellipse (Эллипс);
 y Donut (Кольцо);
 y Star (Многоугольник в виде звезды);
 y Helix (Спираль);
 y Section (Сечение).

Для построения сплайна выбирают объект требуемого типа. 
В нижней части появляются свитки с параметрами выбранно-
го объекта: Rendering (Визуализация) (рис. 4.14, б), Interpolation 
(Интерполяция), Creation Method (Метод создания), Keyboard 
Entry (Клавиатурный ввод) (рис. 4.14, в), Parameters (Параметры).

Объекты Line (Линия) и Arc (Дуга) имеют свитки Creation 
Method (Метод создания), в которых для дуги можно отметить 
параметр Edge (Ребро) или Center (От центра) в зависимости от 
способа построения. Для линии в нем задается тип вершин, ис-
пользуемых при построении.

Чтобы линия была прямая, при ее рисовании следует нажать 
клавишу Shift. Построение производят по точкам. При простом кли-
ке образуется угловая точка (Corner), если кликнуть мышью и по-
тянуть – образуется сглаженная нередактируемая линия (Smooth).

По умолчанию сплайновые примитивы не отображаются на 
этапе визуализации и используются как вспомогательные объек-
ты для создания моделей со сложной геометрией. Однако любой 
сплайновый примитив может выступать в сцене как самостоя-
тельный объект. Для этого в свитке Rendering (Визуализация) 
нужно установить флажок Renderable (Показать при визуали-
зации), а также задать толщину (Thickness), количество сторон 
(Sides) и угол поворота (Angle). 

В свитке Interpolation (Интерполяция) настраивают параметры 
интерполяции криволинейных сегментов сплайна, т. е. задают число 
точек излома криволинейных сегментов с помощью счетчика Steps 
(Шаги), а также устанавливают параметр Optimize (Оптимизация), 
который заставляет программу оптимизировать сплайн путем сброса 
в ноль числа шагов для его линейных сегментов.

В 3ds Max есть также дополнительные сплайновые объекты, 
которые отличаются сложной формой и гибкими настройками:
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 y WRectangle (Прямоугольник за стеной) – позволяет соз-
давать закрытые сплайны, состоящие из двух концентрических 
прямоугольников;

 y Channel (С-образный) – позволяет создавать закрытые 
сплайны в форме буквы C, напоминающие канавки;

 y Angle (L-образный) – позволяет создавать закрытые сплай-
ны в форме буквы L, напоминающие уголки;

 y Tee (T-образный) – позволяет создавать закрытые сплайны 
в форме буквы T;

 y Wide Flange (I-образный) – позволяет создавать закрытые 
сплайны в форме буквы I.

Любой сплайновый примитив можно преобразовать в Editable 
Spline (Редактируемый сплайн), который позволяет изменять фор-
му объектов, с помощью команды Convert to ⇒ Convert to Editable 
Spline (Преобразовать ⇒ Преобразовать в редактируемый сплайн) 
контекстного меню сплайнового объекта. Но необходимо учиты-
вать, что при этом теряются параметрические свойства объекта 
(становится невозможным использовать такие параметры объек-
та, как ширина, высота, радиус и т. д.), зато открывается полный 
набор возможных команд в свитке Edit Object (Редактирование 
объекта). Объект Line (Линия), в отличие от других сплайновых 
примитивов, по умолчанию обладает всеми свойствами редакти-
руемого сплайна.

Сплайны можно редактировать на уровне формы (уровне объ-
екта), на уровне подобъектов: Vertex (Вершина), Segments (Сегмен-
ты) и Spline (Сплайн) (как составляющей части объекта). Доступ 
к редактированию сплайнов на уровне отдельных сегментов 
и вершин открывается с помощью кнопки Modify (Изменение) на 
командной панели.

Редактирование сплайна на уровне формы позволяет присо-
единить к ней другие готовые сплайны, создавать отрезки линий 
в качестве сегментов текущего сплайна, изменять параметры ин-
терполяции криволинейных сегментов, заданных при его созда-
нии. К примеру, для присоединения к выделенной сплайновой 
форме другого сплайна необходимо раскрыть свиток Geometry 
(Геометрия) и выбрать кнопку Attach (Присоединить). Затем пе-
реместить курсор в окно проекции и указать на присоединяемый 
сплайн. Когда курсор примет специальный вид, щелкнуть левой 
кнопкой мыши. Два сплайна будут соединены в одну форму.
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Редактирование сплайнов на уровне вершин. Для работы 
с вершинами в свитке Selection (Выбор) нужно выбрать пикто-
грамму Vertex (Вершина). В выделенном сплайне все вершины 
обозначатся крестиками, а первая вершина – квадратиком. Для 
изменения типа вершины нужно выделить одну или несколько 
вершин любым известным способом (например, прямоугольной 
рамкой) и в контекстном меню указать новый тип вершины. 

В таблице 4.2 приведены основные операции, применяемые 
при редактировании вершин. 

Таблица 4.2

Операции редактирования вершин

Название Назначение 

Connect (Соединить) Соединить две вершины на концах разомкнутого сплайна отрезком 

прямой

Break (Разбить) Разбить любую, кроме концевых, вершину сплайна на две совпадаю-

щие, но не соединяющиеся вершины

Refine (Уточнить) Вставить дополнительную вершину в произвольной точке сплайна без 

изменения его формы

Insert (Вставить) Вставить вершину в любой точке сплайна, сразу же переместить ее и 

продолжить добавление новых вершин

Weld (Объединить) Объединить две концевые или совпадающие вершины в одну; в счет-

чике Weld Threshold (Порог слияния) задают расстояние, при котором 

будут объединяться совпадающие вершины

Delete (Удалить) Удалить выделенные вершины сплайна

Редактирование сплайнов на уровне сегментов. Для того 
чтобы иметь возможность редактирования сплайнов на уровне 
сегмен тов, в свитке Selection (Выбор) нужно выбрать пиктограм-
му Segment (Сегмент). Выделенные сегменты отличаются крас-
ным цветом. Щелчок правой кнопкой мыши на выделенном 
сегмен те вызывает контекстное меню, где в нижней части можно 
изменить тип сегмента: Curve (Кривая) и Line (Линия). Текущий 
тип отмечен флажком. В таблице 4.3 приведены основные опе-
рации, применяемые при редактировании сегментов, доступные 
в свитке Geometry (Геометрия).

Таблица 4.3

Операции редактирования сегментов

Название Назначение 

Detach (Отделить) Отделить сегмент сплайна, превратив его в самостоятельный объект 
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Название Назначение 

Break (Разбить) Разбить сплайн на отдельные части, добавив новую вершину в указан-

ной точке

Refine (Уточнить) Вставить вершину в произвольной точке сплайна, не разбивая сплайн 

Divide (Разделить) Равномерное разбиение выделенного сегмента на более мелкие 

сегменты за счет размещения равноудаленных вершин по всей длине 

сегмента; в счетчике Divisions (Деления) указываеют число разбиений

Insert (Вставить) Вставить вершину в любой точке сплайна, сразу же переместить ее и 

продолжить добавление новых вершин

Weld (Объединить) Объединить две концевые или совпадающие вершины в одну; в счетчике 

Weld Threshold (Порог слияния) задают расстояние, при котором будут 

объединяться совпадающие вершины

Delete (Удалить) Удалить выделенный сегмент сплайна 

Редактирование сплайнов на уровне сплайнов. Для редакти-
рования сплайнов в свитке Selection (Выбор) необходимо выбрать 
пиктограмму Spline (Сплайн). Выделенный сплайн приобретет 
красный цвет в окнах проекций.

Команды свитка Geometry (Геометрия) при редактировании 
сплайна на уровне Spline (Сплайн):

1. Outline (Контур) – позволяет создать концентрическую ко-
пию сплайна.

2. Boolean (Булевы) – вычитание, объединение, пересечение 
нескольких сплайнов. Для того чтобы объединить два сплайна, 
нужно щелкнуть на кнопке Attach (Присоединить), далее на при-
соединяемом сплайне, затем последовательно на кнопках Boolean 
(Булевы) и Union (Объединение). После этого нужно навести 
на второй сплайн курсор и, когда он примет специальный вид, 
щелкнуть левой кнопкой мыши. Две другие булевы операции: 
Intersection (Пересечение) и Subtraction (Исключение) выполняют 
аналогично. 

3. Mirror (Зеркало) – зеркальное отображение сплайна. 
Для работы с командой Mirror (Зеркало) необходимо назна-

чить один из вариантов зеркального отражения и щелкнуть на 
кнопке Mirror (Зеркало). Выделенный сплайн зеркально отра-
зится в соответствии с пиктограммой на кнопке группы вариан-
тов. Флажок Copy (Копия) позволяет создать зеркальную копию 
выделенного сплайна. Нажатие кнопки Reverse (Обратить) ведет 
к обращению порядка следования вершин выделенного сплайна.

Окончание табл. 4.3
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4. Trim (Обрезать) – позволяет обрезать ненужные части 
сплайна до пересечения с каким-либо участком сплайна.

5. Extend (Продлить) – позволяет продлить часть сплайна до 
пересечения с каким-либо участком сплайна.

6. Detach (Отсоединить) – позволяет разъединить два сплайна  
на абсолютно независимые друг от друга объекты.

Для придания сплайновым формам объема существует ряд 
модификаторов (будут рассмотрены далее), например:

 y Extrude (Выдавливание);
 y Bevel (Скос с выдавливанием);
 y Lathe (Вращение).

Практические задания по пункту 4.5

Задание 1. Задание 1. Создание сплайнов.
Рекомендации по выполнениюРекомендации по выполнению
1. Создайте новую сцену. 
2. Для создания сплайна типа Line (Линия) перейдите в па-

нель Create (Создание) и выберите пункт Splines (Сплайны) из 
раскрывающегося списка, вызываемого кнопкой Shapes (Формы). 

3. В свитке Object Type (Тип объекта) щелкните на кнопке 
Line (Линия). Переместите курсор в видовое окно Тор (Сверху) и 
произведите серию щелчков левой кнопкой мыши и перемеще-
ний, создавая ломаную линию произвольной формы. Для завер-
шения выполните щелчок правой кнопкой мыши. 

4. Все созданные вершины принадлежат к типу Corner (Угло-
вая), в чем можно убедиться, перейдя на вкладку Modify (Изме-
нение) и выбрав подобъектный уровень Vertex (Вершина). 

5. Выделите любую вершину щелчком правой кнопкой мыши 
для вызова контекстного меню. 

6. Вернитесь обратно на вкладку Create (Создание) команд-
ной панели и измените Creation Method (Метод создания) вершин 
линии, установив переключатель Initial Type (Начальный тип) в 
значение Smooth (Сглаживание). 

7. Повторите создание произвольной ломаной линии. Те-
перь все сегменты приобрели кривизну и указание каждой новой 
вершины видоизменяет смежные сегменты по криволинейному 
закону. Если же при выполнении щелчка не отпускать кнопку 
мыши, то, растягивая далее новый сегмент, можно отрегулиро-
вать кривизну предыдущего. 
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8. Выберите из свитка Object Type (Тип объекта) объект 
Rectangle (Прямоугольник) и создайте в проекции Тор (Сверху) 
прямоугольник, указав поочередно вершины его диагонально 
расположенных углов. Такой способ создания выбирают пере-
ключателем Edge (Ребро). 

9. Укажите следующие значения в свитке Parameters (Пара-
метры): Length (Длина) = 100 см, Width (Ширина) = 190 см, Corner 
Radius (Радиус закругления) = 10 см. 

10. Перейдите на вкладку Modify (Изменение) и обратите 
внимание, что сплайн типа Rectangle (Прямоугольник) не име-
ет подобъектной структуры, т. е. не позволяет редактировать его 
вершины и сегменты. 

11. Чтобы такая возможность по-
явилась, преобразуйте сплайн в Editable 
Spline (Редактируемый сплайн).

12. Постройте фигуры на основании 
сплайна Rectangle (Прямоугольник), из-
меняя их параметры, чтобы добиться 
форм, аналогичных представленным на 
рисунке. 

13. Сохраните файл с именем 
4_5-1.max.

ЗЗададание 2. ание 2. Моделирование лампы с помощью сплайнов.
Рекомендации по выполнениюРекомендации по выполнению
1. Создайте новую сцену.
2. Создайте в окне проекции объект Chamfer Cylinder (Ци-

линдр с фаской). Перейдите на вкладку Modify (Изменение) ко-
мандной панели и установите для него следующие параметры: 
Radius (Радиус) = 55 см, Height (Высота) = 11 см, Fillet (Закруг-
ление) = 1,5 см, Height Segs (Количество сегментов по высоте) 4, 
Fillet Segs (Количество сегментов на фаске) 5, Cap Segs (Количе-
ство сегментов в основании) 7, Sides (Количество сторон) 50. Что-
бы объект принял сглаженную форму, установите флажок Smooth 
(Сглаживание). 

3. Чтобы основание лампы смотрелось более реалистично, 
сделайте в нижней ее части ободок. Для этого клонируйте объ-
ект Chamfer Cylinder (Цилиндр с фаской), перейдите на вкладку 
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Modify (Изменение) командной панели и установите для полу-
ченного объекта больший радиус – 57 см. Измените также другие 
параметры: Height (Высота) = 3 см, Fillet (Закругление) = 0,4 см, 
Height Segs (Количество сегментов по высоте) 3, Fillet Segs (Коли-
чество сегментов на фаске) 4, Cap Segs (Количество сегментов в 
основании) 1, Sides (Количество сторон) 50. Чтобы объект при-
нял сглаженную форму (см. рисунок), установите флажок Smooth 
(Сглаживание).

 

4. Создайте в окне проекции объект Chamfer Cylinder (Ци-
линдр с фаской). Перейдите на вкладку Modify (Изменение) ко-
мандной панели и установите для него следующие параметры: 
Radius (Радиус) = 12 см, Height (Высота) = 4 см, Fillet (Закругле-
ние) = 0,6 см, Height Segs (Количество сегментов по высоте) 4, 
Fillet Segs (Количество сегментов на фаске) 5, Cap Segs (Количе-
ство сегментов в основании) 4, Sides (Количество сторон) 40. Что-
бы объект принял сглаженную форму, установите флажок Smooth 
(Сглаживание). 
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5. Выровняйте созданный объект относительно основы на-
стольной лампы. Для этого в окне Align Selection (Выравнивание 
выделенных объектов) установите следующие параметры: флажок 
Z Position (Z-позиция); переключатель Current Object (Объект, ко-
торый выравнивается) – в положение Center (По центру); пере-
ключатель Target Object (Целевой объект, относительно которо-
го выравнивается) – в положение Maximum (По максимальным 
координатам выбранных осей). Нажмите кнопку Apply (Приме-
нить). Положение выключателя на основе лампы в плоскости XY 
подберите вручную. 

Клонируйте первый элемент включателя. Перейдите на 
вкладку Modify (Изменение) командной панели и установите для 
созданного объекта следующие параметры: Radius (Радиус) = 
= 11 см, Height (Высота) = 9 см, Fillet (Закругление) = 0,6 см, 
Height Segs (Количество сегментов по высоте) 4, Fillet Segs (Коли-
чество сегментов на фаске) 5, Cap Segs (Количество сегментов 
в основании) 4, Sides (Количество сторон) 40. Чтобы объект при-
нял сглаженную форму, установите флажок Smooth (Сглажива-
ние). Включатель готов. 

6. Для моделирования ножки лампы 
используйте сплайн Line (Линия) требу-
емой формы. Чтобы создать объект Line 
(Линия), необходимо перейти на вкладке 
Create (Создание) командной панели в ка-
тегорию Shapes (Формы) и нажать соответ-
ствующую кнопку.

7. Переключитесь в окно проекции 
Front (Вид спереди) и с помощью инст-
румента Line (Линия) создайте ломаную. 
Обратите внимание, что нижняя часть 
кривой должна заходить в середину осно-
вания лампы (см. рисунки).

8. Выделите объект в окне проекции 
Тор (Сверху), перейдите на вкладку Modify 
(Изменение) командной панели.

9. Переключитесь в режим редакти-
рования Vertex (Вершина). Выделите одну 
или несколько вершин, и в контекстном 
меню измените тип на Bezier (Безье).
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Чтобы улучшить форму сплайна, для некоторых вершин нужно не толь-

ко изменить тип, но и переместить их. 

10. Выйдите из режима редактирования Vertex (Вершина) и 
в свитке Rendering (Визуализация) настроек объекта Line (Ли-
ния) установите флажки Enable in Renderable (Визуализируемый) 
и Display Render Mesh (Отображать оболочку объекта), а также 
задайте значение параметра Thickness (Толщина) равным 12, а 
параметра Sides (Количество сторон) 13. Благодаря этому сплайн 
приобретет вид изогнутого цилиндра. 

11. Перейдите в окно проекции Тор (Сверху) и вручную под-
берите оптимальное положение для совмещения ножки с осно-
вой (см. рисунок).

12. Создайте втулку, соединяющую основу с ножкой. Для это-
го клонируйте один из объектов Chamfer Cylinder (Цилиндр с фа-
ской), составляющих выключатель. Перейдите на вкладку Modify 
(Изменение) командной панели и установите для него следую-  
щие параметры: Radius (Радиус) = 9 см, Height (Высота) = 15 см, 
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Fillet (Закругление) = 3 см, Height Segs (Количество сегментов по 
высоте) 4, Fillet Segs (Количество сегментов на фаске) 5, Cap Segs 

(Количество сегментов в основании) 1, 
Sides (Количество сторон) 40. Чтобы объ-
ект принял сглаженную форму, установи-
те флажок Smooth (Сглаживание). Подбе-
рите вручную положение втулки на осно-
вании лампы в плоскости XY. 

13. Для создания плафона лампы пе-
реключитесь в окно проекции Тор (Сверху) 
и с помощью инструмента Line (Линия) 
создайте кривую, показанную на рисунке.

14. Измените тип вершин рассмотрен-
ным ранее способом. Выделите созданный 

сплайн и перейдите на вкладку Modify (Изменение) командной 
панели. Раскройте список Modifier List (Стек модификаторов) и 
выберите в нем модификатор Lathe (Вращение вокруг оси). Дан-
ный модификатор позволяет получить поверхность вращения с 
заданным сплайновым профилем. В свитке Parameters (Параме-
тры) настроек модификатора Lathe (Вращение вокруг оси) на-
жмите кнопку Y в области Direction (Направление). Таким об-
разом выбрана ось, вокруг которой будет происходить вращение 
сплайна. После этого в окне проекции сплайн превратится в фи-
гуру вращения вокруг выбранной оси.

Подробно модификаторы будут рассмотрены в п. 4.6. 

15. Определите положение оси вращения. Для этого в обла-
сти Align (Выравнивание) настроек модификатора нажмите кноп-
ку Мах (Максимальный). Выбранная ранее ось вращения будет 
автоматически выровнена по краю модели. 

16. Выберите тип редактируемой поверхности Mesh (Сетка) 
при помощи переключателя Output (Результат) в настройках мо-
дификатора.

17. Перейдите в окно проекции Тор (Сверху) и вручную подбе-
рите оптимальное положение для совмещения плафона с ножкой.

18. Создайте лампочку при помощи стандартного прими-
тива Sphere (Сфера). Перейдите на вкладку Modify (Изменение) 
командной панели и установите для объекта следующие параме-
тры: Radius (Радиус) = 18 см, Segments (Количество сегментов) 24, 
Hemisphere (Полусфера) 0,55. Чтобы объект принял сглаженную 
форму, установите флажок Smooth (Сглаживание). 
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19. Выровняйте лампочку относительно плафона. Для это-
го в окне Align Selection (Выравнивание выделенных объектов) 
установите следующие параметры: флажки Y Position (Y-позиция) 
и X Position (Х-позиция); переключатель Current Object (Объект, 
который выравнивается) – в положение Center (По центру); пере-
ключатель Target Object (Целевой объект, относительно которо-
го выравнивается) – в положение Center (По центру). Нажмите 
кнопку Apply (Применить).

20. Сохраните файл с именем 4_5-2.max.

Контрольные вопросы
1. Что представляет собой редактируемый сплайн? Какой сплайновый примитив 

обладает свойствами редактируемого сплайна?

2. Какие типы вершин существуют в 3ds Max?

3. Перечислите стандартные сплайновые примитивы в 3ds Max.

4. Дайте определение понятия «сегмент» в рамках сплайнового моделирования. 

5. Какой параметр отвечает за видимость сплайна при визуализации?

6. Каким образом к сплайну можно присоединить другие сплайны?

7. На каких уровнях можно редактировать сплайны?

8. Какие операции применимы при редактировании сплайнов на уровнях вершин 

и сегментов?

4.6. Моделирование с использованием модификаторов

Модификаторы – это специальные функции (команды), ко-
торые позволяют изменять геометрию (форму) объекта при помо-
щи настраиваемых параметров. Полный список модификаторов 
содержат элементы интерфейса:

 y меню Modifiers (Модификаторы) – модификаторы пред-
ставлены в группах по назначению;

 y вкладка Modify (Изменение) (рис. 4.15) – в списке Modifier 
List (Стек модификаторов) модификаторы разделены на три ка-
тегории:

– Selection Modifiers (Модификаторы выделения);
– World-Space Modifiers (Глобальные модификаторы);
– Object-Space Modifiers (Объектные модификаторы).
Чтобы получить доступ к модификаторам, в сцене должен 

быть выделен объект, к которому планируется применение моди-
фикатора. Для назначения модификатора выделенному объекту 
этот модификатор нужно выбрать на вкладке Modify (Измене-
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ние) в списке Modifier List (Стек модификаторов). Если в данный  
момент выделено несколько объектов, то их настройки будут свя-
заны между собой.

Название объекта 

Modifier List 

Список назначенных модификаторов 

объекта (стек модификаторов)

Рис. 4.15. Вкладка Modify (Изменение) командной панели

Gizmo (Гизмо) – габаритный контейнер, в рамках которого действует моди-

фикатор. Изображается в видовых окнах как каркас (обычно оранжевого 

цвета), который первоначально окружает объект. Можно перемещать, вра-

щать и масштабировать гизмо, тем самым изменяя воздействие модифи-

катора на объект. Center (Центр) – точка или ось, относительно которой 

действует модификатор. Можно перемещать ось, тем самым изменяя воз-

действие модификатора на объект.

Внизу вкладки расположены следующие кнопки:
 y Pin Stack (Закрепить стек) – зафиксировать меню стека на 

экране для того, чтобы примененные модификаторы не исчезали, 
когда будет выбран другой объект;

 y Show End Resolt (Показывать последний результат) – пока-
зать конечный результат всех модификаций объекта;

 y Make Unique (Сделать уникальным) – сделать выбранный 
модификатор или сам объект независимой копией, которая будет 
активна только в том случае, если объект или модификатор яв-
ляется Instance (Образец);

 y Remove Modifier (Удалить модификатор) – удалить выбран-
ный модификатор из стека;

 y Configure Modifier Sets (Конфигурировать наборы модифика-
торов) – расширенное меню настройки модификаторов.
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Модификаторы бывают обратимые и необратимые. Обрати-
мые модификаторы позволяют вернуться в стеке модификаторов 
на предыдущий этап работы с объектом и подкорректировать на-
стройки объекта или ранее назначенного модификатора, в то вре-
мя как необратимые модификаторы исключают эту возможность.

К одному объекту можно применить несколько модифика-
торов. Читается стек снизу вверх. Причем конечная форма объ-
екта зависит от последовательности применения модификаторов. 
Чтобы поменять местами модификаторы, в стеке необходимо 
выделить один из модификаторов и, удерживая нажатой левую 
кнопку мыши, перетащить его. Чтобы отключить воздействие 
модификатора на объект, нужно сделать один щелчок по лам-
почке, которая располагается слева от названия модификатора, 
и она станет серого цвета. Тогда модификатор останется в стеке 
и все его настройки сохранятся, но модифицировать объект он 
не будет. Чтобы включить модификатор, надо сделать еще один 
щелчок по лампочке, и она опять станет белой. Чтобы удалить 
модификатор из стека, нужно его выделить и щелкнуть по кноп-
ке с изображением корзины.

Контекстное меню стека модификатора вызывается правой 
кнопкой мыши и включает основные команды управления при-
менением модификаторов.

Модификаторы, представленные в меню Modifiers (Модифи-
каторы), объединены в группы: 

 y Selection Modifiers (Модификаторы выделения); 
 y Mesh Editing (Редактирование поверхности); 
 y Free Form Deformers (Произвольные деформации);
 y Parametric Deformers (Параметрические деформации) и др.

В таблице 4.4 представлены параметрические модификаторы 
с иллюстрациями их применения.

Таблица 4.4

Параметрические модификаторы 3ds Max

Описание модификатора Результат применения

Bend (Изгиб) сгибает объект под определенным углом 

вдоль выбранной оси Bend Axis (Ось изгиба). В свитке 

Parameters (Параметры) есть область Limits (Пределы), 

с помощью параметров которой определяют границы 

применения модификатора
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Описание модификатора Результат применения

Push (Нажим) деформирует оболочку трехмерной мо-

дели, сдвигая ее в направлении нормали к поверхности. 

Модификатор имеет всего один параметр, определя-

ющий величину деформации, – Push Value (Величина 

нажима)

Twist (Скручивание) закручивает объекты вдоль ука-

занной оси. Угол изгиба задается параметром Angle 

(Угол), величина смещения эффекта – параметром 

Bias (Наклон), а ось, относительно которой происходит 

деформация, – положением переключателя Twist Axis 

(Ось скручивания)

Lattice (Решетка) используется для создания решетки на 

поверхности объекта. За основу берется полигональная 

структура объекта: на месте ребер создаются прутья 

решетки, а на месте вершин – узлы. В области Geometry 

(Геометрия) настроек модификатора переключатель 

устанавливается в одно из трех положений: Joints Only 

from Vertices (Только вершины), Struts Only from Edges 

(Только прутья решетки) или Both (Все). Для каждого 

элемента решетки предусмотрены свои параметры

Skew (Наклон) предназначен для наклона объекта. 
Параметры: Amount (Величина), Direction (Направление), 
переключатель Skew Axis (Ось наклона). Параметры 
области Limits (Пределы) дают возможность ограничить 
применение модификатора. Чтобы использовать ограни-
чения, нужно установить флажок Limit Effect (Ограничи-
вающий эффект)

Ripple (Рябь) имитирует рябь на поверхности объекта. 
Параметры: изменения амплитуды первичной и вторич-
ной волны Amplitude 1 (Амплитуда 1) и Amplitude 2 (Ам-
плитуда 2), изменения длины волны Wave Length (Длина 
волны) и степени затухания Decay (Затухание). Параметр 
Phase (Фаза) позволяет анимировать эффект

Stretch (Растягивание) растягивает объект вдоль одной из 
осей, одновременно сжимая его по двум другим осям в 
обратном направлении. Степень деформации определяет-
ся параметром Stretch (Растягивание), величина сжатия в 
обратном направлении – параметром Amplify (Усиление), 
а ось, относительно которой происходит деформация, – 
параметром Stretch Axis (Ось растягивания). Параметры 
области Limits (Пределы) аналогичны модификатору Skew

Продолжение табл. 4.4
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Описание модификатора Результат применения

Wave (Волна) имитирует рябь, которая распространяется 
не во все стороны, а вдоль некоторой оси. Параметры 
модификатора совпадают с настройками модификатора  
Ripple (Рябь)

Shell (Оболочка) придает плоской поверхности толщину. 
Параметры: Inner Amount (Внутреннее наращивание обо-
лочки) и Outer Amount (Внешнее наращивание оболочки). 
Количество сегментов наращиваемой оболочки задают 
при помощи параметра Segments (Количество сегментов)

Spherity (Сферичность) придает объекту шарообразную 
форму. Модификатор имеет только один параметр – 
Perсent (Процент), который определяет степень дефор-
мации объекта. Чем выше значение этого параметра, тем 
больше объект будет походить на шар

Relax (Расслабление) сглаживает общую геометрию 
объекта, перемещая вершины. Параметры: Relax Value 

(Степень ослабления), Iterations (Количество итераций) 
Save Outer Corners (Сохранить внешние углы) (закрепля-
ет позицию вершин объекта)

Noise (Шум) размещает  вершины объекта случайным 
образом. Основные настройки: Seed (Зерно) – вы-
бор варианта искажений, Scale (Масштаб искажений), 
Roughness (Степень грубости), Iteration (Сложность 
искажений), Strength (XYZ) – сила искажений по разным 
осям, Animate Noise (Анимация шума) – включение ани-
мации искажений

Squeeze (Сдавливание) создает деформацию, при 
которой вершины объекта, расположенные ближе всего 
к его опорной точке, перемещаются внутрь. Параметры: 
Amount (Величина), степень кривизны Curve (Кривая) 
в областях Radial Squeeze (Радиальное сдавливание) и 
Axial Bulge (Выпуклость с осевой симметрией). Параме-
тры области Effect Balance (Баланс эффекта): Bias (На-
клон) и Volume (Объем) определяют соотношение между 
сжатием в радиальном направлении и угловым сжатием

Taper (Заострение) сужает объект вдоль оси в одном или в 
двух направлениях. Параметры: Amount (Величина дефор-
мации), степень кривизны Curve (Кривая), ось, относи-
тельно которой происходит деформация, – Taper Axis (Ось 
сжатия), флажок Symmetry (Симметричное искажение)

Продолжение табл. 4.4
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Описание модификатора Результат применения

Slice (Срез) позволяет отсечь часть модели условной 
плоскостью. Типы сечения: Refine Mesh (Добавление 
новых вершин в точках пересечения плоскости с объ-
ектом), Split Mesh (Создание двух отдельных элемен-
тов), Remove Top (Удаление всего, что находится выше 
плоскости сечения) или Remove Bottom (Удаление всего, 
что находится ниже плоскости сечения)

Mirror (Зеркало) создает зеркальные копии объекта. Па-
раметры: Mirror Axis (Ось зеркальной копии) – указывает, 
вдоль какой оси или плоскости будет создана копия (X, 
Y, Z, XY, YZ или ZX), Options (Настройки) – можно указать 
величину смещения зеркальной копии относительно ис-
ходного объекта, флажок Copy (Копировать) – позволяет 
создавать зеркальную копию на основе копии исходного 
объекта, сам объект останется неизменным

Displace (Смещение) деформирует поверхность объекта, 
сдвигая вершины трехмерной модели по заданному ри-
сунку. В качестве последнего может выступать растро-
вое изображение (Bitmap), процедурная карта (Map). Для 
загрузки изображения или карты используют кнопки 
области Image (Изображение). Параметры: Strength (Сила 
воздействия), Decay (Затухание) 

Модификаторы свободных деформаций Free Form Deformers 
(FFD) дают возможность деформировать объект на основе уз-
ловых точек, т. е. решетки, в которую помещается объект по-
сле применения таких модификаторов. Они отличаются друг от 
друга количеством доступных узловых точек, а также способом 
построения решетки (она может быть цилиндрической или куби-
ческой). Список модификаторов группы свободной деформации:

 y FFD 2½2½2; (Произвольная деформация 2½2½2);
 y FFD 3½3½3 (Произвольная деформация 3½3½3);
 y FFD 4½4½4 (Произвольная деформация 4½4½4);
 y FFD Box (Произвольно деформируемый контейнер (прямо-

угольный));
 y FFD Cylinder (Произвольно деформируемый контейнер 

(ци линдрический)).
Модификаторы выделения
Модификатор Mesh Select (Выделение поверхности) предостав-

ляет все необходимые средства для выбора субобъектов в каркасе 

Окончание табл. 4.4
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любого объекта (перед его активизацией объект в сцене уже дол-
жен быть выделен). Для применения модификатора нужно выбрать 
его из списка модификаторов вкладки Modify (Изменение) или 
воспользоваться командой меню Modifiers ⇒ Selection ⇒ Mesh Select 
(Модификаторы ⇒ Выбор ⇒ Выделение поверхности). В верхней 
части группы параметров модификатора Mesh Select расположены 
пять кнопок для выбора субобъектов того или иного типа:

 y Vertex (клавиша 1) – выбор вершин многоугольников, из 
которых состоит объект;

 y Edge (клавиша 2) – выбор ребер многоугольников, из кото-
рых состоит объект; 

 y Face (клавиша 3) – выбор треугольных граней, входящих в 
состав многоугольников, из которых состоит объект; 

 y Polygon (клавиша 4) – выбор отдельных многоугольников, 
из которых состоит объект;

 y Element (клавиша 5) – выбор всех многоугольников, из ко-
торых состоит объект.

Для последовательного перебора инструментов выбора суб-
объектов можно воспользоваться клавишей Insert, а для активи-
зации или отключения режима выбора – комбинацией клавиш 
Ctrl + B.

При применении модификатора Edit Mesh (Редактирование по-
верхности) на вкладке Modify (Изменение) в разделе Edit Geometry 
(Редактировать геометрию) отобразится набор параметров, анало-
гичный набору параметров Editable Mesh (Редактируемая сетка). 

При использовании модификатора Edit Poly (Редактирование 
полигонов) на вкладке Modify (Изменение) отображается множе-
ство полезных инструментов, которые можно применять к субобъ-
ектам, выделенным в исходном объекте. Инструменты модифика-
ции субобъектов выбранного типа, расположенные в разделе Edit 
Geometry (Редактировать геометрию), аналогичны набору инст-
рументов Editable Poly (Редактируемая полисетка). Модификато-
ры TurboSmooth (Турбосглаживание) и MeshSmooth (Сглаживание 
сетки) сглаживают поверхность выделенного объекта, разбивая ее 
на дополнительные сегменты.

Практические задания по пункту 4.6

Задание 1. Задание 1. Применение модификатора Bend (Изгиб).
Рекомендации по выполнениюРекомендации по выполнению
1. Создайте новую сцену.
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2. Создайте цилиндр радиусом 0,08 м, высотой 1,4 м и с ко-
личеством сегментов в высоту 30. 

3. Добавьте к нему модификатор Bend (Изгиб).
4. Введите в поле Angle (Угол) раздела Parameters (Параметры) 

для модификатора Bend (Изгиб) значение 360°. Цилиндр будет 
свернут в тор. 

5. В поле Upper Limit (Верхний предел) введите значение 
0,9 м, в поле Lower Limit (Нижний предел) – значение –0,9 м и 
установите флажок Limit Effect (Ограничивающий эффект). 

6. Добавьте в стек еще один модификатор Bend с теми же 
параметрами, что и первый, за исключением параметра Direction 
(Направление), которому назначьте значение 90. 

7. Уменьшите угол до 260° и выберите в качестве оси изгиба 
ось Х, щелкнув на переключателе Х группы Bend Axis (Оси изгиба).

8. Сохраните файл с именем 4_6-1.max.
Задание 2. Задание 2. Применение модификатора Twist (Скручивание). 

Копирование.
Рекомендации по выполнениюРекомендации по выполнению
1. Создайте новую сцену.
2. Создайте тор радиусом 1 м, радиусом трубы 0,2 м, с коли-

чеством сегментов, равным 48, и количеством сторон, равным 24. 
3. Добавьте к нему модификатор Twist (Скручивание).
4. Установите следующие параметры: Angle (Угол) = 180°; 

Twist Axis (Ось скручивания) – X; Upper Limit (Верхний предел) = 
0,4 м; Lower Limit (Нижний предел) = –0,4 м, а затем установите 
флажок Limit Effect (Ограничивающий эффект). 

5. Щелкните правой кнопкой мыши в стеке модификаторов 
и выберите из контекстного меню команду Copy (Копировать). 

6. Еще раз щелкните правой кнопкой мыши в стеке модифи-
каторов и выберите из контекстного меню команду Paste (Вста-
вить), чтобы создать копию предыдущего модификатора Twist. 
Выберите переключатель Z.

7. Сохраните файл с именем 4_6-2.max.
Задание 3. Задание 3. Применение модификатора Noise (Шум).
Рекомендации по выполнениюРекомендации по выполнению
1. Создайте новую сцену.
2. Создайте сферу радиусом 0,6 м с количеством сегментов, 

равным 128. Сделайте еще две копии сферы. 
3. Добавьте к первой сфере модификатор Noise (Шум).



259

4.6. Моделирование с использованием модификаторов4.6. Моделирование с использованием модификаторов

4. Введите в поле Scale (Масштаб искажений) значение 5. 
Установите флажок Fractal (Фрактальный); в поле Roughness (Сте-
пень грубости) введите значение 0,2, а в поле Iterations (Слож-
ность искажений) – значение 1. Во всех трех полях в группе 
Strength (Сила искажений) укажите значение 0,1 м. В результате 
будет получена сфера с игольчатой поверхностью. 

5. Для второй сферы добавьте модификатор со следующими 
значениями параметров: Scale – 50; Roughness – 0,6; Iterations – 5. 
Сфера приобрела оплавленную поверхность. 

6. Для второй сферы добавьте модификатор со следующими 
значениями параметров: Scale – 300; Roughness – 1; Iterations – 3; 
Z = 1 м. Сфера приобрела вид эллипсоида, деформированного 
шумовой волной вдоль оси Z. 

7. Измените значение в поле Iterations (Сложность искаже-
ний) на 7. Семикратное применение шумовой волны приведет к 
преобразованию сферы во фрактальный объект. 

8. Сохраните файл с именем 4_6-3.max.
Задание 4. Задание 4. Применение модификатора FFD Box.
Рекомендации по выполнениюРекомендации по выполнению
1. Создайте новую сцену.
2. Создайте сферу и добавьте к ней модификатор FFD Box. 

В результате вокруг объекта отобразится совокупность манипу-
ляторов в виде решетки.

3. Щелкните на кнопке Set Number of Points (Установить ко-
личество точек) группы Dimensions (Размерность) раздела FFD 
Parameters (FFD параметры) на вкладке Modify (Изменение) и 
укажите в открывшемся диалоговом окне Set FFD Dimensions 
(Установить FFD размерность) по 10 манипуляторов вдоль каж-
дой оси. 

4. Для того чтобы манипуляторы были размещены в соот-
ветствии с формой объекта (см. рисунок), щелкните на кноп-
ке Conform to Shape (Подстроить к форме), которая находится в 
группе Control Points (Контрольные точки) свитка FFD Parameters 
(FFD параметры). 
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5. Щелкните дважды в стеке на модификаторе FFD Box 
10½10½10, чтобы активизировать его. Теперь манипуляторы FFD 
можно перемещать в любом направлении. Переместите какие-
нибудь манипуляторы с помощью инструмента Select and Move 
(Выделить и переместить).

6. Сохраните файл с именем 4_6-4.max. 

Контрольные вопросы
1. Какие типы модификаторов используют в 3ds Max?
2. Опишите параметрические модификаторы и укажите их назначение.
3. Как применить модификатор к объекту?
4. Что такое стек модификаторов?
5. Какие операции применимы к модификаторам в стеке?
6. Какие модификаторы относят к усложненным? 

4.7. Работа с материалами

В 3ds Max Material Editor (Редактор материалов) является од-
ним из важнейших модулей программы. Редактор материалов – 
это расширенная среда, в которой все типы процедурных и тек-
стурных карт и материалов выступают подключаемыми компо-
нентами. 

Открыть диалоговое окно Material Editor можно с помощью:
 y кнопки Material Editor главной панели инструментов (Main 

Toolbar);
 y команды Rendering ⇒ Material Editor (Визуализация ⇒ Ре-

дактор материалов); 
 y клавиши M.  

Окно Material Editor (Редактор материалов) (рис. 4.16) состо-
ит из ячеек образцов материалов, кнопок инструментов управле-
ния и области свитков. 

По умолчанию при работе над новой сценой Material Editor 
(Редактор материалов) показывает шесть ячеек с образцами мате-
риалов. Ячейка с текущим материалом выделяется светлой рамоч-
кой. Если ячейка образца содержит материал, который использу-
ется в сцене, то в ее углах помещаются белые треугольники – 
обычно такие материалы называют «горячими». Те материалы, 
которые не назначены никаким объектам сцены, называют, со-
ответственно, «холодными». Те образцы материалов, которые яв-
ляются копиями «горячих» материалов, но сами не назначены 
объектам сцены, называют «теплыми». Позиция в иерархии мате-
риалов при переключении между окнами образцов запоминается. 
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Рис. 4.16. Окно Material Editor (Редактор материалов)

В Material Editor (Редактор материалов) доступны 24 ячейки 
материалов. Ячейки, содержащие все образцы, можно отобра-
зить, используя полосы прокрутки по горизонтали и вертикали. 
Щелкнув правой кнопкой мыши по ячейке, можно изменить ее 
размер и получить большее число видимых ячеек с образцами 
материалов. После выбора ячейки с образцом материала можно 
присвоить его объекту, выделенному в окне проекции. Для этого 
используют следующие способы:
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 y нажать кнопку Assign Material to Selection (Назначить мате-
риал выделенным объектам), расположенную ниже ячеек с об-
разцами материалов; 

 y выполнить команду Material ⇒ Assign to Selection (Матери-
ал ⇒ Назначить выделенным объектам);

 y перетащить материал из ячейки образца на объект, распо-
ложенный в окне проекции. 

Как только материал присваивается объекту сцены, он автома-
тически попадает в библиотеку материалов, которая сохраняется 
вместе с файлом сцены. Находясь в этой библиотеке, он может не 
отображаться в ячейках с образцами материала. Можно создавать 
и сохранять для загрузки собственные библиотеки материалов.

Material Editor содержит собственную панель инструмен тов 
(см. сверху вниз и справа налево от ячеек с материалами):

 y Sample Type (Тип образца) – определяет форму отображае-
мого в ячейке образца (сфера, цилиндр, параллелепипед); 

 y Backlight (Подсветка позади) – включает или выключает за-
днюю подсветку образца материала в выбранной ячейке; 

 y Background (Фон) – изменяет фон ячейки на шахматное 
поле или подгружаемую текстуру, например для лучшего отобра-
жения прозрачных материалов;

 y Sample UV Tiling (Плитки образцов в плоскости UV) – уста-
навливает количество повторений текстурной карты на образце 
материала (1 ½ 1, 2 ½ 2, 3 ½ 3, 4 ½ 4); 

 y Video Color Check (Контроль цветности) – включает для те-
кущего материала режим контроля соответствия цветов стандар-
там PAL и NTSC; 

 y Make Preview, Play Preview, Save Preview (Создать эскиз, 
Просмотреть эскиз, Сохранить эскиз) – позволяют создать, про-
смотреть и сохранить эскизы анимации материалов до выполне-
ния визуализации сцены; 

 y Options (Параметры) – открывает окно с настройками пара-
метров Ma terial Editor;

 y Select by Material (Выделить по материалу) – выделяет все 
объекты сцены, использующие текущий материал, и отображает 
их в открывшемся окне Select Objects; 

 y Material/Map Navigator (Навигатор по материалам и картам) – 
вызывает окно диалога Material/Map Navigator, содержащее дре-
вовидную структуру материалов и текстур текущего образца; 
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 y Get Material (Получить материал) – открывает окно диа-
лога Material/Map Browser (для выбора готового материала или 
создания нового; 

 y Put Material in Scene (Поместить материал в сцену) – об-
новляет материал объекта сцены, после того как были сделаны 
изменения в его копии («теплом» материале); 

 y Assign Material to Selection (Назначить материал выделенно-
му объекту) – присваивает текущий материал выделенным объ-
ектам сцены; 

 y Reset Map/Mtl  to Default Settings (Сброс настроек/Настройки 
по умолчанию) – удаляет из активной ячейки образца все выпол-
ненные изменения, возвращая ее к установкам по умолчанию;

 y Make Material Copy (Создать копию материала) – создает 
копию текущего «горячего» материала и помещает ее в ту же 
ячейку образца, сохраняя имя и свойства оригинала; 

 y Make Unique (Сделать уникальным) – превращает образец 
материала в новый, независимый материал;

 y Put to Library (Поместить в библиотеку) – помещает ак-
тивный материал в текущую библиотеку материалов; чтобы за-
фиксировать изменения, библио теку после этого следует сохра- 
нить;

 y Material ID Channel (Канал идентификаторов материала) – 
устанавливает один из 15 идентификаторов для последующего 
применения специальных эффектов; 

 y Show Map in Viewport (Показать карту в окне проекции) – 
отображает двумерные карты текстур на поверхности объектов в 
окнах проекций; 

 y Show End Result (Показать конечный результат) – показы-
вает в ячейке образца все уровни комбинированного материала 
(если режим выключен, отображается только текущий уровень); 

 y Go to Parent (Перейти к родительскому) – выполняет пере-
ход от компонентного уровня на более высокий уровень редакти-
рования составного материала; 

 y Go Forward to Sibling (Перейти к компоненту) – выполняет 
переход к правке следующего материала или текстуры, входящей 
в многокомпонентный материал; 

 y Pick Material from Object (Указать материал объекта) – по-
зволяет взять образец материала с объекта сцены и загрузить в 
текущую ячейку; 
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 y Material Drop-Down List (Список материалов) – позволяет 
переименовать текущий материал или текстурную карту; 

 y Туре (Тип образца) – кнопка выбора типа редактируемого 
материала; щелчок на ней вызывает окно Material/Map Browser 
(Браузер материалов/карт (схем)). 

Окно диалога Material/Map Browser (Браузер материалов/
карт (схем)) предназначено для просмотра и выбора материалов 
и текстурных карт. В Material/Map Browser хранятся материалы 
в наборах, именуемых библиотеками. Библиотеки могут хранить-
ся в составе файла сцены или в отдельном файле с расширени-
ем .маt. 

В окне диалога Material/Map Browser материалы помечены 
значком в виде синей сферы, а текстурные карты – зеленым па-
раллелограммом. 

Ниже окна с именем и кнопки выбора типа материала нахо-
дится область свитков текущего материала, состав которой изме-
няется в зависимости от выбранного типа материала. Чаще всего 
в качестве базового типа выбираются устанавливаемый по умол-
чанию тип Standard (Стандартный) и метод тонирования Blinn 
(по Блинну). 

Список параметров свитка Blinn Basic Parameters (Базовые 
параметры метода Блинна) (рис. 4.17):

1. Ambient (Подсветка) – определяет цвет участков поверх-
ности объекта, не освещенных прямыми лучами света, т. е. цвет 
тени на поверхности объекта.

2. Diffuse Color (Диффузный цвет) – задает основной цвето-
вой фон материала объекта, который можно наблюдать, когда 
поверхность объекта освещена прямыми лучами света.

3. Specular Color (Зеркальный цвет) – устанавливает цветовой 
тон световых бликов, появляющихся на поверхности объекта.

4. Self-Illumination (Самосвечение) – определяет особенности 
самосвечения объекта; на цветовой оттенок Specular самосвече-
ние влияния не оказывает и может задаваться двумя способами: 
либо цветом, либо числовым значением.

5. Opacity (Непрозрачность) – задает степень прозрачности 
объекта.

6. Specular Level (Интенсивность блика) – определяет интен-
сивность блика на поверхности; используется только при его на-
личии.
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7. Glossiness (Размер блика) – указывает размер бликового 
пятна: как правило, для матовых поверхностей устанавливается 
больший размер блика, а для блестящих – меньший. 

Рис. 4.17. Параметры метода тонирования Blinn (по Блинну)

Цвета Ambient (Подсветка) и Diffuse Color (Диффузный цвет)  
или  Diffuse Color (Диффузный цвет) и Specular Color (Зеркаль-
ный цвет) могут быть одинаковыми. Их можно заблокировать 
при помощи соответствующей кнопки Lock (Блокировка) (по 
умолчанию опция Lock включена для цветов Ambient (Подсветка) 
и Diffuse Color (Диффузный цвет)).

В свитке Shader Basic Parameters (Базовые параметры тони-
рования окраски) доступны следующие настройки:

1. Wire (Каркасный) – визуализация только каркаса объек-
та. Используется для имитации проволочных моделей, плетеных 
корзинок и т. п.

2. Face Map (Карта граней) – приложение материала с при-
менением текстурных карт к каждой грани объекта.  

3. Sided (Двусторонний) – визуализация не только лицевых, 
но и обратных граней объекта, что необходимо при создании по-
лупрозрачных материалов.

4. Faceted (Грани) – выключение сглаживания ребер и при-
дание объектам ограненного вида. Актуально, например, при мо-
делировании кристаллов. 

Параметры тонирования управляют методом визуализации, 
используемым для оценки и затенения базовых цветов и сияния. 
Существует восемь методов тонирования оболочек объектов, 
представленных в раскрывающемся списке свитка Shader Basic 
Parameters (Базовые параметры тонирования) (табл. 4.5). 
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Таблица 4.5

Методы тонирования

Название Метод Назначение

Blinn Блинна Стандартный метод (алгоритм) затенения. Визуализирует 
круговые свечения и сглаживает ребра вдоль граней. Подходит 
для большинства материалов: пластик, дерево, камень, кера-
мическая плитка, матовое стекло, резина и пр.

Anisotropic Анизотропия Может визуализировать некруглые светлые области. Позволя-
ет управлять формой и углом поворота зеркального блика

Metal Металл Имитирует блеск металлических поверхностей. Используют 
для создания полированных поверхностей: металл и стекло. 
Следует использовать с картами типа Reflection (Отражение) и 
Refraction (Преломление)

Multy-Layer Многослой-
ность

Позволяет управлять формой и углом поворота зеркального 
блика. Удобен при создании поверхности грубо шлифованного 
металла

Oren-Nayar-
Blinn

Алгоритм 
Оурена – На-
яра – Блинна

Удобен при создании матовых поверхностей, например раз-
личных видов тканей

Phong Алгоритм 
Фонга

Подобен Блинну

Strauss Штрауса Применяют для имитации металлов и материалов с металличе-
ским блеском (сталь, стекло и т. п.)

Translucent 
Shader

Полупро-
зрачность

Свет может свободно проходить сквозь объект

Для выбора типа материала служит кнопка рядом с именем 
материала, при нажатии на которую открывается список матери-
алов:

1. Architectural (Архитектурный) – включает множество ша-
блонов, специально разработанных для имитации тех или иных 
материалов.

2. Blend (Смесь) – можно смешать на поверхности объекта 
два материала.

3. Composite (Смешанный) – позволяет смешивать до 10 раз-
личных материалов.

4. Double Sided (Двусторонний) – включает два различных 
материала для передней и задней стороны объекта.

5. Multi/Sub-Object (Многокомпонентный) – позволяет при-
менить к объекту несколько различных материалов.

6. Standard (Стандартный) – универсальный, основной ма-
териал, может быть использован как самостоятельно, так и в со-
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ставе других материалов. Подходит для создания большинства 
материалов и наиболее часто используется.

7. Top/Bottom (Верх/Низ) – включает два различных материа-
ла для верхней и нижней части объекта.

Текстурные и процедурные карты
Материалы основываются не только на том или ином цве-

те, но и на дополнительных компонентах. Такими компонентами 
могут быть изображения, формируемые путем математических 
расчетов, – процедурные карты, или растровые изображения – 
текстурные карты. 

В некоторых предустановленных материалах используются одновремен-

но как процедурный, так и текстурный компоненты. Тем не менее, такие 

материалы можно использовать как частный случай схем, в том числе и 

основных схем.

За работу с картами (также называемыми схемами) в списке 
параметров отвечает отдельный свиток Maps (Карты), содержа-
щий длинный перечень каналов. Каналы отвечают за управление 
свойствами материала, и теоретически каждому из них может 
быть назначена текстурная карта.

Настройка любого из элементов свитка Maps (Карты) произ-
водится путем включения/выключения флажка состояния, уста-
новки значения счетчика влияния карты (Amount) и определения 
типа карты.

Часто используемые карты: 
1. Bitmap (Растровая карта) – представляет собой графиче-

ский файл (чаще всего текстуру), который хранится на диске 
и может быть подготовлен в любом графическом пакете.

2. Cellular (Ячейки) – обеспечивает имитацию соответствую-
щих ячеистых структур: пенопласта, бетона, кожуры апельсина, 
кожи пресмыкающихся и т. п., используется преимущественно на 
канале Bump (Рельеф).

3. Checker (Шахматы) – позволяет создавать текстуру в виде 
шахматного поля, клетки которого могут иметь тонированную 
раскраску либо представлять другие карты текстур.

4. Gradient (Градиент) – обеспечивает радиальную или ли-
нейную градиентную заливку с плавными переходами между 
указанными цветами. При необходимости любой из данных цве-
тов может быть заменен текстурной картой.
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5. Gradient Ramp (Улучшенный градиент) – представляет со-
бой усложненный вариант карты Gradient, отличающийся более 
широкими возможностями настройки.

6. Swirl (Завихрение) – обеспечивает создание своеобразных 
вихревых узоров и используется при имитации радужных пере-
ливов, например бензиновых пятен на воде.

7. Noise (Шум) – обеспечивает генерацию неоднородных по 
структуре (более естественных) материалов.

8. Smoke (Дым) – позволяет имитировать такие атмосферные 
эффекты, как пар, туман, дым и т. п.

9. Waves (Волны) – используется для имитации водных по-
верхностей, например случайного рисунка на поверхности воды 
(при подключении на канале Diffuse Color (Диффузный цвет)) 
или создания ряби, расходящихся кругов, волн и т. п. (при ис-
пользовании на канале Bump (Рельеф)).

10. Wood (Древесина) – позволяет генерировать структуру 
древесной поверхности с отображением годовых колец, фрагмен-
тов сучков и т. п.

11. Marble (Мрамор) и Perlin Marble (Перламутр) – применяют 
для создания таких природных материалов, как мрамор, мала-
хит, родонит и т. п.

12. Dent (Выбоины) – позволяет генерировать на поверхности 
объекта случайные вмятины и шероховатости; обычно приме-
няют совместно с картой Noise (Шум) для придания материалу 
большей естественности.

13. Falloff (Спад) – обеспечивает неоднородную прозрачность 
материала; чаще всего используют на канале Opacity (Непрозрач-
ность).

Карты Noise (Шум) и Smoke (Дым) являются процедурными, 
они формируются на основе формул, значения параметров кото-
рых можно изменять. В разных процедурных картах существуют 
разные параметры, но есть одинаковые для многих процедурных 
карт: Size (Размер), Tiling (Число повторений). 

Самым главным в списке каналов свитка Maps является 
Diffuse Color (Диффузный цвет), определяющий текстуру само-
го объекта. Помимо основной схемы, назначаемой параметру 
Diffuse Color (Диффузный цвет), можно назначить схему рассе-
яния (Аmbient Map) параметру Ambient (Подсветка) или (и) схему 
бликов (Specular Map) параметру Specular Color (Зеркальный цвет). 
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Применение текстурной карты на канале Opacity (Непрозрач-
ность) обеспечивает управление степенью прозрачности объекта, 
а канал Bump (Рельеф) необходим при формировании рельефных 
поверхностей и т. д.

Каналы Specular Level (Интенсивность блика), Glossiness (Раз-
мер блика), Self-Illumination (Самосвечение), Opacity (Непрозрач-
ность), Bump (Рельеф) и Displacement (Смещение) учитывают толь-
ко интенсивность цвета – ее значение колеблется в диапазоне от 
0 (черный) до 255 (белый), поэтому на данных каналах принято 
подключать в качестве карт черно-белые изображения или изо-
бражения в градациях серого цвета.

Каналы Ambient Color (Подсветка), Diffuse Color (Диффузный 
цвет), Specular Color (Зеркальный цвет), Filter Color (Цвет филь-
тра), Reflection (Отражение) и Refraction (Преломление) работа-
ют с цветом, поэтому подключаемые на них текстурные карты 
обычно цветные.

Назначая схемы материалам, необходимо учитывать характер 
их наложения на трехмерную поверхность, чтобы образцы в тек-
стуре не были искажены. Для упрощения и ускорения расчетов 
при применении схем можно воспользоваться различными ти-
пами наложения. При этом в терминах 3ds Max схема наклады-
вается относительно координат UVW, где U соответствует ось Х 
растровой или процедурной текстуры; V – ось Y, а W – нормаль 
двухмерного изображения (ось Z).

Практические задания по пункту 4.7

Задание 1. Задание 1. Использование стандартных материалов.
Рекомендации по выполнениюРекомендации по выполнению
1. Создайте новую сцену.
2. Разместите на ней объекты Box (Параллелепипед), Torus 

(Тор), Sphere (Сфера), Teaport (Чайник).
3. Перейдите в окно редактирования материала. Выберите 

любой свободный слот. 
4. Введите название материала – Plastic. 
5. Разверните свиток Blinn Basic Parameters (Базовые параме-

тры метода Блинна). 
6. Задайте цвет материала, щелкнув по серому прямоуголь-

нику параметра Diffuse Color (Диффузный цвет). 
7. Убедитесь, что цвет зеркального отражения белый, так как 

для материала Plastic он подходит. 
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8. Увеличьте яркость блика до 60. Размер пятна блика уста-
новите равным 50.

9. Назначьте материал Plastic для сферы. 
10. В редакторе материалов выберите любой свободный слот. 

Введите название материала – Rubber. 
11. Выберите метод тонирования Oren-Nayar-Blinn (Алгоритм 

Оурена – Наяра – Блинна).
12. Цвет Diffuse выберите любой. Цвет пятна отражения вы-

берите близкий к белому. 
13. Параметр Diffuse Level (Интенсивность диффузии) устано-

вите равным 80, яркость блика 45, а размер пятна блика 25. 
14. Установите параметр Roughness (Степень грубости) рав-

ным 50 (позволяет сделать поверхность матовой).
15. Назначьте материал объекту Torus.
16. В редакторе материалов выберите любой свободный слот. 

Введите название материала – Glass.
17. Значения параметров: Diffuse Color (Диффузный цвет) – 

серый; Specular Level (Интенсивность блика) 100; Glossiness (Раз-
мер блика) 30; Opacity (Непрозрачность) 40; флажок 2-sided уста-
новлен.

18. Назначьте материал объекту Box.
19. В редакторе материалов выберите любой свободный слот. 

Введите название материала – Porcelain.
20. Метод тонирования: Phong (Алгоритм Фонга). 
21. Значения параметров: Ambient (Подсветка) [190, 190, 190], 

Diffuse Color (Диффузный цвет) [240, 240, 240], Specular Color (Зер-
кальный цвет) [255, 255, 255], Specular Level (Интенсивность бли-
ка) 95, Glossiness (Размер блика) 80, Soften (Размытость блика) 0.

22. В редакторе материалов выберите любой свободный слот. 
Введите название материала – Gilt. 

23. Метод тонирования – Metal (Металл). 
24. Значения параметров: Ambient (Подсветка) [66, 59, 29], 

Diffuse Color (Диффузный цвет) [183, 165, 79], Specular Level (Ин-
тенсивность блика) 77, Glossiness (Размер блика) 75.

25. Преобразуйте объект Teaport (Чайник) в редактируемую 
полисетку (Convert to Editable Poly).

26. Перейдите на уровень редактирования Polygon. В свитке 
Selection (Выбор) не включайте! Ignore Backfacing (Игнорировать 
задние (невидимые) грани).
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27. Выделите весь объект (все полигоны).
28. В свитке Polygon (Многоугольник) во вкладке Material ID 

(ИН Материала) в строке Set ID (Задать идентификатор) укажите 
всем полигонам ID 1. Полигонам с ID 1 будет назначен материал 
Porcelain.

29. Снимите выделение со всех 
полигонов (щелчок левой кнопкой 
мыши в любом свободном месте 
окна проекции).

30. В окне проекции Front (Вид 
спереди) выделите полигоны чай-
ника, которым предполагается на-
значить материал Gilt (см. рисунок).

31. Выделенным полигонам в 
свитке Polygon во вкладке Material 
ID (ИН Материала) в строке Set ID 
(Задать ИН) укажите ID 2.

32. Снимите выделение со всех полигонов (щелчок левой 
кнопкой мыши в любом свободном месте окна проекции). От-
ключите режим редактирования полигонов.

33. Сохраните файл с именем 4_7-1.max.
Задание 2. Задание 2. Создание материала.
Рекомендации по выполнениюРекомендации по выполнению
1. Выделите объект Teaport (Чайник).
2. Откройте редактор материалов (М).
3. В редакторе материалов выберите любой свободный слот, 

переименуйте материал в Teaport_1.
4. Замените материал Standard (Стандартный) на Multi/Sub-

Object (Многокомпонентный).
5. На запрос Replace Material (Перемещение материала) выбе-

рите вариант Discard Old Material (Убрать старый материал).
6. В настройках материала нажмите кнопку Set Number (За-

дать количество) для указания числа составляющих материалов. 
В данном примере их два, следовательно, нужно указать 2.

7. Теперь для работы предложено два материала с ID 1 и 2. 
Чтобы в них не путаться, рекомендуется дать им имена (1) и (2).

8. Далее необходимо создать соответствующие материалы. 
Для создания материала Porcelain (Фарфор) нажмите на кнопку 
None (Без атрибута) рядом с именем материала.
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9. В открывшемся списке материалов выберите Standard. 
Про изойдет переход в настройки материала Standard.

10. В строке с именем материала будет отображаться «(1) 
Porcelain», указывая на то, что материал Porcelain является роди-
тельским для материала (1).

11. Задайте настройки для материала 
(см. задание 1).

12. После того как материал настро-
ен, вернитесь к родительскому материалу 
с помощью кнопки Go to Parent (Перейти 
к родительскому).

13. Первый составляющий материал 
готов; переходите к настройке второго 
составляющего материала Gilt аналогич-
ным образом.

14. После того как второй материал готов, вернитесь к роди-
тельскому материалу и назначьте готовый материал объекту Teaport.

Задание 3. Задание 3. Использование схемы.
Рекомендации по выполнениюРекомендации по выполнению 
1. Создайте новую сцену.
2. В окне проекции Perspective (Вид в перспективе) создайте 

сферу радиусом 0,6 м. 
3. Откройте диалоговое окно Material Editor (Редактор мате-

риалов) и выберите свободную ячейку.
4.  Назначьте каналу Diffuse Color (Диффузный цвет) выбран-

ного материала схему Bitmap (Растровая карта), используя любое 
растровое изображение. 

5. Перейдите на вкладку Modify (Изменение) командной па-
нели и добавьте к сфере модификатор UVW Map (Проецирование 
по координатам UVW) или выполните команду меню Modifiers ⇒ 
UV Coordinates ⇒ UVW Map (Модификаторы ⇒ UV (проекцион-
ные координаты) ⇒ Проецирование).

6. Назначьте материал сфере, перетащив его из диалогового 
окна Material Editor (Редактор материалов) на окно проекции 
Perspective (Вид в перспективе).

7. В разделе параметров (Parameters) вкладки Modify (Изме-
нение) для модификатора UVW Map введите значения в полях 
Length, Width и Height, равные радиусу сферы, т. е. 0,6 м. 

8. Выберите тип наложения схемы с помощью переключателей 
группы Mapping (Карты текстур): Planar – плоское, Cylind rical – 
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цилиндрическое, Spherical – сферическое, Shrink Wrap – оберты-
вание по форме, Box – коробка, Face (Грань) (схема при меняется к 
каждому многоугольнику объекта XYZ to UVW, используется для 
процедурных текстур, которые создаются на основании математи-
ческих формул).

9. Сохраните файл с именем 4_7-3.max. 

Контрольные вопросы
1. Назовите способы открытия редактора материалов.

2. Перечислите основные элементы окна редактора.

3. Какое максимальное количество ячеек с материалами доступно в окне редак-

тора материалов? Сколько отображается по умолчанию?

4. Какие материалы называют «горячими», «теплыми», «холодными»?

5. Опишите способы назначения материала объекту.

6. Какие параметры могут быть настроены для материала?

7. Что означает тип материала?

8. Дайте понятие метода (алгоритма) тонирования. Перечислите алгоритмы 

тонирования. 

9. Какие параметры настраиваются в свитке Blinn Basic Parameters (Базовые па-

раметры метода Блинна)?

10. Изложите понятие карты в 3ds Max. Назовите типы и опишите настройки карт. 

4.8. Настройка освещения в трехмерной среде.  
Работа с камерами  

Свету и тени необходимо уделять не меньше внимания, чем 
трехмерной модели, ее текстуре или фоновым элементам сцены. 
Неудачное размещение источника света может скрыть от зрителя 
некоторые важные детали или же, наоборот, сделать видимыми 
дефекты модели. Из-за невыразительного применения света вся 
сцена может выглядеть бледно и непривлекательно. В то же время 
правильное использование света (особенно в архитектуре, дизай-
не интерьеров и трехмерной компьютерной анимации) позволяет 
получить реалистичные изображения очень высокого качества. 
Для этого нужно:

 y установить источники света и подобрать их яркость (пара-
метры) таким образом, чтобы сцена была равномерно освещена;

 y задать настройки визуализации освещения.

Несмотря на то, что чаще всего источники света используют для освеще-

ния объектов в сцене, иногда свет применяют как самостоятельный объ-
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ект, например для имитации далекого огонька в ночи, маяка, звезды на  

небе и т. д.

В 3ds Max есть несколько типов источников света, которые 
можно условно разделить на три: стандартные, фотометрические 
и системы дневного освещения.

Для создания в сцене источников 
света следует щелкнуть на кнопке Lights 
(Источник света) вкладки Create (Созда-
ние) командной панели (рис. 4.18). После 
этого из раскрывающегося списка можно 
выбрать один из двух наборов источни-
ков света: стандартный набор (Standard) 
и набор фотометрических источников 
света (Photometric). Кроме того, для соз-
дания источников света можно исполь-
зовать команды меню Create ⇒ Lights ⇒ 
Standard Lights (Создание ⇒ Источник 
света ⇒ Стандартный свет) и Create ⇒ 
Lights ⇒ Photometric Lights (Создание ⇒ 
Источник света ⇒  Фотометрический 
свет) соответственно.

Стандартные источники света можно разделить на не-
сколько групп: направленные, нацеленные (имеют мишень или 
цель) и всенаправленные. Направленные источники используют 
для того, чтобы осветить конкретный объект или участок сце-
ны. Всенаправленные источники света равномерно излучают 
свет во всех направлениях. Используя их, можно имитировать, 
например, освещение от электрических ламп, фонарей, свет 
пламени и др. 

В набор Standard входят следующие типы источников света:
1. Target Spot (Нацеленный прожектор) – аналог карманного 

фонаря, театрального прожектора, автомобильной фары. Создает 
конусообразный световой поток, направление которого опреде-
ляют координатами источника и координатами цели. 

2. Target Direct (Нацеленный источник прямого света) – на-
целенный источник прямого света (Target Directional Light (Аналог 
солнечного света)). Создает параллельный световой поток, на-
правление которого определяют координатами источника и ко-
ординатами цели. 

Рис. 4.18. Создание 

источника света
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3. Omni (Всенаправленный) – всенаправленный источник 
света (Omni Light). Аналог электрической лампы, свечи и других 
подобных точечных источников света, предназначенных для обе-
спечения так называемого заполняющего освещения ( fill lighting). 
Создает сферический световой поток во всех направлениях от 
координат источника. 

4. Free Spot (Свободно направленный прожектор) – отличие 
от источника Target Spot (Нацеленный прожектор) состоит в том, 
что направление источника Free Spot не связано с какой-либо 
целью. 

5. Free Direct (Свободно направленный источник прямого 
света) – используется для моделирования солнечного света, при-
чем в более общем случае, чем источник Target Direct (Нацелен-
ный источник прямого света). Последний имеет смысл приме-
нять в тех случаях, когда нужно, например, показать движение 
Солнца по небосклону относительно неподвижного объекта. 

6. Skylight (Небесный свет) – источник небесного света.
В источнике Skylight (рис. 4.19) для расчета непрямого осве-

щения используют встроенный модуль Light Tracer (Трассиров-
щик света), что позволяет создавать очень реалистичное освеще-
ние. Источник небесного света можно располагать в любом месте 
сцены – это не повлияет на ее освещение. Для неравномерного 
окрашивания объектов (исключение эффекта «засвечивания») 
нужно установить в свитке параметров источника флажок Cast 
Shadows (Отбрасывание теней). 

Рис. 4.19. Распространение света от источника Skylight (Небесный свет)

Параметры источников света
Свиток Intensity/Color/Attenuation (Интенсивность/Цвет/За-

тухание):
1. Multiplier (Множитель) – можно указать силу света, а с по-

мощью квадрата рядом – определить цвет света.
2. Decay (Затухание) – определяет степень ослабления света 

за пределами некоторой сферы, центр которой совпадает с источ-
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ником света. Ослабление учитывается, если в группе параметров 
Decay (Затухание) в раскрывающемся списке Type выбран элемент,  
отличный от None: Inverse (Инверсия) – ослабление обратно про-
порционально расстоянию до источника или Inverse Square (Ква-
дратная инверсия) – ослаб ление обратно пропорционально ква-
драту расстояния до источника. Значение Start – начало ослаб-
ления, End – окончание. Подразделы Near Attenuation (Ближнее 
затухание света) и Far Attenuation (Дальнее затухание света) по-
зволяют настроить затухание более точно. 

Свиток Spotlight Parameters (Параметры прожектора) досту-
пен только для источников света типа Spot (Прожектор). В этом 
свитке можно задать размеры конуса света. Параметр Hotspot 
(Световое пятно) определяет размер внутреннего конуса, в кото-
ром освещенность составляет 100 %. Параметр Falloff (Спад осве-
щенности) задает размер внешнего конуса. Чем больше разница 
между этими двумя значениями, тем переход от света к тени мяг-
че, и наоборот.

В свитке Advanced Effects (Дополнительные эффекты) нахо-
дятся дополнительные настройки источника света:

1. Contrast (Констраст) – контраст освещенности; обычно 
ставится значение 0.

2. Soften Diff. Edge (Смягчение края) – смягчение краев света, 
образующихся при пересечении с другим источником; оптималь-
ный вариант этого значения 50.

3. Diffuse (Диффузное рассеивание) – галочка включает осве-
щенность объекта (если ее снять, то объект будет черным).

4. Specular (Блик) – галочка включает блики на объекте от 
источника света. При постановке отраженного света ее снимают.

5. Projector Map (Карта прожектора) – позволяет добавлять чер-
но-белое изображение (карту) для имитации сложного луча света.

Свиток Shadow Parameters (Параметры теней) содержит основ-
ные настройки теней.

1. Color (Цвет тени).
2. Density (Плотность тени).
3. Назначение тени карты Map.
Далее идут настройки выбранного типа теней: Shadow Map Pa-

rameters (Параметры карты тени) или Area Shadows (Область тени).
Свиток Shadow Map Params: 
1. Bias – степень размытия тени.
2. Size – размер размытия тени.



277

4.8. Настройка освещения в трехмерной среде. Работа с камерами   4.8. Настройка освещения в трехмерной среде. Работа с камерами   

Чтобы установить всенаправленный источник света, нужно 
выбрать его во вкладке Lights (Источник света) и расположить 
в нужном месте окна проекции. Свет от всенаправленных источ-
ников проходит сквозь плоскости, поэтому располагать их можно 
не только над плоскостью, но и под ней. 

Чтобы создать нацеленный источник, следует вначале задать 
его положение, а затем цель. 

Последовательность создания прожектора: 
1. Выбрать окно проекции Front (Вид спереди).
2. На вкладке Lights (Источник света) панели Create (Созда-

ние) нажать кнопку Target Spot (Нацеленный прожектор). 
3. В окне проекции щелкнуть левой кнопкой мыши в точке 

расположения источника и, удерживая ее, растянуть источник 
в направлении цели (рис. 4.20).

Рис. 4.20. Создание нацеленного источника света

4. В свитке параметров источника Intensity/Color/Attenuation 

(Интенсивность/Цвет/Затухание) установить значение параметра 
Multiplier (Множитель), достаточное для требуемого уровня осве-
щения (для прожектора значение множителя обычно колеб лется 
в пределах 1,2–1,6).

5. Визуализировать окно проекции Perspectve (Перспектива) 
и задать (при необходимости) дополнительные настройки яркости.

Свободный прожектор (равно как и направленный источ-
ник) располагают по направляющей сетке окна, что требует до-
полнительных перемещений и вращений источника. 

Создание направленного источника света аналогично созда-
нию прожектора. Отличительной особенностью направленных 
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источников является более интенсивное освещение. На практике 
параметр Multiplier (Множитель) для них чаще всего устанавли-
вают в пределах 0,5–1,3. 

Источник света типа Spot (Прожектор) имитирует распро-
странение света сфокусированным пучком. Так как испускаемые 
лучи света расходятся из точки излучения под углом, то и от-
брасываемая этим источником тень наращивает площадь по мере 
отдаления от предмета.

На рисунке 4.21 показано применение источников света раз-
ного типа. 

а б в

Рис. 4.21. Типы стандартных источников света: а – Omni (Всенаправленный);  

б – Target/Free Spot (Нацеленный/свободно направленный прожектор);  

в – Target/Free Direct (Нацеленный/свободно направленный источник прямого света)

Фотометрические источники света могут имитировать раз-
личные осветительные приборы – от ламп под абажуром до ламп 
дневного света или галогеновых ламп подсветки. 

Основным отличием источников набора Standard от источ-
ников набора Photometric является то, что в фотометрических ис-
точниках используется эффект ослабления интенсивности в об-
ратной пропорции к квадрату расстояния до источника. Поэтому 
фотометрические источники следует применять с учетом реаль-
ных размеров объектов. С другой стороны, фотометрические ис-
точники обеспечивают гораздо большую гибкость настройки, 
чем стандартные.

В набор Photometric входят следующие типы источников света:
1) Target Light – нацеленный фотометрический источник света; 
2) Free Light – свободно направленный фотометрический ис-

точник света. 
Параметры фотометрических источников света, отличающи-

е ся от параметров стандартных источников света, размещены 
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в свитках General Parameters (Общие параметры), Intensity/Color/
Attenuation (Интенсивность/Цвет/Затухание) и нескольких до-
полнительных. К ним относят:

1. Light Distribution (Type) (Распределение цвета (Тип))  – тип 
источника, определяющий характер распространения света:

 y Photometric Web (Фотометрические шаблоны) – позволяет 
задать различную интенсивность излучения по разным осям с 
помощью так называемой фотометрической схемы, загружаемой 
из файла в разделе Web Parameters (Web-параметры); 

 y Spotlight (Фотометрический прожектор) – отличается от 
обычного прожектора тем, что его световой поток определяется 
встроенной фотометрической схемой. Параметры фотометриче-
ского прожектора совпадают с параметрами фотометрического 
источника всенаправленного света, за исключением дополни-
тельного раздела Distribution (Распределение). С помощью этого 
раздела можно выполнить тонкую настройку основного светово-
го пятна (Hotspot) и области затухания света (Falloff ), как и для 
стандартного прожектора; 

 y Uniform Diffuse (Равномерный диффузный) – фотометриче-
ский полусферический источник света. Его удобно использовать 
в тех случаях, когда нужно смоделировать освещение у стены; 

 y Uniform Spherical (Равномерный сферический) – фотоме-
трический источник всенаправленного света, аналог стандартно-
го источника Omni (Всенаправленный). 

2. Color (Цвет) – оттенок света, который можно установить 
на основании одной из заготовок или же выбрать переключатель 
Kelvin и указать вручную цветовую температуру в кельвинах (со-
ответствующий цвет отображается справа). 

3. Filter Color (Цветной фильтр) – цвет фильтра, который 
можно наложить на источник света в тех случаях, когда нужно 
получить свет, отличный от оттенков белого. 

4. Intensity (Яркость) – яркость света, которую можно указать 
в люменах (переключатель lm), канделах (переключатель cd) или 
люксах на площадь (переключатель lx at).

5. Resulting Intensity (Результирующая яркость) – если этот 
флажок установлен, то результирующая яркость света будет уве-
личена в соответствующей пропорции. 

Свиток Shape/Area Shadows (Форма/Протяженные тени) со-
держит выпадающий список Emit Light from (Shape) (Испускать 
свет из (форма)), в котором представлены следующие формы ис-
точников света: 
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 y Point (Точка) – точечный источник света; использует сфе-
ру в качестве своего контейнера, что обеспечивает характерную 
форму рассеивания лучей. Эти источники создают щелчком 
мыши. Их положение напрямую влияет на характер освещен-
ности сцены; 

 y Line (Линия) – линейный источник света; свет распростра-
няется вдоль заданной линии узким потоком; 

 y Rectangle (Прямоугольник) – протяженный источник света; 
имеет прямоугольную форму светового контейнера, что позволя-
ет создавать мягкое освещение;

 y Disc (Круг) – круговой источник света;
 y Sphere (Сфера) – сферический источник света. 

6. Template (Шаблон) – это заранее настроенный фотоме-
трический источник, при использовании которого пользователь 
избавлен от необходимости ручной настройки перечисленных 
выше параметров. Определяется с помощью раскрывающегося 
списка раздела Templates. Шаблоны делят на группы по типам 
осветительных приборов: лампы накаливания (Bulb Lights), га-
логеновые лампы (Halogen Lights), рефлекторы (Recessed Lights), 
люминесцентные лампы (Fluorescent Lights) и лампы наружного 
освещения (Other Lights). 

Системы дневного освещения
Источники дневного света Sunlight (Солнечный свет) и Daylight 

(Дневной свет) расположены в окне Systems (Системы) вкладки 
Create (Создание) командной панели (рис. 4.22). Их отличитель-
ная особенность – пространственная ориентация источников 
света относительно географического положения и времени суток. 

Рис. 4.22. Создание систем дневного освещения
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Для пространственной ориентации используют вспомога-
тельный объект Compass (Компас), который задает географиче-
ские направления (север, юг, запад и восток). Этот объект распо-
лагается в сцене вместе с источником света и не визуализируется 
(рис. 4.23).

Рис. 4.23. Объект Compass (Компас) на плоскости сетки

Чтобы создать источник солнечного света, нужно выполнить 
следующие действия: 

1. Выбрать источник света Sunlight (Солнечный свет). 
2. В окне проекции Top (Сверху) щелкнуть левой кнопкой 

мыши по месту установки объекта Compass (Компас) и, удержи-
вая кнопку, растянуть его до нужных размеров. 

3. Переместить курсор вверх или вниз по экрану для уста-
новки высоты источника света (будет задано орбитальное рас-
стояние). 

4. В свитке параметров источника света в группе параметров 
Location (Местоположение) нажать кнопку Get Location (Задать 
местоположение). 

5. В открывшемся диалоговом окне установить географиче-
ское положение по карте. 

6. В группе параметров Time (Время) установить в поле Time 
Zone (Часовой пояс) сдвиг во времени, затем установить дату 
и время в соответствующих полях. Параметр Azimuth (Азимут) 
определяет угол между текущим положением и направлением 
на север. Параметр Altitude (Высота над уровнем моря) указыва-
ет на угол между текущим положением и горизонтом. Значения 
Latitude (Широта) и Longitude (Долгота) можно вводить вручную. 
Изменить параметры положения созданной солнечной системы 
можно в панели Motion (Движение). 
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Источники дневного света широко применяют при анимации 
суточных интервалов. Источник Daylight (Дневной свет) пред-
ставляет собой комбинацию солнечного и небесного света. Его 
создают аналогично источнику солнечного света, параметры 
освещения настраивают таким же образом (устанавливают гео-
графическое положение, дату и время). Помимо настроек сол-
нечного света, свитки параметров источника Daylight (Дневной 
свет) содержат настройки источника небесного света. В свитке 
параметров Daylight Parameters (Параметры источника дневного 
света) можно изменять типы параметров освещения солнечного 
и небесного света в соответствующих выпадающих свитках. 

В настоящее время для настройки источников дневного света 
широко применяют параметры mr Sky (Небо mr) и mr Sun (Солн-
це mr) совместно с активируемыми параметрами mr Physical Sky 
(Физическое небо mr). 

Аббревиатура mr обозначает визуализатор Mental Ray. Визуализаторы бу-

дут рассмотрены в п. 4.9

Для источников дневного света предусмотрена функция уста-
новки погодных условий на основе файлов данных о погодных 
условиях EnergyPlus Weather (EPW ). В свитке параметров Control 
Parameters (Параметры управления) источника присутствует пе-
реключатель, определяющий способ указания координат источ-
ника: Manual (Пользовательский), Date, Time and Location (Дата, 
время и местоположение) и Weather Data File (Файл погодных 
данных). При нажатии кнопки напротив варианта Weather Data 
File откроется диалоговое окно Configure Weather Data (Настрой-
ка погодных данных). Нажатие кнопки Load Weather Data (Загру-
зить погодные данные) открывает стандартное окно обозревателя 
для выбора файла данных о погоде. Файлы с погодными данны-
ми доступны для скачивания в сети Интернет. 

Светопостановка. Метод треугольника
Этот метод хорошо известен; его применяют для освещения 

единичных объектов, небольших сцен и композиций. Для ар-
хитектурного моделирования этот метод не подходит. Базовая 
расстановка содержит три источника света: ключевой (key light), 
заполняющий ( fill light) и обратный (back light). Каждый из этих 
световых источников решает свои задачи. Расположение всех трех 
источников изображено на рисунке 4.24. 
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Тор

Объект

3. Источник обратного 

света

2. Источник  

заполняющего света 1. Источник ключе-

вого света

Рис. 4.24. Расстановка источников методом треугольника, вид Тор

При постановке света придерживайтесь следующих советов: 
1. Освещение любой сцены начинают с ключевого источни-

ка. Расположите его таким образом, чтобы было видно отбрасы-
ваемые тени, но чтобы они не были слишком длинными. Лучше 
всего использовать Target Spot (Нацеленный прожектор). Устано-
вите его не точно сверху, а немного под углом к сцене. 

2. Вторым моделируют заполняющий свет. В качестве этого 
источника обычно используют Omni (Всенаправленный) с мощ-
ностью 0,2–0,5. Можно источник заполняющего света ставить 
немного ниже всей сцены, он будет светить через объекты, так 
как тени ему не включаются. Не забудьте выключить опцию ото-
бражения бликов Specular для этого источника. 

3. В последнюю очередь ставят обратный свет, обычно это 
Target Spot (Нацеленный прожектор). Для большой сцены одного 
источника обратного света может быть мало, поэтому их ставят 
2 или 3. Для того чтобы не получались засветы, используют воз-
можность исключения объектов из освещения Exclude (Исклю-
чить). Из всех контровых источников исключается поверхность, 
на которой лежат объекты, иначе на ней будут лишние световые 
пятна.

Для настройки освещения сцены, в которой размещено не-
сколько источников света, удобно использовать диалоговое окно 
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Light Lister (Список источников света). Для его открытия следует 
воспользоваться командой меню Tools ⇒ Light Lister (Инструмен-
ты ⇒ Список источников света). В этом окне отображаются ос-
новные параметры для всех источников света в сцене (если в раз-
деле параметров Configuration (Конфигурация) выбран переклю-
чатель All Lights (Все источники света)) или только для выбранных 
в данный момент (если в разделе параметров Configuration выбран 
переключатель Selected Lights (Выбранные источники света)). Лю-
бое изменение параметров в диалоговом окне Light Lister сразу же 
применяется к источникам света в сцене. При этом окно позво-
ляет переключаться в другие окна 3ds Max, а значит – изменять 
значения параметров и на вкладке Modify (Изменение). Для того 
чтобы обновить значения в диалоговом окне Light Lister на осно-
вании текущего состояния сцены и параметров вкладки Modify 
(Изменение), необходимо нажать кнопку Refresh (Обновить). 

Камеры созданы, чтобы через них осуществлять визуали-
зацию. При использовании 3ds Max для создания статичных 
изображений (например, интерьера помещения) можно ограни-
читься настройкой источников света и материалов. Однако в тех 
случаях, когда планируется применение 3ds Max для создания 
анимации, трудно обойтись без таких инструментов, как каме-
ры. Камера может передвигаться по сцене, как если бы ролик 
снимался в движении. Простые виды в окнах проекций не могут 
быть анимированы и не позволяют достигать такого эффекта. 

В 3ds Max можно создать камеру нацеленную (Target Camera) 
или свободно направленную (Free Camera). Нацеленная камера 
оптимально подходит для точной настройки параметров изобра-
жения. При этом можно позиционировать и вращать как саму 
камеру, так и точку, на которую она нацелена. Свободно направ-
ленная камера точки нацеливания не имеет, потому при переме-
щении или вращении самой камеры соответствующим образом 
изменяется и полученный с ее помощью ракурс. 

Создать камеру можно одним из следующих способов: 
 y на вкладке Create (Создание) командной панели выбрать 

кнопку Cameras (Камеры) (рис. 4.25), а затем кнопку Target (На-
целенная) либо выполнить команду Create ⇒ Cameras ⇒ Target 
Camera (Создание ⇒ Камеры ⇒ Нацеленная камера). Затем сле-
дует нарисовать направление камеры на нужном видовом экране. 
В результате будет создана нацеленная камера;
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 y на вкладке Create (Создание) командной панели выбрать 
кнопку Cameras (Камеры), а затем кнопку Free (Свободная) либо 
выполнить команду Create ⇒ Cameras ⇒ Free Camera (Создание ⇒ 
Камеры ⇒ Свободная камера). Затем 
следует нарисовать направление каме-
ры на нужном видовом экране. В ре-
зультате будет создана свободно на-
правленная камера, ориентированная 
перпендикулярно плоскости видового 
экрана. 

Объекты типа Cameras (Камеры) 
имеют те же характеристики, что и на-
стоящие камеры: Lens (Размер фокус-
ного расстояния) и Field of View (Поле 
зрения). Эти две характеристики свя-
заны между собой, поэтому при изме-
нении одного параметра второй изменяется автоматически, при 
этом чем больше фокусное расстояние камеры, тем меньше поле 
зрения, и наоборот. На реальном видеоматериале часто можно за-
метить некоторые особенности, обусловленные конструкцией ка-
меры. Это могут быть блики объектива, дрожание изображения 
и т. д. Для имитации таких эффектов в 3ds Max есть специальный 
модуль просчета. Используя его, можно создать восемь эффектов: 
Lens Effects (Эффекты линзы); Color Balance (Цветовой баланс); 
Depth of Field (Глубина резкости); Film Grain (Зернистость); Motion 
Blur (Размытие движения) и др. Чтобы использовать эффект, вы-
полните команду Rendering ⇒ Environment (Визуализация ⇒ Окру-
жение). В окне Environment and Effects (Окружение и эффекты) 
перейдите на вкладку Effects (Эффекты), после чего, нажав на 
кнопку Add (Добавить), выберите нужный.

Практическое задание по пункту 4.8

Настройка освещения сцены.
Рекомендации по выполнениюРекомендации по выполнению
1. Откройте файл 4_5-2.max.
2. Чтобы были видны отбрасываемые горящей лампой тени, 

необходимо создать в сцене поверхность стола и стены. Эти объ-
екты можно создать при помощи стандартных примитивов Plane 
(Плоскость) и Box (Параллелепипед). 

Рис. 4.25. Создание камеры
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3. Чтобы добавить в сцену источник света, перейдите на 
вкладку Create (Создание) командной панели, в категории Lights 
(Источник света) выберите строку Standard (Стандартные) и на-
жмите кнопку Omni (Всенаправленный). Создайте источник све-
та в любой свободной точке пространства. 

При создании источника света 3ds Max выключит свою си-
стему освещения, которая используется по умолчанию.

4. Нажмите кнопку F9, чтобы визуализировать сцену: сцена 
освещена, однако в ней отсутствуют тени, отбрасываемые объек-
том, которые обязательно присутствовали бы в реальности. 

5. Если на полученной картинке вы не видите пола, значит, 
вы создали источник света под ним. Поднимите его выше вдоль 
оси Z и попробуйте визуализировать сцену еще раз.

6. Для добавления теней выделите источник света Omni (Все-
направленный), перейдите на вкладку Modify (Изменение) ко-
мандной панели и в свитке настроек General Parameters (Общие 
параметры) установите флажок Shadows On (Включить тени). Вы-
берите тип просчета теней Shadow Map (Карта теней). Нажмите 
клавишу F9, чтобы еще раз визуализировать сцену. На получен-
ном изображении должны появиться тени. 

7. Чтобы выровнять источник света относительно плафона 
по всем трем осям, в окне Align Selection (Выравнивание выде-
ленных объектов) установите следующие параметры:

 y  флажки Y Position (Y-позиция), Х Position (Х-позиция) и Z Po-
sition (Z-позиция);

 y  переключатель Current Object (Объект, который выравнива-
ется) в положение Center (По центру);

 y  переключатель Target Object (Объект, относительно которо-
го выравнивается) в положение Center (По центру).

8. Нажмите кнопку Apply (Применить). 
9. Поскольку плафон лампы был создан при помощи моди-

фикатора Lathe (Вращение вокруг оси), одна из сторон образо-
ванной поверхности будет прозрачной, в чем можно легко убе-
диться, повернув плафон и заглянув «внутрь».

10.  Чтобы это устранить, необходимо в свойствах материала 
плафона задать отображения обеих сторон трехмерного объекта. 
Для этого откройте окно Мaterial Editor (Редактор материалов), 
выполнив команду Rendering ⇒ Material Editor (Визуализация ⇒ 
Редактор материалов), и в пустой ячейке создайте новый матери-
ал на основе Standard (Стандартный). В свитке настроек Shader 
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Basic Parameter (Основные параметры затенения) установите 
флажок 2-Sided (Двусторонний) для использования двусторон-
него материала.

11. Нажмите кнопку F9, чтобы еще раз визуализировать сце-
ну. На полученном изображении свет падает от лампы, однако 
большая часть картинки слишком темная. К тому же видна тень 
от объекта, который имитирует лампочку. 

12. Чтобы объект Sphere (Сфера) не отбрасывал тень, его не-
обходимо исключить из списка объектов, с которыми работает 
источник света. Для этого выделите источник света Omni (Все-
направленный), перейдите на вкладку Modify (Изменение) ко-
мандной панели и в свитке настроек General Parameters (Общие 
параметры) нажмите кнопку Exclude (Исключить).

13. В списке Scene Objects (Объекты сцены) появившегося 
окна Exclude/Include (Исключить/Включить) выделите объект 
Sphere (Сфера) и нажмите кнопку в виде двойной стрелки. Объ-
ект будет перенесен в список правой части окна.

14. Нажмите клавишу F9, чтобы еще раз визуализировать 
сцену. Тени у объекта Sphere (Сфера) быть не должно. 

15. Чтобы решить проблему затемненности большей части 
сцены, необходимо установить вспомогательное освещение. Ин-
тенсивность вспомогательных источников света, которую зада-
ют при помощи параметра Multiplier (Множитель), обязательно 
должна быть значительно меньше, чем основного. 

16. Чтобы добавить в сцену направленный источник света, 
перейдите на вкладку Create (Создание) командной панели, в ка-
тегории Lights (Источник света) выберите Standard (Стандартные) 
и нажмите кнопку Target Spot (Нацеленный прожектор). Создайте 
источник света таким образом, чтобы свет падал на сцену сверху, 
а мишень находилась в углу, за лампой (рис. 4.26).

17. Чтобы уменьшить интенсивность вспомогательного ис-
точника света, выделите объект Spot (Прожектор), перейдите на 
вкладку Modify (Изменение) командной панели и в свитке настро-
ек Intensity/Color/Attenuation (Интенсивность/Цвет/Затухание) за - 
дайте значение параметра Multiplier (Множитель) равным 0,5.

18. В полученной сцене можно подкорректировать количество 
сегментов в модели плафона, так как тень от плафона не круг-
лая, а имеет очертания многоугольника. Чтобы исправить этот 
недостаток, выделите плафон, перейдите на вкладку Modify (Из-
менение) командной панели и в стеке модификаторов щелк ните 
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на названии модификатора Lathe (Вращение вокруг оси). В свит-
ке Parameters (Параметры) настроек модификатора увеличьте зна-
чение параметра Segments (Количество сегментов) до 60. 

Рис. 4.26. Расположение источника света Target Spot (Нацеленный прожектор) в сцене

19. Нажмите клавишу F9, чтобы еще раз визуализировать 
сцену. Результат показан на рисунке 4.27.

Рис. 4.27. Финальная визуализация

Контрольные вопросы
1. Перечислите типы источников света в 3ds Max. 

2. Как создать источник света?

3. Какие группы стандартных источников света используют в 3ds Max? Какое 

освещение они моделируют?

4. Какие свитки предназначены для настройки параметров источников света?

5. Как влияют настройки источников на результат в сцене? Перечислите основ-

ные параметры.



289

4.9. Финальная обработка4.9. Финальная обработка

6. В чем заключается метод треугольника? Как получить реалистичное изо-

бражение? 

7. Как добавить текстурную карту к источнику или назначить цвет? 

8. Как установить параметры тени? 

9. Как исключить объект из освещения?

10. В чем различие стандартных и фотометрических источников света. Какие па-

раметры у них различаются?

11. Каким образом создать систему дневного освещения?

12. Изложите назначение и типы камер в 3ds Max.

4.9. Финальная обработка 

Визуализация (Rendering) – это операции, позволяющие уви-
деть конечный результат моделирования. Разнообразные параме-
тры визуализации позволяют значительно улучшить и усовер-
шенствовать трехмерную сцену путем добавления источников 
освещения, фоновых заставок, различных эффектов и т. д.

Основные настройки визуализации устанавливают в диа-
логовом окне Render Setup (Настройка визуализации), которое 
можно открыть, выполнив команду Rendering ⇒ Render Setup (Ви-
зуализация  ⇒ Настройка визуализации), нажав кнопку Render 
Setup (Настройка визуализации) на главной панели инструментов 
или клавишу F10.

Состав настроек диалогового окна Render Setup (Настройка 
визуализации) (рис. 4.28) зависит от применяемого визуализатора 
(Renderer), название которого отображается в заголовке диалого-
вого окна. 

Default Scanline Renderer – встроенный стандартный визуали-
затор 3ds Max. Позволяет визуализировать (рендерить) изображе-
ние из любого окна проекции. Сам процесс – рендеринг (или 
визуализация) – создание плоского изображения (картинки) по 
разработанной 3D-сцене.

Возможен просчет сцены и средствами альтернативных визу-
ализаторов: Mental Ray, V-Ray, Brazil и др. 

Для того чтобы изменить текущий визуализатор, необходи-
мо в свитке Assign Renderer (Назначить визуализатор) вкладки 
Common (Общие) диалогового окна Render Setup (Настройка ви-
зуализации) нажать на кнопку Choose Renderer (Выбрать визуа-
лизатор), которая находится справа от строки Production (Произ-
водство), и в открывшемся окне Choose Renderer (Выбрать визуа-
лизатор) выбрать нужный визуализатор.
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Рис. 4.28. Диалоговое окно Render Setup (Настройка визуализации)

При использовании визуализатора Default Scanline Renderer 
окно Render Setup (Настройка визуализации) содержит пять вкла-
док: Common (Общие), Renderer (Визуализатор), Render Elements 
(Элементы визуализации), Raytracer (Трассировщик), Advanced 
Lighting (Дополнительное освещение). 

Ниже приведены основные параметры вкладки Common  
(Общие). 

Time Output (Выходные настройки диапазона)
Эта группа параметров определяет последовательность кад ров 

для визуализации. Визуализации текущего кадра соответствует 
переключатель Single (Один). Все остальные варианты имеют отно-
шение к анимации: Active Time Segment (Текущий промежуток вре-
мени); Range (Диапазон) – визуализация диапазона последователь-
ных кадров; Frames (Кадры) – визуализация отдельных кадров. 

Area to Render (Область визуализации)
В этой группе параметров находится список, определяющий 

визуализируемую область, а также флажок Auto Region Selected 
(Автоматический выбор области). Последний выполняет автома-
тическую настройку визуализируемой области в режимах Region 
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(Область), Crop (Кадрировать) и Blowup (Увеличение), выбирае-
мых из находящегося рядом списка, в котором также присутству-
ют элементы Selected (Выбранные объекты) и View (Вид целиком) 
(выбран по умолчанию).

Output Size (Размер выходного файла)
Эта группа параметров (рис. 4.29) определяет выходной фор-

мат визуализации. В правой ее части расположены кнопки, с по-
мощью которых устанавливают стандартные размеры изображе-
ния. Если щелкнуть правой кнопкой мыши на любой из этих 
кнопок, то ей можно сопоставить другой формат кадра с помощью 
диалогового окна Configure Preset (Конфигурация преднастроек). 
Любые дополнительные размеры можно также указать в полях 
Width и Height непосредственно в группе параметров Output Size 
(Размер выходного файла). В раскрывающемся списке, в котором 
по умолчанию выбран элемент Custom (Пользовательская), мож-
но выбрать один из стандартных форматов кино- и видеопленки. 
Формат кад ра очень важен и должен учитываться при размеще-
нии в сцене камер, поскольку при смене формата важные части 
сцены могут оказаться невидимыми. Для того чтобы включить 
режим отображения реальных размеров кадра на том или ином 
видовом экране, необходимо щелкнуть правой кнопкой мыши на 
названии текущей проекции видового экрана и выбрать из кон-
текстного меню команду Show Safe Frame (Показать сохраненные 
кадры) (комбинация клавиш Shift + F).

Рис. 4.29. Группа параметров Output Size (Размер выходного файла)

Render Output (Выходные настройки визуализации)
В этой области настроек (рис. 4.30) содержатся параметры со-

хранения на диск файла, полученного в результате визуализации. 
Нажав кнопку Files (Файлы), можно определить тип файла, его 
название и папку, в которую он будет сохранен. Обратите внима-
ние, что если визуализируется анимация, а в качестве выходного 
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формата указан графический формат (BMP, JPEG, TIFF и пр.), 
то результат будет сохранен в виде цепочки кадров.

Рис. 4.30. Группа параметров Render Output (Выходные настройки визуализации)

Options (Параметры)
Данная область содержит несколько флажков, которые дают 

возможность ускорить просчет тестовых вариантов изображения. 
В этом случае можно отключить визуализацию некоторых ком-
понентов сцены. К ним относят Atmospherics (Атмосферные явле-
ния), Effects (Эффекты), Displacement (Смещение), Render Hidden 
Geometry (Визуализация скрытой геометрии), Area Lights/Shadows 
as Points (Пространственные источники света/тени как точки), 
Force 2-Sided (Материалы как двусторонние) и т. д.

Advanced Lighting (Дополнительное освещение)
Два флажка этой области определяют, нужно ли задейство-

вать в сцене параметр дополнительного освещения Use Advanced 
Lighting (Использовать дополнительное освещение) и нужно ли 
его просчитывать (Compute Advanced Lighting when Required (Про-
считывать дополнительное освещение, когда это требуется)). 
Эти два параметра оказывают влияние на просчет только в том 
случае, если на вкладке Advanced Lighting (Дополнительное ос-
вещение) (рис. 4.31) указан один из вариантов для просчета до-
полнительного освещения: Light Tracer (Трассировка света) или 
Radiosity (Метод переноса излучательности).

Bitmap Proxies (Растровые изображения-«заместители»)
Чтобы ускорить отображение в окне проекций текстур высо-

кого разрешения, в 3ds Max есть возможность создания растро-
вых изображений – «заместителей» низкого разрешения. Такие 
изображения создаются автоматически и могут использоваться 
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как для быстрого отображения текстур в окнах проекций, так 
и для тестовой визуализации. Для включения этой возможности 
нужно нажать кнопку Setup (Настройка) в области Bitmap Proxies 
(Растровые изображения-«заместители»), а в открывшемся окне 
установить флажок Enable Proxys System (Задействовать систему 
«заместителей»).

Рис. 4.31. Группа параметров Advanced Lighting (Дополнительное освещение)

Элементы управления визуализацией 
Эти элементы управления (рис. 4.32) расположены ввер-

ху диалогового окна Render Setup (Настройка визуализации). 
С их помощью можно указать качество визуализации: Production 
Rendering Mode (Итоговая визуализация), Iterative Rendering Mode 
(Интерактивная визуализация) или ActiveShade Mode (Активное 
тонирование). 

Рис. 4.32. Управление визуализацией

В большинстве случаев для быстрого просмотра резуль-
тата визуализации лучше использовать режимы Iterative или 
ActiveShade, а для конечной визуализации – режим Production. 
В раскрывающемся списке View to Render (Вид для рендеринга) 
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можно выбрать окно проекции, содержимое которого должно 
быть визуализировано, а собственно визуализация начинается 
после щелчка на кнопке Render.

Ход визуализации отображается в отдельном окне кадра. Ре-
зультат визуализации можно также сохранить непосредственно 
в этом окне. Для этого предназначена расположенная в левом 
верхнем углу кнопка Save Image (Сохранить изображение). Три 
кнопки с изображением цветных окружностей предназначены для 
отключения и включения соответствующих каналов модели RGB.

Настройки вкладки Renderer
1. Область Options (Опции):
 y Mapping (Карты текстур) – включение/выключение режима 

визуализации материалов и текстур;
 y Shadows (Тени) – прорисовка теней от объектов сцены;
 y Auto-Reflect/Refract and Mirrors (Автоотражение-Преломле-

ние и Зеркальное отображение) – просчет отражений в зеркаль-
ных и преломляющих материалах.

2. Область Antialiasing:
 y Antialiasing (Сглаживание) – сглаживание границ изобра-

жения;
 y Filter (Фильтр) – выбор алгоритма сглаживания;
 y Filter Map (Фильтрация текстурных карт) – улучшение ото-

бражения текстурных карт, но увеличение времени визуализации;
 y Filter Size (Размер фильтра) – увеличение или уменьшение 

степени размытия растровых изображений.
3. Область Global SuperSampling (Глобальное сверхразрешение):
 y Disable All Samplers (Выключить все фильтры сглажива-

ния) – выключение всех алгоритмов сглаживания, присутствую-
щих в настройках материалов и текстур;

 y Enable Global SuperSampling (Включить глобальное сверхраз-
решение) – выключение алгоритма сглаживания для всех мате-
риалов, присутствующих в сцене.

Самым популярным среди альтернативных визуализаторов 
является V-Ray, реализованный в виде дополнительного модуля, 
разработкой и сопровождением которого занимается компания 
Chaos Software.

Основным принципиальным отличием V-Ray (равно как и  
других альтернативных визуализаторов) от Default Scanline Rende-
rer является то, что при просчете сцен в нем учитываются физи-
ческие свойства света, что и обеспечивает бол́ьшую реалистич-
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ность получаемых изображений. Реализовано это благодаря ис-
пользованию фотонного анализа сцены для просчета эффектов 
рефлективной и рефрактивной каустики и применению ряда тех-
нологий для создания эффекта глобального освещения.

С помощью визуализатора V-Ray можно получать изображе-
ния со всеми основными визуальными эффектами:

1. Реалистичное зеркальное отражение.
2. Прозрачность.
3. Преломление световых лучей (включая эффект каустики 

(Caustics), который приводит к появлению световых бликов в ре-
зультате прохождения света через прозрачные объекты криволи-
нейной формы).

4. Моделирование рассеянного освещения сцены путем ими-
тирования эффекта поверхностного рассеивания света, что реа-
лизуется за счет настройки так называемого глобального освеще-
ния (Global Illumination).

5. Повышение реалистичности путем использования эф-
фекта глубины резкости (Depth of Field) – при данном эффекте 
размываются передний и задний планы сцены в зависимости от 
установленной точки фокусировки (т. е. те фрагменты сцены, ко-
торые находятся вне фокуса камеры).

6. Эффект размытого движения (благодаря ему быстро дви-
жущиеся объекты получаются размытыми (как в реальном мире 
на снимке или в кинокадре), а потому движение их выглядит 
более естественным).

7. Детальная прорисовка карт смещения (Displacement Map-
ping) – получение иллюзии выпуклых поверхностей.

С помощью инструмента VRayFur можно создавать покрытые 
мехом поверхности (при этом мех генерируется только во время 
визуализации и в действительности не присутствует в сцене, что 
упрощает работу с ней).

Для использования визуализатора V-Ray необходимо:
1. Открыть окно настроек визуализации Render Setup, кото-

рое вызывается через меню Rendering (Визуализация) либо на-
жатием на клавишу F10.

2. Подключить V-Ray: в выпадающем списке Renderer (Визу-
ализатор) выбрать V-Ray Adv.

3. Окно настроек визуализации Render Setup можно закрыть, 
позже в нем будет проводиться настройка параметров самого ви-
зуализатора V-Ray.
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Настройки визуализатора V-Ray:
 y Image Sampler (Antialiasing) (Сэмплер изображения (Сглажи-

вание)) – сэмплер изображения (количество проходов (операций 
вычисления), которые должен совершить V-Ray, чтобы получить 
качественную картинку). Качество картинки в данном случае 
определяется шумностью или зернистостью изображения (чем 
меньше зернистость, чем качественнее). Тип Adaptive Subdivision 
(Адаптивное разбиение) – наиболее совершенный сэмплер изо-
бражения;

 y Environment (Окружение) – окружающая среда для просче-
та GI (Глобальное освещение): флажок GI Envirobment включает 
имитацию рассеянного света от неба; Multiplier (Множитель) от-
вечает за интенсивность, можно добавить карту свечения (.HDR);

 y Reflection/Refraction (Отражение/Преломление) – отвечает 
за цвет/карту окружения для отражений и преломлений;

 y Color Mapping (Цветовое отображение) – цветовое ото-
бражение (в списке Type содержится несколько типов цветового 
отображения, каждый характеризуется своими особенностями. 
Рекомендуется использовать HSV Exponential (HSV экспоненци-
альная функция));

 y Global Illumination (Непрямое освещение) – процесс си-
муляции непрямого освещения, при котором учитывается свет, 
отраженный от поверхности, а поверхность, на которую падает 
свет, окрашивается в цвет отражений.

Практическое задание по пункту 4.9

Создайте композицию и сохраните ее в виде конечного фай-
ла изображения, используя настройки визуализатора.

Контрольные вопросы
1. Назовите стандартный визуализатор 3ds Max.

2. Какие параметры настраиваются для стандартного визуализатора?

3. Какими способами можно ускорить расчет сцены?

4. Перечислите параметры, влияющие на качество визуализации.

5. Каким образом сохраняется анимация при визуализации? В каких форматах 

файлов?

6. Назовите альтернативные визуализаторы. В чем их преимущества?

7. Как настроить альтернативный визуализатор?
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